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INTRODUCTION 

How to use this documentation 

REFERENCE GUIDE 

READ THE NEXT TWO PAGES, EVEN IF YOU 
DON'T READ ANYTHING ELSE. 

Many people only read their user's manual as a last 
resort. If you are one of those, the next two pages tell 
you where to find information when you need it. 

1) To learn how to install Xerox Ventura Publisher, 
read Chapter 2: Setup and Installation. If you 
want to install without reading the manual, insert 
the Application Disk in the A drive, type 
A:VPPREP and then press the Enter key. 

2) To run Ventura Publisher, type VP and then press 
the Enter key. To quit, select the QUIT option in the 
File menu. 

3) This is a Reference Guide. It provides a complete 
description of each feature, and assumes you already 
understand concepts unique to Xerox Ventura 
Publisher, such as Style Sheets and Chapters. To 
learn how to use the basic features, read the Ven­
tura Publisher Edition Training Guide. 

4) To learn by looking at examples, OPEN the ex­
ample chapters contained in the TYPESET sub­
directory. The style sheets associated with each of 
these chapters are described in Appendix L. 

5) Read the User Interface chapter to learn about 
using the mouse and keyboard shortcuts. 

6) Read the Functions chapter to learn about Xerox 
Ventura Publisher's four separate functions (Frame 
Setting, Paragraph Tagging, Text Editing, and 
Graphic Drawing.) 
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INTRODUCTION Contents of package 

7) Read the Menu Commands chapter to obtain a 
complete description of each menu operation. 

8) If you have a problem, read through the Common 
Problems appendix (Appendix C.) You should also 
consult the Problem heading in the index. 

9) Other useful information about printers, 
wordprocessors, and advanced operation is contained 
in the various appendices. 

10) If you want to add additional fonts to your printer, 
read Appendix K. 

~ Do not use the DOS COPY command to copy chap­
ters. Use Xerox Ventura Publisher's Multi-chapter 
Copy command instead (see the Multi-chapter sec­
tion in the Menu Commands chapter.) 

~ Background utilities (such as Sidekick) should not be. 
installed when running Xerox Ventura Publisher be­
cause they reduce the chapter size. 

For technical support, call Xerox at (214) 436-2616. 
If you are interested in joining the Ventura Publisher 
User Groug (VPUG) , a non-profit user group which is 
not affiliated with Xerox, you can contact them at: 

VPUG 
675 Jarvis Drive 
Morgan Hill, CA 95037 

Contents of package 

1-2 

Xerox Ventura Publisher includes: 

Eleven 5114 inch MS-DOS formatted floppy 
disks: 

• 1. Xerox Ventura Publisher Application Disk 
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Features 

Features 
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• 2. Xerox Ventura Publisher Examples Disk 
(contains sample style sheets, table templates, 
and example documents.) 

• 3-10. Xerox Ventura Publisher Device Driver 
Disks (contain configuration software for 
various printers and displays, plus fonts for 
each printer and display.) 

• 11. Xerox Ventura Publisher Utilities Disk 
(contains font and picture conversion utilities) 

Ventura Publisher Edition Reference Guide 
Ventura Publisher Edition Training Guide 
Ventura Publisher Edition Quick Reference 
Registration Card 
License Agreement 

Xerox Ventura Publisher is a professional page 
layout system that lets you create typeset documents 
by automatically combining text from wordproces­
sors with pictures from AutoCAD, Lotus 1-2-3, Men­
tor Graphics PC CAD programs, GEM Draw, GEM 
Graph, PC Paintbrush TM, and Macintosh (see Appen­
dix J for a complete list of graphics software sup­
ported.) Also, pictures created in many other 
programs (such as Lotus Freelance), and then con­
verted to General Parametric's Video Show format, 
AutoCAD DXF format, HPGL, CGM, or encapsu­
lated PostScript, can be used as well. Images created 
by a graphics artist can be digitized with a scanner, 
converted to GEM or PC Paintbrush file format, and 
then displayed, scaled, cropped, and moved on the 
computer screen. You can also create simple draw­
ings .directly in Xerox Ventura Publisher. 

The resulting pages are formatted automatically by 
Style Sheets. A Style Sheet is a computer file which 
contains typographic attributes (e.g., fonts, ruling 
lines, inter-line spacing.) These attributes are 
grouped together into Tags which can then be ap-
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INTRODUCTION Typographical conventions 

plied to each paragraph in your document. By apply­
ing a tag to a paragraph, you change the typographic 
attributes for that paragraph. The same Style Sheet 
can be used for many documents, resulting in consis­
tent typography from one document to the next. Also, 
a style· sheet designed by a typographic professional 
can be used by an amateur to produce sophisticated 
documents. 

Depending on the number of pictures, number of 
paragraphs, version of DOS, and size of width table, 
each chapter can contain up to 500K bytes of text in 
a 640K system. Up to 128 chapters can be combined 
together into a Publication. Thus, you can develop 
and print documents which are thousands of pages in 
length. 

Appendix J contains a complete features list. 

Typographical conventions 

1-4 

The ~ callout emphasizes important points 
throughout this manual. 

Throughout this manual, when you see 

Enter 

you should press the Enter key (sometimes called the 
Return key.) 

Anything to be typed by you is shown in upper case, 
but can always be typed in any combination of upper 
and lower case. 

The terms Text, Line Art, Images, and Graphics 
are used throughout this manual. Text refers to 
everything that originates either in a wordprocessor 
or in Xerox Ventura Publisher's Text Editing nmc­
tion. Line Art refers to artwork generated by com­
puter graphics programs such as AutoCAD or GEM 

REFERENCE GUIDE 



Typographical conventions INTRODUCTION 

REFERENCE GUIDE 

Draw. Images refers to artwork generated by a scan­
ner or paint program. Text, line art, and images are 
all stored and maintained in their original format 
under their original file names. Graphics refers to 
any drawing generated with Xerox Ventura 
Publisher's drawing package. 

The term Mouse Cursor refers to the cursor that 
moves when you move the mouse. The shape of this 
cursor depends on the function selected, and on the 
nature of the action being performed. 

The term Text Cursor refers to the vertical line cur­
sor that indicates the location where text is current­
ly being added or deleted. The text cursor is always 
placed between characters. 

Throughout this manual, the phrase Select the ... is 
used. This means you should move the mouse cursor 
to the middle of the item to be selected and then press 
the left mouse button once. 

Except when explicitly stated, the computer hard 
disk is always assumed to be C. 

The correct name for this product is Xerox Desktop 
Publishing Series: Ventura Publisher Edition. 
Within this manual, this is abbreviated to Xerox 
Ventura Publisher. 
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SETUP AND INSTALLATION 

System requirements 

REFERENCE GUIDE 

Xerox Ventura Publisher requires an IBM PC, IBM 
XT, IBM AT, or a compatible computer which runs the 
same software as these machines. Your computer 
must also contain the following or equivalent: 

A minimum of 512 kilobytes of RAM (640 
kilobytes is recommended when creating 
chapters of more than 20 pages.) 

A hard disk drive with one to three megabytes 
available space to hold software and fonts (space 
required depends on printers installed-see the 
Software Installation section which follows.) 

A graphics board: 
Hercules Graphics Card, or equivalent 
IBM Color Card and compatible color monitor 
IBM Enhanced Graphics Adapter and com­
patible color monitor 
Micro Display Systems Genius display 
Wyse 700 
Xerox 6065 color display adapter 
Xerox 6065 full page display adapter 
Xerox 6065 monochrome display adapter 

A mouse: 
• Microsoft Mouse (serial or bus mouse) 
• Mouse Systems PC Mouse, or one of the fol­

lowing equivalents: 
- Summagraphics Summa Mouse 
- Logitek Logi-mouse 
- Torrington Mouse 
- Microage Mouse 

• Xerox 6065 Mouse 

MS-DOS or PC-DOS version 2.10 (or higher) 
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SETUP AND INSTALLATION Software installation 

You must also have one ofthe following printers 
in order to print what you see on the screen: 

• Any Interpress or PostScript compatible 
printer or typesetter 

• Apple Laserwriter or LaserWriter Plus 
• AST TurboLaser 
• Cordata laser printer 
• Epson MX-80IFX-80/RX-80 
• Hewlett-Packard LaserJet Plus 
• Hewlett-Packard LaserJet with 92286F font 

cartridge 
• IBM Proprinter 
• Tall Tree Systems JLaser printer card and 

compatible printer 
• Xerox 4020 Color Ink Jet Printer 
• Xerox 4045 Laser Printer 

Additional display and printer drivers are available 
from other companies although they are not sup­
ported directly by Xerox. 

~ TO RUN THIS SOFTWARE, YOUR COMPUTER 
MUST CONTAIN HARDWARE FROM THE OP· 
TIONS LISTED ABOVE AND ON THE PRE· 
VIOUS PAGE-INCLUDING A MOUSE AND A 
GRAPHICS BOARD 

Software installation 

2-2 

~ If you previously installed version 1.0 of Xerox Ven­
tura Publisher, please consult Appendix A in the sec­
tion Updating From Version 1.0. 

This section provides installation instructions in­
tended for use by a person who has basic familiarity 
with the IBM PC. Step-by-step installation instruc- ( 
tions, along with instructions on how to modify an ex­
isting installation, are provided in Appendix A. 
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Software installation SETUP AND INSTALLATION 

Note that Xerox Ventura Publisher will not operate 
when shared between multiple computers, nor is it 
licensed for sharing between multiple computer 
workstations on a communications network. It can, 
however, print over a network provided: 

• Each computer workstation on which it is in­
stalled contains 640K bytes of RAM 

• The network software which runs on each 
workstation adds less than 64K bytes to the 
memory required by DOS. 

Installation preparation 

REFERENCE GUIDE 

You need to know the following about your computer 
hardware: 

• Graphics board installed in your computer. 
• Printer port used by your printer e.g., serial or 

parallel ports (or special printer interface.) 
• Serial port or special board used by your 

mouse. 

You should make backup copies of your distribution 
disks to guard against accidental damage. Read the 
Software License and Warranty Agreement at the 
beginning of this manual to understand the legal 
restrictions governing copying and installation of the 
software. 

You need between one and three megabytes of space 
on your computer's hard disk to hold all printer fonts, 
screen fonts, system software, application software, 
and examples. Approximate space requirements are 
as follows: 

Xerox 4045, HP LaserJet Plus . 3.0 Megabytes 
PostScript . . . . . . . . . .. . 1.2 Megabytes 
JLaser, Dot Matrix, Xerox 4020 . 2.0 Megabytes 

Exact space requirements are given in Appendix A. 
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SETUP AND INSTALLATION Software installation 

If you'll be using a Microsoft Bus Mouse, Xerox opti­
cal mouse, or AT&T 6300 mouse, locate the disk that 
contains the MOUSE.COM file. (The Xerox 6060 
mouse file is on the MS-DOS with ScreenMate disk.) 
You must copy this file to your computer's hard disk 
when finished with installation. 

Installation 

~ The installation process can be aborted at any time 
by pressing and holding the Ctrl key and then press­
ing the Break key. 

Make sure that MS-DOS or PC-DOS version 2.10 or 
above has been booted. 

Insert the Xerox Ventura Publisher disk labeled 
Xerox Ventura Publisher Application Disk #1 
into the A drive. The 1.2 Mbyte drive in an AT is 
usually the A drive and can be used. Close the drive 
door, type A:VPPREP and then press the Enter key. 

~ If you install from any drive other than A, type 
n:VPPREP n: where n is replaced with letter of the 
floppy disk drive. 

The system responds with: Is your hard disk drive 
C?Y 

To install Xerox Ventura Publisher on drive C, press 
Enter. If your computer uses a different letter, or you 
have more than one hard disk drive and want to in­
stall on another disk drive, type N and then press the 
Enter key. 

If you answer N, the computer asks you to: 

II Type your hard dis.k drive letter ( A-Z )? II 
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Software installation SETUP AND INSTALLATION 

Respond by typing the appropriate letter. For in­
stance to install for the D drive, type D and then 
press the Enter key. 

After you enter the drive letter, the computer asks: 

Are you installing this version for the first 
time? Y. 

REFERENCE GUIDE 

Respond by pressing Enter. (Note: If you have al­
ready installed Xerox Ventura Publisher version 1.1, 
you can change part of the installation without going 
through the entire installation process by typing N 
and then pressing the Enter key in response to this 
question.) 

Xerox Ventura Publisher then creates new direc­
tories, and instructs you to insert Screen Device 
Driver Disk #3. 

You are then asked what type of graphics board, dis­
play, mouse, and printer you wish to install. You are 
given a list of choices for each hardware option. Type 
the letter of the option you want to install, and then ' 
press Enter. If you make a mistake and type the 
wrong letter, merely type the new letter. If you press 
Enter after typing the wrong letter, either abort and 
start over, or continue until you are asked to confirm 
your choices, and then tell the system that your 
choices are not all correct. You can install up to five 
printer drivers. 

After you have confirmed your choices, you are asked 
to insert one or more of the Xerox Ventura Publisher 
disks, depending on what display, mouse, and 
printers you are using. Don't be surprised if you 
never use certain disks, and you are asked to insert 
others more than once. This is normal. 
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SETUP AND INSTALLATION Software installation 

2-6 

The installation process takes five to thirty minutes 
depending on the printers installed. The message 
Expanding Font Files stays on the screen for five 
to ten minutes, for each printer installed, towards 
the end of installation. 

For complete installation information, consult 
AppendixA. 

Post-installation 

To assure best performance, use the ASCII text nmc­
tion of your wordprocessor to modifY the file in your 
computer called CONFIG.SYS to contain the lines: 
BUFFERS=15 
FILES=15. 

Any number greater than 15 also works. Any number 
less than 15 noticeably degrades performance. 
Without a BUFFERS statement in the CONFIG.SYS 
file, the default is BUFFERS=3. 

If CONFIG.SYS does not exist, you can create it, 
and add the line BUFFERS = 15 by typing the fol­
lowing directly from the DOS prompt (this example 
assumes that the computer boots from hard disk C): 

COPY CON: C:\CONFIG.SYS Enter 
BUFFERS=15 Enter 
FILES=15 Enter 
<Ctrl Z> Enter 

where <Ctrl Z> means "hold down the Ctrl key while 
typing a Z." 

~ Failure to add the BUFFERS and FILES statements 
to your CONFIG.SYS file results in slower perfor­
mance. 

If you installed a bus mouse (option C in the mouse 
menu), copy the file MOUSE.COM from your mouse 
distribution disk to the root directory of your com-
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Starting the program SETUP AND INSTALLATION 

puter. Then use the ASCII text function in your word­
processor to add the word MOUSE to the 
AUTOEXEC.BAT file: 

If your system does not have an AUTOEXEC.BAT 
file, you can create one, and place the MOUSE com­
mand in it by typing the following: 

COPY CON: C:\AUTOEXEC.BAT Enter 
MOUSE Enter 
<Ctrl Z> Enter 

where <Ctrl Z> means "hold down the Ctrl key while 
typing a Z." Some mice use the CONFIG.SYS file to 
load the mouse driver. In this case you must copy the 
file called MOUSE.SYS to the root directory of your 
hard disk, and add the statement 
DEVICE=MOUSE.SYS to the CONFIG.SYS file. 
Consult your mouse manual for more information. 

~ You must place the MOUSE statement in your 
AUTOEXEC.BAT file when using a Microsoft Bus 
mouse, or AT&T or Xerox 6065 Keyboard mouse. 

Starting the program 

REFERENCE GUIDE 

To run Xerox Ventura Publisher, make sure that you 
have logged-onto to your computer's hard disk drive, 
and that you are in the root directory. To log onto your 
computer's hard disk drive (assuming it is drive C), 
and change to the root directory, type the following: 

C: Enter 
CD \ Enter 

Make sure you type \ not I. 

To run Xerox Ventura Publisher, type VP Enter. 

Depending on your computer, Xerox Ventura Pub­
lisher takes anywhere from five to forty-five seconds 
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SETUP AND INSTALLATION Quitting 

Quitting 

to load. Ifloading time seems excessively long (more 
than 45 seconds), make sure that the CONFIG.SYS 
file contains the statement BUFFERS=15, as 
described under Post Installation. 

You can specify the chapter you want to load when 
you start the program by typing the file name on the 
same line with VP. For example: 

VP C:\TYPESET\SCOOP.CHP Enter 

If your computer contains at least 1.2 megabytes of 
RAM, you can increase performance when creating 
long documents. Th do this, follow these steps: 

~ Use the software supplied with your memory card 
to create a RAM disk of at least 500 Kbytes. 

~ Add/O=n :to the last line of the VP.BAT file, where 
n is the letter of your RAM disk drive. For in­
stance, to use a RAM disk configured as drive D, 
the last line of the VP.BAT file should read: 

DRVRMRGR VP %1 fS=SD_X6655.EGAIM=3210=D: 

The IS and 1M options may differ depending on the 
screen and mouse installed 

To load Xerox Ventura Publisher using Xerox Screen­
Mate: 

.~ Press FI, then F9 
~ Highlight VP.BAT 
~ PressF2 and Enter 

OR 
~ Press F9, then Esc (to exit to the DOS prompt) 
~ Type VPEnter 

Th quit from Xerox Ventura Publisher, select the 
QUIT option in the File menu. 
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Mouse 

USER INTERFACE 

This chapter describes the use ofthe mouse and func­
tion of each keyboard key. 

Description 

The mouse is used to move the Mouse Cursor to 
items on the screen which are to be selected. It is also 
used to draw frames and graphics. 

Operation 

Single items are selected by placing the mouse cur· 
sor anywhere inside the item to be selected and then 
pressing the left mouse button once. Placement of the 
cursor is not critical as long as the point of the cursor 
lies within the item to be selected. 

Xerox Ventura Publisher uses only the left mouse 
button. 

When selecting file names, pressing the mouse but­
ton twice in a row, very quickly, is equivalent to 
selecting an item and then selecting OK. 

The mouse cursor changes shape depending on the 
function selected, as shown in Figure 3-1. 

Keyboard keys 

Description 

REFERENCE GUIDE 

Various keys on the keyboard perform special func­
tions: 

3-1 



USER INTERFACE Keyboard keys 

Frame Setting + 
Add New Frame Ifi 

Re-size Frame ~ 
Pan Image ~ 

Move Frame + 
Paragraph Tagging ~ 

Text Editing I 
Graphic Selection ~ 

Box Text lYe 
Line Drawing , 

Circle Drawing E9 
Rectangle Drawing r 

Rounded Rectangle Drawing r 
Figure 3-1 Mouse Cursor Shapes 
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The keyboard Cursor keys control the movement 
of the Text Cursor. 

The Home key goes to the first page ofthe docu­
ment. 

The End key goes to the last page of the docu­
ment. 

The Pg Up key goes to the previous page. 

The Pg Dn key goes to the next page. 

The Del key deletes the character to the right of 
the text cursor when you are using the Text Edit­
ing function. When a block of text, frame, or 
graphic is selected, pressing the Del key is 
equivalent to selecting the Cut option in the Edit 
menu. Pressing the Shift key simultaneously 
with the Del key is equivalent to selecting the 
Copy option in the Edit menu. 

Pressing the Ins key is equivalent to selecting the 
Paste option in the Edit menu. 

The Backspace key deletes the character to the 
left of the text cursor. 

The Esc key halts the print operation for the cur­
rent chapter when printing. When going to a page, 
the Esc key also halts a "go to page" operation. In 
a Dialog Box, the Esc key deletes all characters on 
the line that contains the text cursor. At all other 
times, the Esc key reformats the current page. 

The Alt key performs several functions: 

• Used in conjunction with the mouse to move 
cropped pictures within frames. Press and 
hold down the Alt key, move the mouse cursor 
to the center of the image to be moved, press 
and hold the mouse button, and then move the 
image. Release both the Alt key and the 
mouse button when finished. 

The Shift keys are used in conjunction with the 
mouse to select multiple paragraphs, frames, or 
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graphics.. Press and hold down either shift key 
while selecting in order to select several items. 
Also, pressing the Shift key while adding frames 
or graphics keeps the Add New Frame or graphic 
tool enabled> thus letting you draw several frames 
orgrapbics ina row. Finally,pressing the right i 

Shift key and theCtrl key simultaneously causes 
the keyboard cursor keys to toggle between con­
trolling the text cursor (normal operation) and 
controlling the mouse cursor. 

The Tab key inserts horizontal tab characters. 

The Special Function Keys can be used to tag 
paragraphs, if the style sheet has assigned tags to 
these keys. See Assign Function Keys in the 
Menu C()tttmall'cischapter. 

The Ctrlkey is used: 

,. With the Enter .key to insert a line break 
• With the Hyphen key to insert a discretionary 

hyphen. 

Pressing and holding the Ctrlkey while selecting 
graphics or frames with the mouse lets yoo.select 
graphi'cs which are "hidden"beneat'hother 
gfa,phics. Pressing theCtri and right Shift keys 
simultanoouslytoggle:s the keyh<rard :cursor keys 
between 'COntrol of the mouseaml text eursors. 

Many ofXero:i: VenturaPublisher'sfu.nctions eanhe 
oontrotled di'teCtly front the keyboard" as :Shown ;in 
the table (}nthe ifeUo-win;gpage.'The Aaymboi mean~ 
"'press mld~d down the Ctrl hy." 



Keyboard keys 

Function 

Assign Func. Keys 
Bring to Front 
Copy ... . 
Cut ... . 
Enlarged View 
Fill Attributes 
Frame Setting Function 
Go to Page ..... 
Graphic Drawing Function 
Line Attributes ... . 
Normal View .... . 
Paragraph Tagging Function 
Paste ...... . 
Recall Last Dialog Box 
Reduced View 
Renumber Chapter 
Save ..... . 
Select All (graphics) 
Send to Back 
ShowlHide Tabs & Returns 
ShowlHide Side-Bar 
Text Editing Function . . 

Key 

"K 
"A 

USER INTERFACE 

Shift Del 
Del 
"E 
"F 
"U 
"G 
"P 
"L 
"N 
"I 
Ins 
"X 
"R 
"B 
"S 
"Q 
"Z 
"T 
"W 
"0 

Adding characters not on keyboard 

REFERENCE GUIDE 

Many typographic characters not found on the stand­
ard computer keyboard can be entered using the 
keyboard combinations shown below. 

Many characters can be entered using the Alt key 
and numeric keypad combination as follows: Press 
and hold down the Alt key, and type the numeric 
equivalent on the keypad for the character you wish 
to enter; then release the Alt key (Appendix E shows 
the numbers for each character.) For commonly used 
typographic characters, Xerox Ventura Publisher 
provides the keyboard shortcuts shown below. Also 
shown below are the keyboard combinations for 
various types of typographic spaces. As in the pre­
vious table, the " symbol means "press and hold 
down the Ctrl key." 
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Function 

Addition button 
Copyright mark © 
Discretionary hyphen 
Em dash-
Em space 
En space 
En dash-
Figure space 
Non-breaking space 
Quote, open " 
Quote, closed" 
Registered trademark ® 
Thin space 
Trademark ™ 

Keyboard keys 

Key 

1\ 2 
1\ Shift C 
1\ 

1\ ] 

1\ Shift M 
1\ Shift N 
1\ [ 

1\ Shift F 
1\ space 
1\ Shift [ 
1\ Shift] 
1\ Shift R 
1\ Shift T 
1\ Shift 2 

Operation-Cursor keys 

3-6 

While in a Dialog Box, Item Selector, or when using 
the Text Editing function, the text cursor can be 
moved to another location on the screen by moving 
the mouse cursor to the desired new position and 
pressing the mouse button once. Once placed, the 
text cursor can be moved back and forth one charac­
ter at a time, as well as up and down one line at a 
time, using the keyboard cursor keys. 

The keyboard cursor keys can also be used to control 
the mouse cursor. Changing from text cursor to 
mouse cursor control is done by pressing the Ctrl and 
right Shift key simultaneously. Xerox Ventura 
Publisher causes the computer to beep, indicating 
that the usage of the cursor keys has changed from 
controlling the text cursor to controlling the mouse 
cursor. In this mode, pressing the Home key once is 
equivalent to pressing and releasing the mouse but­
ton. Pressing the End key is equivalent to pressing 
and holding the mouse button. (Press the Home key 
to "release" the mouse button.) Press and hold the 
Shift key to reduce the travel of the mouse cursor 
each time the keyboard cursor key is pressed. Press-
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ing the Ctrl and right Shift keys again resumes the 
keyboard cursor keys' normal operation. 

~ If the keyboard keys do not affect either the mouse or 
the text cursor, press the Num Lock key once and try 
again. On many computers, Nurn Lock must be offfor 
the keyboard cursor keys to work. 

Dialog box 

RULlN6 LINES ABOOE 

Width: I None I I Text I I Margill I I COIURIl I liliiii I CustaR I 
Color: []iillJ Iml Red II Sreen II Blue I am:J I Yellolll CHilliliJ 

Pattern: rn m rn rn m rn CD lID I Dashes Off I 
0.II1II 
O.BOO 
B.ODD 

Space Above Rule 1: 
Height of Rule 1: 

Space Below Rule 1: 
Height of Rule 2: O.BOB 

Space Below Rule 2: 0.000 
Height of Rule 3: 0.000 

j 
Dash Width: 0.000 

Dash Spacing: 0.000 
CustOR Indent: 0.000 m G 

CustOR Width: 0.000 

0.500 inches ~_--11 

Space Be low Rule 3: 0.000 • G 
Overall Height: O.DBO 

Point to the 
measurement units 
with the mouse 
cursor, and press the 
mouse button to 
change the 
measurement units 

Figure 3-2 Typical Dialog Box. Note that Frame, 
Black, Solid, and + are selected. 

Description 

Most of Xerox Ventura Publisher's features are con­
trolled through Dialog Boxes similar to the one 
shown in Figure 3-2. 

Operation 

REFERENCE GUIDE 

To set a feature in a Dialog Box, use the mouse to 
point to the selection you want to choose, and then 
press the mouse button. The background in the box 
just selected changes from white to black. 
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If the item you select is a Command or Insert, the 
background will not change color permanently, but 
the command you requested will be executed. 

Ifthe text within the item you want to select is shown 
in gray instead of black type (e.g., the word Column 
in Figure 3-2), this means that the item is notavail­
able for selection given the current Dialog Box set­
tings. 

To enter information, first place the text cursor on 
the line whose value you want to change. This is done 
either by moving the mouse cursor to the line whose 
value you want to change and then pressing the 
mouse button once, or by moving the text cursor from 
its current location using the keyboard cursor keys. 
The vertical text cursor then appears on the chosen 
line. You can then use the Backspace key or Del key 
to erase some of the line; use the Esc key to erase the 
entire line; or use the keyboard cursor keys to move 
the text cursor without erasing information. Then, 
type the desired value. 

I1af The Esc key is used in the Dialog Box to erase an en­
tire line of text or numbers. 

To accept the new settings in a Dialog Box, move the 
mouse cursor to the box labeled OK and press the 
mouse button. Pressing the Enter key on the 
keyboard is equivalent to selecting OK with the 
mouse button. If you decide not to make any changes, 
move the mouse cursor to the box labeled Cancel and 
press the mouse button once. None of the changes 
will take effect. 

I1af Do not use the Enter key to move the text cursor to 
the next line. Pressing this key is equivalent to 
selecting OK. Use the keyboard up and down arrows, 
or tab and backtab instead. 
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Changing measurement system 

REFERENCE GUIDE 

Numerical settings in each Dialog Box may be set in 
inches, centimeters, picas & points, or fractional 
points. The measure used can be changed at any 
time. To change a measure, simply point to the unit 
of measurement (e.g., the word Inches), and press 
the mouse button once (Figure 3-2.) The unit of 
measure changes and the value for that setting is 
recalculated. Each press of the mouse button changes 
to the next unit of measure, until you return to the 
original measure. Fractional Points provides the 
greatest precision. 

When Fractional Points is selected, you may notice 
that Xerox Ventura Publisher changes the number 
you entered slightly. For instance, 2.00 points is 
changed to 1.98 points. This is normal, and is due to 
the way numbers are converted from one measure­
ment system to another. 

When setting measurements in picas, the numbers to 
the left of the comma are picas, and to the right of the 
comma the numbers are points. Thus, to set three 
picas, two points, you should type 3,02. 

Since there are twelve points in a pica, 3,12 is 
equivalent to 4,00. 

For those not familiar with typesetter measures, 
seventy-two points and six picas both equal one inch. 

When changing between measurement units, the 
tilde (-) character may appear. This indicates that 
the setting is too large to be displayed in that 
measurement unit. For instance, if you set the top 
margin to 2.00 inches and then change to Fractional 
Points, you will see the tilde character because two 
inches is larger than 99.99 points, the largest setting 
aUowed in that measurement unit. If the tilde is dis­
played, the original setting is not lost. Simply select 
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a different unit of measure and make the desired 
changes in that different measurement system. 

Item selector 

3-10 

ITEM SELECTOR File Filter 

Directory Line - .. Di~~":~,~"~~,: C:\LET,~,,~~\~ ___ _ 
Backup Button - ... 1~m"E"","m *.CHP ;;;;;mm""m Sdectlon: ACCOUNT ,CH~ 

Directory Name - - •• AU6USL,_ :. 
• JULY_,_ 
• SEPT • 

File Name - -. 2JB -:r1iJi - Scroll Bar 
240 .CHP 

,~mIA~1 DO 
ACCOUHTJ.CHP ill 
EPSBtlCK ,CHP • lliiilliJ 

Figure 3-3 Item Selector. Directory names are 
preceded by the • character. The backup button I 

moves up one directory level. 

Description 

The display shown in Figure 3-3 is called an Item 
Selector. The Item Selector is used for saving and 
retrieving files. 

Application 

The Item Selector allows you to save and retrieve 
files by pointing to the file name, or by typing the file 
name. 

The Item Selector also provides a simple way to move 
between various DOS subdirectories where text, line 
art, image, chapter, and publication files may be 
stored. 
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The Item Selector automatically "filters" the files dis­
played so that you need only search for files which 
match specified criteria. For instance, only chapter 
files (which are stored with a file extension CHP) are 
displayed when loading or saving chapters. The 
method for filtering files follows standard DOS con­
ventions, including wildcard characters (e.g., * and 
?) These filters can be changed by placing the text 
cursor on the Directory line and typing a new filter 
name. Figure 3-3 shows the filter set to display all 
chapter (CHP) files that are contained in the sub­
directory called LETTERS. 

Operation 

To save or retrieve a file once the Item Selector is dis­
played on the screen, select the file name with the 
mouse and then select OK. 

Until you press the mouse button while pointing to 
OK, you can change your mind and select some other 
file name. If you decide not to make any selections, 
point to Cancel and press the mouse button. 

If the file name you are looking for is not shown, use 
the Scroll Bar to move up and down through the list 
of files. Scrolling operations are described later in 
this section. 

~ Pointing to the desired file name, holding the mouse 
stationary, and pressing the mouse button twice, 
with little hesitation between each depression is 
equivalent to selecting the file name and then select­
ingOK. 

Ifthe file name does not yet exist (when saving a file), 
or if you want to save the file under a different name, 
or if you prefer to use the keyboard to type the name 
of the desired file, place the text cursor on the Selec­
tion line, erase any text on this line, type the new file 
name, and then select OK. 
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~ If the computer beeps when the Item Selector is dis­
played, more than 64 files match the file filter in the 
current subdirectory. The last files modified are not 
shown. Either change the file filter to restrict the 
number of files shown, or delete some files using the 
DOS File Operations option in the Options menu. 

Subdirectories 

Changing directories and disk drives is covered in 
the Training Guide. Please note, however, the follow­
ing two cautions: 

~ If you have only one disk drive, and you select the B 
drive, DOS attempts to print a message on the screen 
telling you to insert a disk in the B drive. You may not 
be able to read the message, however, and will see 
several jagged horizontal lines through the display. 
Ignore these lines, place a disk in the floppy disk 
drive, and press Enter. The horizontal lines disap­
pear as you continue working on your chapter. 

~ Be careful when reading files directly from a floppy 
disk. If you create a chapter with files from a floppy 
disk and then save the chapter on your computer's 
hard disk, Xerox Ventura Publisher expects those 
same files to be available in the floppy disk drive 
when that chapter is next opened. 

File name conventions 

The default file name extensions are shown on the 
next page. Any changes to these default extensions 
remain in effect until next changed, even if you Quit 
and then return to Xerox Ventura Publisher. 
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Program 

ASCII 
AutoCAD 
CGM .. 
DCA 
GEM Line Art 
GEM Image 
HPGL 
Lotus 1-2-3 
Macintosh Paint 
Macintosh PICT 
Mentor Graphics 
MS Word 
Multimate 
PC Paintbrush . 
PostScript Encapsulated 
Video Show files 
Wordperfect 
Wordstar 
WordstarUK 
Xerox Writer 
Xywrite .. 
Ventura Publisher 
Captions .... . 
Chapters ... .. 
Chapter Information 
Generated text 
Fonts ..... . 
Graphics .... . 
Hyphenation algorithms 
Hyphenation dictionaries 
Printer information file 
Print files . 
Publications 
Style sheets 
Width tables 

USER INTERFACE 

Extension 

*.TXT 
*.SLD 
*.CGM 
*.DCA 
*.GEM 
*.IMG 
*.HPG 
*.PIC 
*.PNT 
*.PCT 
*.P* 
*.DOC 
*.DOC 
*.PCX 
*.EPS 
*.PIC 
*.WP 
*.WS 
*.TXT 
*.xWP 
*.TXT 

*.CAP 
*.CHP 
*.CIF 
*.GEN 
*.FNT 
*.VGR 
*.HY1, *.HY2 
*.DIC 
*.CNF 
*.COO 
*.PUB 
*.STY 
*.WID 

~ If you can't find a file name, check to make sure you 
are looking in the correct subdirectory, on the proper 
disk drive, using a file filter that matches the type of 
file you are retrieving (e.g., CHP or STY files.) 
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These file name conventions are designed to help you 
avoid loading the wrong type of file. For example, if 
you specify a text file after choosing Load TextlPic­
ture, but instead actually load an image file, the 
results of this operation cannot be guaranteed. 

Main screen controls 

Function "e.leC:~01·"~ 
Full Box 

Scroll Up One Line Addition Button -,..iiiioi .... 

Vertical Scroll Bar 
Assignment List -I-+-+ 

PageN 

Menus 

Horizontal Scroll Controls 

Size Box I Scroll Down One Line 

Figure 3-4 Ventura Publisher Main Screen 

Figure 3-4 shows the Xerox Ventura Publisher screen 
with the Paragraph Tagging function enabled. The 
operation of each function shown in this figure is 
described below. The functions are explained, in 
clockwise order, starting at the top of the screen. 

When the mouse cursor points to the menu names at 
the top of the screen, menus drop down. 

~ To clear a menu that has dropped down, move the 
mouse cursor outside the drop down menu and press 
the left mouse button once. 

3-14 REFERENCE GUIDE 



Main screen controls USER INTERFACE 

As you move the mouse cursor down through the 
menu, each menu option, initially shown as black on 
white, reverses to white on black. This highlighting 
indicates that the item is available for selection. To 
select a highlighted item, press the left mouse button 
once. 

Some items in a menu are shown in gray rather than 
black and cannot be highlighted. This indicates that 
the option is not available with the current function 
selected. 

Title bar 

The Title Bar shows the current chapter and style 
sheet file names. If the chapter has not yet been 
saved, the word "UNTITLED.CHP" appears. 

Full box 

Xerox Ventura Publisher pages appear within a win­
dow on the screen. If you have used the Size Box to 
make the window smaller, the Full Box returns the 
window to full screen size. 

Scroll up one line 

REFERENCE GUIDE 

The Scroll Up One Line feature moves the screen 
up over the page in increments of approximately one 
line. 

To operate, move the mouse cursor to the scroll up 
box and press the mouse button once. To continue 
scrolling, press and hold the mouse button until the 
display is where you want it, then release the mouse 
button. For large movements, use the Vertical Scroll 
Bar instead. 
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Vertical scroll bar 

The Vertical Scroll Bar moves the screen up or 
down over the page by an amount that depends on 
how far you move the scroll bar. 

To operate, move the mouse cursor to the scroll bar, 
press and hold the mouse button, and "drag" the 
scroll bar up or down, depending on which direction 
you want the screen to move over the page. When the 
scroll bar is where you want it, release the mouse 
button. 

The gray area above and below the scroll bar indi­
cates how much of the page is not displayed. For in­
stance, if the gray area is three times as long as the 
scroll bar, then three times more page length is not 
shown compared to what is shown. 

To move up or down approximately one screen 
length, move the mouse cursor to the gray area above 
or below the scroll bar and press the mouse button 
once. 

Scroll down one line 

This works identically to Scroll Up One Line, 
described on the previous page, except that it moves 
the screen in the other direction. 

Size box 

The Size Box is used to change the size of the Xerox 
Ventura Publisher window. 

The Size Box is installed for future use. 

Horizontal scrolling controls 

These controls work like the Vertical Scroll controls, 
except that they move the screen horizontally. 
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Side-bar 

USER INTERFACE 

The left side of the screen, called the Side-Bar, con­
sists of four features: The Page Number Indicator, 
the Assignment List, the Current Selection Indicator, 
and the Function Selector. 

Page number indicator 

The Page Number Indicator shows which page is 
currently displayed and whether the page is a left or 
right page. When you change a tag, renumber sec­
tions, or go to page, the page number indicator shows 
which page is currently being reformatted. 

Assignment list 

Frame 
Setting 

Paragraph 
Tagging 

Text 
Editing 

Graphic 
Drawing 

The Assignment List shows the items which can be 
assigned to whatever is currently selected in the 
main screen area. The Assignment List displays, in 
alphabetical order, the choices available with each 
Xerox Ventura Publisher function. The Assignment 
List is used to transfer a file, tag, attribute, or 

TextlPicture PageslFrames Frame Contents, 
Files Size, Placement 

Tags Paragraphs Paragraph 
Format 

Text Text Text 
Attributes Attributes 

Graphic Graphic Objects Graphics 
Tools Size, Placement 

Figure 3-5 Assignment List contents depend on function selected. 
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graphic object from the Assignment List to either the 
frame, the paragraph, or the text that has been 
selected. The contents of the Assignment List for 
each function are shown in Figure 3-5. 

I@f If nothing happens when you point to the item in the 
Assignment List, you probably forgot to first select a 
frame, paragraph, or text. 

The operation of the scroll bars in the Assignment list 
is identical to the main screen scroll bars, described 
on the previous page. 

Current selection indicator 

The Current Selection Indicator shows what item 
from the Assignment List is currently assigned to the 
selected frame, paragraph, text or graphic. 

Function selector 

The Function Selector consists offour icons (pictures) 
in the upper left corner of the screen. These icons 
show which of the four major functions is currently 
enabled. The operation of the four major functions is 
described in the next chapter. 

Immediately below the Function Selector is the Ad­
dition Button which lets you add a frame, tag, or 
text attribute, depending on which function is cur­
rently enabled. The addition button can be activated 
by selecting with the mouse, or by holding the Ctrl 
key and then pressing 2. 

WYSIWYG 
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Xerox Ventura Publisher is designed to provide What 
You See (on the screen) Is What You Get printed 
(WYSIWYG.) This means that the computer display 
should match as closely as possible, at all times, what 
you will see on the final printed page. Of course, the 
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difference between the technology used to display a 
page on a computer screen and the technologies used 
to print a page on a laser printer or typesetter do 
create some unavoidable differences. In particular, 
because a computer screen cannot produce anywhere 
near the same resolution as a printer or typesetter, 
and because what is displayed is shown in a different 
aspect ratio (height to width ratio), the space be­
tween words and between lines will appear larger or 
smaller on the computer screen than on the printed 
page. 

All colors other than white appear as the same shade 
of black on a monochrome monitor. In order to see 
color on the screen, you must use an Enhanced 
Graphics Adapter (EGA) or Display Enhancement 
Board (DEB) and compatible color monitor. The num­
ber of colors displayed depends on the EGA or DEB 
hardware configuration. However, regardless of 
monitor used, the text prints in the color chosen if a 
color printer is used and if that printer is capable of 
producing the color selected. 

Most printers do not print to the edge of the page. 
Therefore, if you place pictures, graphics, or text near 
the edge ofthe page, these will show correctly on the 
screen, but will not print. Consult Appendix F for in­
formation on the blank space left at the edge of the 
page by your printer, or print the CAPABILI chap­
ter contained in the TYPESET directory to see the 
capabilities of your particular printer. 

The character set for certain printers doesn't include 
all characters available in Xerox Ventura Publisher's 
character set (Appendix E.) Consult Appendix F to 
see which characters are available for your printer. 
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This page intentionally left blank. 
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FUNCTIONS 

Figure 4-1 Function Selector. (The Frame Setting 
Function is enabled.) 

This chapter describes Xerox Ventura Publisher's 
four major functions (modes of operation.) 

• Frame Setting 
• Paragraph Tagging 
• Text Editing 
• Graphic Drawing 

To enable a function, move the mouse cursor to the 
appropriate box in the Function Selector and press 
the mouse button once. The background of the 
selected icon changes from white to black, and the 
contents of the Assignment List immediately change 
to show the attributes available in that function. In 
Figure 4-1, the Frame Setting function is selected. 

The use of each of the functions is described on the 
following pages. 
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Frame setting function 
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Frame definition 

A frame is a rectangular area of the page which can 
contain either: 

• Text 
• Line art 
• Graphics 

Frames can be moved and re-sized. 

Underneath the frames you draw is a special frame 
called the Underlying Page. When text fills the un­
derlying page, a new page is automatically created. 
However, when text fills a frame that you've drawn, 
you must draw a new frame. 

The underlying page cannot be cut, copied, re-sized, 
or moved. 

~ Placing text in frames which you draw is used for 
newsletter and magazine layout. Placing text in the 
underlying page is used for books and manuals. 

Frame setting function application 

The Frame Setting function allows you to: 

• Create new frames 
• Place files from the Assignment List into 

frames 
• Select, move, re-size, copy, and delete frames 
• Remove files from selected frames, or from the 

Assignment List 
• Change frame attributes such as column 

balance, margins and columns, ruling lines, 
captions, and background pattern 
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Adding frames 

REFERENCE GUIDE 

The Addition Button displays the words Add New 
Frame when the Frame Setting function is enabled. 
Add New Frame has three primary purposes: 

Add new frames to an existing layout. 
Block text from flowing into unwanted areas of 
the page. This is particularly useful for con­
structing runarounds, where text is made to 
flow around an irregularly shaped object. 
Add additional space between lines or 
paragraphs. 

To add a new frame, first select the Frame Setting 
function (Figure 4-1) and then select the Add New 
Frame button or hold the Ctrl key and then press 2. 
Frames are then created by moving the mouse cursor 
to the point on the page where you want to start the 
upper left corner of the frame. Press and hold the 
mouse button. Then drag the lower right corner of 
the frame to the desired location (Figure 4-2) and 
release the mouse button (Figure 4-3.) Text already 
on the page flows around the frame. 

CompetingTechnologiesl 

• Daisy Wheel1F 

• Dot Matrix'll 

Bond Survey, milrket'resear~h Firm 
Laser Computing of Alamo, TeXiS, 
polled over 600 computer spedalty 
stores Findlng that, while laser­
printer sales ire up, they hive not 
eClipsed dot-matrix printers.1I 

LlSer Computing analyst Todd 
Wiggins siid he expects dot-mltrix 
~~,-.-.~ .- .• _,,_ ..• '. __ .'<-- ........ 

Figure 4-2 Adding New Frame. Mouse button still 
pressed down. 
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A'i laser printers glin more iltten­
L"'l.ion with low~ pri~es:, higher 
speeds ilnd quality output, high-end 
doi-mitt;X printers irE! starting to 
lose some of . 
their 

aUOI'ding to industry observers.1F 
Lilser printers, though relatively ex' 

pensive, irE! being used more in nel' 
worked environments where the dis' 
tributed use of the printer justiFies 
the expense, seven! aflalysts said. 
The non-imp.ld printers 11so eiteh 
user interest 'beciuse they ire less 
noisy, oFFer sharper graphiesf 

(eommonly 300·by·300 dots per 

i.~h!_~~_d _:~n !,:~~.~~ From eight to 

Frame setting function 

d~~:~~S W:~h ;~6~bO;_~O" ··r·~S~l~on. 
Th.d's when you will see i. huge im­
pilei on dol-matdx printers, both in 
prke lTId the number of units ship­
ping," he Slid, adding thi t it will be 
I y*r to 18 mon.ths beFore this hlP 
pens.1F 

Jones WiS quick to point out that 
he never sees dol "matrix printers 
disappearing. .. .. Multiple·pit! Forms 
_~~ _~'" ' ...... _A~ •• _. ~_ .... _ , __ .. ~ 

Figure 4-3 Adding New Frame, mouse button 
released. Text flows around frame automatically 

Text which contains horizontal tabs will not flow 
around frames if the tab stops and the frame occupy 
the same position on the page. 

Once the mouse button is released, Xerox Ventura 
Publisher automatically de-selects the Add New 
Frame button, and the frame just created is selected. 
This allows you to move or re-size the frame just 
created, or immediately assign a file from the Assign­
ment List. To prevent Xerox Ventura Publisher from 
automatically de-selecting the Add New Frame but­
ton, press and hold either Shift key on the keyboard 
prior to drawing a frame. As long as you hold the 
Shift key, Xerox Ventura Publisher lets you draw 
another frame without first selecting the Add New 
Frame button. 

The last frame drawn on a page is placed on top of all 
other frames. Text placed in lower frames flows 
around frames on top. To place an existing frame on 
top, cut that frame and then immediately paste it 
back to the page. 
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If text from a file is placed into more than one frame 
on a page, it will always flow into the bottom frame 
first and then into the top frame. 

Types of files in frames 

Xerox Ventura Publisher can place text or picture 
files into frames. Text files can originate in another 
wordprocessor or be entered using the built-in 
wordprocessor. Pictures, on the other hand, are al­
ways created and edited in another program. Pic­
tures can be either Line Art or Images. 

Line Art refers to pictures stored as vectors and ob­
jects (mathematical expressions) whereas Images 
refers to pictures stored as simple bits (l's and O's.) 
Because the mathematical expressions can be re­
computed for any output device (printer or typeset­
ter), line art always prints at the maximum resolu­
tion that the output device can produce. By contrast, 
images can never be printed with more resolution 
than when they were first created. For instance, an 
image created with a 300 dot per inch scanner and 
printed on a 1200 dot per inch typesetter only 
provides 300 dots per inch quality. On the other hand, 
line art created on the computer screen (which is 
relatively low resolution), still prints with 1200 dots 
per inch resolution. 

Placing files into frames 

REFERENCE GUIDE 

Select the left box in the Function Selector. 

Use the Load TextlPicture option (Figure 4-4) to build 
up a list of text, image, and line art files in the As­
signment List. To place the contents of a file into a 
frame, first select the frame and then select the file 
from the Assignment List. If a file is already in the 
frame, the new file takes its place. (The contents of 
the file which is removed this way are not affected.) 

4-5 



FUNCTIONS 

4-6 

Frame setting function 

LOAD TEXT/PICTURE 

T~pe of File: lliill'W. D!illJ 
Text Fornat: I G~l1mt~d I rn:m:J I WardStar US I I Mu1tiMJt~ I 
~ I Writer I I WordPerfect I 
I Word5tJf UK I ~ []ill 

Line·Art fmat: rn!O 'iMiilli!i_lIll I Lotus .PIC I I Mentor 6r I 
I UideoShow I Q!KIillJ [ill] I PostScript I 
I HPH I 

lnage Fornat: I GEM! HlllD DPE I I PC-Paintbrush I I MAC Paint I 
~ of Files: lID I Several I [J!J I Cancel I 

Figure 4-4 Load Text / Picture Dialog Box set to load 
AutoCAD file 

The file currently placed in the selected frame or 
page is shown in the Current Selection Indicator. 

When a text file is placed in the underlying page, any 
text that does not fit on the page automatically flows 
to succeeding pages. However, when placing text in a 
frame, you must first manually select the next frame 
on which you want the text to continue, and then 
select the file name in the Assignment List. 

~ You must always select a frame or the underlying 
page before selecting a file to place in the frame or 
page. If no frame is selected, nothing happens. 

The same line art or image file can be placed within 
different frames in a chapter. This same picture can 
be scaled differently in each different frame. 
However, a text file, even if it fits entirely into one 
frame, can only be used once in a chapter. (One ex- I 

ception: Repeating Frames allow the same text to ap­
pear on every page. See Repeating Frames in the 
Menu Commands chapter.) 
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Removing files from frames 

A file can be removed from a frame either by placing 
another file in the frame, or by selecting the frame 
and then selecting the Remove File option in the 
Edit menu (Figure 4-5.) 

REMOVE FILE 

File Name: GRAPH2 .PICI 

Remove from: list of Files I Frame I 

OK I Cancel I 

Figure 4-5 Remove File Dialog Box. GRAPH2.PIC 
will be removed from list of files in Assignment List as 
well as from frame. 

Moving and re-sizing frames 
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To move a frame and its contents to another position 
on the page, first select the frame. Next, place the 
mouse cursor within the frame, and press and hold 
the mouse button. The mouse cursor changes to a pic­
ture of a cross with arrows on each end. Move the 
frame to the desired new location and release the 
mouse button. If Turn Column Snap On is selected 
in the Options menu, the frame aligns with the 
nearest column guide when placed near that guide. 

To increase or decrease the size of a frame, first select 
the frame. Next, place the mouse cursor inside one of 
the eight sizing buttons found around the perimeter 
of each selected frame (Figure 4-6.) Press and hold 
the mouse button. The mouse cursor changes to a pic­
ture of a finger. Continue holding the mouse button 
and move the selected corner or edge to the desired 
new location. When satisfied with placement, release 
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Figure 4-6 AutoCAD file placed in frame. (Note 
sizing buttons.) 

the button. Changing a frame's size changes the size 
ofthe picture in the frame (depending on settings in 
the Sizing & Scaling option-see Menu chapter), and 
increases or decreases the amount of text the frame 
holds. However, any graphic drawn with the Graphic 
Drawing function is unaffected. 

~ If the mouse cursor changes to a picture of a cross 
with arrows on each end instead of a picture of a 
finger, you have not placed the cursor inside the 
sizing buttons. 

Change size of picture only 

To change the placement of a picture within a given 
frame size, first select the frame, and then select the 
Margins & Columns option in the Frame menu. To 
reduce the area occupied by a picture, select larger 
margins, and vice versa. To place the picture to the 
right side of the frame, increase the left margin; to 
place the picture at the bottom of the frame, increase 
the top margin, and so on. 
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Move/copy/delete frames 

To copy or move a frame to another page, or delete a 
frame, follow the instructions given under Cut, Copy, 
and Paste, described in the Edit menu section. 

Select multiple frames 

To select more than one frame, hold down either 
Shift key on the keyboard while selecting each frame 
with the mouse. The Current Selection Indicator dis­
plays the word Multiple to indicate that more than 
one frame has been selected. Any frame in a Multiple 
group can be de-selected by pointing to the frame 
while holding the Shift key and pressing the mouse 
button once. This group offrames can then be moved, 
re-sized, cut, copied, and pasted. 

Text blocking (run arounds) 
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Normally, text already on a page flows around a 
newly created frame. However, text can be made to 
flow behind a selected frame by turning Text Flow 
Around Off in the Sizing and Scaling option (found 
in the Frame menu.) 

To use this feature to make text follow the outline of 
an irregular object (a run around), first create a 
frame as described earlier in this chapter. With this 
frame selected, turn Text Flow Around Off in the 
Sizing and Scaling menu. Next, select the line art or 
image from the Assignment List that you want to 
place in the frame. You should now have an image 
which overlaps text, as shown in Figure 4-7. Then, 
select the Add New Frame button and place boxes 
over each portion of the image or line art that you 
want to be free of text. To keep the Add New Frame 
button selected, hold down either Shift key while 
placing these frames. The process is shown in 
Figures 4-8 and 4-9. 
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Figure 4-7 Flow text around turned off 

Figure 4-8 Multiple Frames added to create 
runaround. 
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You can add space between paragraphs using narrow 
frames. Turn Column Snap and Line Snap On to as­
sure that these frames reach the exact edges of the 
columns and to force each frame to be exactly 1,2,3, 
etc. lines high (See Figure 4-10.) 
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Figure 4-10 Add Frame to make column balance 
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Paragraph tagging function 

4·12 

Figure 4·11 Paragraph Tagging Function 

The Paragraph Tagging function is used to assign 
tags from the style sheet to individual paragraphs. 
Tag attributes are changed through the options in 
the Paragraph menu. 

The Paragraph Tagging function allows you to for­
mat the chapter without having to specify point size, ( 
typeface, spacing, ruling lines, etc. for each 
paragraph. 

To enable the Paragraph Tagging function, select the 
second box from the left in the Function Selector. (See 
Figure 4-11.) 

Once the Paragraph Tagging function is enabled, you 
first select a paragraph with the mouse and then 
select a tag from the Assignment List. If multiple 
paragraphs are selected (see next page) the same tag 
is assigned to all paragraphs. The paragraph selected 
is highlighted in reverse video (white text on black 
background.) To de-select a paragraph, either select 
another paragraph, or move the mouse cursor to a 
part of the page which contains no text and press the ~ 
mouse button once. 

The tags available within a style sheet are shown in 
the Assignment List. 
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I The tag currently assigned to a selected paragraph is 
shown in the Current Selection Indicator. 

Multiple paral;raph selection 

To select more than one paragraph, hold down either 
Shift key on the keyboard while selecting each 
paragraph with the mouse. The Current Selection 
Indicator displays the word Multiple to indicate that 
more than one paragraph has been selected. Any 
paragraph in a Multiple group can be de-selected by 
pointing to the paragraph while holding the Shift 
key and pressing the mouse button once. 

~ When selecting a group of paragraphs, failure to hold 
down the Shift key results in the next paragraph 
selected being the only paragraph selected. 

Header, footer, and caption tagging 
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In addition to selecting and tagging text which has 
been placed in a frame, you can also tag the text in 
headers and footers, section numbers, footnotes, or in 
captions. Text in headers, footers, section numbers, 
captions, table of contents, and indices are automati­
cally tagged with Generated Tags. Generated Tags 
are created by Xerox Ventura Publisher, and always 
have names which begin with the letter Z. Generated 
Tags are assigned Body Text attributes when first 
created. You can change Generated Tags as you 
would any other tag. To remind you that you are 
changing a Generated Tag, the paragraph is 
automatically de-selected after each change is made 
to the tag's attributes. 

When tagging a header or footer, the entire header or 
footer is selected. 
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Add new tag 

==============."Enter new tag 

ADD NEW TAG 

Tag NaillI!' to Add: 

Tag NaillI!' to Copy Frolll: 

I OK I I Cancel I 

name on 
this line 

New tag's initial 
attributes are 
copied from this 
tag 

Figure 4-12 Add New Tag Dialog Box 

The words Add New Tag appear in the Addition 
Button when the Paragraph Tagging function is 
enabled. 

To add a new tag, select the Add New Tag button or 
hold the Ctrl key and then press 2. The Add New Tag I 
Dialog Box shown in Figure 4-12 appears. Enter the 
name of the new tag. If you want to copy the settings 
of another tag, enter that tag's name on the Tag 
Name to Copy From line. Select OK when finished. 
The new tag name immediately appears in the al­
phabetized Assignment List. 

If a paragraph is already selected and the Add New 
Tag button is selected, the Tag Name to Copy 
From line is automatically set to that paragraph's 
tag name. If you don't want to use that tag as a start­
ing point, use the keyboard cursor keys to erase that 
name and enter a different tag name. When you 
select OK, the currently selected paragraph is tagged 
with this new tag. 

Modify tag 

To modifY a given tag, select a paragraph that has 
been tagged with the tag you wish to modify. Then, 
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select any of the options in the Paragraph menu and 
make the changes you desire. As soon as you select 
OK, every paragraph in the entire chapter which is 
tagged with this tag will be changed. If you then save 
the chapter or style sheet, the change to this tag will 
be permanently saved in the style sheet. If you save 
the style sheet under a new name, you will create a 
new style sheet. 

Text editing function 

~ 
--------­____ a 

-------_ . . _-----

Figure 4-13 Text Editing Function enabled 

The Text Editing function is a wordprocessor which 
can be used to add, delete, copy, or move text, as well 
as change the attributes of existing text (bold, italic, 
subscript, 18 point, etc.) and insert index references, 
frame anchors, and footnotes. With the Text Editing 
function, you can compose directly in Xerox Ventura 
Publisher. 

Changing text attributes 
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Using the Text Editing function, you can make font 
and attribute changes to single characters and blocks 
of text. By contrast, the Paragraph Tagging function 
changes all text attributes, including line spacing, 
for the entire paragraph. 

To change text attributes, first select the Text Edit­
ing function (Figure 4-13.) The cursor changes to an 
"I-Beam" and the Assignment List displays the list of 
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text attributes available. Next, move the mouse cur­
sor directly in front of the first letter to be selected 
and then press and hold the mouse button. While 
holding the mouse button, move to the end of the last 
character in the text you want to select and release 
the mouse button. The selected text (Figure 4-14) is 
shown in reverse video (white text on black back-

do you stack up? 

by Joe· Smithlf 
Selected Text ______ ~!1'_-~ • .".! 

How much you 
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Figure 4-14 
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Because of the dYTJ.¥!lic growth of the 

software industry over ~e last d"cade, the 
demand for experienced, qualified programm€'rs 
has. greatly increased, thus leading to a spiraling 
of salaries. If 

But what causes managers to pay one 

Text Selected 

ground.) If the wrong text is selected, repeat the 
selection process. The following steps can also be 
used to select text: 

)J- Move the mouse cursor to the beginning of the text 
to be selected 

)J- Press the mouse button once 
)J- Move the mouse cursor to the last character in the 

text to be selected 
)J- Press and hold the Shift key, and then press the 

mouse button once. 

An existing selection can be extended or shortened ~ 
using this Shift key and mouse combination. 

Text cannot be selected across page or frame boun­
daries. 
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Once text is selected, the attributes in the Assign­
ment List can be assigned. For instance, to change 
the selected text to boldface and underline, select the 
Bold attribute in the Assignment List, and then 
select the Underline attribute. Selecting Normal 
clears all attributes within the selected text and 
returns text to the attributes set by the paragraph 
tag. 

The Capitalize attribute converts selected text to in­
itial capital letters, whereas Upper Case changes 
every letter to upper case. 

~ Normal restores text to the attributes specified in 
the paragraph tag. It does not, however, undo case 
conversions (e.g., upper case to lower case.) 

~ Text and font attributes which are set using the Text 
Editing function take precedence over font attributes 
applied with a paragraph tag. 

The attributes available in the Text Editing function 
are: 

• Bold 
• Capitalize 
• Double underline 
• Italic 
• Lower case 
• Overscore 
• Small (reduces to the next smallest point size) 
• Strike-through 
• Subscript 
• Superscript 
• Underline 
• Upper case 

Changing font settings 
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The Set Font button lets you change the typeface, 
size, style, color, vertical, and horizontal position 
(kerning) of the selected text. 
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To change the font of text which has already been 

FONT SETTING FOR SELECTED TEXT 

(ourier 
SYAbol 
IT( Avant Garde 
IT( Book~an 

• Helvetica Narow 
Palatino • 

(usto~ Size: 01~ points 

mmii Stub m:m 

light 

Bold 
L·1t<J1ic 
tHtalic 
B·ltalic 

Shift: I!J!II ~ O.BOo inches 

Kern: 0.000 

im (olor m 

White 

I~'.-Red 
Green 
Blue 
(yan 
Yellow 
Magenta 

Figure 4-15 Font Setting Dialog Box. (Typeface 
selection shown is for PostScript printers.) 

selected, select the Set Font button or hold the Ctrl 
key and then type 2. (The Addition Button has the I 
words Set Font in it when the Text Editing function 
is enabled.) A Dialog Box similar to the one shown in 
Figure 4-15 appears. The actual typefaces and sizes 
available depend on the printer installed. Select the 
desired typeface, size, weight, and color. Font sizes 
are shown in Points, where 72 points equals one 
inch. 

When increasing the size of text, remember that this 
text must fit in the line spacing defined for the sur­
rounding text. Since this may result in a tight fit, you 
may need to raise or lower the text slightly to achieve 
the desired effect. Simply enter the Shift amount, 
and whether you want to move the text Up or Down. 

When you raise or lower text, the spacing between 
lines remains as set in the tag for each paragraph. 

Select OK when finished. 
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Manual kerning 

Kerning is the process of moving letters closer 
together, and is usually used in headlines where cer­
tain letter combinations, such as a capital V followed 
by a capital A, appear to be too far apart when spaced 
with normal proportional spacing. For example, the 
A in VALUE is kerned in the second line below. 

Un-kerned text: VALUE 
Kerned text: VALUE 
To move individual letters closer together, select the 
first character to be moved to the left. Then select the 
Set Font option and set the amount of left shift by 
placing the text cursor on the Kern line and typing 
the desired left shift. All text to the right of the 
shifted character will also shift left. 

Adding and deleting text 
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Text from either wordprocessor or caption files can be 
added and deleted: 

• Wordprocessor files can be created either 
with an external wordprocessor, or by typing 
directly into the blank underlying page. 
These files are stored in separate files, under 
file names that you choose, and in the file for­
mat of the chosen wordprocessor. 

• Caption files are created by typing directly 
into a blank frame; by adding a caption to a 
frame; or by adding box text using the Graphic 
Drawing function. All captions for a chapter 
are stored together in a single Caption file. 
This file is automatically created and given 
the same file name as the chapter, but with 
the extension CAP. A caption file is an ASCII 
file which can be edited and spell-checked with 
an external wordprocessor. (Don't change the 
number of paragraphs when spell checking.) 
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When adding and deleting text, you should use the 
Show Tabs & Returns option in order to see hidden 
formatting characters. 

To begin adding or deleting existing text, move the 
mouse cursor to the point directly after the character 
to be edited and press the mouse button. A vertical 
cursor appears, indicating that you can begin typing. 
Use the Backspace key to delete text directly to the 
left of the cursor, and use the Del key to delete text 
directly to the right of the cursor. 

As text is added or deleted, the page automatically 
reformats as you type, so you can always see the ef­
fect on the page layout. When editing across page 
boundaries, press the Pg Dn key to go to the next 
page, and place the cursor at the point where you 
wish to resume editing. When the cursor reaches the 
edge of the screen, use the scroll bars to move the 
screen and then resume editing. 

Depress the Caps Lock key once to type only upper i 

case characters. Depress the Caps Lock key again 
to resume normal text entry. 

As you add and delete text, you may occasionally see 
some extra "ink" around certain characters and 
ruling lines. Press the ESC key to re-draw the page 
and eliminate this ink. This ink is particularly 
noticeable when editing white text on a black back­
ground. 

Text may suddenly disappear when you are editing 
near the end of a page or column. This is caused by 
the Widow & Orphan and Keep With Next con­
trols automatically placing text in the appropriate 
page or column. Scroll to a different part of the page, 
or press the Page Up or Page Down keys as neces­
sary, and continue editing. 

As you move the text cursor with the keyboard cur­
sor keys, the presence of text attributes, index 
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references, footnotes, frame anchors, paragraph 
marks, horizontal tabs, line breaks, discretionary 
hyphens, and non-breaking spaces is shown in the 
Current Selection Indicator. Pressing the Del key 
deletes these attributes. 

~ Deleting the attribute at the end of text which is 
italic, bold, etc., causes the remaining text in the 
paragraph to change to italic, bold, etc. If this hap­
pens, immediately press the Ins key. Re-assign the 
desired attributes, if necessary. 

Attributes are terminated at the end of each 
paragraph, even if the "end attribute" character has 
been deleted. 

Use the keyboard cursor keys to move the text cursor 
a short distance. Use the mouse to move the text cur­
sor to remote portions of the page. 

To move, copy, or delete blocks of text, index referen­
ces, footnotes, and anchors, refer to the Cut, Copy, 
and Paste commands found in the Edit menu section. 

Adding text to a blank page 

Xerox Ventura Publisher can be used to create new 
text files, just like any wordprocessor. The resulting 
files can be saved in any file format available (e.g., 
Wordstar, Wordperfect, DCA.) 

To create a new text file, select the Text Editing func­
tion and place the text cursor in the underlying page. 
The following alert appears on the screen: 

Before you can type text on an empty page you 
must give the name and type of the file that 
will hold that text. If you did not intend to 
create a new file, choose Cancel. 

REFERENCE GUIDE 4-21 



FUNCTIONS 

4-22 

Text editing function 

If you select New File, the File TypelRename Dialog 
Box appears, and you can enter the file name on the 
New Name: line, and select the Text Format to use 
when saving the file. 

You are then ready to begin entering text, using 
Xerox Ventura Publisher as a wordprocessor. The 
text will begin at the upper left corner of the under­
lying page. To place text at a specific location, draw a 
frame and then use box text, as described in the 
Graphic Drawing section, to place the text at the 
location you desire. 

To save a text file, select the Save As option in the 
File menu and save a new Chapter. Remember that 
the text file contains the actual text, whereas the 
chapter file contains information on where to place 
the text file, plus all header, footer, and page counter 
information. 

~ You store or retrieve a text file by Saving or Opening 
the Chapter which points to that text file. 

Tagging using the text editing function 

Whenever you press the Enter key, you automatical­
ly create a new paragraph which has the same tag as 
the last paragraph. Since you may want to change 
the tag of this new paragraph, and since it takes time 
to change to the Paragraph Tagging function, Xerox 
Ventura Publisher provides an easy shortcut. You can 
assign frequently used tags to the special function 
keys on your computer's keyboard. (See the Assign 
Function Keys option in the Paragraph menu.) 
Once a tag is assigned to a function key, pressing that 
function key while using the Text Editing function 
immediately tags the entire paragraph in which you 
are typing. Also, if you select text which spans 
several paragraphs, all paragraphs included in the 
selection will be tagged with the same tag. 
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Line break 

When creating headlines and tables, you may want 
to end a line within a paragraph without breaking 
the text into two paragraphs. This is done with a 
Line Break. Line breaks are created by holding 
down the Ctrl key while you press the Enter key. 
Line breaks add the normal inter-line spacing, but no 
inter-paragraph, above, below, or ruling line space. 

~ Line breaks consume less memory than paragraphs 
and should therefore be used whenever possible in 
directory listings and other database publishing ap­
plications. 

Page break 

Spaces 
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Page breaks are created by defining a page break tag 
and then assigning that tag to the special function 
key of your choice. See Chapter 6. 

Xerox Ventura Publisher can create spaces of many 
different thicknesses, including: 

· Em space (Ctrl + Shift + M) 
· En space (Ctrl + Shift + N) 
• Figure space (Ctrl + Shift + F) 
· Thin space (Ctrl + Shift + T) 

If you want two words kept together on the same line, 
you can add a Non-breaking space between those 
words. Non-breaking spaces are added by pressing 
and holding the Ctrl key and then pressing the 
spacebar. 

Whenever the chapter is retrieved, double spaces 
added after periods or colons are converted to a single 
space followed by a non-breaking space. 
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Discretionary hyphen 

Discretionary hyphens are most often used to tighten 
up a "loose" line. For example: 

This line is too loose because the word 
overextended has not been hyphenated. 

This line is not loose because the word overex­
tended has been hyphenated with a discretionary 
hyphen. 

Discretionary hyphens are usually added to the first 
word in the line below a loose line, as in the example 
above. 

Placing a discretionary hyphen at the beginning of a 
word suppresses, hyphenation for that occurrence of 
the word. 

To add a discretionary hyphen to any word: 

~ Place the text cursor at the point in the word 
where you wish a hyphen to be inserted 

~ Press and hold down the Ctrl key 
~ Press the - key (next to the Zero key on most 

keyboards.) This hyphen is not displayed on the 
screen (and printed) unless the word needs to be 
hyphenated. With Show Tabs and Returns on, 
a small hyphen is displayed at each discretionary 
hyphen point, although this hyphen is not printed. 

As you move the text cursor across a word containing 
a discretionary hyphen, the discretionary hyphen's 
presence is displayed in the Current Selection In­
dicator box. Once displayed, the discretionary 
hyphen can be removed by pressing the Del key. 

See Appendix B for information on the hyphenation 
dictionary. 
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Adding non-keyboard characters 

Characters not on your keyboard can be added using 
the Edit Text function. First, locate the desired 
character and its numeric equivalent in Appendix E. 
Then, hold down the Alt key on the keyboard as you 
use numeric keypad to enter this number. (Whether 
or not Num Lock is on doesn't matter.) Mter the 
number is entered, release the Alt key. The charac­
ter appears on the screen. This character can be 
deleted and its attributes changed just like any 
keyboard character. For instance, to enter the 
registered trademark symbol ®, press the Alt key 
and type 190. 

When the Alt key is released, the ® will appear. 

Non-keyboard characters are useful for two reasons: 

• Adding foreign language characters to English 
text. (Typing an entire document in a language 
different than English requires that the MS­
DOS foreign language keyboard program be 
run before starting Xerox Ventura Publisher.) 

• Adding real typographic characters such as: 
Em dashes (- instead of --) 
True typographic quotes (" ", instead of ") 
Trademark and copyright symbols (®, ©) 

~ If the character entered does not print, this character 
may not be available for the printer you have current­
ly selected. Print the CHARSET chapter located in 
the TYPESET directory to see the character set for 
your printer. 

Symbol character set 
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Xerox Ventura Publisher provides a mathematical 
and Greek character set, shown in Appendix E. 
When you tag a paragraph with a symbol font tag, 
each character in the paragraph is converted to sym­
bols. For instance, an upper case F (decimal code 70) 
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Text editing function 

displays as <D. Text previously entered with the Alt 
key is also converted to symbols. 

To create occasional symbols within a paragraph: 

>- Select a range of text 
>- Use the Set Font button to change this range of 

text to Symbol characters 

Additional symbols can be added within this range 
using the Text Editing function. 

~ The symbol character set is not available with all 
printers. Consult Appendix F. 

Generating mathematical formulas 

Although not designed specifically to generate com­
plex mathematical equations (e.g., large integrals, 
chemical equations), Xerox Ventura Publisher can 
easily generate simple formulas using the symbol . 

I 
character set. 

If you only need one or two symbols within a 
paragraph, select the one or two characters you wish 
to change to symbols, and change them using the 
Text Editing Set Font button. For instance, to put a 
1t in the formula 

type the letter p, then select this letter and use the 
Set Font button to change this one letter to a symbol. 
V se superscript, subscript, or Set Font Shift option 
to create powers and subscripts. 

To change all characters in a paragraph to symbols, 
create a new tag and change its typeface to symbol. 
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Interaction with your wordprocessor. 

Consult Appendix D for important information on 
text transfer between Xerox Ventura Publisher's 
wordprocessor and your favorite wordprocessor. 

Graphic drawing function 

Xerox Ventura Publisher includes a drawing package 
that lets you draw lines, ellipses, rectangles and 
rounded-edge rectangles. These shapes can then be 
filled with different colors and shades. Also included 
is the ability to place text in a box and move this box 
anywhere on a page. This drawing capability is 
designed to let you draw call-out boxes, create forms 
and tables, place additional ruling lines anywhere on 
the page, and create additional graphic effects. 

The graphics drawn in Xerox Ventura Publisher will 
print with the maximum resolution your printer is 
capable of producing. These graphics are not "screen 
snapshots". 

Box text 

Ellipse 

Rounded rectangle 

Figure 4-16 Graphic Drawing function enabled 
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Tying graphics to a frame 

To draw graphics, a frame must first be selected, and 
then the Graphic Drawing function enabled, as 
shown in Figure 4-16 .. 

Graphics are tied to a frame, and can be placed either 
inside or outside the frame boundaries. A frame that 
already contains either text or a picture file can also 
have graphics associated with it. When the frame is 
cut, copied, pasted, or moved, the graphics tied to 
that frame are cut, copied, pasted or moved with it. 

Graphics can be moved anywhere on the page. They 
can also be re-sized. However, when the frame is re­
sized, the graphics associated with that frame do not 
change size or shape. 

~ Graphics tied to the underlying page will automati­
cally repeat on every page. 

Basic drawing 

Enable the Frame Setting function and select either 
a frame or the underlying page. Graphics are tied to 
the frame selected. Each frame can have its own set 
of graphics. 

Next, enable the Graphic Drawing function. The As­
signment List is replaced with six icons (pictures) 
which represent Graphic Selection and the five draw­
ing tools available. Figure 4-16 shows these icons and 
their function. 

You can select any of these tools and then draw the 
graphic object. To draw the object: 

~ Press and hold the mouse button 
~ Draw the object 
~ Release the mouse button when the desired size 

and shape has been obtained 
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Once a graphic is drawn, you can move it, re-size it, 
or change its attributes. 

~ When the Graphic Drawing function is enabled, you 
can select graphics, but not frames. When the Frame 
Setting function is enabled you can select frames, but 
not graphics. Always first select the frame whose 
graphics you want to change, and then enable the 
Graphic Drawing function. 

One exception: When the Frame Setting function is 
enabled, you can type Ctrl + Q to select all graphics 
associated with that frame. 

The Current Selection Indicator shows the type of 
graphic currently selected (i.e., ellipse, line, rec­
tangle, box text.) 

Multiple graphic objects can be selected by pressing 
and holding either Shift key and then selecting each 
individual graphic. All graphics associated with a 
frame can be selected by choosing the Select All 
function in the Graphic menu. 

These graphics can then be cut, copied, pasted, or 
moved. Attributes can also be applied simultaneous­
ly to all selected graphics. Multiple graphic objects 
can also be re-sized as a group: Re-size one graphic 
in a group, and all graphics in that group will change 
size proportionally. 

Grid settings 
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Graphics can be snapped to an invisible grid which is 
defined in the Grid Settings option in the Graphic 
menu (Figure 4-17.) The grid setting can be different 
for each frame in the chapter. 

The Grid Setting is used to help align different 
graphic objects with one another. It also is used, in 
conjunction with Boxed Text, to construct complex 
tables or forms. 
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GRID SETTINGS 

Grid Snap: • []ff] 

Horizontal Spacing: B1,B~ picas & points 

Vertical Spacing: B1,BB 

OK I Cancel I 

Figure 4-17 Grid Settings Dialog Box 

Graphic attributes 

To change a graphic's attributes, first enable the 
Frame Setting function and select the frame tied to ( 
the graphic. Then enable the Graphic Drawing func­
tion. Select the graphic object whose attributes you 
wish to change. Then choose either the Line At­
tributes or the Fill Attributes option in the 
Graphic menu. The operation of these options is ex­
plained in the Menu Commands chapter. 

Graphic order 

If graphics are placed on top of one another, the last 
graphic placed on the page is always placed on top. 
To change this order, first select the graphic you wish 
to move and then select either the Send to Back or 
Bring to Front option in the Graphic menu. The 
selected graphic is then either put on the bottom of 
all graphics associated with this frame (Send to , 
Back), or on the top (Bring to Front.) 
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Figure 4-18 Line behind a rectangle 

Figure 4-18 shows a line behind a rectangle. Figure 
4-19 shows the result of selecting the line and then 
choosing the Bring to Front option. 

Figure 4-19 Line brought to front of rectangle 
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Selecting graphic on bottom 

When one graphic is underneath another graphic, it 
is sometimes difficult to select the graphic on the bot­
tom. To select a graphic which is covered by several 
other graphics, press and hold the Ctrl key and then 
select the first graphic. While holding the Ctrl key, 
press the mouse button again to select the next 
graphic down from the top. Continue pressing the 
mouse button, while holding the Ctrl key, until you 
select the desired graphic. 

Drawing multiple graphics 

After each graphic is drawn, Xerox Ventura 
Publisher automatically changes to the Graphic 
Selection mode. If, however, you want to draw several 
graphics of the same kind, you can depress and hold 
either Shift key while drawing each graphic. As long 
as you depress the Shift key while drawing the 
graphic, the drawing tool remains available. As soon i 
as a graphic is drawn without pressing the Shift key, 
the Graphic Selection mode is immediately enabled. 

Box text 

The box text feature lets you place text anywhere on 
the page. Unlike text in frames, which is formatted 
in columns and causes text in other frames to move 
aside, Box Text is formatted in a single column, and 
overlaps all text and pictures on the page. Think of 
box text as a Post-It® (self-adhesive yellow note 
paper) that can be placed anywhere on the page. 

To create box text, first select a frame to which the 
box text will be attached. Select the Box Text icon, 
then draw a box in the same manner as you would 
draw a frame. This box can then be moved anywhere 
on the page; and it can be increased or decreased in 
size. 
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Notice that the words Box Text appear within the 
box. Select the Text Editing function and then delete 
these words and place any text you desire in the box. 
If necessary, select the Graphic Drawing function 
and make the box larger or smaller, to hold more or 
less text. The text entered into this box is stored in 
the chapter's caption (CAP) file. 

~ If you don't see any text when you first draw box text, 
this means that the Above, Below, In From Left, or In 
From Right spacing for the box text tag (Z_BOX­
TEXT), is greater than the box size. To correct, tem­
porarily make the box text larger until you can see 
the words Box Text. Select the Paragraph Tagging 
function, select the words Box Text, and reduce its 
spacing as necessary. 
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Box text callouts 

Use the box text feature to place callouts outside, but 
attached to, a picture frame. To do this, enable the 
Frame Setting function and select the desired frame. 
Then, enable the Graphic Setting function and draw 
a box text box. If you don't want a line around the box, 
select Line Attributes and set Thickness to None. 

Place the box at the position inside or outside the 
frame where you want the callout to appear. When 
the box is placed correctly, select the line drawing tool 
and draw a line from the box to the item in the frame 
you wish to annotate. You can change the line's thick­
ness and add arrows. If you want to move the line and 
box together, select both, using the Shift key and the 
mouse as described above, and move them both. 
When they are positioned correctly, enable the Text 
Editing function, place the text cursor in the box, and 
type the callout. 

Box text tables and forms 

Simple tables can be created using tabs and 
paragraph ruling lines, as described in the Tables 
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section in the Hints, Tips, & Techniques chapter. 
However, complex tables, as shown in Figure 4-21, 
are more easily done with box text. To create a com­
plex table, first use the Frame Setting function to 
create a frame in which the table will be placed. 

Next, enable the Graphic Drawing function and set 
the Grid Settings for this frame. Make the horizontal 
spacing a convenient sub-multiple of the frame 
width, and the vertical spacing an integer multiple of 
Z_BOXTEXT. 

D D 

Figure 4-20 Creating table with Box Text 

WidgetTablel Fe at u re L i st2 

This is the second Th i sis th 
category third category 

This is th 
third category 

This is the second Th i 5 is th e 
(ate gory third category 

Figure 4-21 Table composed with Box Text 
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Look at Figure 4-20 to see how a table might be or­
ganized using box text. Notice that different boxes 
are created for each row of items, and that two boxes 
are used for the table headings. Since you are draw­
ing multiple boxes, be sure to depress the Shift key 
to keep the box text tool available. 

When all boxes have been drawn, select each box and 
use the Text Editing function to add text. (You can 
also change line or fill attributes for each box.) Figure 
4-21 shows the finished table. 
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This chapter describes each function controlled 
through the menus at the top of the screen and the 
options within them. These commands are presented 
in the order in which they appear on the screen, from 
left to right. Use the index for an alphabetical 
reference to these commands. 

Menu conventions 

DESK 

Publisher Info ... 

FILE 

New 
Open Chapter ... 
Save 
Save As .. . 
Abandon .. . 

Often, a menu option is shown in gray, and cannot be 
highlighted. This usually indicates that the proper 
function has not been selected. The table below indi­
cates which function should be selected to use the 
desired option. 

Always available 

Must Open Chapter or Load TextlPicture 
Always available 
File name must be in title bar 
Always available 

Load TextlPicture ... 
Load Diff. Style ... 
Save As New Style ... 
To Print ... 

Chapter must have been saved 
Always available 
Always available 
Always available 
Always available 

DOS File Ops ... 
Quit 
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Always available 
Always available 
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EDIT 

Cut or Copy 

Paste 

Insert Footnote 
InsertlEdit Index .. . 
InsertlEdit Anchor .. . 
Remove TextlFile .. . 
File TypelRename .. . 

VIEW 

Facing Pages View 
Reduced View 
Normal View (IX) 
Enlarged View (2X) 
Frame Setting 
Paragraph Tagging 
Text Editing 
Graphic Drawing 

PAGE 

Page Layout ... 
Widows & Orphans ... 
Chapter Counter ... 
Page Counter ... 
Auto-Numbering ... 
Renumber Chapter 
Re-Anchor Frames .. . 
Headers & Footers .. . 
Turn Header On/Off 
Turn Footer On/Off 
Footnote Settings ... 
InsertlRemove Page ... 
Go To Page ... 

5-2 

Text Editing; Text selected 
Frame Setting; Frame selected 
Graphic Drawing; Graphic selected 
Text Editing; Text on clipboard 
Frame Setting; Frame on clipboard 
Graphic Drawing; Graphic on clipboard 
Text function; Text cursor placed 
Text function; Text cursor placed 
Text function; Text cursor placed 
Frame Setting function 
Frame Setting function 

Double Sided selected in Page Layout 
Always available 
Always available 
Always available 
Always available 
Always available 
Always available 
Always available 

Always available 
Always available 
Chapter number set in header/footer 
Page number set in header/footer 
Always available 
Auto-Numbering turned on 
Always available 
Always available 
Headers disabled/enabled for this page 
Footers disabled/enabled for this page 
Always available 
Always available 
Always available 
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Margins & Columns ... 
Sizing & Scaling .. . 
Repeating Frame .. . 
Anchor & Caption Setting 
Table Counter ... 

Figure Counter ... 

Vertical Rules ... 
Ruling Line Above .. . 
Ruling Line Below .. . 
Ruling Box Around .. . 
Frame Background .. . 

PARAGRAPH 

Font ... 
Alignment ... 
Spacing .. . 
Breaks .. . 
Tab Settings ... 
Special Effects ... 
Typographic Controls ... 
Ruling Line Above .. . 
Ruling Line Below .. . 
Ruling Box Around .. . 
Remove Tag .. . 
Rename Tag .. . 
Assign Function Keys ... 

GRAPHIC 

Send to Back 
Bring to Front 
Line Attributes .. . 
Fill Attributes .. . 
Select All 
Grid Settings ... 
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Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; 
Frame selected, caption defined 
Frame Setting function; 
Frame selected, caption defined 

Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; Frame selected 
Frame Setting function; Frame selected 

Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging; paragraph selected 
Paragraph Tagging 
Paragraph Tagging 
Paragraph Tagging 

Graphic Drawing; Graphic selected 
Graphic Drawing; Graphic selected 
Graphic Drawing; Graphic selected 
Graphic Drawing; Graphic selected 
Graphic Drawing 
Graphic Drawing 
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OPTIONS 

Set Preferences... Always available 
Set Rulers... Always available 
Set Printer Info... Always available 
AddlRemove Fonts Always available 
ShowlHide Side-Bar Always available 
ShowlHide Rulers Always available 
ShowlHide Column Guides Always available 
ShowlHide Pictures Always available 
ShowlHide Tabs & Returns Always available 
ShowlHide Loose Lines Always available 
Turn Column Snap On/Off Always available 
Tum Line Snap On/Off Always available 
Multi-Chapter... Always available 
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DESK MENU 

Figure 5-1 Desk Menu 

Description 
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The Desk menu provides both the version and serial 
numbers for your copy of Xerox Ventura Publisher. 

To operate, select Publisher Info. When finished, 
select OK. 
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FILEMENU 

New 
Open Chapter ... 

Save AS 
Save As". 
Abandon .. . 

Load Te~t/Picture .. . 
Load Diff. Style .. . 
Save As New Style .. . 

To Print ... 
DOS File Ops". 
uit 

Figure 5-2 File Menu 

FILE MENU 

Description/application 
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The File menu controls the flow of information into 
and out of Xerox Ventura Publisher. 

The File menu provides five basic functions: 

• You can Open or Save the entire chapter 
• You can Load individual text, line art, or 

image files into the chapter 
• You can use a different style sheet than the 

one currently in use, or save a newly created 
style sheet 

• You can print the chapter 
• You can execute DOS file commands 
• You can finish using (Quit) Xerox Ventura 

Publisher 
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New 
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Description 

Selecting New removes the current chapter from 
memory and provides a blank screen. The last ver­
sion saved is still available on disk. 

Application 

• Start composing a brand new chapter. 

Operation 

Select New in the File menu. If any changes have 
been made to the chapter since it was last saved, a 
warning appears reminding you to save the chapter. 
Also, if any changes have been made to the style 
sheet since the chapter or style sheet was last saved, 
a second warning appears. In both cases, select Save 
to save all changes made, or select Abandon to 
throwaway all changes. 

The current style sheet remains in effect after New 
is selected. 
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Open chapter 
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Description 

The Open Chapter option retrieves a previously 
stored chapter, and its related style sheet, text, and 
picture files. 

Application 

Operation 

Resume composing and editing a previously 
saved chapter. 

Select the Open Chapter option in the File menu. If 
another chapter is currently being edited, Xerox Ven­
tura Publisher prompts you to save the existing chap­
ter. Select Save to save, or select Abandon to throw 
away all changes. 

The Item Selector then appears. Using the conven­
tions described under Item Selector in the User In­
terface chapter, select the chapter to open. 

~ If the file name is not shown, you may have saved the 
chapter with an extension different than the CHP 
default used by Xerox Ventura Publisher, or the file 
may be saved in a different subdirectory than cur­
rently shown in the Item Selector. Either change the 
default extension on the Directory line in the Item 
Selector, or change the subdirectory. 

As the chapter is loading, different messages appear 
on the screen. When text files are loading, the mes­
sage Loading & Hyphenating Text File: appears. 
Xerox Ventura Publisher places all possible hyphena­
tion points in the text in order to increase re-format­
ting speed each time you add a frame or change a text 
attribute. For a large text file, this takes several 
minutes, depending on the speed of your computer 
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and size of the chapter. If you install a hyphenation 
algorithm other than the US English algorithm, the 
text loading time may increase. The hyphenation 
time is different for each language. 

~ Use Open Chapter to retrieve an entire chapter and 
all associated text, picture, and style sheet files. To 
add another text or picture file to an existing chapter, 
use Load TextlPicture instead. 
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Save 
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Description 

The Save option stores the chapter under the name 
shown in the Title Bar. The style sheet and each text 
file are also saved if they have been changed. 

Application 

• Save changes under an existing file name. 
• Protect against accidental erasure due to 

power failures. 

Operation 

Select the Save option in the File menu, or press and 
hold the Ctrl key and then press S. The file is saved 
under the file name shown in the Title Bar. If the 
name UNTITLED.CHP is shown in the Title Bar, 
the Item Selector appears and you must then specify 
a chapter file name. 

The style sheet shown in the Title Bar, and all text 
files shown in the Assignment List, are also saved, if 
they have been changed. If you don't want to change 
the current style sheet, use the Save as new style op­
tion to save the style sheet under a new name prior 
to saving the chapter. 

All captions, graphics, and information for a chapter 
are automatically saved in files which have the same 
name as the chapter, but which have the extensions 
CAP, VGR, and CIF respectively. The elF file is for 
use by future software programs. 

If selected in the Set Preferences option in the Option 
menu, backup files (e.g., $HP) are automatically 
made for chapter, style sheet, and text files. 
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Save as 

MENU COMMANDS 

Description 

The Save As option saves the chapter under a new 
name. The style sheet and each text file are also 
saved-under their original names-if they have 
been changed. 

Application 

• Save the same chapter under a name different 
than shown in the Title Bar. 

Operation 

Select the Save As option in the File menu, then use 
the Item Selector to specify the new file name. If the 
extension is not specified, Xerox Ventura Publisher 
automatically adds CHP. 

If you don't want to change the current style sheet, 
use the Save as new style option to save the style 
sheet under a new name prior to saving the chapter. 

All captions, graphics, and information for a chapter 
are automatically saved in files which have the same 
name as the chapter, but which have the extensions 
CAP, VGR, and CIF respectively. The elF file is 
available for use by other future software programs. 

Backup files (e.g., $HP) are automatically made for 
chapter, style sheet, and text files, if selected in the 
Set Preferences option. The first letter of the backup 
file extension is changed to a dollar sign. 
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Abandon 

Description 

I Abandon replaces the chapter currently in memory 
with the last version saved. 

Application 

• Recover from major mistakes. 

Operation 

I Select the Abandon option in the File menu. An 
Alert Box appears asking if you want to 

Abandon changes to this chapter and revert to 
the previously saved version? 
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Select OK to throwaway all changes and automati­
cally Open the last version saved. All changes made 
since the last time the chapter was saved are lost. 
Select Cancel to stop the Abandon operation and 
resume working with the existing chapter. 

If the chapter has been saved, but you want to get rid 
of the changes and start with a blank page, select 
New instead. 
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Load text/picture 

LOAD TEXT/PICTURE 

hpe of File: .. ! Line· Art! I::i!illJ 
Text Fomat: ! Generated! ... ! WordStar US! ! "ultiMate! 

C!lDmJ ! Writer US! ! WordPerfect! 

! WordStar UK! ! Writer G·1 ! llill!iliJ []ill 
Line·Art Fmat: [@l] ! AutoCad ,SLD! ! Lotti, ,PIC! ! Mentor (ir ! 

! VideoSllow! ! MAC PICT! ! ((iM! ! PostScript! 

[]ill] 

[Aage Fomat: I GEM ( Dr, HALO! ! PC·Painturu,h I ! MAC Paint! 

~ of Files: _ ! Several! [][] !Cancel! 

Figure 5-3 Load Text / Picture Dialog Box 

Description 

The Load TextlPicture option places either text, 
line art, or image files in the Assignment List prior 
to placing them in a frame. 

Application 

• Build a list of all files in the chapter. 

Operation 
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~ Select the Load Text/Picture option in the File 
menu. The Load Text/Picture Dialog Box shown in 
Figure 5-3 appears. 

~ Select the type of file you want to add e.g., text, 
line art, or image. 

~ Select the file format under which this file was 
saved, such as GEM, or Lotus 1-2-3. (Select Text 
and Generated to load a table of contents or index 
file generated by Xerox Ventura Publisher.) 
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~ If you want to load several files of the same type 
(e.g., four Lotus 1-2-3 pictures) select Several at 
the bottom of the screen. 

~ Select OK when ready to select files. 
~ Xerox Ventura Publisher then displays the Item 

Selector, with the appropriate subdirectory and 
file filter already chosen. If the subdirectory and 
filter are not initially correct, change them as 
described in the Item Selector section. 

~ Finally, elect the file name to be loaded and then 
select OK. 

For instance, if you are loading a Wordstar file, first 
select Text and then select Wordstar. Or, if you are 
loading Lotus 1-2-3 graphics, first select line art and 
then select Lotus .PIC. 

Ilaf When loading text files, you will notice a delay-up 
to several minutes for large files-as Xerox Ventura 
Publisher converts text and inserts hyphens. 

If you selected Multiple, the Item Selector reap­
pears after each file is selected. To finish selecting 
multiple files, select OK without first selecting 
another file name, or choose cancel. 

Ilaf Use Load TextlPicture to add another text or picture 
file to an existing chapter. To retrieve an entire chap­
ter and all associated text, picture, and style sheet 
files, use Open Chapter instead. 

Text changes made during load 

The following is a list of all changes made to text 
during the Load TextlPicture operation: 

• Multiple spaces are converted to a single space 
plus non-breaking spaces. 

• All possible hyphen points are temporarily in­
serted into the text. (They are not saved back 
into the text file.) 
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• Information not used by Xerox Ventura 
Publisher, such as centering, indents, printing 
commands, and so on, is eliminated. 

Most typists press Enter twice in a row to create 
blank lines between paragraphs. However, Xerox 
Ventura Publisher treats each carriage return in the 
wordprocessor file as a new paragraph and adds 
above, below, and inter-paragraph spacing. This may 
create too much space between paragraphs within 
Xerox Ventura Publisher and unwanted spaces at the 
top of columns. To eliminate these null paragraphs, 
type the following on the first line of the 
wordprocessor's text file: 

@PARAFILTR ON = 

Most typists type two spaces after a period or colon. 
This, however, is not considered correct when a page 
is typeset. Therefore, you should use the search and 
replace feature in your wordprocessor to eliminate 
all double spaces. 

Picture changes made during load 

Pictures stored in other than GEM format (e.g., a 
Lotus 1-2-3 PIC file), are automatically converted to 
Xerox Ventura Publisher's file format and saved in 
new files which have the same name as the original 
file, but with the extension GEM (line art) or IMG 
(image.) The original files remain unchanged. Your 
disk must have enough room to hold both the original 
and the converted files. 

Graphics limitations 
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Xerox Ventura Publisher converts several industry 
standard graphics formats into its own file format, as 
described above. These formats include: 
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• GEM 
• CGM 
• DXF 
• HPGL 
• Macintosh PICT 
• Macintosh Paint 
• PostScript 
• Video Show 

Because of the tremendous range of capabilities of 
these programs, not all graphics produced by them 
can be completely displayed and printed by Xerox 
Ventura Publisher. The limitations noted in Appen­
dix G for the DXF to GEM converter apply to all 
graphics brought into Xerox Ventura Publisher. 

Use PC Paintbrush format to load files created by a 
scanner. 

Picture size 

Xerox Ventura Publisher cannot always calculate the 
size of pictures imported from other sources. This 
may result in a picture which is larger than the 
frame. To correct, reduce the picture size using the 
Sizing & Scaling option. 

PostScript iIles 

PostScript files must be in encapsulated (EPSF) 
format, or an error message will result. If your 
program produces PostScript files, check with the 
software manufacturer to make sure these are stored 
in encapsulated format. Note: Any single page 
printed to a disk file by Xerox Ventura Publisher is 
created in encapsulated format. This lets you load a 
page into a frame and then expand or shrink it. 

~ PostScript files cannot be displayed on the screen. A 
frame containing a PostScript file is filled with a 
large X, and the name of the file is displayed in the 
Current Selection Indicator. 
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Load different style 

Description 

Load Different Style combines a different style 
sheet with the chapter currently in memory. If the 
chapter is then saved, the reference to the old style 
sheet is replaced with a reference to the new style 
sheet. 

Application 

• Retrieve an existing style sheet. 
• Experiment with different styles once your 

chapter has been tagged. 

Operation 
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Select Load Different Style in the File menu. The 
Item Selector appears. Select the desired style sheet. 
The new style sheet name appears in the Title Bar at 
the top of the screen. 

The Open Chapter function automatically loads the 
style sheet for that chapter. 

If you used a special set of fonts when you last used 
this style sheet, the width table for these fonts will 
automatically be loaded when you load the style 
sheet. 
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Description 

I Save As New Style creates a new style sheet file or 
modifies an existing style sheet. 

Application 

• Create new style sheets. 

Operation 

Select the Save As New Style option in the File menu. 
When the Item Selector appears, type the name of 
the new style sheet, and then select OK. If you do not 
specify the extension, Xerox Ventura Publisher 

, automatically appends the extension STY to the file 
name. 

~ Saving the chapter after modifying a style sheet, or 
saving a modified style sheet under its original name, 
changes the look of other chapters that use that same 
style sheet. Always save modifications to existing 
style sheets under a new name unless you want those 
modifications to affect other chapters. 

If you have loaded a new width table in order to gain 
access to a different set of fonts, the reference to this 
width table will be stored with the style sheet. (See 
the Set Printer Info and AddlRemove Fonts sections 
in the Menu Commands chapter for more informa­
tion on width tables.) 
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To print 

PRINT IHFIlIMATION 

Which Pag~s: rnIJ IDImD !liliJ mill] I Curr~nt I 
Fran Pag~: 005BB2~ 

Through Pag~: ~ 
Hunb~r of Copi~s: B1 

CollaUd Copies: II!IDI rn 
Printing Ord~r: 11st to Last I 'M.ii.ln 
Configuration: POSTSCRIPT. COH1: 

Paper Tra~: IiDI!8I rnDIl rnDII ~ 
MultHhanm: I m ill (lie file I I Each ill 5epmte File I 

Crop Hans: []ill .. ~ I Cancel I 

Figure 5-4 To Print Dialog Box set to print pages 23 
through 57 

Description 

To Print begins the printing process. 

Application 

Generate printed copies of the currently 
opened chapter. 

• Print to a file. This file can then be copied to 
floppy disk and sent to a remote printer or 
typesetter. 

• Place camera guides around the edge of the 
page. 

Operation 
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Select the To Print option in the File menu. The 
Print Information Dialog Box shown in Figure 5-4 
appears. If you want to print just one copy of the en­
tire chapter, select OK. 

To print more than one copy of the pages selected, 
move the text cursor to the Number of Copies line 
and type the number of copies desired. You can have 
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these copies printed so they are collated by selecting 
Collated Copies: On. 

~ When printing pages that contain pictures, selecting 
Collated adds a tremendous amount of time to the 
printing operation. 

You can change the printing order from 1st to Last 
to Last to 1st or vice versa, depending on how your 
printer stacks paper in the output tray, 

To print only part of the chapter, pick the Selected 
option. Next, enter the number of the first page to 
print on the From Page line. Type the number of the 
last page to print on the Through Page line. The 
page numbers specified refer to the page numbers 
shown in the on-screen Page Number Indicator, not 
the numbers in the header or footer. To print only the 
current page, select Current. 

Duplex printing 

Which Pages: LeftlRight is used to print on both 
sides of the page (duplex printing.) To do this: 

~ Print all left pages (if the chapter begins on right 
page) 

~ Turn the paper over and re-insert in the paper tray 
(insert a blank sheet after the last page, if neces­
sary) 

~ Print all right pages 

The Configuration line shows which printer is 
selected. To change printers, or to print to a file, 
select the Set Printer Info option in the Options 
menu. If Output To: Filename is selected in the Set 
Printer Info option, then the Configuration line will 
display the word Filename, and the Item Selector 
appears as soon as you select OK. Type the name of 
the print file you wish to create, and select OK. 
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The Paper Tray option lets you select which paper 
tray to use. Select Manual if you want to feed paper 
manually, one page at a time. 

The Multi-Chapter options, shown in gray, are only 
used in the Multi-Chapter Print option, and are not 
used in the To Print option. 

~ To stop a print operation in progress, press Esc. 
Printing stops after the current page is printed. 

Crop marks 

To place camera crop marks around the edge of the 
page, select Crop Marks On. 

Large page printing 

If Double is selected in the page layout option, a 
Dialog Box appears which gives you three choices: 
Shrink, Overlap, and Nothing. Choose Shrink if you 
want to reduce the 11 x 17 page to fit on an 8 1;2 X 11 
sheet. (This option os only available with PostScript 
printers.) Choose Overlap if you want to print four 
8 1;2 x 11 pages which can later be pasted together to 
form one 11 x 17 page. Choose Nothing if your printer 
can actually print an 11 x 17 page. 

If Broadsheet is selected, you can also Shrink, or you 
can print in strips. Printing in strips prints three 
strips each 24 inches long. Note: Printing in strips is 
used with typesetting machines only and is not in­
tended for use with laser printers. 
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DOS FI LE OP ERATI OMS 

File Spec: (:,*.I~l-____ -----

Operation: I Select Different File Specification I 
lliake Directory I I Renove Directory I 
I Delete Hatching File(s) I 

Figure 5-5 DOS File Operations Dialog Box 

Description 

DOS File Operations lets you delete files, and 
make and delete DOS directories. 

Application 

• Delete files before quitting from Xerox Ventura 
Publisher, if you run out of room on your hard 
disk while attempting to save a style sheet or 
chapter. 

• Create a subdirectory if you decide to save 
style sheets or chapters in a new DOS sub­
directory. 

Delete files 

To delete a file or files, select the DOS File Opera­
tions option in the File menu (Figure 5-5.) Then, 
type the file name to delete (including DOS wildcard 
characters) directly on the File Spec: line, including 
the subdirectory, if any. Then, select Delete Match-
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ing File(s) to delete all files matching the File Spec. 
Alternatively, you can select Operation: Select Dif­
ferent File Specification. The Item Selector ap­
pears and you can select the file to delete. 

Make directory 

To create a new directory: 
~ Type the new directory name, including disk drive 

and any parent directories, directly on the File 
Spec line. 

~ Select Make Directory. 

For instance, to make a new sub-directory called 
STYSHET under the directory called TYPESET, type 
the following: 

C:\ TYPESET\STYSHET 

Select Make Directory. 

Operation-Delete directory 

To delete a directory: 

~ Type the directory name, including disk drive and 
any parent directories, directly on the File Spec 
line. 

~ Select Delete Directory. 

For instance, to delete a sub-directory called CHAP1, 
type the following on the File Spec line C:\CHAPI. 
Then, select Remove Directory. 

All files must be removed from the directory before 
the directory can be removed. 

~ For all DOS file operations, no operation is performed 
if the file is write-protected or if the directory or file 
selected does not exist. 
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Quit 

Description 

The Quit option ends the current Xerox Ventura 
Publisher session and returns you to DOS. 

Application 

• Move to other programs to do wordprocessing, 
line art design, and image editing. When you 
use Xerox Ventura Publisher the next time, 
any changes made by these other programs to 
text, image, or line art files will automatically 
appear in your chapter. 

Operation 

Select Quit in the File menu. If you have made chan­
ges to your chapter or style sheet since they were last ~ 
saved, Xerox Ventura Publisher asks: 

Save or Abandon changes to this chapter? 
Save, Abandon, Don't Quit. 

5-24 

Select Save to save the changes before quitting; 
select Abandon to throwaway any changes made; 
select Don't Quit to continue editing. 

When you Quit from Xerox Ventura Publisher, the 
current Function, View, and Options settings are all 
saved. When you next use Xerox Ventura Publisher, 
you resume with the same settings that were in ef­
fect at the end ofthe previous session. These settings 
are saved in the VP.INF file in the VENTURA sub­
directory. 
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Cut T~xt n~l 
Cory T~xt tn~l 
Paste Text Ins 

Insert Footnote 
Insert/Edit Index", 
Insert/Edit Anchor .. , I 
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fil~ T ~!R~;1<m~», 

Figure 5-6 Edit Menu 

MENU COMMANDS 

Description 
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The Edit menu controls insertion and deletion of 
text blocks, pictures and graphics. 

The Edit menu provides the capability to cut, copy, 
and paste selected text, and to insert footnote and 
index references. The Edit menu lets you cut 
(remove) frames and their contents from the page, as 
well as copy frames (and their contents) to another 
location. You can also cut, copy and paste graphics 
created within Xerox Ventura Publisher from one 
frame to the next. Finally, this menu provides the 
ability to remove files from the selected frame, 
remove them completely from the Assignment List, 
rename text files, or change a text file from one 
wordprocessor format to another. 

Each feature ofthe Edit menu is described more fully 
on the following pages. 
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Description 

Cut, Copy, and Paste let you delete, move, and copy 
text, frames, and graphics. 

Cut removes the selected text, frame, or graphic 
from the screen and places it on an imaginary clip­
board. The text, frame or graphic can then be pasted 
(moved) to another location. Xerox Ventura 
Publisher uses three independent clipboards: One for 
text, one for frames, and one for graphics. Operations 
on one clipboard do not affect information stored on 
another clipboard. 

Copy places an identical copy of the selected text, 
frame, or graphic on an imaginary clipboard, but 
does not remove the selected item from the page. 

Paste takes the last item which was cut or copied 
and places it: 

• At the current location of the text cursor, if the 
clipboard contains text and the Text Editing 
function is selected. 

• At the identical position on a new page or the 
current page, if the clipboard contains a frame 
and the Frame Setting function is enabled. 

• At the identical position on a new page or the 
current page, if the clipboard contains a 
graphic and the Graphic Drawing function is 
enabled. 

Application 

• Text, frames, and graphics can be moved from 
one part of a chapter to another, as well as be­
tween chapters 

• Text can be moved between different files. (For 
instance, if a frame on page 36 contains text 
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from a Wordstar file, and you want to place a 
copy of part of this text in a Multimate file 
which is in a frame on page 3, you can select 
the desired text on page 36, copy it to the clip­
board, go to page 3, place the text cursor at the 
point in the text where the clipboard text is to 
begin, and then select Paste Text in the Edit 
menu.) 

• Place identical copies of the same picture on 
more than one page 

• Duplicate several blank frames. (If you want 
to put the same frame on every page, use 
Repeating Frames instead.) 

• Copy or move selected graphics associated 
with a frame. 

Operation-Text 
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To cut (delete) text, select the Text Editing function, 
and then select the text to be deleted. Next, select the 
Cut Text option in the Edit menu, or press the Del 
key on the keyboard. The text disappears from the 
screen, and the remaining text on the page is refor­
matted. If a mistake is made, the text can be restored 
by immediately selecting Paste Text, or by pressing 
the Ins key on the keyboard. To include the end of 
paragraph mark, move the text cursor in front of the 
first word of the next paragraph during text selec­
tion. 

To move text to a new location after it has been cut, 
place the text cursor at the exact spot in the chapter's 
text where the cut text is to start. When the text cur­
sor is placed correctly, select the Paste Text option, or 
press the Ins key on the keyboard. The inserted text 
is always converted to the tag and text attributes in 
effect at the point of insertion. 

To copy text, select the Text Editing function and 
then select the text to be copied. Next, select the Copy 
Text option in the Edit menu or press and hold the 
Shift key and then press the Del key. The text is 
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placed on the clipboard. Then, place the text cursor 
at the exact spot in the chapter's text where the text 
now on the clipboard is to start. When the text cursor 
is placed correctly, select the Paste Text option, or 
press the Ins key on the keyboard. 

Since the text remains on the clipboard after a paste 
operation, additional copies of the text which have 
been cut or copied can be placed elsewhere by follow­
ing the procedure in the previous paragraphs. 
However, you don't have to re-cut or re-copy the text. 
Also, text remains on the clipboard even after a new 
chapter is opened. This lets you copy text between 
chapters. 

As soon as you cut or copy a new piece oftext, the text 
currently on the clipboard is lost. However, if a frame 
or graphic is cut or copied, any text on the clipboard 
remains on the clipboard. 

Cut, Copy, and Paste can also be used to move or copy 
any of the hidden attributes shown in the Current 
Selection indicator. To do this, first move the text cur­
sor until the hidden attribute is shown in the Current 
Selection indicator. Then press either the Del key 
(cut) or the Shift and Del keys (copy.) Move the text 
cursor to the new location and then press the Ins key. 

Ilaf You must use the keyboard keys when cutting or 
copying attributes. The Cut and Copy options in the 
Edit menu will not work. 

Note that if the Current Selection indicator is blank, 
pressing the Del or Shift and Del keys will not cut or 
copy text to the clipboard. 

Operation-Frames 

To cut (delete) a frame, first enable the Frame Set­
ting function and then select the frame to be cut. 
Next, select the Cut Frame option in the Edit menu, 
or press the Del key on the keyboard. If a mistake is 
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made, the frame can be restored by immediately 
selecting Paste Frame, or pressing the Ins key on 
the keyboard. 

To move a frame to a new location once it has been 
cut or copied, first enable the Frame Setting function. 
Next go to the page where the frame is to be moved, 
and then select the Paste Frame option, or press the 
Ins key. The frame, and the file it contains, is placed 
on the page. The frame's original location on the page 
prior to the cut or copy operation determines where 
it is pasted. You can then move the frame to a new 
location on the page. 

To copy a frame, first activate the Frame Setting 
function and then select the frame to be copied. Next, 
select the Copy Frame option in the Edit menu or 
press the Shift and Del keys. Then go to the page 
where the frame is to be copied and select the Paste 
Frame option, or press the Ins key. The frame, and 
the file it contains, is placed on the page. 

As soon as you cut or copy a new frame, the frame 
currently on the clipboard is lost. However, if text or 
a graphic is cut or copied, any frame on the clipboard 
remains on the clipboard. 

Captions and graphics attached to a frame will also 
be cut or copied. Xerox Ventura Publisher automati­
cally generates new Table or Figure counters in cap­
tions which are pasted onto a page. The last frame 
pasted on a page is always assigned the highest Table 
or Figure number on the page. 

If multiple frames are selected, they are all Cut, 
Copied, or Pasted. 

Operation-Graphics 
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To cut (delete) a graphic, first enable the Graphic 
Drawing function and then select the graphic to be 
cut. Next, select the Cut Graphic option in the Edit 
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menu, or press the Del key on the keyboard. If a mis­
take is made, the graphic can be restored by im­
mediately selecting Paste Graphic, or pressing the 
Ins key on the keyboard. 

To move a graphic to another frame once it has been 
cut or copied, first enable the Frame Setting function 
and select the frame where the graphic is to be 
moved. Then, select the Graphic Drawing function 
and select the Paste Graphic option, or press the 
Ins key. The graphic's original location in the frame 
prior to the cut or copy operation determines where 
it is pasted. You can then move the graphic to a new 
location within the frame. 

To copy a graphic, first activate the Graphic Drawing 
function and then select the graphic to be copied. 
Next, select the Copy Graphic option in the Edit 
menu or press the Shift and Del keys. Then, go to 
the frame where the graphic is to be copied, and 
select the Paste Frame option, or press the Ins key. 
The graphic is placed in the frame. 

As soon as you cut or copy a new graphic, the graphic 
currently on the clipboard is lost. However, if text or 
a frame is cut or copied, any graphic on the clipboard 
remains on the clipboard. 

If multiple graphics are selected, they are all Cut, 
Copied, or Pasted. 

~ Pasting a frame or graphic onto the same page from 
which it was copied places two identical frames or 
graphics on top of one another. Since the two are 
identical and occupy the same position, you will see 
only one copy on the screen. However, you can select 
the frame or graphic on top and move it to another 
location on the page. 

5-30 REFERENCE GUIDE 



Insert footnote MENU COMMANDS 

Insert footnote 

Description 

The Insert Footnote option places footnote refer­
ences at the current text cursor position, and also 
adds a footnote at the bottom of the current page. 

Application 

• Provide on-page references 

Operation 

Footnotes must first be turned on using the Foot­
note Settings option in the Page menu. 

Enable the Text Editing function. Place the text cur­
sor where you want the reference inserted. Then 
select the Insert Footnote option in the Edit menu. 
Depending on the current Footnote Settings, a num­
ber or character appears next to the text cursor. The 
same footnote reference appears at the bottom of the 
page, followed by: TEXT OF FOOTNOTE. Delete 
these words and type the desired footnote. To delete 
the footnote reference and the footnote itself, place 
the text cursor at the footnote reference in the main 
body oftext. Move the text cursor back and forth until 
the Current Selection Indicator displays the word 
Footnote. Press the Del key. Both the footnote refer­
ence and the footnote itself are deleted. 

~ The combined length of all footnotes on a page must 
be less than one half page. If your footnotes are 
longer, turn Footnote Settings off, and then create 
footnotes manually by typing them into frames which 
you draw at the bottom of the page. 
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Footnotes can be created from within your 
wordprocessor. See Appendix D-Wordproces­
sors for more details. 
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INSERT lED IT INDEX ENTRY 

Type of Entry: IIIII!I!II I See I I See Also I 
PriMary Entry: Hovie Technologies, _______ _ 

Pri"ary Sort Key: 

Secondary Entry: 3-D-,-___________ _ 
Secondary Sort Key: Threel-i ___________ _ 

~ 

Figure 5-7 Insert/Edit Index Dialog Box 

Description 

The InsertlEdit Index option inserts an index 
reference at the current position of the text cursor. 

Once index entries have been inserted, an index is 
generated using the index feature in the Multi-Chap­
ter option. This index generator collects all index 
references, remembers what page they're on, al­
phabetizes them, and generates a new text file which 
is the index for the entire publication. This index text 
file can then be loaded, tagged, edited, and printed, 
just like any other text file. 

Application 

• Insert hidden index words into the chapter. 

Operation-Index entry 

Place the text cursor at the location in the text you 
wish to reference and then select InsertlEdit Index. 
The Index Dialog Box shown in Figure 5-7 appears. 
Select Type of Entry: Index. 
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On the Primary Entry line, type the primary index 
reference. For instance, in a book about the movie in­
dustry, a primary reference might be Movie Tech­
nologies. Next, type a sub-heading on the Secon­
dary Entry line, which should appear under the 
primary reference. A secondary reference in this ex­
ample could be Sound, 3-D, or Wide Screen. 

Be careful to type the precisely identical words on the 
Primary and Secondary lines for each index entry 
which references the same concept. Otherwise you'll 
create two different entries instead of multiple page 
references to the same entry. For instance, if you 
have a reference at one point to Wide Screen, and 
another reference to Wide Screen~, two separate 
entries will appear in the index instead of two page 
references under the same entry. 

Sort keys 

The sort keys for each entry are used to place the 
entry in a different alphabetic sequence than the 
entry name itself would suggest. This is used for 
numbers and for phrases which begin with articles 
(e.g., a, an, the.) For instance, if the primary entry is 
The Maltese Falcon, and you want to have this al­
phabetized under Maltese rather than The, enter 
Maltese Falcon on the Primary Sort Key line. 

Most index entries do not require sort keys. 

Index entries can be typed directly from your word­
processor. This lets you create index entries from 
within wordprocessors that don't support indexing. 
(See Appendix D for more information.) 

The index entries shown in Figure 5-7 insert the fol­
lowing into the wordprocessor text file: 

<$IMovie Technologies;3-D[Three1> 

This entry is placed into the final index as follows: 
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M 

Motion Picture 
See Movies 

Movie Technologies 
Sound 4-12,4-15 - 4-18 
3-D 4-34, 5-33 
Wide screen 4-25,5-15 
See Also Technology 

Note that multiple index entries result in multiple 
chapter and page references, separated by commas. 
If these entries appear on consecutive pages, the 
starting and ending pages are shown, separated by a 
dash. 

Operation-See, See also 

If See is selected, the index entry is placed in the al­
phabetically correct location in the index according to 
the Primary Entry, and the word See is placed in 
front of the Secondary Entry. The See entry does not 
generate a page or chapter number. See Also works 
like See, except the words See Also are added to the 
front of the reference. 

Since See and See Also do not generate chapter or 
page references, their locations within a chapter or 
publication do not matter. It is recommended that all 
See and See Also references be grouped together at 
the beginning or end of a chapter. This lets you add 
and delete these cross-references without searching 
for them. 

Operation-Editing index entries 

Index entries can be edited by placing the text cursor 
at the location ofthe entry. The Current Selection In­
dicator displays the word Index if the cursor is 
properly placed. If you then select the InsertlEdit 
Index option in the Edit menu, the dialog box which 
appears will display the current index entry. Make 
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whatever changes you desire, and then select OK. To 
delete this index entry: 

~ Select OK or Cancel to clear the dialog box from 
the screen 

~ Check to make sure the word Index is still in the 
Current Selection Indicator 

~ Press the Del key. 

Index entries placed at the beginning of the 
paragraph are placed before the first character posi­
tion in the paragraph. Therefore to edit or delete an 
index entry at the beginning of the paragraph, use 
the keyboard cursor keys to move the cursor to the 
left until the word INDEX appears in the Current 
Selection Indicator. 

Index generation is an art, far beyond the scope of 
this manual. In general, it is a good idea to insert 
more than one reference, using synonyms, at espe­
cially important points in a manual. Since an index 
can be inserted within your wordprocessor (see Ap­
pendix D), you can search for every occurrence of a 
word or phrase and insert an index entry. However, 
this technique should be used with caution, since it 
typically results in many meaningless references. 
The best indexes are those which index concepts as 
well as words, and which provide many synonym 
references to the same point. 
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Insert/edit anchor 
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REMOUE FILE 

File Nane: NOZZLE ,GE~ 

RenolJe fron: I Frane I List of Files 

OK I Cancel I 

Figure 5-8 Insert/Edit Anchor Dialog Box 

Description 

The InsertlEdit Anchor option lets you place a 
frame anchor into text placed in the underlying page. 
Any time the Re-Anchor Frames command is ex­
ecuted, the referenced frame is automatically moved 
to the same page as the text anchor. 

Application 

• Insert a location in text to which frames will 
be anchored. 

Operation 

Place the text cursor where you wish to insert an 
anchor point and then select the InsertlEdit 
Anchor option. The InsertlEditAnchor Dialog Box 
shown in figure 5-8 appears. Type the name of the 
frame you wish to reference. The name must match 
the name entered in the Anchors & Captions 
Dialog box. If it doesn't, an error message appears 
during the Re-Anchor Frames operation. 
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The frame can be placed either before or after the line 
which contains the frame anchor. If Fixed, On Same 
Page As Anchor is chosen, the frame's position on a 
new page is identical to its position on the old page. 

~ Always check each page after you Re-Anchor Frames 
to make sure that no frames have been pushed off the 
edge of the page, and that no frames overlap. 
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Remove text/file 
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REMOVE FILE 

File Nane: NOZZLE .GE~ 

Renave fran: I Frane I List of Files 

OK I Cancel I 

Figure 5-9 Remove File Dialog Box 

Description 

Remove TextlFile completely removes a file and its 
contents from a frame or the Assignment List. The 
file is not deleted from disk. (Use Delete Matching 
Files in the DOS Files Operations option to delete 
files from disk.) 

Application 

• Remove TextlFile (from list of files) is used 
when the wrong file has been placed in a chap­
ter . 

• Remove TextlFile (From frame) is used to 
create an empty frame. This is useful when 
you have set a frame's margins, columns, 
ruling lines, background pattern, etc., and you 
want to use Copy Frame and Paste Frame to 
create additional frames with these identical 
settings, but with nothing in them. 

Operation 

To remove a file name from either the list of files in 
the Assignment List or from a frame or page: 
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~ Activate the Frame Setting function. 
~ Select the frame whose contents you wish to 

remove. 
~ Select Remove Text/File in the Edit menu. The 

Dialog Box shown in Figure 5-9 appears. 
~ To remove the file from both the frame and from 

the list of files in the Assignment List, select 
Remove from List of Files 

~ To remove the file from the frame or page only, but 
keep the file name in the Assignment List, select 
Remove from Frame. 

~ It is a good idea to remove excess files from the As­
signment List, since excess files slow down the time 
it takes to open a chapter. Also, all text files in the 
Assignment List are loaded into memory, whether or 
not they are placed anywhere in the chapter. 
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You can place a file into a frame which already con­
tains a text or picture file by selecting the frame and 
then selecting a file from the Assignment List. A 
Remove from Frame operation is automatically 
performed on the file already in the frame. 
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File type/rename 

Enter new text file 
name on this line 

FILE TYPE / RENAME 

Old Nallle: C:\TYPESET\BOOK,TXT ______ _ 

New Nallle: C:\TYPESET\NEWBO~, TXT _____ _ 

Text Forlllat: I Generated I .. I WordStar US I I MultiMate I 
I MHord I I Writer US I I WordPerfect I 
I WordStar UK I I Writer G·1 I I XyWrite I []ill 

Figure 5-10 File Type/Rename Dialog Box. A new 
file called NEWBOOK. TXT will be created the next 
time the chapter is saved. 

Description 

I File Type/Rename lets you change the name of any 
text file placed in a frame or page. 

Application 

• Assign a new name to the text file. The next 
time the chapter is saved, a new text file is 
created. The file with the old name remains 
unchanged. 

• Convert from one wordprocessor format to 
another. This option lets you use text files 
from several wordprocessors, and yet save 
each file in a common format. 

• Convert caption frames to text files. 

Operation 

> Enable the Frame Setting function. 
> Select the page or frame which contains the text 

file to be renamed or converted. 
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~ Select the File TypelRename option in the Edit 
menu. The dialog box shown in Figure 5-10 ap­
pears. 

~ Enter the new file name on the New Name: line 
~ Select the wordprocessor format to be used. 

When the chapter is next saved, a new text file is 
created, and the chapter will then point to this new 
file instead of the old file. The old text file remains 
unchanged. 

~ A new file is not actually created until the chapter is 
saved. 
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If you select a frame which contains a caption, then 
you will not only change the file name and file type, 
but will also cause the text to be stored in a separate 
file rather than in the chapter's caption (CAP) file. 
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VIEWMENU 
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Reduced View AR 
NorAal View (1x) AN 
Enlarged View (2x) AE 

Figure 5-11 View Menu 

Description 

The View menu provides four different ways to 
present the chapter on your computer screen: 

• Facing Pages View 
• Reduced View 
• Normal Page View (IX) 
• Enlarged View (2X) 

It also provide an alternative way to enable each of 
the four major functions when the Side-bar is hidden. 

Application 

• Check the overall layout of a page. 
• Place frames (easier when you can see the 

whole page) 

Operation 

Select the desired option in the View menu (Figure 5-
U.) Views can also be selected from the keyboard by 
pressing a combination of the Ctrl key and one of the 
following keys: 
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View 

Reduced View 
Normal View 
Enlarged View 

Key 

R 
N 
E 

MENU COMMANDS 

Normal Page View is used to edit and read text. This 
view provides the most accurate view of the final 
printed page. Use Enlarged View to check picture 
details and graphic placement. Use reduced view to 
place frames and check overall layout. 

In reduced view and facing pages view, text which is 
too small to be read on the screen is "greeked," mean­
ing that a line of the appropriate height and length 
replaces the actual text. Greeking decreases the time 
needed to redraw the page on the screen. You can set 
the size of text to be greeked in the Set Preferences 
option in the Options menu. 

When changing to a more magnified view, you can 
zoom into a specific area of the page as follows: 

~ Place the mouse cursor at the spot which will be 
the upper left corner of the more magnified view. 

~ Use the keyboard shortcuts shown above to 
change view 

~ In Facing Pages View, you cannot drag frames from 
one page to another. Use Cut, Copy, Paste instead. 
Facing Pages View is only available when Double 
Sided printing is enabled in the Page Layout option. 

To enable any of the four Xerox Ventura Publisher 
functions, select the appropriate option in the View 
menu, or press a combination ofthe Ctrl key and one 
of the following keys: 

Function 

Frame Setting 
Paragraph Tagging 
Text Editing . . 
Graphic Drawing . 

Key 

U 
I 
o 
P 
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PAGEMENU 

agl! layout ... 
Widows & Orphans ... 

Chaptl!r Countl!r ... 
Pagl! Countl!r .. . 
Auto-Nunbl!ring .. . 
R(!mmU(!f Ch<l!1t(!f 'S 
RI!-Anchor Franl!s 

H·l!adl!rs & Footl!rs ... 
Turn Hl!adl!r On 
Turn Footl!r On 
Footnotl! Sl!ttings ... 

Insl!rt/Rl!novl! Pagl! ... 
60 to Pa I!... "6 

Figure 5-12 Page Menu 

PAGE MENU 

Description 

The Page menu controls page formatting for the en­
tire chapter. (The Frame menu, on the other hand, 
controls formatting for each individual frame.) 

The individual options available in the Page menu 
are described on the following pages. 

Page Layout, Widow & Orphan, Auto-Numbering, 
and Footnote Settings are stored in the style sheet. 
All other settings are stored with the chapter. 
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Page layout 

MENU COMMANDS 

PAGE LAYOUT 

Orientation: IImmDI I Landscape I 

Paper T9pe: []ill] IImI UlliIJ I Double I 00 00 
I Broad Sheet I 

Dirllmions: 0.5 x 11 in. 

Sides: rnniliJ IIil!I!ImII 
Start On: I Left Side I •• mHlfill 
Kerning: Idl!!!tI'l1Irlil I Globa1l9 Off I 

[JD ICamli 

Figure 5-13 Page Layout Dialog Box. Settings 
shown are typical. 

Description 

Page Layout defines the physical size of the paper 
used in the printer, printing orientation, and selec­
tion of either single or double sided formatting. 

Application 
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Page Layout is used to: 

• Change between portrait and landscape 
(Figure 5-14) display and printing. 

• Change paper sizes: 
- Half (8 ~ x 5 ~ inch) 

Letter (8 ~ x 11 inch) 
Legal (8 ~ x 14 inch) 
Double (11 x 17 inch) 

- B5 (17.6 x 25 centimeters) 
A4 (21 x 29.7 centimeters) 
Broad Sheet (18 x 24 inch) 

• Enable different formatting on left and right 
pages 

• Turn kerning completely off 
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Operation 

Select the Page Layout option in the Page menu. The 
Page Layout Dialog Box is shown in Figure 5-13. 
Select first whether you want the chapter to be i 

printed in Portrait or Landscape. 

Next, select the physical size of the paper on which 
your chapter will be printed. Smaller formats can be 
printed on printers that only handle one size paper 
by increasing the underlying page's margin settings 
in the Margins & Columns menu. 

Finally, select either Single- or Double-sided format­
ting, and whether the first page should start on the 
Left Side or Right Side. If Single-sided formatting 
and Start On Left Side are both enabled, only the 
Left Side settings for headers & footers, margins, 
column widths, vertical rules, and tag (In From Left, 
In From Right) spacing are applied to each page. The 
same comment applies to Single-sided formatting 
and Start On Right Side. 

Portrait Landscape 

Figure 5-14 Portrait us. Landscape printing 
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The Facing Pages option in the View menu only 
works when Double-sided printing is selected. 

~ Double-sided must be enabled in order to allow dif­
ferent headers & footers, margins, column widths, 
vertical rules, and tag (In From Left, In From Right) 
spacing settings for left and right pages. 

11 x 17 and Broadsheet 

If 11 x 17 is chosen, a Dialog Box appears at print 
time which gives you three choices: Shrink, Overlap, 
and Nothing. 

Choose Shrink if you want to reduce the entire 11 x 
17 page to fit on an 8 h x 11 sheet. (This option only 
works on PostScript printers.) Choose Overlap if 
you want to print four 8 h x 11 pages which can be 
pasted together to form one 11 x 17 page. Choose 
Nothing if your printer can actually print an 11 x 17 
page. If Broadsheet is selected, you can also Shrink 
(if you have a PostScript printer), or print in strips. 
This latter option prints three strips, each 24 inches 
long, and is used with certain typesetting machines. 
This option is not intended for use with laser 
printers. 

Kerning 

Kerning can be turned off globally by selecting 
Globally Off. This overt-ides the paragraph tag set­
tings but does not change them. If kerning is turned 
Globally On, kerning will once again be enabled for 
those paragraph tags which specify Kerning On in 
the Typographic Controls menu. 

Page Layout settings are stored in the style sheet file. 
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Widows & Orphans 
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WIDOWS & ORPHANS 

Minimum Isolated Lines 

At Top (Widow): rn II rn rn rn 
At Bottom (Orphan): rn II rn rn rn 

c:::Q[J I Cancel I 

Figure 5-15 Widow & Orphan Dialog Box. The set­
tings shown here are the normal default settings. 

Description 

A widow is a single line of text at the top of a page or 
column which has been separated from the 
paragraph that finishes the previous page or column. 
An orphan is a single line of text at the bottom of a 
page or column which has been separated from the 
paragraph that starts the next page or column (see 
Figure 5-16.) The Widow and Orphan control in­
creases or decreases the number of lines that can be 
widowed or orphaned. 

Application 

• Improve the look of chapters. 

Operation 

Select the Widows & Orphans option in the Page 
menu. The Widows & Orphans Dialog Box, shown 
in Figure 5-15, appears. To change the current set­
ting, move the mouse cursor to the widow or orphan 
number and select the minimum number of lines to 
leave at the top or bottom of the page or column. 
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Widow 
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MENU COMMANDS 

A default setting of 2 means that at least two lines 
must remain on the previous page or column or be 
forced to the next page/column, when possible. 

Widow & Orphan settings are stored in the style 
sheet file. 

Orphan J 

Figure 5-16 A single line widow at column top and 
single line orphan at column end 
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Chapter counter 

5-50 

CHAPTER COOIHER 

Restart Counting: _ IJ!2J 
lIith "UMber: 811341 

"Imber Fomat: [h[] []:;]] ~ 

C][J I Cancel I 

Figure 5-17 Chapter Counter Dialog Box. The 
chapter number in this example will print as XXXIv. 

Description 

The Chapter Counter sets the chapter numbering 
style to arabic numerals (1,2,3 ... ), roman numerals, 
letters (A, B, C ... ) or text (One, Two, Three .... ) In ad­
dition to setting the numbering style, it can also set 
the chapter number itself. 

Application 

Set numbering style for a chapter. For instance, book 
introductions are often numbered in lower case 
roman numerals, the body of the book in arabic or 
text, and the appendices in letters. 

Operation 

To start chapter numbering at a number other than 
one, select the Chapter Counter option in the Page 
menu. When the Chapter Counter Dialog Box ap­
pears (Figure 5-17), select YES next to Restart 
Counting. The words With Number: change from 
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gray to black and a text cursor appears next to the 
page number. Enter the starting chapter number. 

Next, select the appropriate number format. 

~ Only one chapter number is allowed per chapter. 
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If the Chapter Counter is not set, the default chapter 
number for any new chapter is one, displayed in 
arabic. 

Chapter numbers can be placed in Section Numbers, 
Captions, Headers, Footers, Table of Contents, and 
Indexes. 
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Page counter 

PAGEClllltTER 

Restart Counting:: _ l:!!2J 
With Number: 882~ 

Page counter 

Hulllber ForMat: I:L:[] [];I] ~ o::;:m I i,ii I 

'miN " I ONE, TWO I I one, two I 

OD ! Cancel! 

Figure 5-18 Page Counter Dialog Box. Page num­
bering re-starts on this page. Prints as 'IWenty-'IWo. 

Description 
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The Page Counter sets the page numbering style to 
arabic numerals (1,2,3 ... ), roman numerals, letters 
(A, B, C ... ) or text (One, Two, Three .... ) It can also 
force the page numbering to start at a new number 
on any given page. 

Application 

• Set numbering style for a chapter. 
• Continue page numbering from last chapter 

For instance, book introductions are often numbered 
in lower case roman numerals, the body of the book 
in arabic or text, and the appendices in letters. 

When a whole series of chapters are to be printed 
using the Multi·Chapter feature, you may want to 
consecutively number all chapters. To do this, use the I 

page counter option to set the page number on the 
first page of each chapter. The page number you set 
should be one greater than the last page of the pre­
vious chapter. 
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Operation 

The page counter can be restarted on any page in the 
chapter. To change the numbering of any page, first 
go to that page, and then select the Page Counter op­
tion in the Page menu. When the Page Counter 
Dialog Box appears (Figure 5-18), select YES next to 
Restart Counting. The words With Number: 
change from gray to black and a text cursor appears 
next to the current page number. Enter the new page 
number. In Figure 5-18, the page counter is set to res­
tart at page 22 and to number the pages in English. 
Next, select the appropriate number format. 

The Page Number Indicator in the lower left corner 
of the computer screen is not changed by the Restart 
Counting option. This on-screen page counter simply 
shows the number of pages relative to the start ofthe 
chapter. All references to page number within Xerox 
Ventura Publisher, other than Restart Counting 
With Number: refer to this on-screen page number. 

~ The page numbers specified in the To Print option 
refer to the page numbers shown in the on-screen 
page counter, not the numbers set by the page 
counter. 

The default page number for any new chapter is page 
1, arabic (i.e., 1,2.)Page numbers can be placed in 
Headers, Footers, Table of Contents, and Indexes. 
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Auto-numbering 
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RUTO·NUMBERING 

Usage: • []ill 
Level 1: [.Heading 1,1]'~ ______ _ 
Level 2: ['Section Sub,1

1
].--------

Level 3: ['Hinor Head, 1 1"-. _______ _ 
Level 4: 
Level 5: 
Level 6: 
Level 7: 
Level B: 
Level 9: 

Level 10: 

Inserts: I Chapter ~ I [ill [];I] QJJ CIJIJ ITJI] 
I Suppress Previous Level I I Te~t Rttr. I rnii"""I rr.::::n 

L-L L.!:!!!lli..J 

Figure 5-19 Auto-Numbering Dialog Box. Three 
levels of numbering shown, with periods after the first 
two levels. 

Description 

Auto-Numbering automatically inserts section 
numbers before tagged paragraphs. These section 
numbers can contain any combination of numbering 
styles and punctuation. For example: 

1. Major heading 
1.1 Sub heading 
1.2 Sub heading 
1.2.1 Sub-sub heading 

Application 

• Technical manual section numbers 
• Outlines 
• Automatic headings 
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Operation 

Select the Auto-Numbering option in the Page menu. 
The Auto-Numbering Dialog Box, shown in Figure 
5-19, appears. Select the On option at the top of this 
Dialog Box in order to enable Auto-Numbering. Next, 
insert, on the Level 1 line, the auto-numbering style 
for the top level paragraph. To do this, place the text 
cursor on the Levell line and then choose either the 
1, 2; A, B; a, b; I, II; or i, ii options. If you select 
arabic numbering (i.e., 1, 2), this places the words: 

II [*tag narne,l] II 

on the Level 1 line. Use the keyboard cursor and 
backspace keys to replace the words tag name with 
the actual tag name of the highest level paragraphs 
you want numbered. You must type the tag name ex­
actly as it appears in the Assignment List, although 
upper and lower case letters don't matter. For in­
stance, to number all sections tagged with a tag 
called Heading 1, the level one line looks like this: 

II [*Heading 1, 1] II 

If you then select OK, an arabic number is inserted 
before every paragraph tagged with Heading 1. 
Each succeeding Heading 1 paragraph is numbered 
consecutively, even if other paragraphs intervene. 

To start numbering with a number other than one, 
enter this number just inside the right bracket. For 
instance to start numbering with the number 3, the 
above example would be modified to look like this: 

II [*Heading 1,1,3] II 
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This starting number is optional. If omitted, one is 
assumed. The starting number is always entered in 
arabic. 

Repeat the above procedure for each additional level 
you wish to number automatically. Add punctuation, 
such as periods or hyphens, that you want to appear 
in the numbering. For instance, if you want 
paragraphs tagged with the tag name Section Sub 
to be numbered with arabic numerals, followed by a 
period, the Level 2 line would look like this: 

II [*Section Sub,lj. II 

~ Each time a tagged paragraph is encountered, the 
numbers for all paragraphs tagged below that level 
are reset to their initial count 

Section numbers are only added, deleted, or changed 
when you make a change in the Auto-Numbering I 
menu or when you select the Renumber Chapter 
option in the Page menu. 

Section numbers cannot be edited. 

Suppress previous level 

It is often unnecessary to include the numbers of 
higher level paragraphs in section numbers at the 
lower levels. Some numbering schemes, such as that 
used in a typical outline, only display one level of 
numbering with each paragraph. To suppress print­
ing of the higher level numbers, select Suppress 
Previous Level. This places a [-] at the current text 
cursor position. This should be inserted as the very 
first item on the line. Figure 5-20 shows the settings ~ 
for an outline that follows standard conventions (up­
percase Roman letters, followed by uppercase letters, 
followed by arabic numbers.) 
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AUTO-NUHBERIN6 

Usag~: • (]ff] 

Level 1: 
Level 2: 
Level 3: 
Level 4: 
Level 5: 

I ·Hain. I]. 
1·]['Sub H""eaT"d.TIA)-. --------
11.]['Minor Head.11. _______ _ 

Level 6: 
Level 7: 
Level B: 
Level 9: 

L~vel 10: 

Ins~rts: I Chapter ~ I [JJJ [I[] [h[] !LID IIJ!] 

I Suppress Pr~viDus L~velll T~xt Attr. I r--;;;;-'1 
L.....l!!L..J I Cancel I 

Figure 5-20 Numbering for outline. Note the [-] at 
the beginning of levels 2 & 3 to suppress printing of 
previous level numbers. 

~ Only text in underlying pages can be auto-numbered. 
Text in frames and box text will not be numbered. 

Advanced operation-Section number tags 

REFERENCE GUIDE 

The tag names specified in the auto-numbering 
Dialog Box specify which paragraphs should be num­
bered. The numbers which Xerox Ventura Publisher 
creates are then automatically tagged. These gen­
erated tag names are Z_SECl, Z_SEC2, ... Z_SECB. 
These names cannot be changed. Generated tags 
are not shown in the Assignment List, unless re­
quested in the Set Preferences option. 

Initially these generated tags have the same at­
tributes as Body Text, but these attributes can be 
changed just like any other tag. You can change these 
tags so that section numbers are placed on the same 
line with their associated paragraphs as shown on 
the following page. 
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Change the section number's tag attributes to: 

Font 

Alignment 
Spacing 
Line Break 
Ruling Lines Above 
Ruling Lines Below 

Same as 
paragraph tag 
Left 
No space below 
Before 
As desired 
None 

Change the paragraph's tag attributes to: 
Font Same as section tag 
Alignment Indent relative to 

Spacing 
Line Break 
Ruling Lines Above 
Ruling Lines Below 

previous line, 
plus one pica 
No space above 
After 
None 
As desired 

Figure 5-21 shows the results of changing the tags. 

8.5. TIPS, TRICKS, AND TECHNIOUES 

Section num­
bers placed 
on same line 

with the 
headings 

8.5.1 TextBlocking (Run Arounds) 

Placing text around an irregular object is called a Run 
Around, Normally, Ventura Publisher automatically 
L~lowS" text around rectangular Frames, However, text 
can also be made to flow around irregular objects, 
The technique for doing this, which involves turning 
Text flow Around off in the Frame Menu, is 
described under the Layout heading in the Reference 
8 ection, 

8.5.2 Creatina MultiDle frames 

Figure 5-21 Generated numbers placed on line with headings 
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II 

During text editing, some paragraphs may draw over 
the first line of the previous paragraph if you set the 
tags as described above. However, if you change the 
Line Break for all other tags in your style sheet 
from Before to Mter, you eliminate this effect. 

Chapter numbers 

Chapter numbers can be included at any level by 
selecting the Chapter # option in the auto-number­
ing Dialog Box. This places [C#] at the current text 
cursor position and automatically inserts a chapter 
number into the section number. 

Advanced operation-Suppress numbering 

[*Body Text 1 
\ 

If you create an outline or a numbered list using the 
approach shown in Figure 5-20, you cannot reset the 
top level number back to one. If you want to have 
several independent numbered lists within the same 
chapter, you need a way to reset numbering. 

You could place Body Text as the tag name on level 
1, and then create your numbered list hierarchy 
starting on level 2. Thus, as soon as any body text 
paragraph is encountered, the outline or list number­
ing resets. However, every body text paragraph will 
now be numbered. Fortunately, you can suppress 
numbering at any level merely by deleting the 
paragraph numbering type. For instance, if you 
wanted to use body text to reset numbering, then you 
would place the following on the level 1 line: 

II 
Note U\at numbering 
is removed 

This trick works with any paragraph tag, not just 
body text. 
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Advanced operation-Auto-text addition 

You can place text on any level, either before or after 
the tag name. Figures 5-19 and 5-20 show periods 
placed after some of the tag names. Any other text 
can be placed on these lines. If the section number is 
suppressed as described above, you can add text to 
the beginning of every paragraph tagged with the 
designated tag. For instance, to place the words 
Daily Times: at the beginning of every paragraph 
tagged as a Question (as is often done in interviews), 
type [*Question]Daily Times: at the appropriate 
level. 

Text attributes 

Any of the text attributes (e.g., bold-<B» shown in 
Appendix D can be used in section numbering. These 
attributes must be placed outside the command 
brackets (i.e., [ ]) 

Example: To change the word Times in the above ex­
ample to bold italic, type [*Question]Daily 
<BI>Times:<D> at the appropriate level. 
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Renumber chapter 

Description 

Renumber Chapter updates the numbering of 
paragraphs defined in the Auto-Numbering option. 

Application 

• Renumber the entire chapter according to the 
Auto-numbering settings 

Operation 

Select Renumber Chapter in the Page menu, or press 
and hold the Ctrl key and then press B. The entire 
chapter is immediately renumbered. Select Renum­
ber Chapter any time you want to update section 
numbering. Removing or retagging section num­
bered paragraphs also requires that you renumber 
the chapter. 

~ Section numbers are not added, deleted or modified 
during text editing. You must Renumber Chapter to 
update section numbers. 
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Section numbers are not saved in the text file. In­
stead, they are regenerated each time the chapter is 
loaded. 
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Re-anchor frames 
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Description 

Re-Anchor Frames moves every frame in the chap­
ter to the page on which its anchor appears. A frame 
is not moved if no anchor has been set for it in the 
Anchors & Caption option, or if the anchor name set 
for the frame does not match any anchor name in the 
text. 

Application 

• Move frames to anchor points in the text 

Operation 

If the frame anchor name specified in the Anchors & 
Captions pption matches a frame anchor name in the 
text, the frame moves to a new location when Re- I 
anchor Frames is selected. 

To operate: 

~ Select the Re-Anchor Frames option in the Page 
menu. 

~ A Dialog Box appears. Choose whether you want 
to re-anchor only the frames on this page, or all the 
frames in this chapter. 

~ Go to each page to make sure that frames have 
been moved to a desireable location. 

If frames are anchored above or below a point in the 
text, and that text is currently at the top or bottom of 
the page, the re-anchor operation will move those 
frames into the upper and lower margins. These 
frames must be re-Iocated manually, as described in 
the Functions chapter, after the re-anchor operation. 

If the anchor name in the text does not match the 
anchor name given to the frame, Xerox Ventura 
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Publisher displays a message on the screen during 
the re-anchor process. You can then correct the name 
of the anchor in the text before the re-anchor process 
continues. 
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Headers & footers 
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HEIlDERS I FOOTERS 

Define: 1 Left Page Header 1 Rlght PJgc HCJdcr 

1 Left Page Footer 1 "1 Rl""ig~ht:-1P;-ag--e"'Fo--o::-te"'r 1 

Usage: III I]ff] 
Left: [<Heading 11, ___________ _ 

Center: <P1B>Page<P255> IU]-[P"I _______ _ 

Right: 1[<Chapter Headl __________ _ 

Inserts: 1 Chapter" 1 !!illIl11st Hatch 1 1 Last Match 1 

1 Text Am. 1 1 COPY To Facing Page 1 

Figure 5-22 Headers & Footers Dialog Box. The 
word Page is set to 18 point. 

Description 

Headers & Footers defines text which is placed at 
the top and bottom of each page. 

Each header and footer can have three separate 
entries: One left-justified, one centered, and one 
right-justified, each up to two lines. Also, you can 
specify different headers and footers for the left and 
right page. Thus, pages 1,3,5,7, ... can have a dif­
ferent set of headers and footers than pages 2, 4, 6, 8. 
Chapter numbers and page numbers can be inserted 
into any header or footer. Also, the first and/or last 
occurrence on a page of any paragraph tagged with a 
specified tag can be copied to the header or footer. 

Application 

• Create page and chapter numbers 
• Automatic section titles 
• Directory headings 
• Chapter headings 
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General operation 

To use Headers and Footers, select the Headers & 
Footers option in the Page menu. The Headers & 
Footers Dialog Box (Figure 5-22) appears. 

Next, decide where you want to place text (e.g., left, 
center, right aligned.) For example, to place text at 
the top center of the left page: 

~ Select Left Page Header 
~ Turn Usage On 
~ Move the text cursor to the first line opposite 

Center, and enter the text 

If Double is specified in Page Layout, all settings for 
a header or footer can be "reflected" to the other page 
(i.e., the left aligned header on the left page is trans­
ferred to the right aligned header on the right page.) 
To do this, select Copy to Facing Page. (The words 
Copy to Facing Page do not remain highlighted.) 

If Single and Start on Left Side are specified in 
Page Layout, only the left header and footer are used. 
The same is true for Single and Start on Right 
Side. 

I@f' If either the right or left header/footer doesn't appear 
on the screen, make sure to check the Single and 
Double settings in the Page Layout option. Also check 
to make sure you have defined a header or footer for 
both the left and the right page. Finally, make sure 
the header/footer is turned on for this page. 

Chapter and page numbering 
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To place a chapter or page number in the header or 
footer, select the header/footer location as described 
above. Next, select Inserts Chapter # or Inserts 
Page # at the bottom of the Dialog Box. For page 
numbering, this automatically places the following 
on the header or footer line selected: 
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II [P#] 

Headers & footers 

II 

The symbol for chapter number is [C/l. 

Chapter and page numbers automatically start with 
one, unless set by choosing Restart Counting With 
Number: in the Chapter or Page Counter options. 

Generated headers & footers 

II [<tag name] 

II [<Heading 1] 

5-66 

Xerox Ventura Publisher can automatically place 
tagged text in the header or footer. For instance, sup­
pose you want text tagged with a tag called Heading 
1 to appear left-justified on each right page. To do 
this, first select Right Page Header, place the text 
cursor on the Left line, and then select the 1st 
Match option at the bottom of the Dialog Box. You 
will see the following appear on the Left line: 

II 

Next, use the cursor and backspace keys to remove 
the word tag name and replace it with Heading 1. 
The text on your Left line should now look like this: 

II 

This command copies the first occurrence of text 
tagged with the Heading 1 tag to the top left of every 
right-hand page. If no text is labeled with Heading 1 
on a particular page, the most recent paragraph in 
the chapter tagged with Heading 1 is used. Any index 
entries in the tagged text will also be copied to the 
header or footer. This automatically creates a range 
of index entries for the entire section. 
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I i 
I Header Space Above 

Top Margin 
~ 

1 Header 
Body of Page 

1 
I !Footer 

Bottom Margin 
Footer Space Above 

1 

Figure 5-23 Relationship of Header & Footer 
Above / Below space with Header & Footer Frame 
margins 

Text attribute 
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The text attributes described in Appendix D can be 
used to modify the header or footer text. Figure 5-22 
shows how these attributes can be used to change the 
word Page to 18 point. This figure also shows how to 
place text from paragraphs tagged with Heading 1 
and Chapter Head into the right header. 
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Tagging headers & footers 

The Z_HEADER and Z_FOOTER tags are automati­
cally created and assigned to Headers or Footers 
when you select OK in the Headers & Footers Dialog 
Box. When first created, the Header and Footer tags 
are each assigned Body Text attributes. To place the 
header closer to the body of the document, increase 
the header tag's Above space. To place the footer 
closer to the body of the document, decrease the footer 
tag's Above space. (See Figure 5-23.) To place a ruling 
line below each header, change the header's tag to 
add a ruling line below, and so on. 

~ If header above plus below space is larger than the 
top margin, your document displays with a larger top 
margin than set in the Margins & Columns option. To 
correct, select the Paragraph Tagging function, select 
the header text, and then decrease the above or below 
space. The same comment applies to footers. 
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Turn header/footer off (on) 

Description 

Turn Header Off (On) or Turn Footer Off (On) 
suppresses (enables) the information that has been 
entered using the Headers & Footers option. Headers 
or footers can be turned off on a page by page basis 
throughout the chapter. 

Application 

• Remove header or footer from the current page 

Operation 

To tum headers off for the page currently displayed, 
select the Turn Headers Off option in the Page 
menu. To turn headers back on, select the Turn 
Headers On option in the Page menu. Tum Footers 
Off(On) works identically. 

~ Tum Headers Off/On stays associated with the page 
number shown in the Current Selection Indicator, 
even if text gets moved from one page to another. 
Therefore, do not tum headers or footers off until you 
have finished creating the chapter. 
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Footnote setting 
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FOOTNOTE SETTINGS 

Usage & Fomat: []1[] I ~ FrOlil Start of Page (1,2,3) I 
~ FpOfl Star't of Page (UseI' Defined) 

I ~ Fro" Start of Chapter (1,2,3) I 
Start lIith ~: 0005 

Nu .. ber Template: ~_ 

Position of tlulltber: I No Shift I ai'4;;4';; I Subscript I 

User- Defined Strings: 1: * _ 2: ** _ 3: 4: 
5: +_ 6: ++_ 7: .... +_ 8: ++++ 

Separator line lIidth: ...... -- fractional pts 
Space Above line: 

Height of line: 
24.0°1 
01.00 DO 

Figure 5-24 Footnote Settings Dialog Box. Settings 
shown will place a superscripted + next to the first 
footnote on a page. A one point line will be placed 24 
points below the last line of text on the page. 

Description 

Footnote Settings controls chapter footnote for­
matting. Footnotes are created using the Insert 
Footnote option in the Edit menu. 

Application 

• Provide quick references to other information 

Operation 

Select the Footnote Setting option in the Page 
menu. (See Figure 5-24.) Then, select one of the three 
Usage & Format options: 

# From Start of Page (1,2,3.) This re-starts 
footnote numbering at the top of each page, and 
numbers each footnote with an arabic number. 
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# From Start of Page (User-Defined.) Same 
as above, but instead of arabic numbers, each 
footnote reference is shown by whatever is 
defined on the User Defined Strings: line. The 
default strings are shown in Figure 5-24, but you 
can enter any other characters for up to eight 
footnote references per page. 

# From Start of Chapter (1,2,3.) Same as the 
first option above, but the numbers continue 
increasing throughout the chapter. 

~ You must select one of the three options, or footnot­
ing is not enabled for this chapter. 
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To start footnote numbering at a number other than 
one, place the text cursor on the Start With #: line 
and enter the starting number. This is useful when 
printing a chapter in the middle of a long document. 

You can place fixed text immediately before and after 
the footnote reference at the bottom of the page by 
typing up to three characters on the Number 
Template: line. The # character specifies where to 
place the footnote number. For example, typing (#) 
on this line places parentheses around the footnote 
reference number at the bottom of the page. 

Next, select your choice of Subscript, Superscript, 
or No Shift. These settings control the vertical place­
ment of the footnote reference number or character. 

Finally, if you want to place a ruling line above the 
footnotes at the bottom of the page, enter the Space 
Above Line, Height of Line, and the Separator 
Line Width (the width of this line.) The separator 
line width controls the length of the line across the 
page. 

To turn footnotes off, select the Off option and then 
select OK. Turning footnotes off does not affect the 
footnote text stored in the text files. As soon as foot-
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notes are turned back on, all footnotes will once again 
display. 

~ Footnote references can only be placed in the under­
lying page. Footnotes in frames or in box text are ig­
nored. 

Footnotes are placed at the bottom of the page in a 
frame which is created when footnotes are turned on. 
This frame is automatically enlarged as additional 
footnotes are added. If you wish, you can select this 
frame and change its margins to achieve different 
footnote formatting. (You cannot, however, change 
the number of columns in the footnote frame.) 

Advanced operation-Footnote tags 

The footnote number at the bottom of the page is 
automatically assigned a tag called Z_FNOT #, and 
the footnote itself is automatically tagged with a tag 
called Z_FNOT ENTRY. Each of these tags can be 
independently changed to achieve different format- I 

ting effects. 

~ If you have specified a large amount of Above or 
Below space for Body Text prior to turning footnotes 
on, the frame which is automatically created to hold 
the footnote will be made much larger than you 
probably want. To correct, select the Paragraph Tag­
ging function, select the footnote number and then 
decrease the Above or Below space. Repeat for the 
footnote text. 
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Insert page/remove page 

INSERT/REMOVE PAGE 

Operation: I Insert New Page Before Current Page I 
(nsept Ne<l Page Aftep CuPt'ent Page 

I Remove Current Page I 

Figure 5-25 Insert / Remove Page Dialog Box 

Description 

Insert Page lets you insert a blank page anywhere 
in your chapter. Text and pictures can then be placed 
on this blank page. Remove Page removes an in­
serted page. 

Application 

Add additional pages when text is plac.e in 
frames (e.g., newspaper layout) 

• Remove pages which have been added 

Operation 
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To insert a page,. go to the page before or the page 
after the position where the new page is to be in­
serted (see Go To Page.} Next, select the In­
sert/Remove Page option. The InsertlRemove Page 
Dialog Box shown in Figure 5-25 appears. Select 
either Insert New Page Before Current Page or 
Insert New Page After Current Page, depending 
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Insert page/remove page 

on whether the blank page should appear before or 
after the currently displayed page. 

Any text file placed directly in an inserted page 
(rather than in a frame placed on top of the inserted 
page) creates a new underlying page, and therefore 
automatically inserts pages as needed, until all text 
is placed in the chapter. Text already in the first un­
derlying page will automatically flow around the in­
serted file. Thus, if text from file number one 
originally flows from page one to page eight, and a 
new page is inserted between pages six and seven, 
the text from file number one will flow from page one 
to page six, skip page seven, and finish on pages eight 
and nine. If file number two is then placed on the 
blank page seven, and if this file takes five pages, 
then file one will now flow from page one to page six, 
then finish on pages twelve and thirteen. File two 
will be placed on pages seven through eleven. 

To remove an inserted page, first use the Remove 
File option in the Edit menu to remove the file(s) 
from the inserted page. Then select Remove Cur­
rent Page. The inserted page is removed from the 
chapter. You can't remove the current page until all 
text files have been removed from that page. 
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Go to page 

GO TO PAGE 

Relative to: In.tA"MAn, I Fi IH I 

Which Page: I First I I Prev I lummi I Next I I Last I 
ShortCut: [HoMe] [PgUp] 

Current Page: 0011 
Selected Page: 00341 

[PgDn] [End] 

Figure 5-26 Go To Page Dialog Box. Set to go to 
page 34. 

Description 

Go To Page lets you go directly to the desired page 
in your chapter. 

Application 

• Find a specific page in a long chapter without 
searching. 

• Find the page on which a selected file con­
tinues, in a chapter which contains multiple 
text files. 

This is especially helpful in a newspaper or magazine 
layout where many articles are placed across multi­
ple, non-contiguous pages. 

Operation 
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To go to another page, first select the Go To Page op­
tion in the Page menu or press and hold the Ctrl key 
and then press G. The Go To Page Dialog Box shown 
in Figure 5-26 appears. Next, select which page to go 
to. You can go to the first, previous, next or last page 
in the chapter merely by making one of these selec-
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tions and then selecting OK. You can also go directly 
to a specified page number by choosing Selected and 
then entering the appropriate page number on the 
Selected Page line. The current page number is 
shown for reference. 

If you want to move forward or back one page at a 
time, or go to the beginning or end of a chapter, the 
keyboard shortcuts on the Go To Page Dialog Box are 
the easiest way to do so. (See Figure 5-26.) Make sure 
Num Lock is off. 

To halt a Go To Page operation, press the Esc key. 

When you are creating a newspaper or magazine, it 
is possible to have one text file which starts on page 
2 and continues on page 34, and another text file that 
starts on page 5 and continues on page 12. In a chap­
ter with many files, it can become difficult to find the 
next page that contains the remainder of the file. The 
Relative To File selection solves this problem. To go 
to the next page that contains text from a selected i 
file: 

~ Select the frame that contains the file 
~ Select the Go To Page option in the Page menu 
~ Select the File option 
~ Select First, Prev, Next, or Last to go to the first, 

previous, next, or last page which contains text 
from the selected file. 

~ The on-screen scroll bars move within a given page. 
Use the Go To Page function to change pages. 

~ When you are editing text across page boundaries, 
the text cursor must be placed at the desired location 
on the new page before you can resume editing. 
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FRAME MENU 
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Anchors & Captions ... 
Table Counter .. . 
Figure Counter .. . 

Uertical Rules ... 
Ruling Line Above .. . 
Ruling Line Below .. . 
Ruling Box Around .. . 

Frallle 

Figure 5-27 Frame Menu. 

The Frame menu controls the format of frames, as 
well as the underlying page. The options in the 
Frame menu include margins, columns, ruling lines, 
frame sizing and scaling, anchors and captions, and 
background fill patterns. 

The underlying page is like any other frame, except 
that Margin and Column settings for the underlying 
page are stored in the style sheet. All other frame set­
tings are stored with the chapter. 

Changes made to any underlying page affect all un­
derlying pages, whereas changes made to a frame 
placed using the Frame Setting function only affect 
that frame. 

5-77 



MENU COMMANDS Margins & columns 

Margins & columns 
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HAR6IHS & COLUHNS 

# of ColuNns: IT] II CD rn ill [I] III []] 
Settings For: IDa. I Right Page I 

ColuAn 1: 
2: 
3: 
4: 
5: 
6: 
7: 
B: 

Widtr 04,5 
02,5 
00.00 
00.00 
00.00 
00,00 
00.00 
00.00 

Gutters 
0B.50 
00.00 
00.00 
00.00 
00.00 
00,00 
00.00 

Hargins 
Top: 01 ,00 inches 

BOttOA: 01.00 
Left: 00,50 

Right: 00,50 

Calculated Width = 08.50 
Actual FraAe Width = 08.50 

Inserts: I Hake Equal Widths II Cop~ To Facing Page I 
[][] I Cancel I 

Figure 5-28 Margins & Columns Dialog Box. Left 
page settings shown. 

Description 

The Margins & Columns option sets the margins 
for any underlying page or frame, including frames 
automatically generated by Xerox Ventura Publisher 
(e.g., headers, footer, footnote, or caption frames.) 

For the underlying page or for any frame, Margins 
& Columns sets: 

• The top, bottom, left, and right margins 
• The number of columns 
• The width of each column and inter-column 

spacing 

Application 

Set different margins & columns for each 
frame 
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• Set different margins & columns for left and 
right page (e.g., binding margins) 

• Create complementary facing pages 
• Move picture placement within a frame 

Equal column widths 

To set equal column widths, first select the frame or 
page to be changed. Next select the Margins & 
Columns option in the Frame menu. The Margins & 
Columns Dialog Box shown in Figure 5-28 appears. 
Follow these steps to set equal column widths: 

~ Select the number of columns 
~ Set each margin 
~ Set the first inter-column space 
~ Select Make Equal Widths 

If OK is selected at this point, each column is made 
the same width. Any later changes made to left or 
right margins, or inter-column width, change the 
column width. 

Unequal column widths 
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~ Select the number of columns 
~ Set each margin 
~ Set each column width 
~ Set each inter-column space 

Mter entering all information, but before selecting 
OK, make sure that the Calculated Width (which 
shows the current sum of left margin, right margin, 
column widths, and inter-column space) equals the 
Actual Frame Width. Xerox Ventura Publisher 
cannot do this for you because the Margin & Columns 
menu gives you independent control over each set­
ting, and it is therefore possible to create margin and 
column widths that don't equal the width of the page 
or frame. To assure correct formatting, you should 
adjust the margin and column settings as necessary 
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to make the Calculated Width equal the Actual 
Frame Width. 

~ If the margin and column appearance on-screen do 
not match what you specified, check to make sure 
that Calculated Width equals Actual Frame Width. 

Different left/right page margins 

If Double-Sided was selected in the Page Layout op­
tion, each frame or page can have different margins 
and column widths for the left pages than for right 
pages. This is useful for creating binding margins 
and for making left pages which look different from 
right pages. 

To set different margins and columns for left and 
right pages, follow the above procedures for either 
equal or unequal column widths. However, before 
selecting OK, select the option Settings For the 
other page and enter all settings for that page. 

If you want the same unequal column widths on both 
pages, select Settings For the opposite page and 
change its left and right margin settings. 

Captions 

A frame is automatically created for each caption. 
The caption frame's settings can be changed inde­
pendently by selecting the caption frame and setting 
its margins. The caption frame can also be selected 
and made larger or smaller. 

Header & footer frames 

A repeating frame is automatically created for 
headers and footers. This frame's margins are initial­
ly set to vertically center the header text. You can 
change either the frame margins or change the 
Z_HEADER and Z_FOOTER tags, described under 
the Headers & Footers section, to place the headers 
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and footers in the desired location within the header 
or footer frame. 

Footnote frames 
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A frame is automatically created for each footnote. 
Each frame's margins are initially set to vertically 
center the footnote text. However, you can select any 
footnote frame, and then change its margins in order 
to put the footnote at a different place within the 
frame. You can also change the footnote tag's spacing 
to place the text at a different place within the frame. 
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Sizing & scaling 

X Crop + moves 
picture to the 

left. 
X Crop - moves 

picture to the 
right 

Scale Width 
defines width of 

SIZIN6 & SCALING 

Flow Text Around: II []ill 
Upper left X: I12.8B a G Upper left Y: BUO a G 

FraPl! Width: 01.00 FraPl! Height: BUB 
Horiz, Padding: OB.OB Vert, Padding: DUB inches 

Picture Scaling: I Fit in Frail! I':''','N 
Aspect Ratio: '@ijiQ,' I Distorted I 

X (rap Offset: 00.00 a G Y (rap Offset: ao.og a G 
Scale Width: 01.08 Scale Height: 01.O~ 

(olu~n Balance: []ijJ liD 

Measurement 
units controls 

Y Crop Offset + 
moves picture 
up, - moves 

DO I (ancell down 
picture'i!==================l 
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Figure 5-29 Sizing & Scaling Dialog Box 

Description 

The Sizing & Scaling option lets you precisely con- ~ 
trol the size and placement offrames. It also lets you 
exactly control picture reduction or enlargement. 
Finally, this option controls the way text is formatted 
both within and around a frame. 

Application 

• Place the frame at a precise location 
• Scale pictures 
• Crop pictures 
• Let text flow under a picture 
• Create runarounds 
• Help balance columns exactly 

Operation-Text flow around 

To allow text to flow under a frame, turn Flow Text 
Around off. Use of this feature to make text wrap 
around pictures is covered in the Frame Setting 
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sectio.n in the Functio.ns chapter. If the text co.ntains 
tabs, text may no.t co.mpletely flo.w aro.und frames. 

Operation-Frame placement 
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A frame's placement o.n a page is no.rmally co.ntrolled 
by the mouse. To. control the exact placement of a 
frame on a page: 

~ Enable the Frame Setting function 
~ Select a frame 
~ Select the SizWg & Scaling option in the Frame 

menu 
~ Set the Upper Left X and Upper Left Y coor­

dinates of the frame. These numbers refer to. the 
distance o.f the upper left corner of the frame from 
the upper left corner of the physical page (Figure 
5-30). 

~ Set the frame size by modifying the frame's Width 
and Height settings. 

t Upper LeftY 

l 
I+- Upper Left X ~ 

Frame Heigh~ 

1 
~ Frame Width +I 

Figure 5-30 X and Y Frame placement defined 
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Operation-Column balance 

Turn column balance on if you want: 

• Columns to end at the same place in a 
frame/page (Figures 5-31, 5-32) 

• Multi-column text to balance above a 
paragraph tagged to extend across the entire 
frame. 

~ Column balance reduces text formatting speed. 

Column balance adjusts the number of lines in ad-
jacent columns, but does not actually change the 
space between lines or paragraphs (verticaljustifica-
tion.) Therefore, if a two column page contains an odd 
number oflines, or if text is forced to the next column 
or page by the widow and orphan or keep-with-next 
controls, you must add additional space manually be-
tween paragraphs, using narrow frames, if you want 
multi-column pages to balance exactly. (See the 

--- ---

. 
--- ---

Figure 5-31 Column Unbalance Figure 5-32 Column Balance 
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Frame Setting section for instructions on using 
frames to add space between lines and paragraphs.) 

~ When using a frame-wide tag on a paragraph (other 
than the first paragraph on a page) you must turn 
column balance on. 

Scaling 

When Aspect Ratio: Maintain is selected, the 
height to width aspect ratio of the original picture is 
maintained as the frame is made larger and smaller 
(Figure 5-33). By contrast, Distorted scales the pic­
ture to fill the entire frame minus the frame margins 
(Figure 5-34). 

Scaling options include Fit in Frame, and By Scale 
Factors. When Fit in Frame is selected, the picture 
is scaled to fit in the frame. 

By Scale Factors (Figure 5-35) lets you precisely in­
crease or decrease the size of the picture, inde­
pendent of the size of the frame. Scale Width and 
Scale Height control the width and height of the pic-

Figure 5-33 Aspect 
Ratio: Maintain 

Figure 5-34 Same 
as 5-33, except Dis­
torted. 

Figure 5-35 Same 
as Figure 5-34, ex­
cept scale width & 
height both doubled, 
0.75 inch (+) crop. 
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ture. For instance, selecting a Scale Width of 03.00 
inches makes the picture exactly three inches wide. 
When Maintained is selected, only the Scale Width 
can be set. The Scale Height is automatically in­
creased or decreased as necessary to maintain the 
original aspect ratio of the picture. 

Ignore any lines that appear on the screen in scaled 
images. These lines result from the difference in 
resolution between the scanned image and the com­
puter screen resolution. 

To print a scanned image at exactly the same size and 
resolution at which it was scanned, select By Scale 
Factors. 

Actual Picture 
Size (shaded area) 

X Crop (+) 

Y Crop (+) 

Figure 5-36 Cropping for picture which is scaled 
1.5 inches in the X direction, 3.0 inches in the Y direc­
tion. X Crop Offset is 0.25 inches (+). Y Crop Offset is 
0.50 inches (+). 
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Cropping 

Pictures which have been scaled by factors can be 
cropped. Crop pictures by specifying the X (horizon­
tal) and Y (vertical) amount to move the scaled pic­
ture relative to the frame (see Figure 5-36). 

If the scaled picture is larger than the frame, you can 
also crop the picture as follows: 

~ Place the mouse cursor within the frame 
~ Press and hold the Alt key on the keyboard 
~ Press and hold the mouse button 
~ Move the image behind the frame until the desired 

cropping has been achieved 
~ Release the mouse button and the Alt key 

Padding 
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The Padding settings let you increase space around 
a frame to keep text from touching the side of a 
frame. 
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Repeating frame 
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REPEATINi FRAME 

For All Pages: []ill [!ill] []!ill] IQII:I;n;Utl 
On Current Page: Show ThlS Repeating Frame 

I Hide This Repeating FraMe I 
I Show All Hidden FraAes I 

[]D I Cancd I 

Figure 5-37 Repeating Frame Dialog Box 

Description 

The Repeating Frame option duplicates a frame, 
its ruling lines, background, and contents, on every ~ 
page in the chapter. 

Application 

• Place the company logo on every page of the 
chapter. 

• Place a black box at the edge of every page, 
thus providing a visual tab that can be seen at 
the edge of the document. 

• Place a large header or footer on every page. 
• Eliminate the Frame Too Complex message 

during database publishing 

Operation 

~ Create the frame you wish to repeat. If it is to i 
.repeat on left pages only, make sure you create it 
on a left page. (The same comment applies to the 
right page.) 

~ Place a file into the frame 
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~ Add ruling lines, background pattern, etc. 
~ Make sure that this frame is selected 
~ Select the Repeating Frame option in the Frame 

menu. 
~ If you want the frame to appear only on Left pages, 

select For All Pages: Left. If you want the frame 
to appear only on Right pages, select For All 
Pages: Right. 

~ If you want the frame to appear on both left and 
right pages, select For All Pages: Left & Right. 
The frame is automatically reflected on alternat­
ing, pages as shown in Figure 5-38. 

To place the frame in the same position on both left 
and right pages without reflecting: 

~ Copy the frame to the next page. (See the Copy op­
tion in the Edit menu.) 

~ Select the frame on the left page and make it 
repeat on all left pages. 

~ Select the frame on the right page and make it 
repeat on all right pages. 

A repeating frame can be selected, but the selection 
boxes around the edge of the frame are displayed in 
gray rather than black to alert you to the fact that 
this frame is a repeating frame. Repeating Frames 
cannot be cut, copied, or pasted. They can, however, 

Left Page Right Page 

Figure 5-38 Repeating Frames reflected 
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be re-sized and moved. Any change made to a repeat­
ing frame changes every occurrence of that frame. 

Up to six frames can be repeated within a chapter. 
Repeating Frames cannot have captions. 

Operation-Hide/delete repeating frames 

5-90 

To remove a repeating frame from the current page 
only: 

>- Select the frame 
>- Select Hide This Repeating Frame in the 

Repeating Frame option. 

To restore this frame to view: 

>- Select Show This Repeating Frame. Once you 
select another frame, however, you must select 
Show All ffidden Frames to make all hidden 
repeating frames on the current page reappear. • 
You can then selectively re-hide any repeating ~ 
frame on the current page that you don't wish to 
see. 

To remove a repeating frame from the entire chapter: 

>- Select the repeating frame 
>- Select For All Pages: Offin the Repeating Frame 

option. 

The frame is removed from every page except the cur­
rent page. Since this is now a normal frame, you can 
remove it from the page using the Cut option in the 
Edit menu. 
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Operation-Large headers/footers 

To create a header larger than allowed by the Header 
& Footer function or create a multi-column header: 

~ Turn Headers off 
~ Place a frame at the top of a page 
~ Type the header desired directly into this frame. 
~ Make this frame a repeating frame. 

The same technique works for footers. Page num­
bers, however, can only be placed in a header or footer 
created with the Headers & Footers function. 

Operation-Create more columns per page 

Repeating frames can be used to automatically 
create a large document which contains more 
columns per page than Xerox Ventura Publisher can 
normally handle. To do this: 

~ Set the number of columns in the underlying page 
to at least two columns 

~ Place a text file in the underlying page 
~ Draw a frame. Snap the frame to the top, bottom 

and both sides of one of the column guides, so that 
one column is completely covered. 

~ Set the number of columns in the selected frame 
~ Place the same text file into this frame 
~ Select Repeating Frame and make this frame 

repeat on both left and right pages 

On each page, the text will flow from the underlying 
page first and into the repeating frame second. 

If you create several repeating frames, and set more 
than one column in each frame, you can create docu­
ments with more than eight columns. 

~ Do not completely cover the underlying page with 
repeating frames when using this technique. Some 
text must still flow into the underlying page. 
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Anchors & caption settings 

5-92 

ANCHORS & CAPTIONS 

Anchor: NozzleL---

Caption: [][] I Aboue I DIll QillJ []!ili] 
Label: Figure [C#]-[F#l __________ _ 

Inserts: I Table # II Figure #11 Chapter # II Text Attr. I 

Figure 5-39 Anchors & Caption Setting Dialog Box 

Description 

The Anchors & Caption Settings option lets you: 

• Assign an anchor name to a frame 
• Attach a caption frame to the left, right, above, 

or below any given frame. The caption can con­
sist of either automatically generated text or 
manually entered text. 

Two different caption counters-a Table counter and 
a Figure counter-can be used to number captions. 
These counters are automatically updated as cap­
tions are added and deleted. (See the Table 
Counter/Figure Counter sections.) 

All captions for a chapter are stored in a caption file 
which can later be edited and checked for spelling er­
rors using the ASCII text function of a standard I 

wordprocessor. Be careful not to change the number 
of paragraphs, or text will appear in the wrong cap­
tions. 
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Application 

• Create captions for pictures 
• Automatically generate figure/table numbers 
• Anchor a picture to a location in the text 

Operation-Anchor 

Type the anchor name you wish to assign to a frame 
on the Anchor line. This name must match the 
anchor name inserted into the text. Whenever the 
Re-Anchor Frame command is executed, this frame 
will be moved to the page that contains the cor­
responding anchor reference in the text. 

Operation-Generated caption 
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To create a caption: 

~ Select the frame which is to be captioned 
~ Select the Caption option in the Frame menu 
~ Choose whether the caption is to be placed above, 

below, to the left or right of the frame. 
~ Type the desired caption on the label line. 
~ Select the Table #, Figure #, or Chapter # options 

at any point that you want to insert an automati­
cally updated number. Selecting these options 
places the following codes on the label line: 

Inserts 

Table # 
Figure # 
Chapter # 

Code 

[T#] 
[F#] 
[C#] 

These codes generate table, figure, or chapter num­
bers. You can use either the table or figure number 
(not both) plus chapter number in each caption. 

For example, if the caption setting shown in Figure 
5-39 were the sixth caption in the fifth chapter, and 
the previous four captions all specified the [F#] 
figure counter, this caption would display as: 
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II Figure 5-6 II 

5-94 

Once the caption frame is attached, it always moves 
with the original frame, even when using Cut, Copy, 
or Paste. The caption frame can be sized inde­
pendently from the original frame. To remove a cap­
tion, select the frame and tum Position: Off. 

~ If no text appears in the caption frame, enable the 
Frame Setting Function, select the caption frame, 
and make this frame longer until the caption ap­
pears. Then enable the Paragraph Tagging function, 
select the caption, and adjust the above, below, and 
in from left/right space as necessary. 

Operation-Free-form caption 

If you make the caption frame longer, and if you 
select Show Tabs and Returns in the Set Preferen­
ces option, you will notice an end of file mark in the 
caption frame, next to or below the caption. Select the 
Text Editing function and place the text cursor 
directly in front ofthis paragraph mark. You can then 
type additional text directly into the caption frame in 
exactly the same manner as you would add text to 
any other frame in the chapter. By making the cap­
tion frame larger, this free-form caption can be made 
very long. 

The text for all captions in the chapter is saved in a 
caption file which is automatically created when the 
chapter is saved and given the same name as the 
chapter, but with the extension CAP. The caption file 
is an ASCII text file which can be edited with a 
wordprocessor or checked with a spelling checker. 

Advanced operation 

Two tags are automatically generated the first time 
you add a caption to a frame within a chapter: One 
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for the generated caption (the part entered from the 
Dialog Box) and one for the free-form caption. These 
tag names are Z_LABEL FIG, and Z_CAPTION. 
These names cannot be changed. 

The basic attributes for these tags are copied from 
Body Text, although some changes in the Alignment 
settings are made (e.g., Z_LABEL FIG is centered.) 
You can change ,both caption tags so that free form 
captions are placed on the same line as generated 
captions. To do this, change the generated 
caption's tag attributes to: 

Font 

Line Break 
Alignment 
Spacing 
Ruling Lines Above 
Ruling Lines Below 

Same as 
free form caption 
Before 
Left 
No space below 
(As desired) 
None 

Change the free-form caption's tag attributes to: 

Font 

Break 
Alignment 

Spacing 
Ruling Lines Above 
Ruling Lines Below 

Same as 
generated caption 
After 
Indent relative 
to previous line 
plus 1 pica 
No space above 
None 
(As desired) 

The figure captions in this document consist of two 
parts: The words "Figure 5-39" are created in the cap­
tion Dialog Box, and the remaining text is entered as 
a free form caption. 
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Table counter/figure counter 
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TABLE (OUmR 

Restart (ounting: .. [!] 

With !Wilber: 88261 

!WRber ForRat: _ [gJ [JJJ []JIJ [bill 

[]M;"]iiQJ ~ lone, two I 

Figure 5-40 Table / Figure Counter Dialog Box 

Description 

The Table Counter sets the table numbering style 
to arabic numbers (1, 2, 3, ... ), roman numerals, let­
ters (A, B, C, ... ) and text (One, Two, Three, .... ) It can 
also force the table numbering to start at a new num­
ber. 

The table counter and figure counter work in 
the same way. The only difference is that the Table 
Counter affects captions that are numbered with 
Table H, whereas the Figure Counter affects captions 
numbered with Figure H. The phrase Table Counter 
is used throughout this section, but the same com­
ments apply to the Figure Counter. 

Application 

• Set numbering style 
• Start numbering captions at a number other 

than one. 
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Operation 
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To start numbering the first table with a number 
other than one: 

> Select the Table Counter option in the Page menu 
> Select YES next to Restart Counting. The words 

With Number: change from gray to black and a 
text cursor appears immediately to their right. 

> Enter the starting table number. 

To select a different number format, select the Num­
ber Format desired. 

Restart Counting always restarts the counter to the 
same number, even if the frame is cut and moved to 
another location in the chapter. 
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Vertical rules 
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UERTICAL RUlES 

Settings For: ' •• I Right Page I 
Inter· Col. Rules: • []ill Width: 00.5_ 

Rule 1 Position: O2.BO inches 
Rule 1 Width: 02. DB fractional pts 

Rule 2 Position: OUII 
Rule 2 Width: DB. iii! 

Inserts: I COP? To Facing Pm I 

Figure 5-41 Vertical Rules Dialog Box 

Description 

The Vertical Rules option lets you place ruling lines I 

between each column on either left pages, right 
pages, or both pages. In addition, vertical rules can 
be placed between columns of text within any frame. 
Up to two vertical rules can be placed anywhere 
within a page or within a frame. 

Application 

• Place rules between columns 
• Place rules at edge of page or column (e.g., the 

vertical rule on this page) 

Operation 

>- Select the frame in which you want to place verti­
cal rules. 

>- Select the Vertical Rules option in the Frame 
menu (Figure 5-41.) 

>- Choose whether you want the rules placed on the 
left or on the right page. 
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+-- Vertical Rule 
Placement Measured 
From Edge Of 

....----.1..----..., 
Vertical 
Rule 
Within 
Frame 

Page 

Figure 5-42 Vertical Rule placement is measured 
from edge of page, not edge of Frame 

~ Turn inter-column Rules On and set the inter­
column Rules Width to place ruling lines between 
each column. 

~ Enter Rule Width and the Rule Position for Rule 1 
and/or Rule 2. The Rule Position is measured from 
the left edge of the physical page, not the edge of 
the frame. It is independent of margin settings. 

~ The dimensions for all vertical rule widths are set by 
changing Rule 1 's width. 

Ifthe same settings are desired for the opposite page 
(when Double sided is selected in Page Layout), 
choose Copy to Facing Page. If different settings 
are desired for the opposite page, select Settings 
For: the opposite page, and enter the opposite page 
vertical rule information as described above. 

~ If you don't immediately see a vertical rule within a 
frame, the frame is probably in the wrong position on 
the page relative to the rule. (See Figure 5-42.) 

Frame-wide paragraphs interrupt vertical rules. 
Column-wide paragraphs do not. 
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Ruling lines 
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RULlIUi LINES ABOIJE 

Width: I Hone I [ill[] I Margin I !1iliiiiiJ I11III I tusta~ I 
(alar: [J!6lli] IIi!!D []ill I 'reen II Blue I [ill!] I Yellow I []illlli] 

Pattern: IT] rn rn rn rn rn rn IlmII I Dashes OFF I 
Space Above Rule 1: 116. 

Height of Rule 1: 07 • D2 
Space Below Rule 1: 04.98 

Height of Rule 2: 04.82 
Space Below Rule 2: 03.08 

Height of Rule J: 01.98 

Space Below Rule J: 00. BB a c::J 
Overall Height: 27. jjjj Measurement 

Units 

Figure 5-43 Ruling Lines Dialog Box 

Description 

Up to three ruling lines, each of different thickness 
and with different spacing between each rule, can be 
placed above, below, or around a frame or the under­
lying page. Texture and color can be assigned to each 
set of ruling lines. 

All three Ruling Lines menus function the same 
way. 

Application 

• Isolate text or pictures from the surrounding 
text. 

Operation 

~ Activate the Frame Setting function. 
~ Select the frame. 
~ Select the appropriate ruling line option (Above, 

Below, or Box Around.) 
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MENU COMMANDS 

~ Select Frame to enable this ruling line. 
~ Select the ruling line Color and Pattern. The same 

color and pattern is assigned to all three rules. 
~ Enter the appropriate ruling line height, as well as 

space between each ruling line, for each of the 
three rules. 

~ If you wish to make dashed rules, turn dashes on, 
and then select the width of the dash and the space 
between each dash. Note: Xerox Ventura 
Publisher cannot display or print thick dashed 
rules. If dashes do not display on the screen, 
reduce the ruling line thickness. 

The ruling lines are immediately shown to aid in 
determining the proper line thicknesses and spacing. 
The total height and space between all ruling lines is 
shown on the Overall Height line. Keep changing 
the thicknesses and spacing until you are satisfied. 

The dimensions for all settings can be changed 
among inches, centimeters, picas & points, and frac­
tional points. To change to a different unit of 
measurement, point to the measurement units and 
press the mouse button once. When setting in picas 
& points, remember that, three picas, twelve points 
(i.e., 3,12) is equivalent to four picas (4,00.) Measure­
ment units in other Dialog Boxes can be changed in 
a similar manner. 

Note that the ruling line Overall Height is measured 
from the edge ofthe frame and is independent of the 
current frame margin s, ttings. Therefore, if the 
frame top, bottom and side margins are set to zero, 
the ruling lines will overlap any text or pictures 
placed inside the frame. Therefore, you may need to 
increase the frame margins after adding ruling lines. 
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Frame background 
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FRAME BACKGROUND 

Color: I White I I Black I ~ I Green I 
I!1l!l!I ~ I Yellow I I Magenta I 

Pattern: I Hollow I D m m 
m m m rn I Solid I 

Result: . '. . ~ : 

OK I Cancel I 

Figure 5-44 Frame Background Dialog Box 

Description 
--~------------------------~ 

I The Background option sets the frame background 
color and texture. 

Application 

• Isolate a picture or text frame from the sur­
rounding text. 

• For printers that support white on black print­
ing, the background can be set to black. (The 
text within the frame is automatically set to 
white.) 

Operation 

>- Activate the Frame Setting function and select the 
frame. 

>- Select the Background option in the Frame menu. 
>- Select the color and pattern desired. 
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~ Selecting a background pattern that is too dark may 
make the printed output unreadable. For most ap­
plications, stay with the lightest patterns. 

The background pattern fills the frame, minus: 

• The space above the ruling line above 
• The space below the ruling line below 
• The space above the ruling box around. 
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PARAGRAPH MENU 
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••• 1 

Font ... 
Aligm1llmt .. . 
Spacing .. . 
Brl!aks .. . 
Tab Sl!ttings ... 
Spl!cial Effl!cts ... 
T9Pographic Controls ... 

Ruling Linl! AboVI! .. . 
Ruling Linl! Bl!low .. . 
Ruling BOK Around .. . 

Figure 5-45 Paragraph Menu 

The Paragraph Menu defines the individual Tags 
(paragraph formats) contained within a style sheet. 
These tags are used to change the text format for 
each paragraph in a chapter. 

Each tag defines a set of font, alignment, spacing, 
breaks, tabs,special effects, typographic characteris­
tics, and ruling lines for a paragraph. A collection of 
tags, plus the current underlying page layout and 
margin and column settings, is stored in a style 
sheet. Xerox Ventura Publisher includes a series of 
style sheets designed by typographers. (See Appen­
dix L.) You can also create your own, as described in 
the Training Guide. 

~ Before any option in the Paragraph menu can be 
selected, the Paragraph Tagging function must be 
enabled and a paragraph selected. 

The tag Body Text is reserved by Xerox Ventura 
Publisher. While the characteristics of Body Text can 

REFERENCE GUIDE 



PARAGRAPH MENU MENU COMMANDS 

be changed, the name itself cannot be removed. All 
text not formatted with a specific tag is automatical­
ly formatted as Body Text. 

Note that before you can change a tag's attributes, 
you must first select a paragraph that has been 
tagged with this tag. This lets you see what the tag's 
attributes currently look like, and also lets you see 
the effect of any changes made. 

~ Any attributes placed in the text using the Text Edit­
ing function take precedence over the paragraph tag. 
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Each option in the Paragraph menu is described on 
the following pages. 
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Font 
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"Body Text" FONT 

CustaR She: ooa nail1ts 

:,:,:m Stule :mm 

Light 
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Bold 
Htalic 

B·ltalic 

Shift: []Jl] [Jlillill] 0.000 il1ches 

Km: 0,000 

,:,: (alar iii 
White 
II.m. 
Red 
Green 
Blue 
(yan 
Yellow 
Magenta 

Figure 5-46 Font Dialog Box. Size option displays 
the word Custom for PostScript printers; displays 
discrete sizes for other printers. 

Description 

The Font option defines the typeface, type size, type 
style (bold, italic), and color for each paragraph. 

Application 

• Set the font for each paragraph tag 
• Change text to white to print white text on a 

black background 
• Change text to colors for color separations 

Operation 

To change a tag's font: 

>- Select the Font option in the Paragraph menu. 
(The typefaces and fonts available depend on the 
printer width table installed.) 
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> Select the desired typeface, size, style, and color. 
The Font sizes are displayed in Points, where 72 
points equals one inch. Ten and twelve points are 
standard sizes for Body Text. 

The paragraph selected, and all other paragraphs 
tagged with the same tag will be formatted with the 
new font. Note, however, that the paragraph font 
does not override any font attributes placed in the 
text using the Text Editing function. 

For PostScript printers, select the size in points, on 
the Custom Size line. (See Figure 5-46.) Any integer 
size between 1 and 254 points is allowed. For other 
printers, only certain font sizes are available, and the 
Custom Size option is not available. Instead, select 
one of the discrete sizes shown in the Size menu. 

~ Depending on the printer installed, not all styles are 
available for every typeface. Those selections not 
available are "grayed out." For instance, with the HP 
LaserJet Plus, Normal type is available for 10 point 
Dutch (Times Roman) type, but is not available for 24 
point Dutch (Times Roman.) You can add additional 
fonts to overcome these limitations. Also, for Post­
Script printers, only the fonts actually installed in 
your printer or on your computer's hard disk can be 
printed. See Appendix K for more information. 

If Auto Adjust Styles is set to Yes in the Set Preferen­
ces menu, changing the size of the font automatical­
ly changes the tag's spacing. For instance, changing 
from 10 point to 18 point increases the tag's inter­
line, inter-paragraph, above, and below spacing by a 
factor of 1.8. If you want a different spacing, change 
the inter-line space in the Paragraph Spacing option 
after changing fonts. 

Shift and Kern are only used when setting text at­
tributes using the Set Font option in the Text Editing 
function. They are therefore not available when 
using the paragraph Font option. 
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Alignment 

Alignment 

"Body Text" ALIGNMENT 

Alignl1lent: [Jill] ~ c::llililJ .IIAUml 
Hyphenation: []ill 11~,u(n~':1 I SPANISH I 

Successive Hyphens: OJ 111 rn rn rn I Unlil1lited I 
Overall Width: I,'bli,,,i/mrw I Fral1le' Wide I 

First Line: um I Outdent I 
In/Outdent Width: B1.B~ picas & points 

In/Outdent Height: BB1 lines 

Relative Indent: lIm I Length of Previous Line I 

DO I Cancel I 

Figure 5-47 Alignment Dialog Box. (Indent width 
is set to one pica.) 

Description 

5·108 

Alignment controls the way in which text lines up 
within a column. The controls available include left, 
center, right or justified alignment; hyphenation 
on/off; first line indent/outdent; and column-wide or 
frame-wide overall paragraph width. 

Application 

• Change from ragged right to fully justified and 
hyphenated text. 

• Center headlines. 
• Force a paragraph to go across the entire 

frame or page. 
• Cause the first lines in a paragraph to be in- i 

dented by either a fixed amount, or relative to 
the length of the last line in the previous 
paragraph. 

• Create a lead-in paragraph. 
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• Change hyphenation algorithms (allowing 
simultaneous hyphenation in two languages 
within the same document.) 

Operation 

REFERENCE GUIDE 

To change a tag's alignment, select the Alignment op­
tion in the Paragraph menu. (See Figure 5-47.) Then 
choose whether the text will be aligned with the left 
or right column guide, centered within the column, or 
justified. 

Hyphenation can be turned on or off for any 
paragraph tag. Select the language for which 
hyphenation should be performed. (The default in­
stallation sets both hyphenation options to US 
English.) The number oflines in a row which can be 
hyphenated can be changed by the Successive 
Hyphens control. A setting of 2, for instance, only al­
lows two lines in a row to be hyphenated. See Appen­
dix B for more information on hyphenation. 

To override column settings and make a paragraph 
print across the entire frame, select Frame-wide. 
Text below a frame-wide paragraph continues in the 
next column, below the frame-wide paragraph. Also, 
if a paragraph in a column other than the left column 
is made frame-wide, it prints over the paragraphs in 
the left columns. Therefore, Column Balance should 
always be turned on whenever frame-wide tags are 
applied to paragraphs which are not at the top of the 
frame. Frame-wide paragraphs interrupt vertical 
rules. 

First Line Indent/Outdent lets you force the first 
line of a paragraph in or out from the left margin by 
the space specified on the Fixed Indent line. For ex­
ample, to select an indent of 0.1 inch, select First 
Line Indent, Relative Indent None, and then 
place the text cursor on the Fixed Indent line and 
type 00.10. Make sure the measurement units are set 
to inches. 
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If you specifY a temporary indent using the In From 
Left setting in the Spacing option, the Indent/Out­
dent is calculated from this temporary margin. 

~ Do not use fixed indent in conjunction with right 
aligned or centered text. 

Relative Indent: Length of Previous Line adds a 
first line indent to this paragraph exactly equal to the 
length of the last line in the previous paragraph. To 
use this feature, select Length of Previous Line. If 
a Fixed Indent amount is specified, this adds a fixed 
additional amount to the length of the previous line. 
When used in conjunction with Paragraph Breaks, 
this feature is useful to create lead-ins. (See the end 
ofthe Breaks option in the Paragraph menu.) 

Indent/Outdent Height lets you specify the num­
ber oflines for which the indent/outdent is to take ef­
fect. Normally, only the first line is indented or out­
dented, but you can indent any number of lines. 

To indent the entire paragraph, use In From Left 
spacing in the Spacing option instead. 
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Spacing 

"Bod~ Text" SPACIHfi 

Above: 01, DB picas & points 
Belo,,: ~O, DB 

I nter·line: 01,00 picas & points 
Inter· Paragraph: B1,BB 

Add in Above: [llilli] When Not at ColuMn Top 

Settings For: IIU.M I Right page I 

In Froll Left: B2,BB picas a points 
In Froll Right: B2', BB 

Inserts: I COPY To Facing Page I 

Figure 5-48 Spacing Dialog Box. Add in Above 
When Not at Column Top means above space is not 
added when paragraph is at top of column or page. 

Description 

I The Spacing option controls the space between lines 
and paragraphs, and sets temporary margins. 

Application 

Set temporary left and right margins (for 
quotes, bullets, etc.) 

• Create complementary left and right pages 
• Set inter-line spacing (leading) 

Operation-Vertical spacing 
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To change a tag's spacing: 

.. Select the Spacing option in the Paragraph menu . 

.. Enter the values for above, below, inter-line and 
inter-paragraph spacing. The option Add in 
Above: When Not at Column Top suppresses 
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Figure 5-49 Complementary left and right pages 

any above space when the paragraph begins a new 
column. 

Inter-line spacing sets the space between the base of 
the characters on one line and the base of the charac­
ters on the following line (Figure 5-50)-what typog­
raphers call "leading" (pronounced led-ing.) While 
inter-line spacing may be set to any value you desire, 
typesetting aesthetics usually allow a certain 

Inter-line spacing 

Inter-paragraph spacing 

{ 

~ow is the time 
"""""""---Tor all good men 
--to come to the 
--aid of their country 

{ 
--The quick brown fox 

jumped over the lazy 
dog. 

Figure 5-50 Paragraph vertical space 
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amount of spacing between lines, depending on the 
font size selected. A good rule of thumb is that inter­
line spacing should be roughly 1.2 times the font size. 
Thus, a tag with 10 point type should have 12 point 
inter-line spacing. Increase the inter-line spacing 
when using wide columns, or single column formats. 

Above and Below space adds additional space be­
tween paragraphs tagged with different tags. Inter­
paragraph adds space between paragraphs tagged 
with the same tag. Think of inter-paragraph as the 
space you want to place between similar paragraphs, 
and above or below as the minimum acceptable space 
between this paragraph and a paragraph with a dif­
ferent tag. 

Ifinter-paragraph space is even slightly different for 
each paragraph, then no inter-paragraph space is 
added. To judge whether two paragraphs contain 
precisely identical inter-paragraph spacing, change 
the measurement system for inter-line and inter­
paragraph to fractional points. This unit of measure­
ment provides the greatest precision. 

~ Suggestion: For most documents, set both Above 
and Below to the space between paragraphs and set 
Inter-paragraph to zero. 

The total space between paragraphs is controlled by 
inter-line, above, below, and ruling line space. 

The spacing between any two paragraphs equals (see 
Figure 5-51): 

• The greater of 

plus 

The first paragraph's below space and the 
overall ruling height below or around or 
The second paragraph's above space and the 
overall ruling height above or around 
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Spacing Between Paragraphs is The Greater Of 

I 

j j 
Second Paragraph Above 

plus 
Overall Ruling Line Above. J 

plusL 
Inter-paragraph* 

plusl' 
First Paragraph Inter-line 

plus ] 

First Paragraph Below 

~ Overall Ruling Line Below 
plus 

Inter-paragraph spacing only 
added if the inter-paragraph 
spacing for both paragraphs is 
exactly identical 

Inter-paragraph* 
plus 
First Paragraph Inter-line 

Figure 5-51 Space between paragraphs 

• The inter-paragraph 
paragraph space is 
paragraph tags 

plus 

space, if the inter- ~ 
identical for both 

• The first paragraph's inter-line space 

~ If you inadvertently set spacing in inches instead of 
fractional points, you may set spacing which is 
greater than the page length. When you press Page 
Down, the page counter begins counting and will 
never stop. To fix, press ESC to stop the formatting, 
and then press HOME. If the paragraph tag name is 
still shown in the Current Selection indicator, you 
can simply change the spacing settings. If the 
paragraph tag is not shown, then you must use the 
Remove option to delete the tag. 
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Multiple column spacing 

To assure that text in adjacent columns aligns, the 
total vertical space for every tag in a multi-column 
style sheet should always equal an integer multiple 
(e.g., 1, 2, 3, ... ) of Body Text's inter-line spacing. 

To assure that adjacent columns of Body Text always 
align when designing a multi-column style sheet, fol­
low these rules for each tag: 

~ Set inter-line spacing to an integral multiple of 
Body Text's inter-line spacing. 

~ Set inter-paragraph spacing to an integral multi­
ple of Body Text's inter-line spacing. 

~ Set above space plus overall ruling line height 
above to an integral multiple of Body Text's inter­
line spacing. 

~ Set below space plus overall ruling line height 
below to an integral multiple of Body Text's inter­
line spacing. 

The style sheets in Appendix L provide examples of 
how to set tag spacing. 

In From Left 
Margin is 
Measured 
From 
Column Edge 

Figure 5-52 In from left setting 
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Operation-Temporary margins 

5-116 

A temporary margin is set by In From Left and In 
From Right. In From Left and In From Right refer 
to the distance towards the center of the column from 
the column edges. (See Figure 5-52.) Ruling Lines 
which are set to Margin Width are affected by this 
setting. In From Left and In From Right can be set 
differently for Left and Right pages. To enter dif­
ferent settings for each page, first select Left Page 
and enter its In From Left/Right settings, then 
repeat for the Right Page. The In From LeftlRight 
settings can be copied to the opposite page at any 
time by selecting Copy To Facing Page. 

Note that the Settings For: Left PagelRight Page 
option only applies to In From Left and In From 
Right, not to the rest of the Spacing option. 
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Breaks 

MENU COMMANDS 

"Bod, Text" BREAKS 

Page Break: IlII []iliii] I After I I Before a After I 
I Before/Until Left I I Before/Until Right I 

ColulII1 Break: IlII I Before I I After I I Before a After I 
Line Break: []!J IIlII'mI Cillru I Before a After I 

Next Y Position: ... I Beside Last Line of Prevo Para I 
Alloll Within: _ []!J 

Keep Wi th Next: [!ru IlII 

Figure 5-53 Breaks Dialog Box. These are the ap­
propriate settings for most tags. 

Description 

REFERENCE GUIDE 

A Break is an interruption in the flow of text be­
tween paragraphs. Mter a break, the next paragraph 
can begin on a new line (line break), at the top of a 
new column (column break), at the top of a new page 
or frame (page break), or at the top of the next left or 
right page or frame (page break before/until 
left/right.) 

In addition, the break can occur either before, after, 
or both before and after the paragraph. For instance, 
selecting page break before and after causes any 
paragraph formatted with this tag to start at the top 
of a new page, and to be the only paragraph on that 
page. 

Allow Within controls whether or not line breaks 
are allowed within the paragraph. When Allow 
Within is set to No, the paragraph does not split be­
tween two pages. 
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Keep With Next forces the selected paragraph to al­
ways appear on the same page as the next para­
graph. This feature is very- useful for headings. 

Application 

• Vertical tabs 
• Outdented heading 
• Paragraph lead-ins 
• Page breaks 

Operation 

To change paragraph breaks, select the Breaks op­
tion in the Paragraph menu (see Figure 5-53.) Select 
the appropriate options and then select OK. 

Each break further down the. Dialog Box is overrid­
den by the break shown immediately above (e.g., if 
both Page Break Before and Column Break 
Before are selected, only Page Break Before takes 
effect.) 

If no break of any type is set between two para­
graphs, the second paragraph begins on the first 
line of the previous paragraph if Next Y Position is 
set to Normal. You should increase the second 
paragraph tag's In From Left spacing to keep the two 
paragraphs from overlapping. 

If no break of any type is set between two para­
graphs, the second paragraph begins on the same 
line as the last line of the previous paragraph if 
Next Y Position: Beside Last Line of Previous 
Paragraph is selected. 
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This is a 
separate 
paragraph 
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Example 

The following "paragraph" is actually two different 
paragraphs. The first paragraph-The style sheet 
examples-is formatted with Line Break Before. 
The second paragraph (the remainder of the text) is 
formatted with line break after and indent relative to 
previous line. 

L.:-----'--"--'-"--'--'---=c...:..,:.-=-....:..:....--="'_le-"--sceJin Appendix L show how 
tag options can be combined together. 

Most paragraphs in the style sheets supplied use line 
break before. However, if you change Body Text to 
Line Break After in order to place lead-ins or sec­
tion numbers on the same line, as in the example 
paragraph above, You may find that text sometimes 
overlaps the previous paragraph during text editing. 
To fix this problem, change the other tags in the style 
sheet to line break after. 

The chapters in the TYPESET directory and the ap­
plications shown in Appendix M provide examples of 
how to combine Breaks with other paragraph at­
tributes to create effects such as vertical tabs, out­
dented headings, paragraph lead-ins, and page 
breaks. 
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Tab settings 

"UAPTION" TAB SETTINGS 

Tab NUJllber: • m rn m m m rn rn 
If tab stop is turned 
off, no tab will show mooDIlm:JmJD!lmJOO 

Tab T9pe: []ill I!mI ~ I Right I I DeciJllal1 

Shown as Leader Char 

Tab location is 
measured from left 
edge of the column 

I Shown as Open Space I 
OJ.D~ inches 

Leader Char: Uillill • D []!§£!J 046 (ASCill 

Leader Spacing: []] OJ II rn rn IT] rn rn rn 
[][] I Cancel I 

5-120 

Figure 5-54 Tab Settings Dialog Box. First tab stop 
set to 3 inches from left margin, with dot leader 
turned on, left aligned. Two spaces will be placed be­
tween each leader dot. 

Description 

Horizontal Tabs are used to align text or numbers. 

Whenever a horizontal tab character is encountered 
in the text, Xerox Ventura Publisher positions the 
next character at the next tab location. Up to sixteen 
tabs are allowed per paragraph. Text can be aligned 
so that the right, center, left, or decimal (in the case 
of numbers) part of the text or numbers aligns with 
the tab position. 

The space created by the tab can be filled with any 
character. These fill characters are called Leaders 
(pronounced leed-ers.) 
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Application 

• Tables 
• Directory listings 
• Equations 

When using proportionally spaced fonts, you cannot 
fonnat tables reliably using spaces between entries. 
Therefore, you must use tabs to make columns align 
correctly. 

Operation 

To set tabs: 

.. Select the Tab Settings option in the Paragraph 
menu (Figure 5-54.) 

.. Choose the Tab Number you want to set . 

.. Choose whether the text is to be Left, Center, 
Right, or Decimal aligned . 

.. Select Shown as Leader Char for Tab Display 
if you want to place leader characters for this tab 
stop. Select Shown as Open Space if you don't 
want leader characters for this tab stop . 

.. Enter the tab location. The tab location is 
measured from the left edge of the current column . 

.. Repeat this process for each tab you wish to set. 
You can review and edit any Tab Number's Tab 
Location at any time by selecting the Tab Number. 

~ Remember to select Left, Center, Right, or Decimal. 
One of these options must be chosen, or the tab stop 
will not be enabled. 

If Shown as Leader Character is chosen for any 
tab stop 

.. Select the leader character (spaces, periods, un­
derlines, or some other character) for this tag . 

.. If you choose Other, consult the character set 
table in Appendix E, choose the decimal number 
which corresponds to the character you want to 
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put in the tab space, place the text cursor on the 
Leader Char line, and type this number. 

~ Enter the space between leader characters al­
lowed for this tag. 

~ Justification (set in Alignment) overrides tab set­
tings. Therefore, tabs do not work if justify is set on. 

~ Do not set tabs to create a first line indent. Use the 
indent feature in the Alignment option instead. 

Tabs are designed to be used on a single line. This 
line should be terminated with a paragraph end 
(Enter) or line break (Ctrl plus Enter.) Also, when 
tabs are set, automatic wordwrap will not work. 
Therefore, text on any line which contains a tab may 
extend beyond the right margin. Use a line break 
(Ctrl plus Enter) to force this text down to the next 
line. 

Equations 

Tabs can also be used to format equations. Set a 
Center Tab stop at the position on the page where you 
want to center the equation. Then, type a tab charac­
ter and then the equation. The equation automatical­
ly centers itself at the location defined by the tab 
stop. 

Superscript ......... 
X2 +y2 +Z2 ... -- Overscore 
5X+ 2Y +3Z 

t 
Centered around 
centered tab 
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Special effects 

"Bod~ Text" SPECIAL EFFECTS 

Special Effect: I:ilmJ Ild.EO I Bullet I 
COllllllands: I Set Font Properties I 

Space for Big First: I NOrillal I III!l!ID 0021 lines 

Show Bullet As: ~ 0 0 IT] D D D 0 
[}] [§J D IT] [}] I Other I 

Bullet Char: 000 (ASCI! ) 

Il1del1t After Bullet: 00.00 il1ches 

Figure 5-55 Special Effects Dialog Box. Settings 
are for big first character at beginning of paragraph. 

Description 

Special Effects allows you to add a Big First 
Character (also called a Dropped Capital) or Bullet 
at the beginning of a paragraph. The font for the bul­
let or big character can be selected independently 
from the rest of the paragraph. 

Application 

• Dropped capitals at beginning of paragraph 
Real typographic bullets for lists (e.g., • in­
stead of*) 

Operation-Big first character 

REFERENCE GUIDE 

To create a Big First Character: 

~ Select Special Effects in the Paragraph menu. 
(See Figure 5-55.) 

~ Choose Special Effect: Big First Char 
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~ Select Set Font Properties. The font selections 
available depend on the printer installed. 

~ Select Face, Size, Style, Color and character 
shift up or down. Zero shift usually works best. 

~ Select OK to return to the first Dialog Box, and 
then select OK again. 

Space for Big First Char specifies how many lines 
of text the first character will occupy. Normal 
creates the number of line automatically. Custom 
lets you specifY the number oflines. 

Operation-Bullet 

To add a Bullet: 

~ Select Special Effects in the Paragraph menu. 
~ Choose Special Effect: Bullet. 
~ Select Set Font Properties to make the bullet a 

different font from the rest of the paragraph. The 
Font Settings For Bullet Dialog Box appears. 
The actual font selections available depend on the 
printer installed. Choose the Face and Size and 
vertical shift. Zero shift works for most situations. 

~ Select OK to return to the first Dialog Box. 
~ Select, from the Show Bullet As: line, the bullet 

you want to use. To use some other bullet charac­
ter, select Other,. place the text cursor on the Bul­
let Char line, and type the number from the table 
in Appendix E for the desired bullet character. 

~ Select the Indent After Bullet. This indent 
specifies the space between the bullet and the text 
following the bullet. 

~ Failure to specifY indent after the bullet results in 
the first line in the paragraph overlapping the bullet. 

Select None to remove an existing special effect from 
a given paragraph tag. 

Note: Text attributes cannot be applied to bullets and 
Big First Characters. 

REFERENCE GUIDE 



Typographic controls MENU COMMANDS 

Typographic controls 

'Bod~ TeKt" TYPOtiRAPHIC CONTROLS 

Auto~atic Kerning: []IT] .. 

Letter Spacing: [][] _ Up to: 0.100 Ens 

Tracking: 0.050 Ens I Looser I .. 

Ilininun Space Width: 0.= * (space width) = 0.150 E~s 
Nornal Space Width: 1.00 * (space width) = 0.250 Ens 

MaKinun Space Width: 2. * (space width) = 0.500 Ens 

Overscore Height: 00.66 Shift t By: 11.94 fractional pts 
Strike· Thru Height: 00.66 03.72 
Underline 1 Height: 00.66 Shift • B~: 00.66 
Underline 2 Height: 00.66 02.84 

DO I Cancel I 

Figure 5-56 Typographic Controls Dialog Box 

Description 

The Typographic Controls option lets you control 
important typographic attributes for each tag, in­
cluding kerning, letterspacing, spacing between 
words, and text attributes such as underlining. 

Application 

REFERENCE GUIDE 

• Automatic Kerning-Makes headlines more 
attractive by placing individual letters closer 
together. It can also reduce the page count of 
long documents which contain large blocks of 
body text. 

• Letter Spacing-Reduces visual impact of 
loose lines (lines with too much space between 
words) by adding space between letters. 

• Tracking-Used to expand or contract head­
lines to fit a given space. If applied to Body 
Text, the entire document can be expanded or 
reduced in size with only a subtle change in 
overall appearance. 
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• Customize text attributes. (Overscore, 
Strike-thru, Underline 1, Underline 2 height.) 

Operation-Automatic Kerning 

Kerning can be turned on or off for any given 
paragraph tag. To turn kerning on (off), select On 
(Off) on the Kern: On/Off line. To see the effect of 
kerning on the computer screen, On-Screen Kern­
ing must be turned on in the Set Preferences option 
in the Options menu. 

Kerning reduces the text formatting speed slightly. 

The font width table for the printer must include 
kerning information for this feature to work. The 
PostScript fonts supplied include kerning informa­
tion. Fonts for the other printers do not. To add kern­
ing information to fonts, or adjust the kerning values 
for existing fonts, consult Appendix K. 

Automatic kerning can be overridden for all tags by 
selecting Globally Off in the Page Layout option. 

Operation-Letter Spacing 

As each paragraph is justified, Xerox Ventura 
Publisher tries to fit words on a line, until the space 
between words falls below the Minimum Space 
Width. The word which could not fit on the line 
without violating the Minimum Space Width then 
starts the next line. If this word is long compared to 
the length of the line (very likely in a multi-column 
document), the space between words on this line may 
exceed the Maximum Space Width. This results in a 
loose line. 

If Letter Spacing is turned on, additional space is I 

added between letters until the space between words 
is less than the Maximum Space Width. 
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To use Letter Spacing: 

~ Turn justification on in the Alignment option 
~ Turn Letter Spacing on 
~ Set the Minimum Space Width to less than the 

Normal Space Width. A typical number is 0.600 
(i.e., 60% of normal space width.) Values above 
1.000 have no effect. 

~ Set the Normal Space Width to 1.000. 
~ Set the Maximum Space Width to the largest 

space between words allowable during justifica­
tion. 2.000 (i.e., twice the Normal Space Width) is 
a typical number. 

~ Set the Up To amount to the maximum space al­
lowed between letters during letterspacing. 

The resulting space width is calculated and shown in 
EMs, a typographic measurement equal to the width 
of an M character in the current font size. 

Example: 

t 
Normal space width 
(line is not justified) 

Maximum 
Space Width 

1 
This is a loose line and therefore the line 

Normal Space Width 

The Normal Space Width setting lets you control 
the amount of space between words. This lets you in­
crease or decrease the size of any given paragraph by 
subtly changing the space between each and every 
word in that paragraph. For instance, choosing a 
value of two doubles the space between every word. 
As suggested above, 1.000 is the normal setting for 
most documents. 
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Operation-Tracking 

To increase or decrease the space between letters 

~ Select Looser to increase, Tighter to decrease 
~ Enter, on the Tracking line, the amount to add or 

subtract between individual letters. 

Operation-Custom attributes 

The line attributes (i.e., underline, double underline, 
overs core, strikethrough) available in the Text Edit­
ing mode can be customized for any given paragraph 
tag. For each attribute you can specify both the 
height of the line and the amount this line should be 
vertically shifted. 

You should increase the height of the line attributes 
whenever you change a tag's font size. For instance, 
if you increase the font from 12 to 24 point, you 
should double the height of each attribute. The i 

height and shift for Underline 1 controls both the 
underline and the first line in the double underline. 
Underline 2 controls height and shift for the second 
line in the double underline. 
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Ruling lines 

MENU COMMANDS 

RULING LINES ABOIJE 

Width: I Hone I []!ill IJi!ii!iiJ III!I!II I FraAe I I (ustOA I 

(olor: I White IIlImICRillIGreen II Blue ICillnJI Yellow I~ 

Pattern: [II rn rn rn [IJ [I] rn ImD I Dashes Off I 

Space Abo~e Rule 1: 09.00 i Dash Width: 00,00 
Height of Rule 1: 04,02 Dash Spacing: 00,00 

Space Below Rule 1: 03. 9 (UStOA Indent: 00, 00 CD G 
Height of Rule 2: 01,5 CUStoA Width: 00,00 

Space Below Rule 2: BB, 
Height of Rule 3: OB.OB 36,00 fractional pts 

Space Below Rule 3: 09.00 a G 
O~erall Height: OB,52 

Figure 5-57 Ruling Lines Dialog Box, Two rules 
will be created. Both rules will be the width of the 
column. 

Description 

All three Ruling Lines Menus function in an iden­
tical manner and provide the capability to place 
ruling lines above, below, and around a paragraph, 

Up to three ruling lines, each of different thickness, 
with different spacing between each rule, can be 
placed above, below, or around the paragraph. Tex­
ture and color can be assigned to each set of ruling 
lines, and ruling lines can be dashed. 

Application 
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• Isolate text from surrounding copy. 
• Provide lines between entries in a table. 
• Place text within a ruling line to create the ef­

fect shown in Figure 5-58. 
• Create change bars 
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Operation 

To place ruling lines above, below or around a 
paragraph: 

~ Select the appropriate ruling line option in the 
Paragraph menu. 

~ Select the ruling line width. The ruling line can be 
made the width of the text, current margin, 
column, or frame or you can define a custom width. 
If Margin is selected, the ruling line width is 
decreased by the paragraph's In From Left and In 
From Right spacing set in the Paragraph Spacing 
option. If Custom is selected you can specify how 
far from the left margin the ruling line should 
begin by entering the appropriate number on the 
Custom Indent line. Specify the width of the 
ruling line by entering the desired width on the 
Custom Width line. 

~ Select the ruling line color and pattern. The same 
color and pattern is assigned to all three rules. 

~ Enter the height of each ruling line and the space i 

above and below each ruling line. This is done by 
placing the text cursor next to the Space 
AbovelBelow and Height of Rule lines and typing 
the desired heights. The ruling line and line spac­
ing is immediately shown to aid determining the 
proper line thicknesses and spacing. Keep chang­
ing the height and spacing until you are satisfied. 

Finally, if you wish to make dashed rules, select 
Dashes On, and then select the length of the dash 
and the space between each dash. (Dashes can be 
turned off by selecting Dashes Off.) Note: Xerox 
Ventura Publisher cannot display or print thick 
dashed rules. If dashes do not display on the screen, 
reduce the ruling line thickness. 

~ Ruling boxes around paragraphs are intended for 
headlines and other short paragraphs. Placing a 
ruling box around a long paragraph which continues 
into the next column or page causes the first part of 
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the paragraph to be enclosed in a box. The second 
part of the paragraph is placed in the next column or 
page without any ruling box. 

Overall Height: provides continuous feedback on 
the total space occupied by all ruling lines. When the 
measurement units are set to Fractional Points, in­
dividual settings are rounded up or down slightly as 
you type. This is normal and is due to the way num­
bers are stored within Xerox Ventura Publisher. 

Advanced operation-White text on black rule 

The Space Below Rule 3 setting lets you shift the 
entire set of ruling lines up or down by the amount 
you specify, without moving the text in the tagged 
paragraph. This lets you, among other things, put 
white text on top of a black ruling line. To achieve this 
effect: 

.. Create a new tag called, for example, White Text . 

.. Set the Font Color for this tag to White . 

.. Select Ruling Line Above and create a height for 
Rule 1 that is higher than the tag's font size. 

Chapter 1 

The Adventure Begins 

This trip really began in September last year when Gerr 
won first prize in a raffle at the fashion show which Rush 

Presbyterian-St. Luke's Medical Center holds every year. The 
prize was two round trip tickets to Hong Kong on United Air­
lines, and ten nights in the Hong Kong Hyatt Hotel. Analyz­
ing our good fortune, we concluded that we wanted to do 
more than spend ten days in Hong Kong and return, but a 
the same time, United, having just gotten its routes and equip­
ment from Pan American, had not yet received authority to 

Figure 5-58 White text within black ruling line 
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~ Select the - on the Space Below Rule 3 line and 
enter the distance required to move the ruling line 
down over the text. This distance is approximate­
ly one halfthe sum of the ruling line overall height 
plus the Font Size. 

For example, if you want to place 24 point white type 
within a 36 point ruling line, enter approximately 
0.5*(24 + 36) = 30 points for the Space Below Rule 3. 

Some printers cannot print white text on a black 
background. Print the CAPABILI chapter, located in 
the TYPESET directory, to see if your printer is 
capable of this effect. 

Advanced operation-Change bars 

5-132 

A change bar is used to alert the reader that the con­
tents of a paragraph have changed. A change bar can 
be created as follows: 

~ Add a new tag called Change Bar and copy the at- i 

tributes from Body Text 
~ Assign this tag name to a special function key 

using the Assign Function Keys option 
~ Select a paragraph and tag it with this new tag 
~ Select Paragraph ruling line around 
~ Enter a Custom Width of 1 point 
~ Enter a Height of Rule 1 of less than 2 points 
~ Add a small (e.g., 1 pica) negative Custom In­

dent. 

To use this feature, create a new tag which has the 
same attributes as Body Text, but with this change 
bar added. Then assign this new tag to a special func­
tion key. Whenever a change is made, simply press 
the special function key while making the change. 

Because change bars are created with a ruling box 
around, and because ruling boxes do not continue 
across column or page boundaries, change bars will 
not continue to the top of the next column or page. 

REFERENCE GUIDE 



Remove tag MENU COMMANDS 

Remove tag 

REMOVE TAG 

Tag NaAe to ReAove: Chapter ~L--­

Tag NaAe to Convert to: Body Text ____ 

OK I Cancel I 

Figure 5-59 Remove Tag Dialog Box 

Description 

I Remove Tag lets you remove extra tags from the 
sty Ie sheet. 

Application 

• Remove tags no longer used 
• Make tags easier to find in the Assignment 

List 

Operation 
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Select the Remove Tag option in the Paragraph menu 
and specify the tag to be removed. (See Figure 5-59.) 
The tag from the currently selected paragraph, if any, 
is automatically placed on this line. 

All paragraphs previously tagged with the removed 
tag are converted to Body Text unless another tag 
name is specified. Enter this new tag on the Tag 
Name to Convert To: line. For example, if you 
remove a tag called Headline and replace it with a 
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tag called Sub Head, each paragraph in the entire 
chapter previously tagged with Headline is tagged 
with Sub Head. 

Remove Tag removes the selected tag from 
paragraphs in all text files in the currently opened 
chapter. However, all other text files previously for­
matted with this style sheet may still contain 
paragraphs tagged with the removed tag name. 
When chapters containing these text files are next 
loaded and combined with the revised style sheet, all 
paragraphs previously tagged with the removed 
name are formatted as Body Text, and the removed 
tag name appears in the Assignment List, in upper 
case. 

~ If any tags are removed, save the style sheet under a 
new name. This avoids changing the format of other 
documents that use the same style sheet. 
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Rename tag 

RENAME TAG 

Old Tag NaMe: Major Heading 

New Tag NaMe: Heading 1L---

OK I Cancel I 

Figure 5-60 Rename Tag Dialog Box 

Description 

I Rename Tag lets you change the names of existing 
tags. 

Application 

• Make similar tags appear together in the As­
signment List. 

Operation 

~ Select the Rename Tag option in the Paragraph 
menu. 

~ Enter the Old Tag Name and the New Tag 
Name. If a paragraph is selected, its tag is 
automatically entered on the Old Tag Name line. 

~ If any tags are renamed, save the style sheet under a 
new name. This avoids changing the format of other 
documents that use the same style sheet. 
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ASSIGN FUNCTION KEYS 

F1: FirstPa~ 
FJ: Minor heading 
F5: Chapter Title 
F7: Caption __ 
F9: Header __ 

F2: Major heading 
F4: Bullet __ 
F6: Chapter~_ 
Fa: Foote,r __ 

F10: Bod~ Text_ 

OK I Cancel I 

Figure 5-61 Assign Function Keys Dialog Box 

Description 

I The Assign Function Keys option lets you assign 
tag names to each of the ten keyboard function keys. 

Application 

This feature lets you simultaneously tag paragraphs 
and edit text, without switching back and forth be­
tween the Paragraph Tagging and Text Editing func­
tions. It greatly decreases the time required to for­
mat and edit a document. 

Operation 

Select the Assign Function Keys option or press and 
hold the Ctrl key and then press K. As shown in 
Figure 5-61, the name of each tag is typed next to the 
name of the function key. Use the mouse, or the up 
and down keyboard cursor keys to move from line to 
line. Select OK when finished. 
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If a tag name is entered which doesn't exist for this 
style sheet, a message appears on the screen. Return 
to the Assign Function Keys option. Blank lines ap­
pear where the incorrect tag name(s) was typed. If 
the same tag name is entered twice, only the first 
name entered is used. 

Once tags are assigned to function keys, pressing the 
appropriate function key while using either the 
Paragraph Tagging or Text Editing function causes 
that tag to be assigned to the selected paragraph or 
the paragraph which contains the text cursor. 

All style sheets included with Xerox Ventura 
Publisher use FlO for Body Text. This of course can 
be changed using the Assign Function Keys option. 
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GRAPHIC MENU 
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.~.Ir. !II"" 
Send to Back AZ 
Bring to Front AA 

Line Attributes ... AL 
Fill Attributes ... AF 

Select All AQ 
Grid Settings ... 

Figure 5-62 Graphic Menu 

The Graphic Menu lets you perform three major 
functions on selected graphics: 

• Move them in front or behind one another 
• Change line and fill (shading) attributes 
• Create a grid to which all graphics will snap 
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Send to back 

Description 

Send to Back takes the selected graphic and places 
it at the bottom of all graphics associated with the 
currently selected frame. 

Application 

• Change the way graphics overlap each other 

Operation 

Select the graphic you wish to place behind all other 
graphics. Then either select the Send to Back option 
in the Graphic menu, or press and hold the Ctrl key 
and then press Z. 

Figure 5-63 Line sent to back of rectangle 
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Description 

Bring to Front takes the selected graphic and 
places it on top of all graphics associated with the 
currently selected frame. 

Application 

• Change the way graphics overlap each other 

Operation 

Select the graphic you wish to place on to of other 
graphics. Then either select the Bring to Front option 
in the Graphic menu, or press and hold the Ctrl key 
and then press A. 

Figure 5-64 Line brought to front of rectangle 
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LINE ATTRIBUTES For LINE 

Thickness: []!iii] [ffi!] II rn m , Thick' 

, CustOI1l Width I 01.261 Fractional pts 

Color: 'White' .. []ill ffilliJ 
, Blue' IJillJ , Yellow' , Magenta' 

End St~les: J _ _ 

.. J+ - -DeFaults: 'load Frol1l ... , 'Save To ..• , 

[]D 'Cancel' 

Figure 5-65 Line Attributes Dialog Box 

Description 

I Line Attributes let you change the thickness, color, 
and end style of the line placed around each graphic. 

Application 

• Change the thickness of graphic lines used as 
extra rules. 

• Create one or two way arrows for callouts. 

Operation 
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~ Select the graphic. 
~ Select the Line Attributes option in the Graphic 

menu. A Dialog Box similar to Figure 5-65 ap­
pears. (Each of the five graphic types has its own 
dialog box.) 

~ Choose either a preset thickness for the line, or 
select Custom Width to produce a line of any 
thickness. If Custom Width is selected, place the 
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text cursor on the Custom Width line and enter the 
desired width . 

.. Select the Color and End Styles for the line. The 
beginning and ending of each line can have a dif­
ferent end style. The End Styles in the left column 
are for the beginning of the line, and the End 
Styles in the right column are for the end of the 
line. 

You can save the line attributes for a particular type 
of graphic (box text, line, ellipse, rectangle, rounded 
rectangle) by using the Defaults: Save To feature. 
If Save To is selected, the next time the same type of 
graphic is created, it will have identical attributes. 

If you want to apply the saved defaults to an existing 
graphic of the same type: 

.. Select the desired graphic 

.. Select the Line Attributes option 

.. Select Defaults: Load From. When OK is 
selected, the saved defaults are automatically ap­
plied to the existing graphic. 

To copy attributes from another graphic in a chapter: 

.. Select that graphic. (You may need to select a dif­
ferent frame first.) 

.. Choose the Line Attributes option and select 
Defaults: Save To. This makes this particular 
graphic's attributes the defaults for its graphic 
type . 

.. Select the graphic whose attributes you want to 
change. Choose the Line Attributes option and 
select Defaults: Load From. The attributes just 
saved are copied to the selected graphic. 
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Fill attributes 

FILL ATTRIBUTES for R. RECTANGlE 

Color: I White I DEllI [!ill ~ 
I Blue I !Jill] I Yellow I I Magenta I 

Pattern: I Hollow I []] m rn 
D m m rn I Solid I 

Result: IlII!II 
I Transparent I 

Defaults: I load Frolll ... I I Save To ... I 
[][] I Cancel I 

Figure 5-66 Fill Attributes Dialog Box 

Description 

I Fill Attributes let you change the color and back­
ground of each graphic. 

Application 

• Provide a background for cells in a form or 
table. 

Operation 
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>- Select the desired graphic. 
>- Select the Fill Attributes option in the Graphic 

menu. A Dialog Box similar to Figure 5-66 ap­
pears. (Each of the five graphic types has its own 
dialog box.) 

>- Select the color and pattern desired. 

You can save the Fill Attributes for a particular type 
of graphic (box text, line, ellipse, rectangle, rounded 
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rectangle) by using the Defaults: Save To feature. 
If Save To is selected, then the next time the same 
type of graphic is created, it will have the saved at­
tributes. 

If you want to apply the saved defaults to an existing 
graphic ofthe same type, select the desired graphic, 
choose the Fill Attributes option, and then select 
Defaults: Load From. When OK is selected, the 
defaults are automatically applied to the existing 
graphic. 

To copy attributes from another graphic in a chapter: 

~ Select that graphic. (You may need to first select a 
different frame.) 

~ Choose the Fill Attributes option and select 
Defaults: Save To. This makes this particular 
graphic's attributes the defaults for its graphic 
type. 

~ Select the graphic whose attributes you want to 
change. 

~ Select the Fill Attributes option and select 
Defaults: Load From. The attributes just saved 
are copied to the selected graphic. 

The Opaque and Transparent options let you change 
the look of overlapping graphics. If Opaque is 
selected for the graphic on top, it completely blocks 
any graphics below it. If Transparent is selected for 
the graphic on top, and if the fill pattern is anything 
other than black, then the graphics below will show 
through the graphic on top. 

Not all printers can print transparent graphics. Print 
the CAPABILI chapter (located in the TYPESET 
directory) to determine the capabilities of your 
printer. 

REFERENCE GUIDE 



Select all MENU COMMANDS 

Select all 

Description 

Select All selects every graphic associated with the 
currently selected frame. 

Application 

• Move every graphic associated with a frame to 
a new location relative to the frame. 

• Change the attributes for all graphics tied to a 
frame. 

Operation 

~ Enable the Frame Setting function and select the 
frame whose graphics you wish to select. 

~ Enable the Graphic Drawing function 
~ Choose the Select All option in the Graphic menu, 

or hold the Ctrl key and press Q. All graphics as­
sociated with the selected frame are now selected. 

You can de-select individual graphics, without de­
selecting the remainder, by pressing and holding the 
Shift key, pointing to the desired graphic, and then 
pressing the mouse button once. 

~ Normally you must be using the Graphic Drawing 
function to be able to select all graphics associated 
with a frame. However, the CtrlQ keyboard shortcut 
lets you select all graphics while using the Frame 
Setting function. This is useful to see which graphics 
are associated with a selected frame before selecting 
the Graphic Drawing function. 
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GRID SETTINGS 

Grid Snap: Ell []ffJ 

Horizontal Spacing: B1,B~ picas & points 

Uertical Spacing: B1,BB 

OK I (ancell 

Figure 5-67 Grid Settings Dialog Box 

Description 

Grid Settings defines an invisible piece of graph 
paper for the currently selected frame. All graphics 
are then fastened to the grid points on this graph 
paper when drawn or moved. 

Application 

• Provide alignment for forms and tables, where 
adjacent boxes must line up exactly . 

• Assure perfect vertical or horizontal align­
ment. 

Operation 

~ Enable the Graphic Drawing function. 
~ Select the Grid Settings option in the Graphic 

menu. 
~ Select Grid Snap: On. 
~ Set the horizontal and vertical spacing. 
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OPTIONS MENU 

Set Preferences ... 
Set Ruler ... 
Set Printer Info .. . 
Rdd/Renove Fonts .. . 

Hide Side-Bar AW 
Show Rulers 
Show Colunn Guides 
Hide Pictures 
Hide Tabs & Returns AT 
Show Loose Lines 

Turn Colunn Snap Off 
Turn Line Snap Off 

Multi-Cha ter ... 

Figure 5-68 Options Menu 

The Options Menu performs three major functions: 

• Set screen and printer format options 
• Add or remove fonts 
• Perform multi-chapter operations 

~ Use the Multi-Chapter Copy option to copy chapters. 
DO NOT use the DOS Copy command to copy chap­
ters. 
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SET PREFERENCES 

Generated Tags: IIlI!imlI I Shown I 

Text to Greek: I None I [IJ rn D rn [][] []ill 

Keep Backup Files: []!i] IIll'I 
Double Click Speed: I Slow I [IJ D rn ClliIJ 

Decillal Tab Char: 9461 (ASCII) 

On' Screen Kerning: I None I rn:J [llJ IIiI [HJ DID []ill 

Auto·Adjust St~les: III []!] 

Figure 5-69 Set Preferences Dialog Box 

Description 

Set Preferences lets you: 

• Show or hide tags in the Assignment List for 
generated text (e.g., captions). 

• Control the size below which text is "greeked." 
(The word greek is described on the next 
page.) 

• Create or not create backup files 
• Change the speed at which two mouse clicks in 

a row will be recognized as OK 
• Change the tab-align character for decimal 

numbers. (The US uses the period, Europe 
uses the comma) 

• Turn screen kerning on/off 
Adjust or not adjust the inter-line spacing 
when fonts sizes are changed. 
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Application 

Hide Generated Tags (e.g., captions, section head­
ings) is used to reduce the number of tags shown in 
the Assignment List. Since generated text tags are 
automatically assigned to headers, footers, section 
numbers, etc., you don't need to see them in the As­
signment List. 

When using tabs, one of the tab types is Decimal. 
You can change the decimal tab character from a 
period (American convention) to a comma (European 
convention.) This feature also lets you set the 
decimal tab character to a slash (I), an equal sign (=) 
or other characters. 

Operation-General 

Select the Set Preference option in the Options menu. 
The Dialog Box shown in Figure 5-69 appears. Select 
the option desired. 

Operation-Greeking 

The word greeking describes the practice in the 
graphics art industry of quickly drawing horizontal 
lines on a page to approximate how a real page of text 
will look. Greeking is used in Xerox Ventura 
Publisher to speed up the time it takes to draw the 
screen when displaying either a Reduced or Facing 
Pages View. Select larger numbers to display only the 
largest text as readable text. Select smaller numbers 
to display much smaller text as readable text. The 
numbers refer to the screen pixel height of the font. 

~ Depending on the resolution of your display, text 
below a certain size may not be readable in Full Page 
or Facing Pages View when greeking is completely 
turned off. This is normal. 
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Operation-Backup files 

Select YES to create style sheet, chapter, and text 
backup files each time a chapter is saved. Backup 
files have the same name as the original, with the 
first letter of the extension changed to $. 

Operation-Double click speed 

When making selections in the Item Selector, you can 
press the mouse button twice quickly, while pointing 
to the file name, in order to select the file and select 
OK. You can change the double-click speed necessary 
to activate the selection process. Note that Xerox 
Ventura Publisher delays all selection operations by 
the time required for two mouse clicks. Therefore, al­
ways pick the fastest speed you can handle. If you do 
not use the double-click shortcut, set double-click 
speed to Fast. 

Operation-Decimal tab character 

One of the choices in the Tab Setting option in the 
Paragraph menu is decimal tab. When selected, the 
text aligns at the tab stop on the first decimal point 
in the text. Xerox Ventura Publisher initially as­
sumes that the period character is used as the 
decimal point. However, some European countries 
use the comma instead. Consult Appendix E and 
enter the numeric value on the Decimal Tab 
Character line for the character you wish to use as 
a decimal point. (The comma is decimal 44.) 

Operation-On-screen kerning 

When Kerning is selected in the Typographic Con­
trols option, the change in the space between letters 
can be shown on the screen as well as on the printer. 
However, the additional calculations necessary to ad­
just the space between each character take addition­
al time and therefore slow down the screen drawing 
speed. Also, because of the relatively limited resolu-
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tion of the computer screen, the subtle differences 
provided by kerning may not be noticeable at small 
(less than 14 point) font sizes. Therefore, to provide 
optimum performance, you can choose whether to 
show kerning on the computer screen. If you do show 
kerning, you can choose to show only fonts above a 
certain size. 

To show kerning on-screen, select the minimum font 
size you wish to kern. All characters equal to or above 
the font size chosen will be kerned. 18 or 24 point are 
typical font sizes to choose. 

If kerning is turned on in the Typographic Controls 
option, and ifthe printer fonts provide kerning infor­
mation (see Appendix K), the printed output will al­
ways be kerned, regardless of whether on-screen 
kerning is enabled or not. 

Operation-Auto adjust styles 
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Whenever you change a tag's font size, the inter-line 
spacing for that font is automatically increased or 
decreased. Thus, if the font was originally 12 point 
with 14 point inter-line spacing and you increase the 
font size to 24 point, the inter-line spacing is 
automatically increased to 28 point. If you don't want 
the inter-line spacing automatically adjusted, select 
Auto Adjust Styles No. This is especially useful for 
tables, where the space between lines should remain 
constant. 
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SET RULER 

Horizontal Units: I Inches I I Centineters I Dl!II 
Vertical Units: IIIII!D I Centineters I I Picas I 

Horizontal Zero Point: 06, O~ picas & points 
Vertical Zero Point: 06, O~ 

Figure 5-70 Set Ruler Dialog Box 

Description 

Set ruler lets you set different ruler measurement 
units for the vertical and horizontal rulers shown on 
the edge of the screen. 

Application 

Measure the page horizontally in picas and 
vertically in inches. 

• Move the ruler to measure from column edge 
rather than page edge 

Operation 

~ Select the desired measurement unit for both the 
horizontal and vertical ruler. 

~ Set the horizontal and vertical zero points. 

The default for horizontal and vertical zero point is 
zero. This lets you easily measure from the page 
edge. However, since tabs are measured from the 
column edge, you may find it useful to set the 
horizontal zero point equal to the left margin. The 
numbers on the horizontal ruler will then show the 
distance from the left column edge. 
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The rulers can also be set interactively, as shown 
below. 

To move the rulers 
with the mouse, or to 
pull the ruler cross­
hairs onto the screen, 
point to the 0,0 box, L 

press and hold the 
mouse button, and 
then ... 

drag the cross-hairs 
onto the screen. Use 
these cross hairs to 
check for vertical and 

a,a 

horizontal alignment. L 

, .13 , 

,.e, 

In facing pages view, .... : ......................................... + ................................. . 
you can check for align-
ment across pages. 
When you release the 2_ 

mouse button ... 
a,a 

the zero points move -
to the mouse location. L 

Move the mouse to the 

,/, 

top ruler before releas- - Rule~ zero point set :0 
ing the mouse button to ty locatIOn ?f mouse pnor 

. /. to releasmg the mouse 
reset only the vertlcal .P.. button. 
ruler. Select 0,0 to reset ~ 
the ruler zero point to 
the upper left corner. 
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Load new screen fonts 
by typing the 

extension of the 
screen font files on 

this line (e.g., PSF for 
PostScript fonts) 

When the width table 
contains fonts for the 

selected device (in 
this case PostScript), 
this line displays the 

word Ultimate. 

Printer info 

SET PRJ NT ER INFO 

I EPSOM IIK/FX I lal~u.'Ma' 

EGAI (Use those ~atchin9 this file extension.) 

Output To: I LPT1 II LPT2 II LPTl I mill I (OM2 I I Direct I I Filenm I 
Width Table: (:\UENTURA\POSTS(PT.WID. ________ _ 

(oAlland: I Load Different Width Table (Le., Font Metrics) I 
Quali t~: UltiAate 

Figure 5-71 Set Printer Info Dialog Box. 

Description 

5-154 

The Printer Info option lets you change printers, 
printer connections, printer and screen fonts. It also 
lets you direct the printed output to a file. 

Application 

• Switch between several output devices con­
nected to different computer ports. This can be 
used to switch, for instance, between a black 
and white printer, and a color printer. 

• Print the chapter to a disk. This disk can be 
sent to another location for printing on a high 
speed laser printer or typesetter. 

• Load a different printer width table. This lets ~ 
you change fonts. It also lets you change the 
character widths to match those used on a dif­
ferent printer or typesetter. 
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Changing output devices 

You can switch between different installed printers 
or typesetters by selecting the appropriate Device 
Name in the Set Printer Info Dialog Box (Figure 5-
70.) After changing the Device Name, you should 
select a different Width Table. See Changing 
Printer Width Tables later in this section. 

You may also need to change the computer port. To 
change computer ports (e.g., from COMl to COM2), 
select the correct option on the Output To line. 

Adding new screen fonts 

To add new screen fonts to Xerox Ventura Publisher, 
copy the fonts to the VENTURA directory. The fonts 
must all have the same file extension. To select these 
screen fonts, specify the correct extension on the 
Screen Fonts line. 

Output to disk file 

If you select Output To: Filename, then the infor­
mation normally sent to the output device during a 
print operation is instead sent to a disk file. Nothing 
is sent to the output device. This disk file can then be 
sent via floppy disk, network, or modem to a remote 
printer or typesetter for printing at a later time. To 
print to a file, select the To Print option in the File 
menu after selecting Output To Filename. 

This option is not available for JLaser, Cordata, and 
AST TurboLaser printers. 

~ The disk file created using this command will be at 
least as big as the sum of all the files contained in 
your chapter or publication. Make sure your com­
puter hard disk has enough room. To copy a large 
print file to floppy disk, use the DOS BACKUP com­
mand rather than the DOS COPY command. 
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Printing a chapter saved to a disk 

Once you have printed to a file, you will eventually 
want to send this file to a printer or typesetter. To do 
this, use the standard DOS COPY command, and 
copy the file directly to the output device by typing 
the following directly from the DOS prompt: 

COpy filename port: IB 

Replace filename with the name of the disk file you 
want to print, and port with the name of the port 
selected, exactly as shown on the Output To: line. (IB 
is not used when copying to a PostScript device.) 
Remember to place a colon directly after the port 
name. For example, to print a file named TECH­
DOCl.COO to a printer connected to LPTl, type the 
following at the DOS prompt: 

COPY TECHDOCl.COO LPTl: IB Enter 

This only works with output devices connected with 
a parallel cable. For output devices connected with a 
serial cable, you must first execute the following com­
mands (assuming your device is connected to COMl): 

MODE LPTl:=COMl: Enter 
MODE COMl:96,N,8,1 Enter 

Then execute the COPY command to LPT1: exactly 
as shown above. 

Use the XPRINT utility to move Interpress files. 

PostScript printers 

When copying to a PostScript printer or typesetter, 
you must first insert the Utilities Disk #11 into the A 
drive and then type the following command directly 
from the DOS prompt: 

COPY A:\POSTSCPT\DTR.TXT LPTl: Enter 
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DTR.TXT is a file contained on the Xerox Ventura 
Publisher Utilities disk in the POSTSCPT directory. 
Once this file is transmitted, it does not ever need to 
be re-transmitted unless another program resets 
your printer. It remains in the printer, even when 
power is turned off. Sending this file to the printer or 
typesetter does not affect the operation of Xerox Ven­
tura Publisher. 

You may not be able to print a file on very early 
models of the Apple LaserWriter using the above 
commands. See Appendix F for additional details on 
how to print a file to an Apple LaserWriter. 

Changing width tables 
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Each printing device creates individual letters and 
symbols differently, with a different shape, height, 
and width. Xerox Ventura Publisher must know, for 
each device installed, the width of each character for 
each typeface and size. This width information is 
then used to adjust the position for each character on 
the screen so the end of each line, paragraph, and 
page matches the printed output. 

During the initial installation process, Xerox Ven­
tura Publisher automatically creates files called 
width tables that provide this information for each 
printing device installed. When a different device is 
selected, as described in the section Changing Out­
put Devices, the matching width table should be 
loaded. 

To load a different width table, select Load Dif­
ferent Width Table (i.e., Font Metrics.) The Item 
Selector appears, and width table files names are 
shown. These files have names like XRX4045.WID 
and POSTSCPT.WID. Select the width table 
desired, and then select OK. 

If the width table is for a different printer than the 
Device Name currently selected, Quality (shown at 
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the bottom of the Set Printer Info Dialog Box) chan­
ges from ffitimate to Draft. 

Whenever a style sheet is saved, the width table cur­
rently in use is stored with that style sheet. This as­
sures that the chapter always prints the same way, 
even if you later load another width table. 

Draft printer 

If you ultimately want to print to a device not con­
nected directly to your computer (perhaps a typeset­
ting machine), but want to create rough draft copies 
on your local printer, you have a problem. The 
character widths used by your draft printer don't 
match the widths used by the ultimate output device. 
When printed on the ultimate device with a different 
width table, lines, paragraphs, and pages will all con­
tain the wrong number of characters, and the chap­
ter will look totally different from what you original­
ly created. 

The solution is to use the ultimate output device 
width table with your local printer. While this 
produces a chapter on your local printer with the 
wrong word spacing, justified text will still look jus­
tified, and the number of characters on each line, 
paragraph and page will exactly match what gets 
printed on the ultimate output device. 

Default width table 

The width table for the first output device installed 
(primary device) is automatically copied during in­
stallation to a file called OUTPUT.WID. This is the 
default width table. Its purpose is to reconfigure style 
sheets which are transferred between systems which 
use different printers. As an example, a style sheet 
created on a system which uses the Xerox 4045 and 
copied to a system which uses a PostScript printer 
will automatically adapt correctly to the PostScript 
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printer's width table if OUTPUT. WID is loaded 
before the style sheet is copied from the 4045 system. 

~ Use the width table name which matches the printer 
name (e.g., POSTSCPT.WID) if you want the charac­
ter widths to remain the same regardless of which 
printer is used. Use OUTPUT. WID if you want the 
character widths to change automatically whenever 
the style sheet is copied to a different system. 

The style sheets shipped with Xerox Ventura 
Publisher use OUTPUT.WID. 

Installing new fonts 

The other reason to change width tables is to change 
to a new set of typefaces. (See Appendix K.) Mter 
loading a width table which contains new typefaces 
and sizes, you will see the Face, Size, and Style 
changed according to the specifications in the new 
width table when you next choose any of the Font 
Dialog Boxes. 

See Appendix K for information on how to generate 
width tables for additional typefaces that you pur­
chase for your printer. See the AddlRemove Fonts op­
tion for information on how to merge fonts from dif­
ferent width tables into a single width table. 
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ADD/REMOVE FONTS (e: \UENTURA\OUTPUT.WID) 

Imm,: Stule ::::m 
Light , 
Bold 
HtJlic 
N·ltalic 
B·ltalic ........... 
Download 

(oAAand: I Merge Width Tables." I I ReAove Selected Font I 
I Save As New Width Table", I 

Figure 5-72 Add / remove fonts Dialog Box 

Description 

AddlRemove Fonts lets you add additional printer 
fonts. It also lets you disable automatic font down­
loading for each individual font. 

Application 

• Add typefaces 
• Enable or disable automatic font downloading 

Operation-Add fonts 

Before using this feature to add new fonts, you must: 

> Copy all new fonts to the VENTURA directory (or i 

the directory specified in the CNF file-see Appen­
dixK) 

> Copy the width table for these new fonts to the 
VENTURA directory. (Use the utilities described 
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in Appendix K to create a width table if the font 
supplier did not provide a Xerox Ventura 
Publisher width table.) 

Once new fonts have been copied to your computer's 
hard disk, run Xerox Ventura Publisher and then: 

~ Select Load New Width Table in the Set Printer 
Info option, and load the width table for the exist­
ing fonts for your printer. 

~ Select the AddlRemove Fonts option in the Op­
tions menu. The Add/Remove Fonts Dialog Box ap­
pears. 

~ Select Save As New Width Table to save the ex­
isting width table under a new name and avoid ac­
cidentally modifying an existing width table. 

~ Select Merge Width Tables and select the width 
table for the new fonts. These new fonts are added 
to those already in the existing width table. The 
combined set of faces, sizes, and styles are im­
mediately shown in the AddlRemove Fonts Dialog 
Box. 

~ Select any face, size or style which you don't wish 
to use, and then select Remove Selected Font. 
The font is removed from the combined width 
table. 

~ Select Save As New Width Table and save the com­
bined width table under a new name. 

All the new fonts are now available for use. 

~ The two width tables merged together must both be 
for the same printer. 

Operation-ResidentJDownload 
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The word Resident in the style portion of the Dialog 
Box means that the font selected is already resident 
in the printer prior to running Xerox Ventura 
Publisher. The word Download means that Xerox 
Ventura Publisher will download the font from the 
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computer's hard disk automatically during the print 
operation. 

Anytime the fonts used to print a chapter reside on 
the computer hard disk, select Download. Anytime 
the fonts used to print a chapter have been placed in 
the printer and made permanent prior to running 
Xerox Ventura Publisher, select Resident. 

~ Each font (i.e., each combination of face, size and 
style) must be individually set to Download or Resi­
dent. 

You can decrease print time when using an HP Laser­
Jet or Xerox 4045 by eliminating automatic 
downloading. To do this, you must first download the 
fonts into your printer, and make them permanent 
prior to running Xerox Ventura Publisher. Use the 
utilities provided by the printer manufacturer. Al­
though you eliminate the time needed to download 
the fonts at the beginning of each print job, Xerox 
Ventura Publisher will not free the memory used by ~ 
the fonts when pages which contain many graphics 
and few fonts are printed. Unless your printer con­
tains several megabytes of memory, your printer will 
likely produce out of memory error messages. 

~ The novice user should not change the state of the 
DownioadlResident configuration from the state 
which is automatically set during installation. 
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Showlhide side-bar 

Description 

The Side-Bar is the left part of the Xerox Ventura 
Publisher screen which contains the Function Selec­
tor, Assignment List, Current Selection Indicator, 
and Page Counter. Hide Side-Bar removes the en­
tire side-bar from the screen, letting you see more of 
the page. 

Application 

• Lets you perform text editing, including 
paragraph tagging, with a more complete view 
ofthe document. 

Operation 
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Make sure the function you want to use (e.g., Text 
Editing) is enabled. Then select Hide Side-Bar in 
the Options menu, or press and hold the Ctrl key as 
you press W. The Side-Bar disappears. 

To show the side-bar, select Show Side-Bar in the 
Options menu, or press and hold the Ctrl key as you 
press W. 

While the Side-Bar is hidden, you can still change be­
tween functions using the View menu or the key­
board shortcuts. Paragraphs can also be tagged using 
the Function Keys. 
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Showlhide rulers 
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Description 

ShowlHide rulers turns rulers at the top and left 
edges of the screen on or off. 

Application 

On-screen rulers help place pictures and graphics. 

Operation 

Select Show Rulers to turn rulers on. Select Hide 
Rulers to turn rulers off. 

When rulers are shown, the mouse cursor's position 
is always shown by a thin hairline which moves 
across the face of each ruler. These hairlines let you 
make accurate frame and graphic placement on the 
page. To assure precise frame size and placement, 
use the Sizing & Scaling option in the Frame menu. 
To make precise graphics placement, use the Grid 
Setting option in the Graphic menu. 

REFERENCE GUIDE 



Show/hide column guides MENU COMMANDS 

Showlhide column guides 

Description 

Show Column Guides paints faint dashed lines on 
the screen that show the outline of each column. 

Application 

• See how much space is left at the bottom of the 
column. 

• Aid in frame placement. 

Operation 
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To tum column guides on, select the Show Column 
Guides option in the Option menu. To tum column 
guides off, select the Hide Column Guides option 
in the Option menu. 

Column guides cannot be printed. 
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Showlhide pictures 
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Description 

The Hide Pictures option replaces all line art and 
all images with a gray rectangular box. 

Application 

• Increase the screen drawing speed. 
• See the frame margins, if the frame contains a 

picture. 

Operation 

To turn pictures off, select Hide Pictures in the Op­
tion menu. To turn pictures back on again, select 
Show Pictures in the Option menu. The frame and 
the picture it contains can still be moved, sized, 
scaled, cut, copied, and pasted while pictures are hid­
den. 

Pictures are always printed, regardless of whether 
pictures on the screen are hidden or shown. 

When pictures are hidden, a gray box appears within 
each frame, covering the exact area occupied by the 
picture. The space between this gray box and the 
frame edge shows you the current frame margin set­
tings. 
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Showlhide tabs & returns 

Tab 

.... 

Description 

Show/Hide Tabs & Returns provides visual 
markers for tabs, non-breaking spaces, line breaks, 
end of paragraph marks, end of file marks, index 
points, frame anchors, and discretionary hyphens. 

Application 

This feature lets you see hidden characters while 
editing text. 

Operation 

To show tabs and returns, select Show Tabs & 
Returns in the Options menu. To hide these charac­
ters, select Hide Tabs & Returns in the Options 
menu. Figure 5-73 shows the symbols used to display 
hidden characters. Showing these characters takes 
additional space which changes the location of 
characters on the screen slightly. This shift in no way 
affects how the page is printed. 

~ It is recommended that you Show Tabs & Returns 
whenever possible to avoid accidentally deleting hid­
den characters. 

Non-break-
Discretion- ing and 

ary other fixed Line Para- End of 
Hyphen spaces Break graph file 

• U j , I] 

Figure 5-73 Tab & return characters. Index and 
anchors display as small circle. 
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Turn column snap on/off 
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Description 

Turn Column Snap On forces all frames to align 
with the sides of the underlying page's column 
guides. 

Application 

• Force picture and text frames placed on the 
page to align perfectly with the underlying 
text columns. 

Operation 

To turn column snap on, choose Turn Column Snap 
On in the Options menu. To turn column snap off, 
choose Turn Column Snap Off in the Options 
menu. When column snap is on, a frame snaps to a 
column guide when it is placed within about 0.1 inch 
of that guide. 

Turning column snap on does not move frames al­
ready in the Chapter until those frames are moved or 
re-sized. 

When re-sizing a frame already placed on the page, 
only the side of the frame currently being moved 
snaps to a column guide. 

Frames do not snap to the top or bottom of the 
column guides. However, if the top margin is an in­
tegral multiple of Body Text inter-line spacing, and 
Line Snap is turned on, the frame can be made to 
align exactly with the top of the column guide. (See 
Turn Line Snap On.) 
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Turn line snap on/off 

Description 

The Turn Line Snap On option forces frames to line 
up exactly with the Body Text inter-line spacing in 
the underlying page. 

Application 

o Assure that frames in adjacent columns line 
up exactly. 

o Let you make the top of one frame align with 
the bottom of the frame above it. 

o Force a line or lines of text in a column to 
move down by exactly one line by increasing 
the height of a frame that has been snapped to 
the column. 

Description 
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To turn line snap on, choose Turn Line Snap On in 
the Options menu. To turn line snap off, choose Turn 
Line Snap Off in the Options menu. 

The inter-line spacing for Body Text is used to create 
an invisible grid to which frames are snapped. If Line 
Snap is turned on or Body Text inter-line spacing 
changed after frames have been placed, the top and 
bottom of each frame must both be moved in order to 
align the frame with the new Body Text grid. 
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Showlhide loose lines 
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Description 

The Showlhide Loose Lines option highlights lines 
which exceed the Maximum Space Width setting in 
the Typographic Controls option. Although Letter 
Spacing may be turned on to compensate for the loose 
line which results when this space is exceeded, the 
line will still be flagged as loose. 

Application 

• Provide a visual aid so the author can edit a 
loose line. (Place a discretionary hyphen in the 
first word below the loose line to correct the 
problem.) 

Operation 

To show loose lines, select the Show Loose Lines ~ 
option in the Options menu. To tum the loose line dis­
playoff, select the Hide Loose Lines option in the 
Options menu. 

Loose lines are shown in reverse video (i.e., white 
text on a black background) on a monochrome dis­
play. They are shown in red on a color display. 

REFERENCE GUIDE 



Multi-chapter MENU COMMANDS 

Multi-chapter 

MULTI·CHAPTER OPERATIONS 
New 

i;i!Wiimi;;iimm:::i:::::::m:i: C: \ TYP ES ET\&EXAMP LE, PUB :::mm;;;;;;;;;';"";;;""""'''' Open 
t C:\TYPESET\&BRO·P3,CHP [lose 

C:\TYPESET\&MA6·P3,CHP ~ A A A A A A A A '" '" '" '" '" '" 

I-- C:\TYPESET\&NEWS·P3,CHP Save 
C:\TYPESET\&NEWS·P2,CHP Save As", 
C:\TYPESET\&PRPT·P2,CHP ............... 
C:\TYPESET\&LST6·P2,CHP Add Chapter", 
C:\TYPESET\&PHON·P2,CHP Renon [hap 
C:\TYPESET\&BOOK·P2,CHP ............... 
C:\TYPESET\&BOOK·P1,CHP Print" , 
C:\TYPESET\&INU·P1,CHP Make TOC", 

.. C:\TYPESET\&LTR1·P1,CHP Make Index" , 
C:\TYPESET\&PREL·P1,CHP COpy All", 

Figure 5-74 Multi-Chapter Operation Dialog Box 

Description 

Multi-Chapter lets you combine a large number of 
chapters together into a Publication. You can then 
print, generate a table of contents, or create an index 
for the entire publication. 

Multi-Chapter also includes a file management 
utility that lets you copy all files associated with a 
chapter or publication. 

Application 
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• Print very large publications, such as books or 
technical manuals. Each chapter can be 
created separately and can point to its own set 
of text, pictures and style sheets. 

• Quickly see every file associated with an in­
dividual chapter. 
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• Automatically create front and back matter 
(table of contents and index.) 

• Copy every file associated with a chapter or 
publication, without accidentally losing a file. 

Creating a large publication 
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Xerox Ventura Publisher can print or copy a publica­
tion which consists of up to 128 chapters. The Multi­
Chapter Operations Dialog Box lets you build a list 
of chapters, which can then be saved as a Publica­
tion. (A publication is nothing more than this list of 
chapters.) This list is then used to tell Xerox Ventura 
Publisher which chapters to use during a multi-chap­
ter print or copy operation, or which chapters to in­
clude in a table of contents or index operation. 

To create a publication: 

~ Select Multi-Chapter in the Options menu. If you 
have made changes since the chapter or style 
sheet was last changed, you are prompted to save 
them. The Multi-Chapter Operations Dialog 
Box shown in Figure 5-74 then appears, and the 
current chapter or publication is shown. 

~ If you want to create a publication that doesn't in­
clude the current chapter, select New. The file 
names are removed from the Dialog Box. (The 
chapter files removed with this New command are 
not altered or deleted.) 

~ If you want to retrieve a publication previously 
created, select Open. The Item Selector appears, 
and you can then specify which publication you 
wish to retrieve. Select OK. The Multi-Chapter 
Operation Dialog Box reappears, with the publi­
cation's chapters displayed. 

~ If you want to add additional chapters to the list 
displayed, select the Add Chapter option. The 
Item Selector appears. After specifying the chap­
ter file name, select OK, and the Multi-Chapter 
Operation Dialog Box reappears. Continue 
selecting Add Chapter for each additional chapter 
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you want to place in your publication. If you make 
a mistake and add a chapter that you don't want, 
select that chapter name, and then select Remove 
Chapter. 

Rearrange chapter order 

The order in which chapters are placed in the list can 
easily be rearranged once you have created a list of 
chapters. Simply move the mouse cursor over the 
name of the file you wish to move, press and hold the 
mouse button, and then "drag" the file name to the 
new location. When you release the mouse button, 
the file name is inserted at the new location in the 
chapter list, and all file names below this point are 
pushed down. To move a file name from the bottom to 
the top of a long list of chapters, scroll to the end of 
the list, move the file to the top of the display area, 
then scroll up until the file name is at the bottom of 
the display area. Repeat until the file is at the top of 
the list. 

Once the list of chapters is complete and in the cor­
rect order, you should save it by selecting the Save 
As option. The Item Selector appears, and you can 
then specify the file name. The extension PUB is 
automatically added to the file name. Note that you 
actually are saving nothing more than a list of chap­
ters. The individual chapters and their associated 
text and picture files have already been saved. 

Once the publication has been saved, you can create 
a table of contents or index for it, print it or copy all 
the files associated with every chapter. 

See chapter file names 

If you want to see what files are associated with any 
given chapter, first select the chapter name and then 
select Open. The individual files for that chapter are 
temporarily displayed. Select Close to return to the 
original display. 
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~ Selecting Open when a chapter name is selected dis­
plays the contents of that chapter. Selecting Open 
with no chapter name selected lets you retrieve a pre­
viously saved publication. 

Multi-chapter print 

To print the multi-chapter publication currently dis­
played, select Print in the Multi-Chapter Operations 
Dialog Box. The options are identical to those 
described in the To Print option in the File menu, 
with one exception: If Output To Filename is 
selected in the Set Printer Info option in the Options 
menu, you are then asked to select whether you want 
to place Each [chapter] in Separate File or All in 
One File. If you select Each in Separate File, Xerox 
Ventura Publisher automatically creates separate 
files for each chapter, with the name you specifY fol­
lowed by the extensions COO, COl, C02, etc. If you 
select All in One File, the entire publication is 
placed in one big file with the extension COO. 

Table of contents generation 

Xerox Ventura Publisher can automatically generate 
a table of contents by extracting tagged text from the 
publication. For instance, you can create a table of 
contents that contains every occurrence of text 
tagged as Chapter Head or Sub Headline, along 
with the associated chapter and page numbers. This 
table of contents is then stored as a text file, which 
can later be loaded and formatted just like any other 
text file and added to the front ofthe publication file. 

To generate a table of contents for the publication dis­
played in the title bar ofthe Multi-Chapter Opera­
tions Dialog Box: 

~ Select Make TOC. The Generate Table of Con­
tents Dialog Box appears (Figure 5-75.) The cur­
rent publication name is shown on the TOC File: 
line, with the last three letters changed to TOC 
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GENERATE TABLE OF CONTENTS 

TOC File: C: \UpDOC\UPDOCTOUEN, _____ _ 
Title String: Table of Contents, _______ _ 

Lml 1: [*Chapter Headl 
Lm12: [*Heading 11 .. [C'"'~I"·[""P~m-II-----­
Lml J: 
Level 4: 
LevelS: 
Level 6: 
Level 7: 
Level 8: 
Level 9: 

Level 10: 

Inserts: I Tag Text I ffi[] I Chapter ~ I []ill]] 
I Text Attr, I 

Figure 5-75 Table of Contents Dialog Box 

and the extension GEN added. This is the name of 
the text file which will be created during the Table 
of Contents generation process. 

>- Use the text cursor to change this file name as 
desired, although you should keep the extension 
GEN. 

>- Modify the Title String, if desired. This is the 
title that appears at the top of the first Table of 
Contents page. 

>- Place the text cursor on the Level 1 line, and then 
select Tag Text. 

This places the following words on the Level 1 line: 

II 

>- Use the keyboard cursor keys to delete the words 
tag name and replace them with the first tag 
whose text you wish to place in the table of con­
tents. 

>- Move the text cursor to the end of the Levell line 
>- Select Tab 
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~ Select Chapter # (if you want chapter numbers 
included) 

~ Type a dash 
~ Select Page #. 

The Level 2 line on your display should look like that 
in Figure 5-75. Repeat this procedure for additional 
levels. 

When finished, select OK. Xerox Ventura Publisher 
then automatically creates a table of contents by 
placing a copy of each paragraph, tagged with the 
tags you specified at each Level, into a text file. 

This text file is automatically tagged with different 
tags for each level, and another tag for the title. 
These tags are called Z_TOCl, Z_TOC2, etc., and 
Z_TOC TITLE. 

The resulting text file can then be loaded (using the 
Load TextlPicture option), formatted with a style 
sheet, edited, and printed just like any other text file. 
Load this text file using the Generated option in the 
Load/Text Picture Dialog Box. 

If you save the publication after creating the table of 
contents, the options are saved with the publication. 

The table of contents for this manual was created 
using Xerox Ventura Publisher. &TCHD-Pl is the 
style sheet for this manual and includes tags for table 
of contents and index entries. 

Index generation 
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Xerox Ventura Publisher can automatically create an 
index from the references inserted into the text using 
the InsertlEdit Index option in the Edit menu. 

To generate an index for the publication displayed in 
the title bar of the Multi-Chapter Operations 
Dialog Box: 
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~ Create a publication file as described earlier in 
this section. 

~ Select Make Index. The Generate Index Dialog 
Box appears (Figure 5-76). The current publica­
tion name, with the last three letters changed to 
IDX and the extension GEN added, is shown on 
the Index File: line. You can use the text cursor 
to change this file name as desired, although you 
should keep the extension GEN. 

~ Modify the Title String, if desired. This is the 
title that appears at the top of the first index page. 

~ If desired, select Letter Headings: On. This 
places an A before the first index entry beginning 
with the letter A, a B before the first index entry 
beginning with the letter B, and so on. An ex­
clamation point (!) is used as the heading for all 
entries which are neither numbers or letters. 

The rest of the Dialog Box is automatically filled out 
as shown in Figure 5-76, and usually does not need 
to be changed. For those wishing to change the 
default format: 

HtlERATE ItlDEX 

Index File: C: \UPDOC\UPDOC IDU EtI _____ _ 

Title String: Index __________ _ 

letter Headings: • []ill 

Before k ~ 
For Each ~: [1...(#-;-] ..... [ p'"'# ];-·--;['""'C#,.-]· ...... [P'"'# ].-------
Between #s: , ___________ _ 

After #s: 
"See ": See 

"See Also": See --;al-so-----------

Inserts: mIll Chapter # I []ill]] I Text Attr. I 

Figure 5-76 Generate Index Dialog Box. 
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Before #s inserts the text specified before the 
chapter and page numbers. The default is one 
horizontal tab character. For the index in this 
manual, the tab was replaced with a comma 
followed by a space. 
For Each # describes how the chapter and page 
numbers will appear in the index. Placing a 
dash as shown in Figure 5-76 will refer to 
entries that occur on consecutive pages by 
showing the first and last chapter and page 
numbers on which they appear, separated by a 
dash. 
Between #s describes the punctuation that 
should be placed between each chapter/page 
number referenced. The default is comma, 
followed by a space. 
After #s describes what punctuation should be 
placed after the chapter/page numbers. The 
default is no punctuation at all. 
See defines the text that should be added for a 
cross reference entry. Usually the word See is 
used. 
See Also defines the text that should be added 
for a secondary cross reference entry. Usually 
the words See Also are used. 

If you save the publication after creating the index, 
any changes made to the default settings will be 
saved with the publication. 

During the index generation process, the actual text 
from each index entry is collected from the publica­
tion, along with the chapter and page number on 
which that entry is currently placed. This text is then 
sorted and placed into a text file. Each entry is fol­
lowed by a line break and horizontal tab character. 
The last entry for each letter in the alphabet is fol­
lowed by a paragraph end (carriage return.) 

This manual's index was generated with Xerox Ven­
tura Publisher's index feature. 
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Copying chapters & publications 

Since both Chapter and Publication files each point 
to a large number of different text and picture files, 
each of which may be in a different subdirectory, 
copying every file in a complete Chapter or Publica­
tion using the DOS COPY command is very 
laborious. In general, the DOS COPY command does 
not work unless every file will ultimately be copied 
back to the same disk drive and subdirectory. 

~ Do not use the DOS COPY command to copy 
chapters. 

The Copy All feature automatically copies all files 
associated with a chapter or publication (except 
hyphenation dictionaries). Each type of file (e.g., 
style sheet, picture, text) can be copied to a different 
disk drive and subdirectory. The references in the 
chapter (CHP) and publication (PUB) files to these 
new drives and subdirectories are automatically up­
dated as these files are copied. 

To copy the entire publication: 

> Open a publication file, or build a list of publica­
tions using the Add Chapter feature then save 
the resulting publication. 

> Select Copy All. Make sure no chapter name is 
selected, or you will only copy that one chapter. (To 
de-select a selected chapter, move the mouse cur­
sor to an empty portion of the screen, and then 
press the mouse button once.) 

> The Copy All Dialog Box appears. (Figure 5-76). 
The PUB or CHP: line shows the name ofthe pub­
lication or chapter to be copied. The destination 
lines show the disk drive and subdirectory to 
which each file type will be copied. 

> On each destination line, enter the disk drive 
name, followed by a colon, followed by the sub­
directory (if any) where you wish to place that file 
type. For example, to save all files in the publica-
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tion to the root directory on the A drive, edit each 
line to look like Figure 5-77. 

COPY ALL 

SOURCE (fro~ this file) 

PUB or CHP: C:\TYPESET\&EXAMPLE,PUB, _____ _ 

DESTINATION (to these directories) 

PUB & CHPs: A:~\-_________ _ 
STYs & WI Ds : A : \ Text Files: A:\·------------

Graphic Files: A:\ ____________ _ 
hlage Files: A:\. ____________ _ 

Co~~and: I Hake All Directories the Sa~e As the First I 
[][] I Cancel I 

Figure 5-77 Copy All Dialog Box. Set to copy all files 
associated with EXAMPLE. PUB to the A drive. 

If all files will be saved to the same disk and direc­
tory, enter information on the first line only, and then 
select Make all Directories the Same as the 
First. Select OK to begin the copying process. Xerox 
Ventura Publisher creates any directory names re­
quested that were not already in existence. 

~ Pressing the Enter key does nothing in the Copy All 
dialog box in order to reduce the chance of accidental­
ly starting the copy process before you are ready. 

If all the files from the publication will not fit on one 
floppy disk, the following message appears when the 
disk becomes full: 

There is not enough space on the target disk. Do 
you wish to continue with a new disk or cancel 
the archive process? 
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To copy only one chapter: 

>- Select that chapter name from the list of files 
shown in the Multi-Chapter Dialog Box. 

>- Select Copy All and follow the preceding instruc­
tions for copying a publication. 

Retrieving a publication or chapter 

Use the Open option in the Multi-Chapter Dialog 
Box to retrieve a publication that has been copied to 
another disk drive. Change the disk drive as 
described in the Item Selector section. Once the pub­
lication is opened and the chapters are shown in the 
Multi-Chapter Dialog Box, select Copy All and fill in 
the destination lines with the appropriate disk drive 
and directories, as described in the preceding 
paragraphs. Figure 5-78 shows the Item Selector set 
to retrieve a publication that was previously copied 
to the A drive. All files are copied to the TYPESET 
subdirectory. 

(OPY ALL 

SOURCE (frolll this file) 

PUB or (HP: A:\&EXAMPLE.PUB, _______ _ 

DESTINATION (to these directories) 

PUB & (HPs: (:\TYPESETI-I ________ _ 
STYs & WIDs: (:\TYPESET 
Text Files: (:\TYPESET----------

Graphic Files: (: \TYPESET _________ _ 
IlIlage Files: (:\TYPESET _________ _ 

(olllllland: I Make All Directories the Sallie As the First I 
DO I (ancell 

Figure 5-78 Copy All Dialog Box set to copy EX­
AMPLE.PUB files from the A drive to the TYPESET 
directory. 
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To retrieve a single chapter that has been copied 
to another disk drive, use the Add Chapter option 
in the Multi-Chapter Dialog Box. Change the Direc­
tory line in the Item Selector, to change to the correct 
disk drive. Once the chapter is shown in the Multi- .4 
Chapter Dialog Box, select the chapter name and ~ 
then select Copy All. Then, fill in the destination 
lines with the appropriate disk drive and directories. 

When retrieving publications or chapters which are 
saved on more than one floppy disk, the following 
message appears: 

This file could not be found: filename. Do you 
wish to skip over it, or retry with a new disk, 
or cancel the archive process? 

Insert the next disk, and then select Retry. 
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This chapter provides a collection of hints, tips, and 
techniques developed by users of Xerox Ventura 
Publisher. 

Frames and pictures 

Multiple article chapters 
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This sub-section describes how to create newspaper­
type chapters with Xerox Ventura Publisher. A 
newspaper format contains multiple articles, each 
saved in a different file. These articles can start on 
any page and can continue on any later page. Each 
portion of each article can be placed in a frame 
anywhere in the chapter. Each frame can have its 
own set of margin, column, and vertical rule settings. 

Text can be placed into a chapter in three ways: 

• Into the underlying page, starting on 
page one. In this case, text flows automatical­
ly from page to page. 

• Into specific frames which are placed on 
top of the underlying page. In this case, 
text flows until the frame is filled. If more text 
remains, another frame must be placed some­
where in the chapter, and the next portion of 
text from the same file flows into this frame. 
Text in the underlying page and in other 
frames flows around the frame. 

• Into box text, using the Graphics Draw­
ing function. Box text is like a PostIt@ (a 
small note temporarily pasted to a page.) Text 
does not flow automatically from one box text 
to another. 
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A combination of all three approaches can be used. 
The first approach works very well for technical 
documentation, manuals, books, proposals, and 
directories. The second approach is better suited to 
newsletters, magazines, and newspapers. The third 
approach is used primarily for callouts, tables, and 
forms. 

Newspaper Layout 

Newspapers and newsletters combine a variety of 
different typographic styles, column widths, and 
margins. This type of complex layout can easily be 
generated by placing text into frames. 

To compose a newspaper layout, first set up the num­
ber of columns desired. Use the Margin & Column 
setting to provide column guides to which frames can 
be snapped (Figure 6-1.) Turn Show Column Guides 
On to show these guides on the screen. 

Use the Frame Setting function to place frames 
wherever you want text to appear (Figure 6-2). 

Then flow text or pictures into each frame by first 
selecting the frame, then selecting the file name in 
the Assignment List. The frame can be made larger 
or smaller to increase or decrease the amount of text 
it contains. 

To continue a text file from a previous frame into a 
new frame (the new frame can be placed on the cur­
rent or any succeeding page), select the new frame, 
and then select the text file name in the Assignment 
List. The text continues from the first frame. This 
process can continue with as many frames as you 
wish, on different pages, until all text from the file is 
placed in the chapter. 

Once text is placed in a frame, it can be tagged in ex­
actly the same manner as text placed in the underly­
ing page. Tagging text changes text attributes, and 
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Figure 6-1 First step in newspaper layout: Create 
underlying grid with Margins & Columns. 

changes the placement of text within the frame (e.g., 
right justifY, center.) All tag spacing is measured 
from the edge of the frame, not the edge of the page. 

Figure 6-2 Second step in newspaper layout: Create 
Frames to hold various text files. Set margins and 
columns for individual frames. 
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Figure 6-3 Place additional frames on page. Place 
text and pictures files in each frame. 

Figures 6-1, 6-2, and 6-3 show how to compose part 
of the first page of a newsletter. 

~ When placing text from the same file into different 
frames on the same page, the first part of the text is 
always put in the frame which was placed on the page 
first, and the last part of the text is put in the frame 
which was placed on the page last. 

If you cut a frame and then immediately paste it, this 
frame becomes the last frame on the page. Use this 
technique to re-order text flowing within frames on 
the same page. 

Also note that if one text frame partially overlaps 
another text frame, the last frame created appears on 
top of the first frame created. The text in the bottom 
frame flows around$the frame on top. 

Since no text is placed in the underlying page using 
this approach, new pages are not created automati­
cally. Therefore, use the Insert New Page option in 
the Page menu to add new blank underlying pages, 
as needed. Then continue placing new frames and ad-
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ding text. Or, you can place the text cursor in the un­
derlying page and create a new text file for the un­
derlying page. The end of file marker will appear in 
the underlying page. If the frames placed over the 
underlying page completely cover the area bounded 
by the column guides, this end of file marker will be 
pushed to the next page, thus creating a new page 
automatically. 

Xerox Ventura Publisher does not require that all 
text from a given file be placed in the chapter. This is 
useful because newspaper layouts often require that 
the end of a story be truncated in order to fit. Xerox 
Ventura Publisher allows this. However, the entire 
original article is still saved when the chapter is 
saved. 

Each frame can have its own set of margins, columns, 
vertical rules, caption settings, column balance, and 
background shading. 

Text from different wordprocessors can be placed in 
different frames within the same chapter. When the 
chapter is saved, each text file is saved under its 
original file name, and in its original wordprocessor 
format (unless changed with the File TypelRename 
option). By placing different text files into different 
frames, you can combine multiple text files into one 
chapter. 

Text can be cut, copied, or pasted from one frame to 
another, even if these frames contain text from dif­
ferent wordprocessors. 

~ Although text can flow from a frame on page 12 to a 
frame on page 27, text cannot be made to flow from a 
later page back to an earlier page. 

REFERENCE GUIDE 

Blank document template 

Different issues of a newsletter or newspaper often 
use the same layout. Rather than spend the time to 
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place frames in the same place on the same pages for 
each new issue, you can create and save a complete 
chapter for your first issue. Then use the Remove File 
option in the Edit menu to remove each file in the As­
signment List from your chapter. For instance, select 
the first frame on the first page and then select 
Remove File in the Edit menu. Next, select the 
Remove from: List of Files option. The file is 
removed from each frame in the chapter, but the 
frames, and all the frame settings, remain. Mter all 
files have been removed in this way, use the Save As 
option to save the chapter under a new name. For the 
next issue, all you need to do is retrieve this blank 
chapter, load the appropriate text and picture files, 
place these files in the frames that are already in the 
chapter, save the chapter under a new name, and 
then print. 

Creating identical frames 

If the same size frame with identical margins, ruling 
lines, captions, and backgrounds is to be used over 
and over, make one master frame of the proper size 
and add the desired margins, ruling lines and back­
grounds. Then copy this frame to the clipboard, go to 
each page where you want the frame to appear, and 
paste a copy of the frame on the new page. 

Pasting a frame onto the page from which it was 
copied results in two identical frames being placed on 
top of one another. Merely move one of the frames to 
another location. 

Selecting frame underneath 

When one frame is placed entirely under one or more 
frames, you cannot select the frame on the bottom in 
the normal way. However, if you press and hold the 
Ctrl key while you select, you can select each frame 
in succession, starting with the currently selected 
frame. 
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Precise frame size and placement 

Frames can be placed and sized precisely using the 
Sizing & Scaling options. (See the Menu Com­
mands chapter.) On the other hand, the mouse pro­
vides a much faster way to draw and change the size 
of the frame. A good way to take advantage of both 
features is to Show Rulers and then use the mouse 
to create and place the frame as closely as your eye 
and the resolution of the screen allows. Then select 
the frame and use the Sizing & Scaling option to 
make minor, but exact, adjustments to the frame's 
placement and size. 

Multiple frame selection 

Several frames can be selected at the same time and 
then moved, cut, copied, pasted, or re-sized as a 
group. To select several frames, make sure the Frame 
Setting function is enabled. Then press and hold 
either Shift key on the keyboard as you select each 
frame. Finally, release the Shift key and then move, 
cut, copy or paste the group offrames. 

To de-select one of a group of selected frames, hold 
down either shift key and select that frame. 

Selecting any frame without pressing the Shift key 
de-selects all other frames. 

Display without selection borders 
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When using any function other than Paragraph Tag­
ging, a light textured border is displayed around each 
picture. This border is used to illustrate the place­
ment of the frame and will not be printed. Select the 
Paragraph Tagging function to display the frames 
without these selection borders. To add borders that 
will print, use the Ruling Lines options in the 
Frame menu, as described in the Menu Commands 
chapter. 
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Text editing 

Copy-fitting 

Copy-fitting is the process of making the copy (text) 
fit a given space. Xerox Ventura Publisher provides 
several copy-fitting tools that can be used individual­
ly or together to solve copy-fitting problems. These 
tools and their application are described below: 

1) Text Editing. The traditional way, and still the 
best, to get copy to fit a given space is to add and 
delete text. Xerox Ventura Publisher's Text Editing 
function gives you a wordprocessor that not only lets 
you add and delete text, but lets you see how the page 
will look when it is printed. 

2) Frame Size. If a frame has been placed on the 
page, its size can be increased or decreased. As its 
size is changed, more or less text is placed in the un­
derlying page and text is "pushed" or "pulled" from 
the next page as needed. If Line Snap is turned on, 
you can easily control the number of lines of text in 
the underlying page that are pushed or pulled to and 
from the next column or page. A variation on this 
technique is to add an empty frame, with both 
Column Snap and Line Snap turned on. Make the 
frame exactly one or two lines high and equal to the 
width of either the column or the page, as necessary. 
This method is equivalent to the old practice of ad­
ding a one line block of lead, when type was set in 
lead. Figures 6-4 and 6-5 show how to use this tech­
nique. 

~ When using this technique, remember that the 
Widow and Orphan control and Keep With Next 
settings (in the Breaks option of the Paragraph 
menu) may cause several lines of text and any as­
sociated heading to move to the next column or page. 
If this happens, use one ofthe other copy-fitting tech­
niques instead. 
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Figure 6-5 Frame added. Columns now even 
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Tables 

6·10 

3) Add New Tag. You can create a new tag and then 
use the Tracking control in the Typographic option to 
increase or decrease the space between characters. 
When this tag is applied to a paragraph, it will subt­
ly increase or decrease its length. 

Tabular material can be formatted in many ways. 
The simplest is to place tabs between each item in the 
table. The Tab option in the Paragraph menu is then 
used to set the horizontal position for each item fol­
lowing a tab. Tables such as the one shown in Figure 
6-6 can be easily formatted in this way. 

Honda, , , Toyota, , , ,Volvo "Pontiac 

Price $3,163" $11,449" $10,333 , $14,370 

De st 21 0 , , , " 1 39 , , , , , ,21 0 ' .... 320 

Auto 390 , , . , , 420" , , , ,610 "".455 

Air 695 , , , , , 700,., , . . 725 ,.," 750 

Figure 6-6 Simple table using horizontal tabs and 
leaders 

Horizontal rules can be added to any table by setting 
the tag ruling lines (above or below.) 

For more complex tables, type the text directly into 
text boxes created using the Graphics Drawing op­
tion, and then use the Line Attributes option to draw 
lines around these boxes. See the Graphic Drawing 
chapter for details on table creation. 
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Automatic conversion to typographic characters 

Xerox Ventura Publisher can create documents with 
real typographic attributes, including em (-) dashes 
and typographic quotes (" ".) Since your computer 
keyboard doesn't contain these characters, Xerox 
Ventura Publisher lets you enter them using the Alt 
key, as described in Chapter Four. 

However, these characters can also be entered direct­
ly from your wordprocessor by enclosing the decimal 
equivalent for the character (see Appendix E) inside 
of the appropriate brackets. For instance, a left 
typographic quote can be inserted while using a 
wordprocessor by typing <169>. 

These codes can be entered easily if your wordproces­
sor supports keyboard macros. Or, you can use the 
search and replace function in your wordprocessor. 
For instance, search for every occurrence of: 

/\ 

(where /\ is a space), and replace it with <169>. Then 
search for every occurrence of" and replace with 
<170>. 

To create em dashes, which are used to separate 
parenthetical statements-such as this one-most 
typists type two hyphens in a row like this: --. If you 
follow this convention, simply search for every occur­
rence of two hyphens and replace with <197>. 

Page break 

Many wordprocessors let you create a new page at 
any point in the text. Xerox Ventura Publisher lets 
you do this by selecting Page Break After in the 
Breaks option of the Paragraph menu. However, you 
may want to create a page break while typing, just 
like you do with a wordprocessor. This is easy to do: 
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~ Create a new tag with attributes identical to those 
of Body Text. 

~ Set Page Break Mter for this new tag. 
~ Assign this tag to a special function key. 

To create a page break, press this function key while 
editing a Body Text paragraph. Text following the 
page break is pushed to the next page or frame. 

Style sheet 

6-12 

Creating style sheets 

A style sheet is a computer file which contains page 
layout settings, margin and column settings, and a 
series of typographic tags. These tags can be applied 
to any paragraph in a chapter. When applied, the tag 
name is inserted invisibly into the paragraph, and 
the paragraph is reformatted according to the text at­
tributes associated with the tag. 

The style sheet approach allows the same typo­
graphic formats to be applied to many chapters, 
regardless of which wordprocessor was used to create 
the chapter and who wrote the chapter. It also lets 
you instantly change the format of an entire chapter. 
This is useful, for example, if you want to customize 
manuals for different customers. Finally, style sheets 
let you format large chapters very quickly, and yield 
a consistent look from page to page, chapter to chap­
ter, regardless of who uses the style sheet. 

Loading a Style Sheet 

An existing style sheet is loaded either by choosing 
the Load Different Style option in the File menu, 
or by opening an existing chapter (which automati- ~ 
cally loads the associated style sheet.) Once loaded, a 
style sheet is modified by: 
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• Changing the settings in the Paragraph menu 
• Changing the Page Layout, Widows & Or­

phans, Auto-numbering, and Footnote settings 
options in the Page menu 

• Modifying the Frame Settings for the underly­
ing page 

• Loading a new printer width table 

If either the style sheet or the chapter is saved, the 
changes made are saved in the original style sheet 
file. However, if the Save As New Style option in the 
File menu is chosen, and a new file name is specified, 
then a new style sheet is created. 

~ Any modification to the style sheet is saved whenever 
the current Chapter is saved. If you don't want these 
changes to affect other Chapters which use the same 
style sheet, select Save As New Style and enter a 
different style sheet name before saving the chapter. 

Designing Style Sheets 

To design a style sheet, first make a sketch of how the 
page should look. If this sketch is done thoroughly, 
the style sheet can be prepared very quickly. To 
create the style sheet, follow these steps: 

~ Load an existing style sheet. Most people find 
it easier to modify an existing design than to 
create a completely new style sheet. Use the Load 
Different Style option in the File menu. 

~ Load a text file. Place this text file in the under­
lying page. This gives you sample text to format as 
you make changes to the style sheet. 

~ Change the margins and columns. Enable the 
Frame Setting function and select the underlying 
page. Then select the Margin and Column option 
in the Frame menu and enter information for both 
the left and right page. If only one page is 
specified, Xerox Ventura Publisher automatically 
makes the right and left page settings identical. If 
the chapter is to be bound, add additional space to 
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the right margin on left facing pages, and add 
more space to the left margin on right facing pages 
to allow space for stapling and hole drilling. 

~ Change the Page Layout, Widow & Orphan, 
Auto-Numbering, and Footnote settings. 
These four options in the Page menu are stored 
with the style sheet. 

~ Set the underlying page's vertical rules. 
Select the Vertical Rules option in the Frame 
menu, and enter information for both the left and 
right page. 

~ Modify existing tags. Enable the Paragraph 
Tagging function and use the options in the 
Paragraph menu to change the attributes of the 
tags in the existing style sheet. You may want a 
different typeface or size, or perhaps different 
spacing between lines. For each tag you want to 
modify, it is good practice to examine each option 
in the Paragraph menu. Any changes made are im­
mediately reflected in the tagged paragraph. If 
you don't like what you see, change it. Pay special 
attention to Body Text, since the format for this 
tag provides the foundation for the overall design. 

~ Create new tags. To create a new tag name, 
enable the Paragraph Tagging function and tag a 
paragraph with a tag similar in design to the one 
you want to create. Then select the Add New Tag 
button, shown just below the Function Selector. 
When you select OK, the new tag name is added 
to the Assignment List, and the new tag is 
automatically assigned to the selected text. 

~ Delete unwanted tag names. Use the Remove 
Tag option to get rid of any tags not needed. 

~ Save the style sheet. Select the Save as New 
Style option in the File menu. Type a new name 
on the Selection: line if you want to create a new 
style sheet. Otherwise, select an existing name in 
the Item Selector, and then select OK. 

~ Any modifications made to the style sheets supplied 
with Xerox Ventura Publisher should be saved under 
a different name. This assures that your documents 

REFERENCE GUIDE 



Style sheet HINTS, TIPS, & TECHNIQUES 

always look like the sample documents in Appendix 
L. If a style sheet should inadvertently be modified, 
simply copy the original file from the Examples disk 
supplied with Xerox Ventura Publisher back to your 
computer hard disk. 

Menu Options Stored With Style Sheet 

The following are stored with the style sheet: 

• All paragraph tag settings 
• Margin and column settings for the underlying 

page. (Margin and column settings for each in­
dividual frame are stored with the chapter.) 

• Page layout settings 
• Widow and orphan settings 
• Auto-numbering settings 
• The printer width table name 

Tag Names 

Most good designs use very few different tags. Al­
though Xerox Ventura Publisher lets you define up to 
128 different tags, most design experts agree that 
you should use only one or two typefaces per chapter, 
and should only use three or four combinations of 
sizes (e.g. 10 point, 14 point) and weights (e.g., bold, 
italic.) Therefore, most style sheets consist of only a 
few tag names. 

Pick tag names that are short, so they can be easily 
entered by the author in the original wordprocessor, 
if desired. (See Appendix D for a description on how 
to enter tag names directly in your favorite word­
processor.) 

Choose tag names that make it easy for the user to 
see the hierarchy between related tags when looking 
at the Assignment List. For instance, the names 
Heading and Sub Heading definitely reflect a 
hierarchy, but the two names will appear in different 
parts of the alphabetized Assignment List. Also, both 
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require the author to type many keystrokes. A better 
choice is Head I and Head 2, or even HI and H2. 

Choose identical tag names as you design different 
style sheets. This lets you instantly reformat old text 
with new style sheets, and also reduces training as 
new style sheets are designed. 

The name Body Text cannot be changed or removed. 

I@f Tags previously placed in the text which do not match 
the tag names in the current style sheet are placed, 
in capital letters, in the Assignment List and as­
signed Body Text attributes. 

For this reason, always enter tag names in lower 
case, or with initial capitals. This allows you to see 
whether the style sheet in use matches the tags al­
ready in the text. If a mismatch occurs, either select 
the correct style sheet, or modify the upper case tag 
attributes, as appropriate. If you do modify the up- ~ 
percase tags, it's a good idea to use the Rename Tag ~ 
function to convert the name to lowercase or initial 
capitals. 

Generated Tags 

When you create a header, footer, caption, automatic 
section number, table of contents, or index, a tag is 
automatically created with the name Z_HEADER, 
Z_FOOTER, Z_CAPTION, etc. The initial tag at­
tributes for these Generated Tags are taken from 
the current definition of Body Text. However, these 
generated tags can be modified and changed, like any 
other tag. For instance, to put a ruling line under 
each header, first enable the Paragraph Tagging 
function, then select the header and, finally, use the 
Ruling Line Below option in the Paragraph menu 
to add the ruling line. 

Generated Tags are always preceded by the capital 
letter Z. These tags are usually not shown in the As-
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signment List because they are not generally as­
signed to any other paragraph. However, they can be 
shown in the Assignment List by selecting Show 
Generated Tags in the Set Preferences option. 

The number of tags in the current Style Sheet, plus 
the number of non-matching tags in all current text 
files, plus the number of generated tags, cannot ex­
ceed 128. 

Vertical tabs 

The Tab option in the Paragraph menu defines 
simple horizontal tab stops. This feature can be used 
to format simple text for tables. However, if more text 
is available then fits between two tab stops, the 
whole line is pushed to the right, beyond the right 
margin edge if necessary. In such cases, you may 
want text to flow automatically within a temporary 
column, as shown in Figure 6-7. This is known as a 
Vertical Tab. 

A vertical tab is different from a column in the follow-

• 

Figure 6-7 Vertically tabbed text 
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ingways: 

A column is a predefined Xerox Ventura 
Publisher function. A vertical tab is simply an 
effect created with a series of Tag attributes. 

• The "column" length in a vertical tab is equal 
to the length of one paragraph, whereas a real 
column has a fixed length. 

Vertical tabs are not generated by placing tab charac­
ters in the text. Instead, to create vertical tabs, fol­
low these steps: 

>- When typing text using your wordprocessor, make 
each block of text to be vertically tabbed a separate 
paragraph. 

>- Create a tag for each vertical tab column. For each 
tag, use the In From Left and In From Right set­
tings in the Spacing option to define the left and 
right boundaries of each column. 

>- Set the Line Break Before for the first vertical tab; 
Line Break After for the last vertical tab; and No 
Line Break for any vertical tabs in between. 

>- Set Keep With Next to Yes for each vertical tab tag 
except the last one. 

>- Set Allow Within to No. 

The &TBL2-Ll style sheet in Appendix L provides a 
good example of how to design vertical tabs. 

Color separations 

The offset printing color separation process requires 
a separate black and white page for each primary 
color. Through the use of style sheets, Xerox Ventura 
Publisher can automatically produce a separate 
black and white document for each color to be 
printed. 

For example, suppose you want to print all 
paragraphs tagged as a HEADING in blue, and print 
all paragraphs tagged as a SUBHEADING in red. To 
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do this 

~ Set the font attribute to WHITE for every tag ex­
cept HEADING. Leave this tag black. 

~ Save as a new style sheet called BLUE. 
~ Next, set the font attributes to WHITE for every 

tag except SUBHEADING. Leave this tag black. 
~ Save as a new style sheet called RED. 
~ Finally, set HEADING and SUBHEADING to 

WHITE, and every other tag to BLACK. 
~ Save this style sheet as BLACK. 

To print separations for any chapter formatted with 
the original style sheet, you need only load the BLUE 
style sheet, then print the chapter; load the RED 
style sheet, then print the chapter; and finally load 
the BLACK style sheet, and then print the chapter. 
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APPENDIX A 
INSTALLATION INSTRUCTIONS 

Xerox Ventura Publisher is contained on eleven 
separate disks. These disks contain all files needed to 
create a version of the program which is customized 
for your particular combination of computer, 
graphics board, mouse, and printer. Typefaces 
designed for your particular display and printer are 
also included on these disks. 

To install your software, follow the instructions 
below exactly. Installation is accomplished by select­
ing printer and display options from menus on the 
screen. These selections are made by typing a single 
letter in either upper- or lowercase. If you make a 
mistake and type the wrong letter, simply type the 
correct letter. (You do not need to press backspace or 
delete.) Press Enter to complete each entry. In most 
cases, the following setup should only take 15-20 
minutes. 

If you have ordered a printer, but have not yet in­
stalled it, you can install Xerox Ventura Publisher 
and connect the printer at a later time. 

Installation with other programs 
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It is recommended that background utilities such as 
Sidekick not be installed when running Xerox Ven­
tura Publisher. These utilities reduce the amount of 
space available, resulting in slower operation. If in­
stalled, activation ofthese background utilities while 
running Xerox Ventura Publisher is not recom­
mended. 

A-l 



APPENDIX A-INSTALLATION INSTRUCTIONS 

A-2 

Hard disk space required 

You need the following amount of space on your hard 
disk to install Xerox Ventura Publisher: 

• 700K bytes for Xerox Ventura Publisher, dis­
play driver, and hyphenation dictionaries. 

plus 

• 260K bytes for example files. These can later 
be deleted, if desired. 

plus 

• Between 140K bytes and 2200K bytes for each 
printer driver and associated fonts as follows: 

- Epson Dot Matrix - 350K bytes 
- HP LaserJet - 220K bytes 

HP LaserJet Plus - 2200K bytes ~ 
- JLaser, AST TurboLaser, Cordata - 1200K 

bytes 
- PostScript, Interpress - 240K bytes 
- Xerox 4045 - 2200K bytes 
- ~erox 4020 - 340K bytes 

For example, to install Xerox Ventura Publisher for 
the 4045 laser printer and the Xerox 4020 color ink 
jet printer requires (600 + 260 + 2200 + 340) = 3400K 
bytes. 

Most of this space is used for printer fonts. 

Updating from version 1.0 

If you previously installed an earlier version of Xerox 
Ventura Publisher, read this section. Otherwise, skip 
the rest of this section and proceed to the next sec­
tion, Software Installation. 
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If you modified the HYPHUSER.DIC file, copy 
this file to a new subdirectory called VENTURA 
prior to installation of version 1.1 as follows: 

MD \ VENTURA Enter 

CD \ GEMAPPS \ VPSYS Enter 

COPY \HYPHUSERDIC \ VENTURA \ HYPHUSERTMP Enter 

Anew HYPHUSER.DIC file is created during instal­
lation. Mter installation, execute the following: 

CD \ VENTURA Enter 

COPY HYPHUSERTMP HYPHUSERDIC Enter 

DEL HYPHUSERTMP Enter 

If you added any additional fonts to version 1.0, 
these new fonts and associated width tables must be 
copied to the VENTURA directory. 

Finally, if you have not installed any other GEM 
programs, and have not copied any files to the fol­
lowing directories, delete all files in the GEMSYS, 
GEMBOOT, GEMDESK, and GEMAPPS direc­
tories as follows: (Respond with Y anytime the com­
puter asks Are You Sure?) 

CD \GEMSYS Enter 

DEL *.* Enter 

CD \GEMBOOT Enter 

DEL *.* Enter 
CD \GEMDESK Enter 

DEL *.* Enter 
CD \GEMAPPS\ VPSYS Enter 

DEL *.* Enter 
CD \GEMAPPS Enter 

DEL *.* Enter 

RD VPSYS Enter 

CD \ Enter 

RD GEMAPPS Enter 

RD GEMSYS Enter 

RD GEMBOOT Enter 

RD GEMDESK Enter 
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Software installation 

~ Note: The installation process can be aborted at any 
time by pressing and holding the Ctrl key and then ~ 
pressing the Break key. ~ 

Load DOS according to the instructions in your 
Microsoft or IBM DOS manual. Mter loading DOS, 
you will see the following on your computer screen: 

II 

You may see a different letter, depending on the let­
ter your computer uses to designate the hard disk. 

Insert the disk labeled Xerox Ventura Publisher 
Application Disk into the "A" floppy disk drive. 
(This is usually the top or left drive in a computer 
with two floppy disk drives.) Close the drive door. ~ 
Then type A:VPPREP Enter 

~ If you install from any drive other than A, type 
n:VPPREP n: where n is replace with letter of the 
floppy disk drive. 

In a few seconds, the following message appears: 

Welcome to Xerox Ventura Publisher Prep! 
Is your hard disk drive C? Y 
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Most systems use the letter "c" as the drive designa­
tion. To install Xerox Ventura Publisher on drive "C", 
press Enter. If your computer uses a different letter, 
or you have more than one hard disk drive and want 
to install on other than the "c" hard disk, type: 

N Enter 
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If you answer N, the computer asks you to: Type your 
hard disk drive letter ( A-Z )? 

Respond by typing the appropriate letter. For in­
stance, to install for the D drive, type: 

DEnter 

Xerox Ventura Publisher next asks: 

Are you installing this version for the first 
time? Y 

Press Enter. If you have already installed version 1.1. 
To change only part of the installation, press: 

N Enter 

Once you have decided which hard disk drive to use, 
Xerox Ventura Publisher displays the message: 

Creating Ventura Publisher Directories 

You are then instructed to: 

Remove the Ventura Publisher APPLICATION DISK 
from drive A. 
Insert the SCREEN DEVICE DRIVER DISK (#3) into 
drive A. 
Press Enter to continue. 

Remove the Application Disk and insert the disk 
labeled Ventura Publisher Device Driver Disk #3 into 
the A drive. Close the drive door and press Enter. 

In a few seconds you will see the following display: 
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Which graphics card and display do you have? 

A IBM Color Card / Color Display (640x200) 
B IBM Enhanced Card / Color Display (640x200) 
C IBM Enhanced Card / Enhanced Display (640x350) 
D IBM Enhanced Card i Monochrome PC Display (640x350) 
E IBM New Enhanced Card / New Color Display (640x480) 
F IBM 3270 Pc / Monochrome PC Display (640x350) 
G Hercules Card / Monochrome PC Display (720x348) 
H Xerox 6065 / AT&T 6300 (640x400) 
I MDS Genius Full Page Display (720 x 1000) 
J Xerox Full Page Display (720 x 992) 
K Wyse WY-700 Display (1280 x 800) 
L ---THE FOLLOWING DRIVERS SHOULD ONLY BE USED WITH 
COLOR PRINTERS---
M IBM Enhanced Card / Color Display 16 Colors 640x200 
N IBM Enhanced Card / Enhanced Display 16 Colors 
640x350 

A·6 

o AT&T Display Enhancement Board (640 x 400) 16 colors 

Type the letter of the graphics card you have: 

Your computer must have one of these graphics 
cards, or else a card that emulates one of these 
products, in order to run Xerox Ventura Publisher. 
Xerox Ventura Publisher does not work with a text­
only monochrome graphics board. If you aren't cer­
tain what type of board you have, consult your com­
puter dealer. 

In order to maximize performance, do not install for 
color operation unless you own a color printer. 

Type the letter that corresponds to the type of 
graphics board installed in your computer, and then 
press Enter. 

Xerox Ventura Publisher then asks: 
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Which mouse do you have? 

A No Mouse 
B PC Mouse or Mouse Systems Compatible / SummaMouse 
C Xerox, AT&T, Microsoft Buss Mouse ( Uses MOUSE.COM 
D Microsoft Serial Mouse ( RS232 
E SummaSketch 1201 with Stylus 
F SummaSketch 1201 with Cursor 

G SummaSketch 961 with Stylus 
H SummaSketch 961 with Cursor 

Type the letter of the mouse you have: 

If you have a Logitek Logi-Mouse, Summagraphics 
Summa-Mouse, Torrington Mouse, or Microage 
Mouse, type the letter B. 

If you are installing for a Microsoft Bus Mouse, Xerox 
6065 or AT&T 6300, type the letter C. If your bus 
mouse does not function, consult the mouse 
documentation for information on proper configura­
tion of the jumpers on the mouse plug-in board. 

~ Other bus mice not listed, and serial mice which re­
quire a MOUSE.COM file should also be installed as 
option C. 

If you answered the last question with anything 
other than C, Xerox Ventura Publisher then asks: 

Which communication port are you using for the mouse? 

A Communication Port #1 
B Communication Port #2 

Type the letter for the communication port you're 
using. 
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If you don't know the answer, select A and press 
Enter. If the mouse doesn't work when you have 
finished with installation, reinstall it as B. (Answer 
No to the question Are you installing this version 
for the first time?) 

Xerox Ventura Publisher then asks: 

Which printer do you have? 

A EPSON MX/FX 
B HP LJ, w/92286F Font 
C HP LJ+, 150dpi 
D HP LJ+, 300dpi 
E POSTSCRIPT 
F INTERPRESS 
G JLASER 
H CORDATA 
I AST TURBO 
J XEROX 4045, 150dpi 
K XEROX 4045, 300dpi 
L XEROX 4020 

Type the letter of the of printer you have: 
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Select the letter of the first printer you want to install 
and press Enter. (If you are installing for the IBM 
Proprinter, select A.) 

Check Appendix F to verify your printer's switch set­
tings, cabling, and other setup information. Addition­
al important information for selected printers is sum­
marized in the following pages. 

Xerox 4045 

The Xerox 4045 must have at least 450K RAM in­
stalled in order to use the 150 dpi driver, and at least 
1.0 Megabyte RAM in order to use the 300 dpi driver. 
The status sheet which prints whenever you turn on 
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the printer tells you the amount of RAM in your 
printer, and shows the current configuration switch 
settings. Check these switch settings with those 
shown in Appendix F. If you have less than 1.0 
megabytes in your 4045, install the 150 dpi printer 
driver. If you have more than 1.0 megabytes, install 
the 300 dpi driver. 

Apple LaserWriterlPostScript printers 

Note that the Apple LaserWriter, LaserWriter Plus, 
and other PostScript printers are installed by typing 
E. Consult Appendix F for important cabling and 
setup information for Postscript printers. The Apple 
LaserWriter can be connected directly to the PC, if 
the proper cable is used. 

JLaser printer 

The JLaser printer requires certain changes to the 
CONFIG.SYS file. Consult the JLaser reference 
manual, or call Tall Tree Systems for assistance. 

HPLaserJet 
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Note that the HP LaserJet (selection B) is different 
from the HP LaserJet Plus (selections C and D.) If 
you own an HP LaserJet, you need to purchase either 
the 92286F font cartridge or the LaserJet Plus 
upgrade kit from Hewlett-Packard. The 92286F font 
cartridge is the only HP font cartridge that works 
with Xerox Ventura Publisher, and it only works with 
the standard LaserJ et. 

When installing the HP LaserJet Plus, install both 
the 150dpi and the 300 dpi drivers. Install the 300 
dpi driver first. You can then switch to the 150 dpi 
driver if the LaserJet displays an Error 20 message 
in its status display during printing to indicate that 
it has run out of memory. The HP LaserJet II is in­
stalled as option D. 
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Cordata and AST TurboLaser 

The Cordata and AST TurboLaser printers require 
certain changes to both the AUTOEXEC.BAT and 
CONFIG.SYS files. Install these printer for serial 
port one or two. Consult Appendix F for details. 

Mter you have selected a printer, Xerox Ventura 
Publisher then asks: 

Which printer port are you using? 

A Printer Parallel Port #1 
B Printer Parallel Port #2 
C Printer Parallel Port #3 
D Printer Serial Port #1 
E Printer Serial Port #2 

Type the letter of the printer port you are 
using: 

Consult your computer dealer if you are not certain 
which option to choose. 

Type the appropriate letter and press Enter. 

~ Make sure the cable you use matches the wmng 
diagrams in Appendix F, and that you don't have two 
serial ports both configured as serial port #1. These 
are the two most common causes of printer problems. 

Xerox Ventura Publisher then asks: 

Do you want to select another printer? N 
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You can install up to five printers simultaneously. 
The printer driver, fonts, and width tables for each 
printer are loaded onto the hard disk. However, since 
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these are big files, only install the printers you will 
be using. 

The first printer selected should be your final output 
device, not your draft printer. 

If you are installing more than one printer, type: 

Y Enter 

and answer the printer questions for every printer 
you wish to install. When finished installing 
printers, simply press Enter when asked: Do you 
want to select another printer? 

Xerox Ventura Publisher then places a message on 
the screen, similar to the following. 

Your screen device choices are: 

Xerox 6065 / AT&T 6300 (640x400) 

Xerox, AT&T, Microsoft Buss Mouse 

(Uses MOUSE.COM ) 

No communication port selected 

Your printer device choices are: 

XEROX 4045, l50dpi 

LPT1: 

Are these the correct screen and printer choices? Y 

If the choices are correct, press Enter. Otherwise, 
type N Enter. You are then given another chance to 
answer all the above questions correctly. 
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You are then asked to insert a series of disks, depend­
ing on which choices you made for graphics card, 
mouse, and printer. Messages similar to the follow­
ing are displayed: 
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Insert the disk with the following label in drive A. 
EPSON DRIVER/FONT DISK (#5) 
Press Enter to continue. 

Don't be surprised if some disks are never used, and 
others inserted more than once. This is normal. 

Installation time varies, depending primarily on the 
number and type of printers and the speed of your 
computer. The HP LaserJet Plus and Xerox 4045 
take the longest (10-15 minutes); PostScript and In­
terpress take the least amount of time. 

Do not be alarmed if the message "Expanding Font 
Files" remains on the screen for 5-10 minutes or 
more. All fonts supplied with Xerox Ventura 
Publisher are stored on floppy disk in compressed 
form in order to reduce the number of disks, and it 
takes time to expand these back to their original size. 

When the installation process is completed success­
fully, the following message appears on the screen: 

This Concludes Ventura Publisher Prep. 

If you wish to use Ventura Publisher. 

Type VP at the DOS prompt and then press the Enter key. 
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Post-installation 

If you chose the Xerox, AT&T, or Microsoft bus mouse 
(option C in the mouse menu), the following message 
appears near the end of the installation process: 

You have chosen a mouse which requires a resident 
Mouse Driver. 

You will need to add MOUSE into your autoexec.bat file. 
You will also need to copy MOUSE.COM from the disk 

which came with your mouse, onto your hard disk. 

This message is a reminder to do two things after the 
installation process is complete: 

> Copy the file MOUSE.COM from the floppy disk 
that came with your mouse to the root directory of 
the hard disk that contains Ventura Publisher 

> Add the word MOUSE to the AUTOEXEC.BAT file 
in your root directory. 

Any modification to the AUTOEXEC.BAT file should 
be done with the ASCII text function of your 
wordprocessor. Alternatively, if your system does not 
have an AUTOEXEC.BAT file, you can create one 
and add the word MOUSE to it by typing the follow­
ing from the DOS prompt: 

COPY CON: C:\AUTOEXEC.BAT Enter 
MOUSE Enter 
Ctrl Z Enter 

where Ctrl Z means "press and hold the Ctrl key and 
then type the letter Z." 

~ To get the maximum performance from Xerox Ven­
tura Publisher, you must add the following state­
ment to the CONFIG.SYS file contained in the root 
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directory of your computer (use the ASCII text func­
tion of your wordprocessor): 

BUFFERS=15 
FILES=15 

Numbers greater than 15 may provide slight perfor­
mance improvement. However, larger numbers 
reduce the amount of memory available for the chap­
ter text files. 

If CONFIG.SYS doesn't exist, you can create it by 
typing the following directly from the DOS prompt 
(assuming your hard disk is C): 

COPY CON: C:\CONFIG.SYS Enter 
BUFFERS=15 Enter 
FILES=15 Enter 
Ctrl Z Enter 

where Ctrl Z means "press and hold the Ctrl key and 
then type the letter Z." 
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Xerox Ventura Publisher automatically hyphenates 
text whenever Hyphenation is selected in the 
Alignment option. The place within a word where 
these hyphens are placed is determined by a com­
bination of a computer algorithm and a small diction­
ary (contained in the file HYPHEXPT.DIC, located in 
the VENTURA directory.) This dictionary overrides 
the algorithm for words where the algorithm fails. 
Since the algorithm fails on only a few words, only a 
few words are actually looked up in the dictionary. 
The result is very fast hyphenation. 

However, while this combination of algorithm and ex­
ception dictionary seldom inserts incorrect hyphens, 
it may occasionally miss opportunities to insert 
hyphens. Also, you may want to suppress hyphena­
tion for certain words. Therefore, Xerox Ventura 
Publisher also provides a User Hyphenation Dic­
tionary in the file called HYPHUSER.DIC, also lo­
cated in the VENTURA directory. This dictionary 
overrides both the algorithm and the system excep­
tion dictionary. Thus, you not only can add hyphens 
that might otherwise be missed, but you can also 
force Xerox Ventura Publisher to hyphenate at a dif­
ferent point than the system would otherwise choose. 

To add words to the dictionary, modify the file called 
HYPHUSER.DIC using your wordprocessor. (Read 
this file into your wordprocessor as an ASCII text 
file.) Add the words with the hyphens inserted, as 
shown on the next page, and then save the file back 
to disk as an ASCII text file. Words can be inserted 
in upper- or lowercase. Several words are already in­
cluded in HYPHUSER.DIC to get you started. 

If you want to suppress hyphenation for a particular 
word-perhaps your company's name-you can enter 
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that word into the HYPHUSER.DIC file with no 
hyphens. 

~ Failure to store this file as an ASCII file will result in 
incorrect hyphenation. 

Foreign language hyphenation algorithms 

Xerox Ventura Publisher provides six hyphenation 
algorithms: 

• American English (fast) 
• American English (exhaustive) 
• French 
• Italian 
• Spanish 
• UKEnglish 

Any two algorithms can be installed at anyone time 
and any two can be used within the same document. 
This lets you create multi-lingual, justified and 
hyphenated documents. 

When you first install Xerox Ventura Publisher, both 
hyphenation choices are set to American English 
(fast.) To install different hyphenation algorithms, 
copy the appropriate hyphenation algorithm from 
the Utilities Disk to the VENTURA directory. 
Hyphenation algorithms are found in files with the 
extension HYl. Rename the extension from HYl to 
HY2 if you want the algorithm to be the second 
hyphenation choice in the Alignment option. If only 
one hyphenation algorithm exists on the VENTURA 
subdirectory, it is the only algorithm used. Only one 
file with the extension HYl and one file with the ex­
tension HY2 should exist in the VENTURA directory 
at anyone time. 

The standard algorithm used for American English is 
very fast and quite accurate, but it may miss some 
hyphenation opportunities. When creating docu­
ments with narrow columns, this may result in an ex­
cessive number of loose lines. For critical applica-
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tions, a second algorithm for American English 
provides more complete, equally accurate hyphena­
tion, but takes somewhat longer to insert hyphens 
when text files are loaded and when text is added 
during text editing. This algorithm is contained in 
the file USENGLS2.HYl in the Utility Disk. Install 
as described in the previous paragraph. You should 
typically only have one English language algorithm 
installed at one time. Delete or rename the UK 
English or American English (fast) algorithm if 
necessary. 

Only one exception dictionary is used for all lan­
guages. To enter words for languages which use 
characters not available on your computer keyboard, 
use the < > codes, as described in Appendix D. For in­
stance, to enter the French word kaleidoscope, with 
appropriate hyphens, type the following into the 
HYPHUSER.DIC dictionary: 

ka-I<130>i-do-scope 

Example of hyphenation dictionary entries 

in-de-fat-i-ga-ble 

moth-er-hood 

plu-ral-i-ty 

ventura 

xerox 
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Commonly asked questions 
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Consult the Index under the heading "Problems" to 
find references to common problems, along with the 
recommended solutions to these problems. 

Can I buy additional fonts for my printer and 
use them with Xerox Ventura Publisher? 

• Yes. Consult Appendix K for details. 

How can I send the printer output to a disk file 
instead of to the printer? How can this disk file 
then be printed? 

• Read the Set Printer Info section in the 
Menu Commands chapter. 

How do I copy all the files associated with a 
chapter? The DOS COpy command does not 
work. 

• Read the Multi-Chapter section of the Menu 
Commands chapter. In particular, read the 
sub-sections that deal with the multi-chapter 
COPY command. 

My printer doesn't print. 

• Check that the cable is connected. 
• Check that the cable is attached to the correct 

connectors on the computer. 
• If you are using a serial cable check the wiring 

diagrams in Appendix F. 
• If you are using a serial cable and your com­

puter contains more than two serial ports, 
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make sure these ports are not configured iden­
tically (e.g., both set to COM1:.) 

• Check Appendix F for other important infor­
mation specific to your printer. 

Does Xerox Ventura Publisher work on a net­
work? 

• Xerox Ventura Publisher is neither licensed for, 
nor will it operate when run from a central file 
server. Separate copies of the program, run­
ning on individual computers, can print over 
the network to a shared printer in some net­
work configurations. However, the network 
software which runs on the local computer 
may occupy so much RAM in some networks 
that very little space remains for Xerox Ven­
tura Publisher. This decreases performance. 

I cannot get text to appear in a frame (or in 
footnotes, box text, captions, footers, or 
headers.) 

• This generally occurs when the tag for a given 
paragraph type (e.g., Z_BOXTEXT) is first 
generated. Since this tag's attributes are 
copied from Body Text, the Above, Below, In 
From Left, or In From Right space applied to 
the text may exceed the space available in the 
frame, footnote, box text, caption, header or 
footer. The solution is to: 

Show Tabs & Returns. 
Temporarily make the frame, box text, etc. 
larger until the end of paragraph or end of 
file mark is displayed. 
Select the end of file mark, then select the 
Spacing option in the Paragraph menu, and 
finally reduce the Above, Below, In From 
Left, or In From Right spacing, as neces­
sary. 
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The picture exceeds the boundaries of the 
frame; the picture appears too big for the 
frame; the text is too big or too small compared 
to the picture. 

• These are all caused by the differences be­
tween Xerox Ventura Publisher and other 
graphics programs. The solution in each case 
is to use the Sizing & Scaling option to reduce 
the picture fit the frame. In some cases, 
making the frame slightly larger or smaller 
may also help. 

A chapter file was created and saved. When 
Xerox Ventura Publisher was re-Ioaded, I 
couldn't find the chapter. 

• Remember to use the Open Chapter com­
mand, not the Load TextlPicture command, 
when trying to retrieve the chapter. Also, 
when saving a chapter, do not specify a file ex­
tension. Xerox Ventura Publisher looks for the 
CHP file extension when retrieving a chapter. 
If you saved the chapter with a file extension 
other than CHP, you will have to change the 
file filter in the Item Selector when you ex­
ecute the Open Chapter command. 

I can't see both pages of the document at once. 

• Select Double-sided in the Page Layout op­
tion of the Page menu. 

I cannot see pictures I placed into a frame. 
Why? 

• This usually occurs when large pictures are 
placed into relatively small frames. The pic­
ture is actually in the frame; however, the por­
tion displayed happens to be all white. The 
solution is to use the Alt key and mouse to pan 
a black portion of the picture into the frame. 
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Alternatively, choose Fit in Frame in the 
Sizing and Scaling menu. 

My color PC Paintbrush image only displays 
and prints in one color. 

• Multiple colors are not retained when PC 
Paintbrush images are converted into Xerox 
Ventura Publisher. Only the black color is 
retained and printed. 

Why doesn't the text cursor appear in the mid­
dle of a blank page when I try to place it there? 

• Xerox Ventura Publisher is designed to format 
text within a given frame, starting at the 
upper left comer. If you want text to appear in 
the middle of a blank page, draw a frame at 
this point, placing the upper left comer of the 
frame at the position where you wish to start 
typing. Then either placethe cursor inside this 
frame and begin typing, or attach a box text to 
this frame and place the text in it. 

When should I place text directly into a frame, 
and when should I use box text? 

• Place text directly into a frame when: 
the text originates in an external 
wordprocessor 
the text must continue into another frame 
(e.g., a newspaper article) 
the text must be formatted into more than 
one column 

• Use box text in all other situations. 

Which scanners does Xerox Ventura Publisher 
support? 

• Xerox Ventura Publisher supports any scanner 
that converts its images into GEM image, 
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Halo DPE, or Z-soft's PC Paintbrush (version 
2.5 or above) format. 

Can I make text flow around irregular shaped 
images like circles and triangles? 

• Yes. See the Frame Setting Function sec­
tion in the Functions chapter. 

I can't get my PC Paint files to load. Why? 

• PC Paint is a different product from PC 
Paintbrush, and is not compatible with Xerox 
Ventura Publisher. 

When I try to print a document, I get a message 
"device not receiving power." What is wrong? 

• Check to see if: 
the printer is turned on 
cables are attached and secured 
the cable you are using is the correct one for 
this printer 

• If this problem is encountered when first using 
Xerox Ventura Publisher, an incorrect cable is 
the most likely cause of the problem. Check 
the cable with a continuity tester or similar 
device in order to verifY correct wiring. 
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The following is an alphabetical listing of error mes­
sages that can appear in Xerox Ventura Publisher, 
along with an explanation of what they mean and 
what to do when they occur. 

A file by that name already exists. Do you wish 
to choose a new name or overwrite the existing 
file? 

[New Name I Overwrite] 

• This message lets you know that you are about 
to destroy an existing file. You can either save 
the file under a new name, or overwrite the ex­
isting file. 

A tag by that name already exists. Therefore, a 
new one by that name can't be created. 

[OK] 

• This message appears when trying to add a 
tag with the same name as one already shown 
in the Assignment List. Pick a different name, 
or remove the tag from the Assignment List. 

Abandon changes to this chapter and revert to 
the previously saved version? 

[OKI Cancel] 

• You have selected the Abandon operation. 
Select OK to throwaway all changes and open 
the previously saved chapter. 
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All 6 of your repeating frames are already in 
use. 

[OK] 

Xerox Ventura Publisher allows up to six 
repeating frames per chapter. To fix this 
problem, you must make one of the existing 
six repeating frames a normal frame. 

Are you sure you wish to delete all files that 
match: filename 

[Delete I Cancel] 

• This message appears during DOS File Opera­
tions as a reminder that you are about to erase 
a file or files. Select Cancel if you don't want to 
continue with the delete operation. 

Couldn't find overlay file. 

[OK] 

• One or more files in the VENTURA subdirec­
tory has been modified or deleted. Re-install 
Xerox Ventura Publisher. 

Currently, there is nothing on the clipboard. 
Therefore, you can't insert any text at the cur­
rent cursor location. 

[OK] 

• You must cut or copy text before you can paste 
(i.e., insert.) 

C-7 



APPENDIX C-COMMON PROBLEMS 

C-8 

Do you want to save or abandon the changes 
you made to this width table by removing 
fonts? 

[Save I Abandon] 

If you remove fonts using the AddlRemove 
Font option, you should Save these changes if 
you want to create a new width table, or 
Abandon if you decide not to make any chan­
ges. 

Do you wish to stop or continue printing? 

[Stop I Continue] 

• This message appears when you press the 
ESC key while printing. Select Stop to abort 
the printing operation. Select Continue to go 
ahead with printing. 

Do you wish to remove the text from the ~ 
selected frame or cancel the request? 

[Remove Text I Cancel] 

• When you type text directly into a frame 
(rather than using the Load Text/Picture op­
tion to load text into a frame), this text is 
stored in the chapter's caption file, along with 
all other captions, box text, and text typed into 
other frames. If you later try to assign a pic­
ture or text file to this frame, this message ap­
pears, warning you that the text in this frame 
will be permanently lost. 
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Do you wish to re-anchor just this page's 
frames, or all page's frames, or cancel the re­
quest? 

[This Page I All Pages I Cancel] 

• If you select This Page, Xerox Ventura Pub­
lisher looks through all the text on this page 
for anchor entries, and then moves frames 
throughout the document to these anchor 
points. If you select All Pages, this process is 
carried out across the whole document. 

Fatal Error! The VP.RSC file couldn't be found 
or would not fit in memory. 

[Abort] 

Fatal Error! The GEM VDI screen driver 
couldn't be loaded. 

[Abort] 

• The VP.RSC or screen driver files in the VEN­
TURA subdirectory have been modified or 
deleted. Re-install Xerox Ventura Publisher. 

Fatal Error! There wasn't enough memory for 
the screen graphics buffer. 

[Abort] 

• You may be running a background utility that 
interferes with the screen graphic buffer. 
Remove this background utility and try again. 

• You may be trying to run in a system which 
has less than 512K RAM. 
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File name collision: filename. Do you wish to 
rename this file, ignore the collision & copy 
over, or cancel the archive process? 

[Rename I Ignore I Cancel] 

• During the Multi-Chapter Copy process, this 
message appears if two files with the same 
name, but located in different directories, are 
to be archived to the same place. 

filename already exists on the target drive. Do 
you wish to overwrite the old version, keep the 
old file, or cancel the archive process? 

[Overwrite I Keep Old I Cancel] 

• This message appears if a file with the same 
name, but a different date and time, is found 
on the target disk drive. Choose the option 
desired. If the file has the same name and the 
same date and time, Xerox Ventura Publisher 
assumes that they are identical and does not 
bother to re-copy the same file. 

Headers, Footers, and other Repeating Frames 
can't be cut or copied to the clipboard. 

[OK] 

• You cannot cut, copy, or paste frames which 
are placed automatically by Xerox Ventura 
Publisher. This includes headers, footers, and 
footnotes. 
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If you intend to type text on an empty page, 
choose New File and enter the name and select 
the type of the file that will hold that text. 
Otherwise, choose Cancel. 

[New File I Cancel] 

• This message appears when you place the text 
cursor into a blank underlying page. Select 
New File to create a new text file. Select Can­
cel to abort the operation. 

Only text files can be renamed and retyped 
using this command. 

[OK] 

• This message appears when creating a new 
text file. Select New File to create a new text 
file. Select Cancel to abort the operation. 

Index entries can't be inserted inside of a foot­
note entry. 

[OK] 

• You cannot place an index entry into footnote 
text placed at the bottom of a page. 

Internal System Error! 1. Note what you just 
did. 2. Use Save As ... to save your work. 3. Call 
Tech. Support. 

[Sorry] 

• This message indicates that memory may have 
been corrupted. Do not make any further 
changes to your chapter. Us the Save As op­
tion and save the chapter under a different 
name than shown in the Title Bar. 

C-11 



APPENDIX C-COMMON PROBLEMS 

C-12 

No directory can be removed until all the files 
it contains have been deleted. 

[Cancel) 

• You must first delete all files within a sub- I 

directory before the directory itself can be 
deleted. 

No file by the name you've typed exists. There­
fore, it can't be removed or have its file type 
changed. 

[OK} 

• You probably typed the wrong name. Spaces 
within the name make a difference. For ex­
ample, Heading land Headingl are two dif­
ferent names. 

No files that match: filename were found. 

[Cancel} 

• You probably typed the wrong name or wrong 
file extension. 

No tag by the name you've typed exists. There­
fore, it can't be renamed, removed, or con­
verted to. 

[OK1 

• Check the tag name as shown in the Assign­
ment List and try again. You probably typed 
the wrong name. Remember, spaces within the 
name make a difference. For example, Head­
ing land Headingl are two different names. 
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Not enough memory to run the program. Either 
add memory to your system or check your 
CONFIG.SYS andAUTOEXEC.BAT files for any 
drivers or resident applications that can be 
removed. 

[Abort] 

o You may be trying to run in a system which 
has less than 512K RAM. 

o You may be running a background utility that 
takes up memory space. Remove this back­
ground utility and try again. 

o Check the CONFIG.SYS file to see if any com­
mands have been given which restrict the 
space available. 

Only text files can be renamed and retyped 
using this command. 

[OK] 

o The File TypelRename option is only available 
for frames which contain text. 

Output file already exists. 

[Overwrite I Cancel] 

o The file you are trying to create has already 
been created. You can either overwrite, or can­
cel the operation and save the file under a dif­
ferent name. 

Over 95% of internal memory has been used. 
You need to reduce the number of pages, 
frames, files, or paragraphs in this chapter or 
divide this chapter into two chapters. 

[OK] 

o This message appears when the combination 
of text, number of frames, number of 
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paragraphs, and number of tags exceeds the 
amount of memory available. If your computer 
has more than 640K memory, this does not 
help. The message itself provides the recom­
mended solution. 

Save or Abandon changes to this chapter? 

[Save I Abandon] 

• This message appears if you have changed the 
chapter since it was last saved. Choose Save 
or Don't Quit, or else lose all changes made 
since the chapter was last saved. 

Save or Abandon changes to this publication? 

[Save I Abandon] 

• When you select Done in the Multi-Chapter 
Operations Dialog Box, Xerox Ventura 
Publisher reminds you to save the Publication ~ 
if any changes have been made since it was 
last saved. Table of contents and index set­
tings are saved with the publication. 

Save or Abandon changes to this style sheet? 

[Save I Abandon] 

• This message appears just before you Quit, if 
you have changed the style sheet since it was 
last saved. Choose Save or Don't Quit, or else 
lose all changes made since the style sheet was 
last saved. 
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The current width table & the merge width 
table are set for different devices: What should 
be done? 

[Ignore I Cancel] 

• You cannot merge width tables intended for 
different printers (e.g. HP LaserJet Plus and 
Xerox 4045). 

The directory name you've specified already 
exists, or the disk is full. Therefore no new 
directory could be created. 

[Cancel] 

• You have attempted to create a directory that 
already exists. Either choose a new name, or 
else place this subdirectory name in another 
directory path. 

The file by the new name you just typed al­
ready exists. Do you wish to overwrite it or can­
cel the rename. 

[Overwrite I Cancel] 

• If you attempt to rename an existing text file, 
but specify a file name that already exists, you 
can either cancel the File TypelRename opera­
tion, or else overwrite the existing file. 

• You have selected a file which is not a stand­
ard publication file. You probably renamed or 
copied an incorrect file; edited a PUB file and 
saved it as something other than an ASCII 
file; or specified the wrong file name. 
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The file named: filename referenced in the 
chapter or publication you are currently load­
ing, could not be found. 

[OK] 

• A text, picture, or chapter file has been deleted 
or moved to another subdirectory. 

The file you just tried to load doesn't exist. 
Therefore, it can't be loaded. 

[OK] 

• A text or picture file has been deleted or 
moved to another subdirectory. 

The file you're trying to open as a Ventura 
Publisher CHP file is not in the standard chap­
ter file format. 

[Cancel] 

• You have selected a file which is not a stand­
ard chapter file. You probably renamed or 
copied an incorrect file; edited a CHP file and 
saved it as something other than an ASCII 
file; or specified the wrong file name. 

The file you're trying to open as a Ventura 
Publisher PUB file is not in the standard pub­
lication file format. 

[Cancel] 

• You have selected a file which is not a stand­
ard style sheet file. You probably renamed or 
copied an incorrect file, or specified the wrong 
file name. 
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The file you're trying to load as a Ventura 
Publisher STY file is not in the standard style 
sheet file format. 

[Cancel] 

• You have selected a file which is not a stand­
ard style sheet file. You probably renamed or 
copied an incorrect file, or specified the wrong 
file name. 

The file you're trying to use as a Ventura 
Publisher WID file is not in the standard width 
table file format. 

[Cancel] 

• You have selected a file which is not a stand­
ard width file. You probably renamed or copied 
an incorrect file, or specified the wrong file 
name. 

• The new width table you created using the 
utilities on the Utilities Disk has not been 
created correctly. Make sure you placed the 
fonts in the correct order (i.e., Normal, Italic, 
Bold, Bold Italic.) 

The HYPH*.DIC and/or * .HYI and/or * .HY2 files 
couldn't be found or were too large. These files 
are used to make sure that all words are cor­
rectly hyphenated. 

[OK] 

• At least one hyphenation dictionary and one 
algorithm must be located in the VENTURA 
subdirectory. To fix, copy the appropriate files 
from the UTILITIES DISK #11 to the VEN­
TURA subdirectory. 
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The new Width Table file couldn't be loaded. 
You may wish to try reloading this width file 
after doing a NEW. For now, we are using the 
current file instead. 

[Okay] 

• Whenever a style sheet file is loaded, either 
directly or by opening a chapter, the style 
sheet file automatically loads the width table 
that was in use when the style sheet was last 
saved. If that width table has been deleted, or 
if the style sheet has been copied to another 
system using the DOS COpy command, Xerox 
Ventura Publisher will not be able to find the 
width table. The current width table (e.g., 
OUTPUT. WID, located in the VENTURA sub­
directory) will be used instead. 

• To prevent this problem, always use the Multi­
Chapter Copy command rather than the DOS 
COpy command, when copying chapters to 
floppy disk. To fix the problem, look at the con­
tents of the style sheet file using the DOS 
TYPE command. While most of what appears 
on the screen will not be readable, you will see 
the name of the width table and the disk drive 
and subdirectory in which the width table file 
should be placed. Copy the width table to this 
directory. 

The paragraph you are trying to tag/edit is 
made up of text that was automatically 
generated. This text can't be tagged or edited 
directly. 

[OK] 

• You cannot use the Text Editing function to 
edit a caption, header, or footer. You must in­
stead select the appropriate option in the Page 
or Frame menu and then edit the text from 
within the Dialog Box. 
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The picture file you tried to load couldn't be 
converted. Either it wasn't in the proper for­
mat or there wasn't enough disk space for the 
conversion. 

[Cancel] 

• You have selected a file which does not match 
the picture file format for the type of file you 
specified. (e.g., You selected AUTOCAD, but 
loaded a LOTUS file.) This message also oc­
curs if your disk is almost full, and the picture 
file is large. In this case, delete some files to 
make room on your hard disk. 

The style sheet file you requested could not be 
found. Therefore, it was not loaded. 

[OK] 

• The style sheet file has been deleted or moved 
to another subdirectory. 

The tabs you have defined for this tag won't 
show up since the tag is marked as Justified. To 
make them show up, choose Left Aligned in the 
Alignment dialog. 

[OK] 

• Justification overrides tab settings. Therefore, 
you must turn Justify off in the Alignment op­
tion in order for tab settings to take effect. 

The text file you're trying to load is not stored 
in the wordprocessing format that you just 
specified or that the CHP file indicates. 

[Cancel] 

• You have selected a file which does not match 
the file format for your wordprocessor. You 
probably renamed or copied an incorrect file; 
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edited a file and saved it as a different 
wordprocessor file type; or specified the wrong 
file name. 

The values you're setting for margins and 
columns exceed the width or height of the 
frame. 

[OK] 

• To keep you from accidentally specifying mar­
gins that are larger than the page itself, Xerox 
Ventura Publisher constantly monitors the 
values you are entering and places this alert 
on the screen if an incorrect value is entered. 
Select OK, press ESC to clear the line, and 
then type the correct value. If the message 
reappears, check again to make sure you are 
using the correct units (e.g., picas.) 

There is not enough space on the target disk to 
save the file. Do you wish to continue with a 
new disk or cancel the archive process? 

[Continue I Cancel] 

• This message indicates you've run out of room 
on the floppy disk during a multi-chapter copy 
operation. Insert the next floppy disk and then 
select Continue to continue the archive 
process. 

There isn't enough memory to merge these two 
width tables into one width table. 

[OK] 

• You must delete files on your hard disk to 
make room for the new, merged width table. 
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There was not enough memory to begin the ar­
chive process. 

[Cancel] 

• Terminate the Multi-Chapter Operations by 
selecting Done, then select NEW in the File 
menu to remove the existing chapter from 
memory. Finally, select the Multi-Chapter op­
tion and resume the archive process. 

There wasn't enough memory to load and 
hyphenate all of the text file you requested. 
You may have to split this chapter & file into 
two parts and try again. 

[OK] 

• In a 640K system, Xerox Ventura Publisher 
can load approximately 500K bytes of text 
which can contain up to 48,000 paragraphs. 
These figures are approximate and depend on 
what version of DOS you are running; on what 
screen driver you installed (higher version of 
DOS, and the color EGA driver reduces the 
amount of text); on the size of your width 
table; on the number of paragraphs in your 
text; and on the number of tabs in your text. 
To fix this problem, use your wordprocessor to 
break the text file into several smaller files, 
and then create two or more chapters instead 
of one large chapter. When publishing data 
from a database, you may be able to eliminate 
this error message by replacing paragraphs 
with line breaks. 
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There wasn't enough space for all the re­
quested font fil~s. Some fonts may not display 
or print correctly. 

[OK] 

• When load.ing a large number of new screen 
fonts using the Screen Fonts option in the 
Printer Info option, Xerox Ventura Publisher 
may not be able to load all the fonts. Reduce 
the number of fonts which match the screen 
font extension. 

• If you merge too many fonts into a width table, 
Xerox Ventura Publisher may not be able to 
load all these fonts. Use the AddlRemove fonts 
option to reduce the number of fonts in this 
width table. 

This file could not be found: filename. Do you 
wish to skip over it, or retry with a new disk, or 
cancel the archive process? 

[Skip I Retry I Cancel] 

• This message appears when retrieving a large 
publication from several floppy disks. Insert 
the next floppy disk, and select Retry. If you 
can't find the file, but want to continue the ar­
chive process, select Skip. 

This frame is too complex to completely format. 
Try splitting it into two frames or reducing the 
number of columns, tabs, leaders, and lines of 
text. 

[OK] 

• If this error message appears, try to format 
the page with fewer attributes, fewer columns, 
fewer tabs, fewer frames or fewer paragraphs. 
You can also create several frames on the 
page. Then manually place text into each 
frame by selecting the frame and then select-
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ing the file name in the Assignment List. See 
the Repeating Frame option in the Menu sec­
tion for information on how to create these 
manually drawn frames automatically. 

Unable to find Anchor Frame: frame name. Do 
you wish to ignore, rename, or delete this un­
resolved anchor frame reference? 

[Ignore I Rename I Delete] 

• If no frame can be found in this chapter which 
has an anchor name which matches the 
anchor name specified in the text, then this 
message appears. If you select Ignore, Xerox 
Ventura Publisher continues with the anchor­
ing process. If you select Rename, you are 
then asked to specify a new text anchor name. 
If you can remember the correct name which 
you specified for the frame, enter that name. If 
this name is correct, this new name replaces 
the old name in the text, the frame is re­
anchored, and the frame anchoring process 
continues. If you select Delete, the anchor 
name in the text is deleted. 

Using the fA=memory command line switch 
may allow you to run but could cause some 
printers not to work. Read more about the fA= 
switch in the manual. 

[Abort] 

• If your computer contains less than 640K 
RAM, or if you are using background utilities, 
or if you are using network software which 
uses more than 50K of RAM, you may not be 
able to run Xerox Ventura Publisher. In some 
cases, you can still run if you start Xerox Ven­
tura Publisher by adding fA=n to the end of 
the second line of the VP.BAT file, where n is 
replaced with a number between 1 and 32. 
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This number represents the number of K bytes 
to subtract from memory allocated to the 
printer and graphics buffers and reallocate to 
text files. The second line in the VP.BAT file 
will then look something like this (depending 
on which mouse and display are installed): 

DRVRMRGR VP %1 IS=SD_X6655.EGAIM=321A=32 

Note, however, that the Cordata, AST, and 
JLaser printers may not work if you specifY a 
large number. Therefore these printers may 
not be usable in your system unless you 
upgrade to 640K RAM, eliminate background 
utilities, or run with a non-networked version 
of DOS. Also, larger numbers may degrade the 
drawing speed of graphic images on the 
screen. 

You can't merge a width table with itself. 

[OK] 

• When using the AddlRemove Fonts option, you 
must merge a width table which is different 
from the width table currently loaded. 

You can't remove or rename the default Body 
Text tag. 

[OK] 

• Body Text is the one tag name that cannot be 
removed or renamed. 

REFERENCE GUIDE 



REFERENCE GUIDE 

APPENDIX C-COMMON PROBLEMS 

You can't remove a tag and then convert the 
paragraph back to the same tag. 

[OK] 

• The name on the Tag Name to Remove and 
Tag Name to Convert to lines cannot be the 
same. 

You can't remove every face, size, and style font 
from a width table. 

[OK] 

• You must leave at least one font in a width 
table. 

You have to select a specific location for the 
text entry cursor before you can paste any text. 

[OK] 

• This message appears if the text cursor is not 
placed anywhere on the page and you attempt 
to paste text. You must first place the text cur­
sor at the location you wish to paste text, and 
then select paste. 

You must select some text before you can cut or 
copy it to the clipboard. 

[OK] 

• This message appears if you attempt a cut or 
copy operation without first selecting text. 
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Your disk is full. The file named: filename has 
not been saved. Before trying to save it again, 
delete enough files to make room. 

[OK] 

• You have run out of room on your hard disk. 
Use the DOS File Operations to delete enough 
files to make room for the chapter or style 
sheet you are saving. If you Quit from Xerox 
Ventura Publisher at this point without delet­
ing some files and then saving, all changes 
made since the chapter or style sheet was last 
saved are lost. 

You're out of memory. Save your document and 
quit the program as soon as possible. 

[OK] 

• If you add a large number of frames or add 
text to a large chapter, you may run out of ~ 
memory. Save the chapter and then quit from 
Xerox Ventura Publisher. To correct the 
problem, you must reduce the amount of text 
in one or more of the text files in the chapter. 

You're about to overwrite an existing caption. 
You won't be able to recover the caption text. Is 
that OK? 

[OK I Cancel] 

• If you don't want to overwrite the file, select 
Cancel. 
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You've used 128 tags, files, or chapters. There 
are no more available. If possible, remove those 
that are no longer in use and try again. 

[OK.] 

• The combination of tags in the style sheet, 
plus generated tags, and tags in the chapter 
text files that don't match the style sheet, can­
not exceed 128. This error message usually oc­
curs when loading a text file which contains 
tags which don't match the style sheet cur­
rently loaded. The usual solution is to select 
New, load the correct style sheet, and then 
Load the desired text file(s.) 
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TEXT FROM OTHER PROGRAMS 

Xerox Ventura Publisher can read text directly from 
many popular wordprocessors. It can also read text 
from many other programs which save text as a 
standard ASCII file. Text is read using the Load 
TextlPicture function. Text is saved automatically 
when saving a chapter using the Save or Save As op­
tions. Once saved, text can be edited using a 
wordprocessor. It can also be checked for spelling er­
rors using a wordprocessor's spelling checker. Final­
ly, text originally loaded into Xerox Ventura Pub­
lisher in one wordprocessor format can be converted 
to another wordprocessor format using the File 
TypelRename option in the Edit menu. 

The two-way communication between a wordproces­
sor and Xerox Ventura Publisher lets you combine 
the familiar user interface and advanced text 
processing capability of your favorite wordprocessing 
program with the graphics and typesetting features 
of Xerox Ventura Publisher. Thus, you can add and 
delete text in Xerox Ventura Publisher, while still 
using a wordprocessor for spell checking, search and 
replace, and moving large blocks of text. 

This section explains how to prepare text from 
various wordprocessors, Lotus 1-2-3, and dBase III 
for use by Xerox Ventura Publisher. 

~ The information in this appendix can also be used by 
a programmer to convert text from a wordprocessor 
or other program into text which can be read by Xerox 
Ventura Publisher as an ASCII or Wordstar file. 

Scope of text translation 
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Since Xerox Ventura Publisher provides its own mar­
gins, indents, hyphenation, page breaks, bullets, 
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page numbering, headers and footers, footnotes, tab 
settings, font information, table of contents, index, 
and section numbering, this information does not 
need to be entered when typing text in your favorite 
wordprocessor. In fact, this information is not trans­
ferred to Xerox Ventura Publisher. Since it is not 
transferred, and since Xerox Ventura Publisher 
saves text files under their original file names, the 
format information from the original wordprocessor 
is eliminated as soon as a chapter containing the text 
file is saved. If you want to retain the original 
wordprocessor formatting, save the text file under a 
different name before loading it into Xerox Ventura 
Publisher. 

~ Information other than text attributes, is lost when 
Xerox Ventura Publisher saves a chapter containing 
wordprocessor text. 

Tags 

However, text attribute information used by the 
author to convey meaning is used. All attributes used 
in Xerox Ventura Publisher's Text Editing function 
(e.g., underline, boldface, font settings) can be trans­
ferred to and from any wordprocessor or any ASCII 
file as described in the sections which follow. 

Xerox Ventura Publisher's paragraph format tags 
can be inserted at the beginning of any paragraph as 
follows (the @ must be the first character in the line): 

where TAGNAME is replaced by the name of the tag 
assigned to the paragraph. (The A symbol indicates 
that you should insert a space.) Thus, whether 
tagged originally by the author, or whether entered 
in the wordprocessor or in Xerox Ventura Publisher, 
these tags can be inserted into the text as shown in 
Figure D-l. 
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@CHAPTER HEAD = APPENDIX C<R>COMMON PROBLEMS 

@HEADING 2 = Commonly asked questions 

Consult the Index under the heading <169>Problems<170> to find 
references to common problems, along with the recommended 
solutions to these problems. 

@MESSAGE = <$IFonts;Adding new>Can I buy additional fonts for 
my printer and use them with Xerox Ventura Publisher? 

@LIST 2 = Yes. Consult Appendix K for details. 

@MESSAGE = <$IFile;Print to file><$IPrinting;To a file>How can I 
send the printer output to a disk file instead ofto the printer? How 
can this disk file then be printed? 

@LIST 2 = Read the Set Printer Info section in the Menu 
Commands chapter. 

Figure D-1 Text for Appendix C, as it appears in a word processor. 
Note index entries, line break, typographic quotes (<169> and <170» 
and tag names. 

Non-keyboard characters 
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Additional characters not found on the keyboard can 
be inserted into text by enclosing the ASCII decimal 
equivalent within brackets. (See Appendix E.) For in­
stance, to insert a trademark symbol (TM), you type: 

<191> 

To use the characters without having them inter­
preted as part of a character attribute code, type two 
brackets in a row. For instance, to produce the follow­
ing: 

<text in brackets> 
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Tabs 

type: 

«text in brackets» 

Any time you press the Tab key on the keyboard, you 
insert a tab character into the text. The wordproces­
sor then moves the cursor to the next tab stop setting 
for that paragraph. Remember, however, that the tab 
settings in the style sheet are at different locations 
from the tab settings in the wordprocessor. This may 
lead to incorrectly formatted tables, as shown in 
Figure D-2. To avoid this problem, use tab settings in 
the wordprocessor that are similar to the style sheet 
to be used. 

Tab Stop Matching 

Wordprocessor 
Tab Stops 

2 

! 
3 

! 
4 5 6 

! ! ! 

// 
This is text in column 1 [TABliTABI This is text in column 2 
Short text [TABI[TABliTABI This is more text in column 2 

2 3 

Ventura Publisher !! 
Tab Stops / ./ 

This is text in column 1 [TABlIT..(s] /This is text in cOlumn 2 
Short text[TABI[TABliTABI . This i~ more text in column 2 

Text Does 
Not Align! 

"' .... 
Make the tab stop settings in your word processor similar to the tab stops 

in the style sheet you will be using. 

Figure D-2 Tab stops in Ventura Publisher set dif­
ferently from those in a wordprocessor causes text to 
misalign 
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Tab check list 

• Turn justify off for any paragraph that con­
tains tabs. 

• Certain wordprocessors (such as Words tar) 
when configured incorrectly, add spaces rather 
than tabs. Make sure the wordprocessor is 
configured to insert tabs. 

• Text which includes tab characters does not 
automatically wrap around frames. 

Text attributes 

REFERENCE GUIDE 

Xerox Ventura Publisher correctly translates, dis­
plays, and prints text attributes, such as boldface 
and underline, from each wordprocessor supported. 
Similarly, any text attributes added using Xerox Ven­
tura Publisher's Text Editing function are stored 
back in the wordprocessor's native file format. 
However, because Xerox Ventura Publisher can 
create a much wider range of text attributes than any 
wordprocessor, and because combinations of these at­
tributes are treated differently within Xerox Ventura 
Publisher, many attributes are stored back into the 
original file using the codes shown below. For in­
stance, the beginning of medium italic text is set by 
inserting the following directly before the text to be 
italicized: 

<MI> 

In general, attributes native to the wordprocessor, 
such as boldface, when used alone, are translated 
back to the original attribute when a chapter is saved 
in Xerox Ventura Publisher. When used in combina­
tion with other attributes, they are translated back, 
using combinations of the codes shown on the follow­
ing pages. 
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Attribute 

Light weight type 
Medium weight type 
Bold weight type 
Italics 
Underline 
Double underline 
Overscore 
Strikethrough 
Small 
Superscript 
Subscript 

Code 

<L> 
<M> 
<B> 
<1> 
<U> 
<=> 
<0> 
<X> 
<S> 
<"> 
<v> 

Color index <Cnnn> 
Replace nnn with one of the following numbers: 

o White 
1 Black 
2 Red 
3 Green 
4 Blue 
5 Cyan 
6 Yellow 
7 Magenta 
255 Reset to tag color 

Typeface <Fnnn> 
Replace nnn with one ofthe following numbers (if 
additional typefaces have been added, the 
typeface ID assigned during the font addition 
process---explained in Appendix K- is used): 

Courier 1 
Swiss (Helvetica) 2 
Dutch (Times) 14 
New Century Schoolbook 20 
Palatino 21 
Garamond 22 
Bookman 23 
Lubalin 24 
Souvenir 25 
Benguiat 26 
Glyph a 27 
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Friz quadrata 28 
Zapf chancery 29 
Trump Medieval 30 
Melior 31 
Galliard 32 
New Baskerville 33 
Goudy 34 
Park Avenue 35 
Bodoni 36 
Bodoni Poster 37 
Century Old Style 38 
Cheltenham 39 
Helvetica Narrow 50 
Avant garde 51 
Optima 52 
Korinna 53 
Helvetica Light 54 
Helvetica Black 55 
Franklin Gothic 56 
Franklin Gothic Heavy 57 
Helvetica Condensed Light 58 
Helvetica Condensed 59 
Helvetica Condensed Black 60 
American Typewriter 100 
Machine 101 
Prestige Elite 103 
Orator 104 
Letter Gothic 105 
Symbol 128 
ZapfDingbats 129 
Sonata 130 
Reset to tag font 255 

Point Size <Pnnn> 
where the variable nnn is replaced by the type 
size, measured in points (1 point equals 1/72 inch.) 
nnn=255 resets to point size specified by the 
paragraph tag. 

Base Line Jump <Jnnn> 
where the variable nnn is replaced by the amount 
of vertical offset, measured in 1/300 of an inch. 

D-7 



APPENDIX D-TEXT FROM OTHER PROGRAMS 

0-8 

nnn may range from -127 to +127 (about ± 1;2 

inch. The measurement -001 is reserved and used 
to reset the Base Line Jump to zero. 

Begin Kerning <Knnn> 
where the variable nnn is replaced by the amount 
of left horizontal shift, measured in 11700 of an 
inch. nnn may range from -127 to +127. The 
measurement -001 is reserved and used to reset 
the kerning to zero. 

Resume Normal 

~ All attributes are terminated at the end of a para­
graph, even if the Resume Normal character «D» 
is not encountered. Also, all previous attributes are 
terminated any time new attributes are set. 

Examples: 

1) Attributes can be grouped together into sequences. 
For example, to set Bold, Italic, Blue, the code is 
<BIC4>. Any new text attribute sequence encountered 
cancels all previous attributes. 

2) Attributes native to the wordprocessor and the 
codes described on the previous pages can be inter­
mixed. For example to create the following effect 
using Wordstar 

airplane automobile 

where the first word is boldfaced and underlined, and 
the second word is boldface only, would require the 
following within Words tar: 

AUABairplaneAU automobileAB 

This same effect can be produced using the codes 
described on the previous pages as follows: 

<BU>airplane <B>automobile<D> 
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The author can choose either to use the attribute set 
shown above, or continue to place attributes in the 
text using the wordprocessor's own commands. 

Other inserted text 

REFERENCE GUIDE 

In addition to paragraph tags and text attributes, 
Xerox Ventura Publisher also inserts other charac­
ters into the wordprocessor text, including line 
breaks, discretionary hyphens, non-breaking spaces, 
frame anchors, index references and footnotes. These 
are always stored back into the wordprocessor file as 
shown below. Some wordprocessors support discre­
tionary hyphens and non-breaking spaces, in which 
case Xerox Ventura Publisher stores these in the 
wordprocessor's native file format. 

Line Break 

The paragraph will have a line ending placed at the 
location of this code. A line break only begins a new 
line. It does not begin a new paragraph. 

Discretionary Hyphen <-> 

A discretionary hyphen presents an additional 
hyphenation opportunity to Xerox Ventura 
Publisher's hyphenation algorithm. If a word does 
not get placed at the end of a line, no hyphen is 
shown. 

Placing a discretionary hyphen at the beginning of 
the word disables hyphenation for the one occurrence 
of that word. 

Non-Breaking Space <N> 

This places a space at this point, but no break (line 
break, page break, etc) may occur at this point. This 
is used to keep words together on the same line. 
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Thin Space 
Figure Space 
En space 
Em space 

Footnote <$Ftext> 
where text is the footnote text. 

Picture anchor (same page) <$&anchor name> 
anchor name is the frame reference name, as 
specified in the Anchors & Captions option. 

Picture anchor (below) <$&anchor name[v]> 
anchor name is the frame reference name, as 
specified in the Anchors & Captions option. 

Picture anchor (above) <$&anchor name[I\]> 
anchor name is the frame reference name, as 
specified in the Anchors & Captions option. 

Hidden text <$!text> 
where text is the text to be hidden. This text will 
not show in the Xerox Ventura Publisher chapter 

Index 
<$IPrimary[Primary sort];Secondary[Secondary sort]> 

Primary is replaced by the primary index entry; 
Secondary is replaced by the secondary index entry; 
and Primary sort and Secondary sort are 
replaced with the two sort keys. For See references, 
$1 is replaced with $S. For See Also references, $1 is 
replaced with $A. 

If no sort keys are specified, the correct code is: 

<$IPrimary;Secondary> 

If only a primary reference is used, the correct code 
is: 

<$IPrimary> 
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Index references can easily be entered directly into 
your favorite wordprocessor. Simply locate the point 
you wish to index and type the index references. For 
instance, this paragraph was indexed within 
Wordperfect by typing: 

<$IWordprocessor;Developing index in> 

at the beginning of the paragraph. 

Deleting null paragraphs 

ASCII text 

REFERENCE GUIDE 

Each time you press the Enter key when using the 
wordprocessor, you create a new paragraph. If you 
type Enter twice in a row in order to place a blank line 
between paragraphs, Xerox Ventura Publisher 
creates a null paragraph, complete with all the space 
normally placed between paragraphs. If this is not 
desireable, you can delete all extra carriage returns 
by using your wordprocessor to place the following 
tag at the beginning of the text file: 

@PARAFILTR ON = 

This must be added from within your wordprocessor, 
not from within Xerox Ventura Publisher. The extra 
paragraphs will be eliminated the next time you load 
this text file or open a chapter containing the text file. 

This section describes how to produce ASCII text files 
from several popular application programs, and how 
to insert text attributes (boldface, underline, etc.) 
within this text. 

Most wordprocessors, spreadsheets, and database 
programs save information in their own file format, 
usually identified by a unique file extension. For in­
stance, Lotus 1-2-3 saves worksheets in WKS files, 
and dBase III saves databases in DBF files. Text can 
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be moved to and from many of the popular programs 
as standard ASCII text files. You can load ASCII files 
using either the ASCII option or Wordstar option. 
Loading as an ASCII file requires two carriage 
return-line feed combinations to create a new 
paragraph. Loading as a Wordstar file treats single 
carriage returns as a new paragraph. 

Characters not used in ASCII text 

ASCII characters below decimal 32 and above 
decimal 127 do not print. The characters used and 
their decimal equivalents are shown in Appendix E. 
When you are transferring ASCII text from other 
sources, the ASCII codes above decimal 127 will be 
converted into the characters shown in Appendix E, 
if they are enclosed in < > brackets. 

Text from mainframe computers 

Some ASCII files, especially those transferred via a 
communication program to your PC from mainframe 
computers, do not have two pairs of carriage return 
(decimal 13) and line feed (decimal 10) characters at 
the end of each paragraph ([CR][LF][CR][LF].) Addi­
tional carriage returns without a matching line feed 
(or vice versa) will cause unpredictable results. 

Publishing Lotus 1·2·3 spreadsheets 

Lotus 1-2-3 spreadsheets can be saved as ASCII files 
using the PRINT FILE option (IFF.) The file name 
chosen automatically has the extension PRN added. 
However, Lotus 1-2-3 places spaces, not tabs, be­
tween each column and cannot be configured to auto­
matically insert TAB characters between columns. 
Therefore, when using proportionally spaced fonts on 
Xerox Ventura Publisher, the columns will not align, 
unless you manually place tabs between each 
column, as described on the next page. 
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To create a table using a Lotus 1-2-3 print file, first 
set the tab stops for Body Text to the desired posi­
tions. Then, use the Load/Text Pictures option to load 
the 1-2-3 PRN file as a WORDSTAR file. (Because 
each row is separated by a single carriage return, and 
because Xerox Ventura Publisher ignores single car­
riage returns in ASCII text, loading as an ASCII file 
would cause each line to run directly into the next 
line. Xerox Ventura Publisher treats single carriage 
returns as paragraph breaks in Wordstar files.) 

Finally, use the Text Editing function to delete all 
spaces and then insert tabs between each column in 
each row. 

Another solution which doesn't require inserting tabs 
is to select a font (if available with your printer) 
which is not proportionally spaced. For example, 
spreadsheet files can be tagged with Courier font 
(which is not proportionally spaced), and the columns 
will then align properly. Set the Normal Space Width 
in the Typographic Controls option to 1.0 in order to 
get the columns to align perfectly. 

Publishing dBase III data 

Dbase III generates ASCII text using the dBase III 
TO FILE option with commands such as REPORT 
and LABEL. The extension TXT is automatically 
added to the file name you choose. Appendix H con­
tains an application note on how to publish a phone 
directory from dBase III. 

Sidekick note files 
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Sidekick Note Files can be read directly as ASCII 
text. Note, however, that if Sidekick is loaded in 
memory while running Xerox Ventura Publisher, 
performance is degraded. Also, any attempt to ac­
tivate Sidekick will interfere with Xerox Ventura 
Publisher's graphics and cause unpredictable 
results, possibly leading to loss of information. 
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DCA (Displaywrite III and IV) 

Xerox Ventura Publisher can read and write stand­
ard DCA version 2.0 files. Displaywrite III and Dis­
playwrite IV can save and retrieve DCA files. 

Xerox Ventura Publisher automatically converts 
standard DCA text attributes to Xerox Ventura 
Publisher text attributes. 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into DCA using the < > commands outlined 
at the beginning of this chapter. 

Microsoft WordlWindows Write 

0-14 

Xerox Ventura Publisher can read and write stand­
ard Microsoft Word version 3.1 files. Other versions 
of Word may also work. Microsoft Word style sheets 
are not usable by Xerox Ventura Publisher. 

Xerox Ventura Publisher automatically converts 
standard Word text attributes to Xerox Ventura 
Publisher text attributes. 
Attribute 
Begin/End Bold 
BeginlEnd Superscript 
Begin/End Subscript 
Begin/End. Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

MSWord 
Altb 
Alt + 
Alt -
Alts 
Altu 
Ctrl-
Ctrl Spacebar 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Microsoft Word using the < > commands 
outlined at the beginning of this chapter. 
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Wordperfect 
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Xerox Ventura Publisher can read and write stand­
ard Multimate version 3.31 files. Other versions of 
Multimate may also work. 

Xerox Ventura Publisher automatically converts 
standard Multimate text attributes to Xerox Ventura 
Publisher text attributes. 
Attribute 
Begin/End Bold 
BeginlEnd Superscript 
BeginlEnd Subscript 
Begin/End Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

Multimate 
AltZ 
AltQ 
AltW 
AltQ 
Shift 
Shift F7 
Alt S 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Multimate using the < > commands out­
lined at the beginning of this chapter. 

Xerox Ventura Publisher can read and write stand­
ard Wordperfect version 4.1 or 4.2 files. Other ver­
sions of Wordperfect may also work. 

Xerox Ventura Publisher automatically converts 
standard Wordperfect text attributes to Publisher 
text attributes. 
Attribute 
Begin/End Bold 
BeginlEnd Superscript 
Begin/End Subscript 
Begin/End Strikethrough 
Underline 
Discretionary Hyphen 
Non Break Space 

Wordperfect 
F6 
Shift F1, 1 
Shift F1, 2 
AltF5,4 
F8 
Ctrl, -
Home, Space bar 
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Wordstar 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Wordperfect using the < > commands 
outlined at the beginning of this chapter. 

Xerox Ventura Publisher can read and write stand­
ard Wordstar 3.3, 3.4 and 4.0 files. Other versions of 
Wordstar may also work. 

Xerox Ventura Publisher automatically converts 
standard Wordstar attributes to Xerox Ventura 
Publisher text attributes. 
Attribute 
Start/Stop Bold 
Start/Stop Superscript 
Start/Stop Subscript 
Start/Stop Strikethrough 
Start/Stop Underline 
Discretionary Hyphen 
Non Break Space 

Wordstar 
AB 
AT 
AV 
AX 
AS 
Soft hyphen 
AO 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Wordstar using the < > commands out­
lined at the beginning of this chapter. 

Foreign characters entered in Wordstar 3.4 which 
are not available in both the Xerox Ventura Publisher 
and the IBM character set will not display or print. 

Wordstar tabs 

0-16 

When you press the tab key, Wordstar does not al­
ways place a tab character into the text, but instead 
inserts multiple spaces. As described earlier in this 
chapter, Xerox Ventura Publisher requires the actual 
tab character in order to correctly format tabular in­
formation. To assure that Wordstar inserts real tab 

REFERENCE GUIDE 



Xerox Writer 

Xywrite 
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characters, turn the Vari-Tab feature within 
Wordstar Off. 

Xerox Ventura Publisher can read and write stand­
ard Xerox Writer version 2.0 files. 

Xerox Ventura Publisher automatically converts 
standard Writer text attributes to Xerox Ventura 
Publisher text attributes. 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Xerox Writer using the < > commands 
outlined at the beginning of this chapter. 

Xerox Ventura Publisher can read and write stand­
ard Xywrite II and Xywrite III files. 

Xerox Ventura Publisher automatically converts 
standard Xywrite text attributes to Xerox Ventura 
Publisher text attributes. 

All other attributes, attribute combinations, foot­
notes, index references, and text characters must be 
entered into Xywrite using the < > commands out­
lined at the beginning of this chapter. 
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Xerox Ventura Publisher includes two character sets: 

• An international character set which includes 
characters for many languages, including 
English, Spanish, French, and Italian 

• A symbol character set which includes 
mathematics and greek characters which can 
be used for simple formulas and equations. 

Not all ofthese characters can be typed directly from 
the keyboard. Characters not available on your key­
board can be entered by holding down the ALT key 
and then typing the Decimal equivalent for that 
character on the numeric keypad. The tables on the 
following pages show these decimal equivalents. 

When using your word processor to enter foreign 
characters and other characters above decimal 127, 
you must enter these characters by using the < > 
codes, as explained in Appendix D. For wordproces­
sors which support foreign characters, Xerox Ven­
tura Publisher will accept these characters without 
placing numbers inside of < >. However, the decimal 
equivalent of these characters must be less than 169. 
Also, the foreign characters in your wordprocessor 
must have the same decimal equivalents as those 
shown on the following pages. 

For users of the Apple Laserwriter Plus and other ad­
vanced PostScript printers, dingbat characters are 
shown in the following table. Dingbats do not display 
on the screen unless you purchase matching screen 
fonts from Adobe Systems. (The international char­
acter set displays instead.) They will print, however, 
if you own an advanced PostScript printer. (Dingbats 
are not provided with Xerox Ventura Publisher.) 
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pn. Inter- Sym- Ding- fui. Inter- Sym- Ding-
mal nat'l hoI hat mal nat'l hoI hat 
1-31 not used 63 ? ? t 
32 space space space 64 @ - ffi 

33 ! , :;,.- 65 A A ¢ 

34 " '\I :?< 66 B B + 
35 # # ~ 67 C X + 
36 $ ::J ~ 68 D ~ + 
37 % % 1l" 69 E E + 
38 & & (f) 70 F <I> • 39 , 

.3 ® 71 G r <r-
40 ( ( '* 72 H H * 41 ) ) [!;J 73 I I * 42 * * c .. 74 J ~ 0 
43 + + ~ 75 K K * 44 , , ~ 76 L A '* 45 - - b 77 M M .. 
46 ~ 78 N N '* 47 / / ©> 79 0 0 *" 48 0 0 ~ 80 P II ~ 

49 1 1 ~ 81 Q 8 * 50 2 2 * 82 R P * 51 3 3 .! 83 S L * 52 4 4 V 84 T T * 53 5 5 X 85 U y * 54 6 6 • 86 V ~ * 55 7 7 X 87 W Q * 56 8 8 )( 88 X ';:;' 

* ...... 

57 9 9 + 89 Y 'P • 58 . + 90 Z Z * 59 , , + 91 [ [ ~# ,-
60 < < -:- 92 \ . 

* . . 
61 = = t 93 ] ] * 62 > > 11 94 A .1 ¥ 
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Deci- Inter- Sym- Ding- Deci- Inter- Sym- Ding-
mal nat'l bol bat mal nat'l hoI bat 
95 - 0 127 
96 

, 
<£> 128 C 

97 a a 0 129 ii Y ~ 
98 b 13 0 130 e , • • 
99 c X * 131 a ~ • • 

100 d () * 132 a / • 
101 e E 3$ 133 a 00 • 102 f <I> * 134 0 

f ~ a 
103 K :t ~~ 135 C oJ, ~ 

104 h 11 * " , 136 e • + 
105 1 t * 137 e • • 106 j <P ~* 138 e • ., 
107 k K * 139 1: H ~ 

108 1 A • 140 ]' ~ CD 
109 m J..l 0 141 1 i @ 

110 n v • 142 A --* @ 

111 0 0 0 143 A -!- @ 

112 p 1t 0 144 E 0 @ 

113 q e 0 145 re ± ® 
114 r p 0 146 JE " ® 
115 s cr .. 147 0 ~ ® 
116 t 't T 148 0 x ® 
117 u '\) • 149 <> oc ~ 

118 v m .:. 150 U a 0 
119 w (0 , 151 U • @ 

120 x ~ I 152 Y + 8) 

121 y \If I 153 6 *- 0 
122 z ~ I 154 tJ - () 

123 { { • 155 ¢ ;:::; <D 
124 I I ~ 156 £ ... f; 

125 } } " 157 ¥ / ~ 

~26 - - ~ 158 0 - Q) 
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JJeri.. Inter- Sym- Ding- ~ Inter- Sym- Ding-
mal nat'l hoI hat mal nat'l hoI hat 
159 .f .J f]) 191 TM JJ, ,,'* 

160 a ~ G) 192 " 
0 III. 

161 i 5 (g) 193 ... ( -162 6 9t ® 194 %0 ® ~ 

163 U fJ @ 195 • © > 
164 fi ® @ 196 - TM ~ 

165 N EB ® 197 - L .. 
166 !! 0 (f) 198 0 ( ,.. 
167 Q n ® 199 A I • 168 l u ® 200 A l • 
169 " => @ 201 E I c::) 

170 " => 0 202 E I <> 
171 < ct. f} 203 E L ~ 

172 > c 8 204 I r ~ 

173 i c 0 205 f i 0 

174 « E 0 206 I l L) 

175 » E (3 207 I I 0 

176 Ii L 0 208 0 
177 6 V 0 209 6 ) 0 

178 0 ® CD 210 0 J :) 

179 ~ © @ 211 S ( »l» 

180 00 TM -+ 212 S I .,. 
181 (E IT -+ 213 U J :»+ 

182 A ~ +--+ 214 U 1 ~ 

183 A t 215 U I ~ 

184 6 -, ...... 216 Y ) »+ 

185 § 1\ -+ 217 B l .. 
186 :j: v .If 218 Z 
187 t ¢::> ~ 219 
188 'II <= .. 220 
189 © 11 --t 221 
190 ® :::::> ..... 222 
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Text codes 

The following table is provided for quick reference. A 
complete description of the text codes is provided in 
Appendix D. 

Description 

Text attributes 
Base Line Jump 
Begin Kerning 
Bold weight type 
Color index . . 
Double underline 
Italics . . . . 
Light weight type 
Line Break 
Medium weight type 
Non-Breaking Space 
Overscore 
Point Size 
Resume Normal 
Small 
Strikethrough 
Subscript 
Superscript 
Underline 
Spaces 
Em space 
En space 
Figure Space 
Thin Space 
Typeface 
Inserted text 
Discretionary Hyphen 
Footnote ..... 
Hidden text . . . . 
Picture anchor (below) 
Picture anchor (same page) 
Picture anchor (above) 
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Code 

. <Jnnn> 
<Knnn> 
.. <B> 
<Cnnn> 

<=> 
<1> 
<L> 
<R> 
<M> 
<N> 
<0> 

<Pnnn> 
<D> 
<S> 
<x> 
<v> 
<A> 
<u> 

<-> 
<-> 
<+> 
<I> 

. <Fnnn> 

<-> 
<$Ftext> 

. <$Htext> 
<$&anchor name[ v]> 
. <$&anchor name> 

<$&anchor name[ A]> 
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PRINTER INFORMATION 

This appendix provides information about how the 
features of your particular printer work with Xerox 
Ventura Publisher. Detailed set up and configuration 
information is also provided. Information on how to 
add additional fonts to your printer is provided in Ap­
pendix K. 

Speed, resolution, maximum picture size, character 
set, and dead space at the edge of the page are dif­
ferent for each printer. To see the limitations of your 
printer, open the chapter called CAPABILI and 
print. 

IEF Check the section within this chapter that pertains 
to your printer for information on limitations of your 
printer. 

IEF On printers which do not use a page description lan­
guage (e.g., PostScript), the fonts which appear in 
line art can only be the discrete sizes. Therefore, 
when the picture is scaled, the fonts may be slightly 
too large or slightly too small for the picture. Solu­
tion: Make the picture slightly larger or smaller. 

Printer troubleshooting 

REFERENCE GUIDE 

The following general troubleshooting guidelines 
apply to all printers. 

If you can't get anything to print, first try press­
ing the self test button on the printer, if your printer 
has one, to see if the basic printer mechanism is 
working. This causes the printer to print one page, 
filled with individual characters. If nothing happens 
in this self-print mode, consult your printer manufac­
turer or dealer for further help. 
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Ifthe printer has just been installed, and doesn't 
print correctly using other software, the problem 
may very well be the printer cable. Disconnect the 
cable from the printer and count the number of pins. 
If the connector has 36 pins, it is a parallel cable, 
and the cable is probably not the cause of your 
problems. If the connector has 25 pins, it is a serial 
cable, and you may not have the correct cable. Many 
people try to connect the laser printers to their com­
puter with a standard serial cable that has the right 
set of connectors, but is not wired as required by a 
laser printer. Both the HP LaserJ et and Apple Laser­
Writer use similar cables. The correct wiring 
diagrams for these cables are shown in the section for 
each printer, along with manufacturer's part num­
bers. Also, check the printer configuration switch set­
tings. 

If the printer prints correctly from other 
programs, but does not print from Xerox Ventura 
Publisher, you have probably specified the wrong 
printer or wrong printer port during installation. 
Select the Printer Info option in the Options menu, 
and try a different printer or printer port. The 
printer selection is shown at the top of the Dialog 
Box. The printer port is shown on the Output To: 
line. If, in the test above, you found a 25 pin cable, 
you can select between printer ports COM1: and 
COM2:. If, in the test above, you found a 36 pin cable, 
you can select between LPT1:, LPT2:, and LPT3:. 
Try printing one page with each ofthese options until 
the page prints correctly. The configuration switch 
settings within the printer should also be examined. 
Different programs work with different switch set­
tings from those required for Xerox Ventura 
Publisher. Check the section within this chapter that 
pertains to your printer for information on the cor­
rect switch settings. Also, check the CONFIG.SYS 
file. Certain device drivers such as GEMPRINT.8YS 
will keep Xerox Ventura Publisher from printing cor­
rectly. These must be removed. 
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Xerox 4045 laser printer 

Xerox 4045-Paper Size 

The 4045, when driven by Xerox Ventura Publisher, 
handles 8.5 X 11 inch, 8.5 X 14 inch, and A4 (21.0 X 
29.7 centimeters) paper. You can always print a 
smaller page on a larger paper size by increasing the 
page margins in the Margins & Columns option. 

The 4045 cannot print to the edge of the page. This 
means that text and pictures placed near the edge of 
the page will show correctly on the computer screen, 
but may not print as displayed. Remember, there­
fore, to set a large enough margin using the Margins 
& Columns option in the Frame menu. To see the 
amount of blank space around the edge of the page, 
print the CAPABILI.CHP chapter in the TYPESET 
directory 

Xerox 4045 configuration switches 

REFERENCE GUIDE 

The 4045 configuration switches are found on the 
101S04200 Cartridge. The settings for various con­
figurations are shown in Figures F-1 through F-4. 
The switch settings to use depend upon: 

• Whether your printer is connected with a 
parallel or serial cable 

• Amount of memory installed (450K or 1.5 
megabytes) 

• 4045 ROM revision 

The Bytes Available (memory installed) and ROM 
revision # is printed on the 4045 Configuration 
Sheet shortly after the machine is first turned on. 

At least 450K bytes of DRAM and ROM revision 2.x 
or above must be installed in the 4045 in order to 
print Xerox Ventura Publisher documents. Installing 
even more DRAM allows larger pictures to be 
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Figure F-1 Xerox 4045 switch settings for version 2.0, 450K RAM, 
parallel interface. Turn DB OFF for version 2.1 ROM . 
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Figure F-2 Xerox 4045 switch settings for version 3.1.1, 1.5M RAM, 
parallel interface 
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Figure F-3 Xerox 4045 switch settings for version 2.0, 450K RAM, 
serial interface 

•• •• • •• 
•••••• •• • 

876 5 4 3 2 1 876 5 4 3 2 1 

B A OFF 

t D C ON 

• •• • •• • • 
• • •• • • • • 
8 7 6 5 4 3 2 1 876 5 4 3 2 1 

Figure F-4 Xerox 4045 switch settings for version 3.1.1, 1.5M RAM, 
serial interface 
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printed. At least 1.0 megabytes of DRAM and 
revision 3.x must be installed to use the 300 dpi 
driver. 

The Xerox 4045 Laser Printer can be set up as either 
a parallel or serial printer. To use it as a serial 
printer, consult your 4045 manual, and set the 4045 
cartridge switches as shown in either Figure F-3 or 
F -4, depending on which ROM version and memory 
is installed. 

Xerox 4045-Resolution 

Xerox Ventura Publisher lets you print both text and 
pictures on your 4045. Text prints with a resolution 
of300 dots per inch, and pictures print with a resolu­
tion of 150 or 300 dots per inch, depending on which 
driver is installed. 

Xerox 4045 fonts 

The 4045 prints most of the Xerox Ventura Publisher 
character set shown in Appendix E. Print the 
CHARSET.CHP chapter (in the TYPESET direc­
tory) to see what characters the 4045 can print. 

The following is a complete list of sizes and weights 
available for each 4045 typeface: 

Typeface Sizes 

Courier (not proportionally spaced) 

• 12 point medium (10 characters to the inch) 

Swiss (Helvetica) san-serif 

• 6, 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14,18,24 point bold 
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Dutch (Times Roman) serif 

• 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14,18,24 point bold 

Symbol (greek, mathematics) 

• 10 point medium 

These fonts are loaded by Xerox Ventura Publisher 
into the 4045 as needed for each page. The space 
taken by these fonts decreases the space available for 
pictures. If a page contains many big pictures, and a 
large number of different fonts, especially larger size 
fonts, the 4045 runs out of memory and prints an 
error page. The remaining pages should print cor­
rectly, unless a similar problem exists on those pages. 

To correct the problem, do one of the following: 

~ Select the 150 dpi driver instead of the 300 dpi 
driver. (If the 150 dpi driver is not already in­
stalled, use VPPREP, as described in the Setup 
and Installation section.) 

~ If this doesn't work, reduce the size or number of 
fonts used on the problem page. 

~ If this doesn't work, reduce the number or size of 
pictures on the problem page. 

Additional type sizes and type faces can be added. 
See Appendix K 

Limitations 

REFERENCE GUIDE 

Pictures which contain text which is rotated at an 
angle to the text on the page will not print correctly. 

The 4045 cannot print white text on a black back­
ground. 

A maximum of four images is allowed per page. 
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Xerox 4020 color ink jet printer 

Xerox Ventura Publisher can print color documents 
directly on the Xerox 4020 Color Ink Jet Printer. Up I 

to eight colors can be printed. 

Xerox 4020 color ink jet printer-Paper size 

I Xerox Ventura Publisher can print to a Xerox 4020 
Color Ink Jet Printer on 8.5 inch wide paper. 

Xerox 4020 Color Ink Jet Printer-Switch settings 

I The 4020 switch settings required for proper opera­
tion are shown in Figure F -5. 

Xerox 4020 color ink jet printer-Resolution 

Xerox Ventura Publisher lets you print both text and 
pictures on your Xerox 4020 Color Ink Jet Printer . 
Both text and pictures print at a resolution of 120 
dots per inch. 

OFF ••• •• • ••• t • 
7 6 5 4 

B 

F-8 

• ON 
3 2 1 4 3 2 1 

A 

Figure F-5 Xerox 4020 switch settings. Settings are 
for parallel interface. 
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Xerox 4020 color ink jet printer fonts 

Not all characters shown in Appendix E are available 
on the Xerox 4020 Color Ink Jet Printer. Print the 
chapter called CHARSET (contained in the 
TYPESET directory) to see which characters are 
available. The typefaces available are Helvetica and 
Times Roman, in the following sizes: 

• 8 point normal; 10, 14 point normal, bold, 
italic; 18, 20, 28, 36 point bold 

Limitations 

You cannot create new colors by overlapping two 
transparent graphics. The colors will not mix. 

Greek and math symbol characters are not available. 

HP LaserJet, LaserJet Plus, LaserJet II 

The first part of this section refers to the LaserJet 
and LaserJet Plus. The last parts refer to the stand­
ard LaserJet only, or the LaserJet Plus only. The 
LaserJet II functions identically to the LaserJet 
Plus. 

HP LaserJetlLaserJet Plus-Cabling 

REFERENCE GUIDE 

The HP LaserJet is sold by Hewlett-Packard with a 
serial (25 pin) interface. The HP LaserJet Plus is 
sold with a serial or parallel (36 pin) interface. The 
cable required for the parallel interface is HP part 
number 24542D. The HP part number for the RS-
232C serial cable is part number 92219J (5.0 meters) 
or 17255D (1.0 meter.) Connection of this serial cable 
to the IBM AT (9 pin) requires the IBM Serial Device 
Adapter Cable (IBM part number 6450217 or 
6450242.) For the IBM AT (9 pin) you can alternative­
ly purchase a single cable from Hewlett-Packard, 
part number 24542G. 
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Computer 25 pin to 25 pin 
Adaptor Cable 

Printer 

FemO. Co,_, M.. Co"",,, M 
• ."~~I_=~ 

Female Connector 

Chassis Gnd 
TO 

1-

2 -------------
RD 3----­

Male Connector 

1 Chassis Gnd 

3 RD 
2TO 

CTS 
DSR 

~ -.::J ------------ 20 DTR 

Signal Gnd 7 -------------------- 7 Signal Gnd 

Figure F-6 HP Laserjet 25 pin to 25 pin cable 

Computer Printer 

Female Male Female Male 

9 pin to 25 pin 
Adaptor Cable 

Female' Mal 
Chassis Gnd NC--------- 1 

TO 3----- -- 2 

RD 2----- --- 3 
CTS 8----- --- 5 
DSR 6 6 

25 pin to 25 pin 
Printer Cable 

Female Male 
1---- Chassis 
2 ---- 3 RD 
3 ---- 2 TO 

~.::J 
--- 20 DTR 

Gnd 

Signal Gnd 5 - ------- 7 7 --------- 7 Signal Gnd 

Figure F-7 HP Laserjet 9 pin to 25 pin cable 

If you want to build your own cables, Figures F-6 and 
F -7 show the correct wiring diagram for both PC (25 
pin connectors) and AT (9 pin) machines. 
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HP LaserJetlLaserJet Plus-Paper size 

Xerox Ventura Publisher and the HP LaserJet 
handles 8.5 X 11 inch, 8.5 X 14 inch, and A4 (21.0 X 
29.7 centimeters) paper. However, the LaserJet can­
not print to the edge of the page. This means that text 
and pictures placed near the edge of the page will 
show correctly on the computer screen, but may not 
print as displayed. Remember, therefore, to set a 
reasonable margin using the Margins & Columns 
option in the Frame menu. 

To see the amount of blank space around the edge of 
the page, print the CAPABILI.CHP chapter in the 
TYPESET directory 

HP LaserJetlLaserJet Plus-Configuration switches 

Xerox Ventura Publisher requires that the internal 
configuration switch be set to the original factory set­
tings. For the serial interface, the switch SW1 set­
tings are 1-0FF, 2-0N, 3-0FF, 4-0N, 5-0FF, 6-0FF, 
7-0FF, 8-0N. For the parallel interface, the settings 
are 1-0N, 2-0N, 3-0FF, 4-0N, 5-0FF, 6-0FF, 7-0FF, 
8-0N. 

HP LaserJetlLaserJet Plus-Resolution 

With both LaserJet models, text prints with a resolu­
tion of300 dots per inch. With the standard LaserJet, 
pictures and graphics print with a resolution of 75 
dots per inch. With the LaserJet Plus, pictures print 
with a resolution of either 150 or 300 dots per inch, 
depending on which Xerox Ventura Publisher option 
you installed. Text within line art pictures print at 
either 300 dots per inch, depending on the text size. 

Standard HP LaserJet 

REFERENCE GUIDE 

The standard HP LaserJet only prints Xerox Ventura 
Publisher documents with the HP 92286F font 
cartridge installed. It does not accept the downloaded 
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fonts that are included with Xerox Ventura Publisher 
for the LaserJet Plus. The characters available with 
this cartridge are a subset ofthe standard Xerox Ven­
tura Publisher font set shown in Appendix E. The ac­
tual characters available can be shown by printing 
the CHARSET chapter located in the TYPESET 
directory. The math symbol set is not included in this 
cartridge. 

HP LaserJet Plus 

The HP LaserJet Plus uses the downloadable fonts 
supplied with Xerox Ventura Publisher. Xerox Ven­
tura Publisher ignores the HP font cartridges when 
printing to the LaserJet Plus. The character set for 
the HP LaserJet Plus is the same as shown in Appen­
dix E, and is available in the following typefaces 
weights and sizes: 

Typeface Sizes 

Courier (fixed pitch) 

• 12 point (10 characters to the inch) medium 

Swiss (Helvetica) san-serif 

• 6, 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14, 18, 24 point bold 

Dutch (Times Roman) serif 

• 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14,18,24 point bold 

Symbol (greek, mathematics) 

• 10 point medium 
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Fonts are loaded by Xerox Ventura Publisher into the 
HP LaserJet Plus as needed for each page. The space 
taken by these fonts decreases the space available for 
pictures. If a page contains many big pictures, and a 
large number of different fonts-especially larger 
size fonts-the LaserJet runs out of memory and dis­
plays error 20 in the status display. To continue 
printing, press the CONTINUE button on the front 
of the LaserJet, and place the printer back on-line, if 
necessary. The LaserJet attempts to print at least a 
portion of the page. Unless a similar problem exists 
on the following pages, the remaining pages should 
print correctly. 

Once an error 20 has occurred, you must simplify the 
page that caused the problem in order to print the 
problem page. To simplify the page, do one or more of 
the following: 

~ Reduce the size or number of fonts used on the 
problem page 

~ Reduce the number or size of pictures on the 
problem page 

~ Make sure that no other program, run prior to 
Xerox Ventura Publisher, downloaded fonts and 
made them "permanent". If this is the case, these 
fonts, which are not used by Xerox Ventura 
Publisher, reduce the LaserJet memory space 
available to print each page. To remove permanent 
fonts, tum off the LaserJet and then tum it back 
on again. 

If you installed for 300 dots per inch, and you fre­
quently encounter the error 20 message, you may 
want to install both the 150 and 300 dot per inch 
drivers (to install both drivers, run VPPREP-see 
Setup and Installation.) You can then choose the 
150 dot per inch HP LaserJet Plus option in the Set 
Printer Info option and print the problem pages. This 
doubles the size of the graphic that can be placed on 
any given page before an error 20 message will occur. 
When the page has printed, you can go back to the 
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Set Printer Info menu and choose the 300 dot per 
inch HP LaserJet driver. 

Permanent fonts 

You can choose to download fonts to the HP LaserJet 
Plus prior to running Xerox Ventura Publisher. This 
reduces printing time by eliminating the need to 
transfer font files to the printer during the print 
operation. However, it does increase the chance of 
getting an out of memory error message. 

To make fonts reside permanently in the HP Laser­
Jet Plus: 

~ Download the fonts to the printer prior to running 
Xerox Ventura Publisher (use the utilities sup­
plied by HP) and make them permanent (i.e., fonts 
cannot be removed except by turning the printer 
off) 

~ Record the HP font ID number for each font 
downloaded 

~ Create an ASCII file which associates each font ID 
number with each font. Save this file under the 
name HPLJPLUS.CNF and store it in the VEN­
TURA directory. 

~ Select the AddlRemove Fonts option. Change each 
font (i.e., each combination of face, size, and style) 
which has been pre-downloaded from Download 
to Resident. 

The format for each entry in the CNF file is: 

permfont(n FONT) 

where n is replaced with the HP font ID number 
created with the HP utilities and font is replaced 
with the font file name. For example: 

permfont(l CENTURY.SFP) 
permfont(2 CENTURY.SFL) 

The word permfont must be in lower case. 
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JLaser 

~ If you save the changes made in the AddlRemove 
Font option, the fonts must always be resident in 
your printer prior to running Xerox Ventura 
Publisher. 

Additional type sizes and type faces can be added. 
See Appendix K. 

Limitations 

Pictures which contain text which is rotated at an 
angle to the text on the page will not print correctly. 

The HP LaserJet Plus cannot print white text on a 
black background. 

The HP LaserJet Plus can print a maximum of four 
images per page. 

The HP LaserJet Plus cannot print Courier fonts in 
landscape orientation. 

The Tall Tree System's JLaser board plugs into your 
computer and lets you print Xerox Ventura Publisher 
documents on laser printers not specifically sup­
ported by Xerox Ventura Publisher. For the current 
list of laser printers and compatible computers, con­
tact Tall Tree Systems at 1120 San Antonio Road, 
Palo Alto, California, 94303. 

JLaser-Paper size 

The JLaser can print on paper up to 8.5 X 14 inches. 
However, the JLaser cannot print to the edge of the 
page. The actual characters available can be shown 
by printing the CHARSET chapter located in the 
TYPESET directory. 
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JLaser-Resolution 

I Text and pictures print with a resolution of 300 dots 
per inch. 

JLaser fonts 

The character set for the JLaser is the same as shown 
in Appendix E, available in the following typefaces, 
weights and sizes: 

Typeface Sizes 

Swiss (san-serif) 

• 6, 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14,18,24 point bold 

Dutch (serif) 

• 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14,18,24 point bold 

Symbol (greek, mathematics) 

• 10 point medium 

These fonts are loaded by Xerox Ventura Publisher 
as needed for each page. Additional type sizes and 
type faces can be added. See Appendix K. 

The JLaser card creates each page in an un-com­
pressed, bitmap format. This means that each page 
is represented by a one megabyte file which is trans­
ferred directly from the JLaser card to the printer at 
extremely fast, video speeds. While this results in 
very fast printing, the fact that each page takes up 
one megabyte makes storage of each page on disk im­
practical. Therefore, no Print To File option is avail­
able for the JLaser card. 
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No error message is given when the JLaser printer 
runs out of paper. It simply stops printing until you 
put more paper in the tray. 

JLaser limitations 

The JLaser card requires that certain jumpers on the 
card be installed correctly, and the DEVICE=\S 
statement be placed in the CONFIG.8YS. If only por­
tions of the page print, or if the page contains 
horizontal white lines, these configuration settings 
may be conflicting with your computer's display or 
disk drive. Contact Tall Tree Systems in Palo Alto, 
California for information on how to reconfigure the 
JLaser card to avoid these problems. 

Dot matrix printers 

Xerox Ventura Publisher supports the Epson MX-80, 
FX-80, and RX-80 dot matrix printers, and the IBM 
Proprinter. The Epson LQ 1500 and Hewlett-Pack­
ard Thinkjet print legible text and pictures, but in 
the wrong aspect ratio. 24 pin printers are not sup­
ported. 

Dot matrix printer-Paper size 

Xerox Ventura Publisher can print to a dot matrix 
printer on 8.5 X 11 inch paper. Dot matrix printers 
having a larger width paper capacity can also be 
used, but only 8.5 X 11 inch (Letter) printing is sup­
ported. 

Dot matrix printer-Resolution 
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Xerox Ventura Publisher lets you print both text and 
pictures on your dot matrix printer at a resolution of 
120 X 144 dots per inch. 
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Dot matrix printer fonts 

The character set for dot matrix printers is the same 
as shown in Appendix E, and is available in Helvetica 
and Times Roman fonts, in the following sizes: 

• 8 point normal; 10, 14 point normal, bold, 
italic; 18, 20, 28, 36 point bold 

Greek and math symbol characters are not available. 

The font height is different when text is printed in 
landscape rather than portrait. A maximum of four 
images per page is allowed. 

PostScript, Interpress 

F-18 

Xerox Ventura Publisher can print on various Post­
Script and Interpress printers and typesetters. Post­
Script printers include the Apple LaserWriter and 
LaserWriter Plus; TI Omnilaser, DEC PrintServer 
40, IBM 4216 printer; Dataproducts LZR 2660 and 
LZR 2665 laser printers; QMS PS 800, 1200, and 
2400 laser printers; and the Linotype Linotronic 100, 
300 typesetters. Interpress printers include the 
Xerox 2700 and 9700 printers. 

Resolution 

Fonts 

Text and graphics print at different resolutions, de­
pending on the capability of the specific device. For 
instance, you will get 300 dots per inch resolution 
with the laser printers listed above, 1270 dots per 
inch for the Linotronic 100, and 2540 dots per inch 
for the Linotronic 300. 

The actual characters available can be shown by 
printing the CHARSET chapter located in the 

. TYPESET directory. 
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~ You can't print all fonts shown in the PostScript font 
menus unless you purchase new fonts from Adobe 
Systems. 

For your reference, the following fonts come standard 
with the Apple Laserwriter: Helvetica, Times 
Roman, Symbol, Courier. Adding new fonts is covered 
in Appendix K. 

Cabling 

Any PostScript printer or typesetter can be con­
nected directly to an IBM PC (or equivalent) using 
the same RS-232C cable used for the HP LaserJet. 
This cable can be purchased from Hewlett-Packard. 
The HP part number for the RS-232C serial cable is 
part number 92219J or 17255D. Connection of this 
serial cable to the IBM AT (9 pin) requires the IBM 
Serial Device Adapter Cable (IBM part number 
6450217 or 6450242.) Some devices (such as the 
Linotronic typesetters) may require a different sex 
connector at the printer end than provided with the 
HP cable. In this case you must build your own cable. 

If you want to build your own cables, Figures F-8 and 
F -9 show the correct wiring diagram for both PC (25 
pin connectors) and AT (9 pin) machines. 

If the cable is not wired correctly, you will get an error 
message on your computer screen when you attempt 
to print. 

The baud rate switch on the PostScript printer 
should be set to 9600 baud. 

Cabling for Interpress printers is shown in the in­
struction manuals for these printers. 

Printing a PostScript or Interpress file 
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You may find it useful to print to a disk file and then 
later send this disk file to the printer or typesetter. 
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Figure F-8 Apple Laserwriter 25 pin to 25 pin cable 
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Figure F-9 Apple Laserwriter 9 pin to 25 pin cable 
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The method for doing this is covered in the Set 
Printer Info section of the Menu Commands chap­
ter. 

Printing over an Apple network 

If the PostScript file is to be printed via an Apple 
network, use the ASCII function in your wordproces­
sor to modify the POSTSCPT.CNF file, located in the 
VENTURA directory. Change the line which says: 

eoftype(PC) 

to: 

eoftype(MAC) 

This suppresses the printing of AD characters which 
are read by Apple network software as an end of file 
character. The POSTSCPT.CNF file must be 
modified prior to printing the PostScript file. 

Reducing PostScript file size 

PostScript files can become quite large when print­
ing pages which contain images. To reduce the size of 
this type of PostScript file, use the ASCII function of 
your wordprocessor to add the following line to the 
POSTSCPT.CNF file: 

irngtype(COMPACT) 

It may take much longer to print this file, but the file 
usually be smaller. 

Downloadable fonts 
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Standard fonts, such as Helvetica and Times Roman 
are resident in all PostScript printers. However, 
Xerox Ventura Publisher lets you use additional 
fonts which are stored on the computer hard disk. 
(See Appendix K, and see the AddlRemove Fonts op-
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tion.) These fonts should be stored in a directory 
called \PSFONTS (for PostScript.) If you want to 
place these fonts in a different directory, use the 
ASCII text function of your wordprocessor to modify 
the POSTSCPT.CNF file in the VENTURA subdirec­
tory. 

For instance to place PostScript fonts in a directory 
called MYFONT, modify the POSTSCPT.CNF file to 
read: 

psfonts(C: \MYFONTS\) 

PostScript prologue 

At the beginning of every PostScript print operation, 
Xerox Ventura Publisher sends subroutines 
(prologue) to the printer. These subroutines are con­
tained in the file called PS2.PRE. Advanced users 
may want to load these subroutines permanently 
into the printer or typesetter and thus avoid the time 
required to load the prologue. To do this: 

>- Copy the file called PERMVP.PS (which contains 
the permanent version of these subroutines) from 
the POSTSCPT directory on the Utility Disk to the 
VENTURA directory. 

>- Download this file to your printer by using the 
DOS COPY command as described in the Set 
Printer Info option for the DTR.TXT file. Unlike 
DTR.TXT, however, this file must be downloaded 
each time your printer is turned on. 

>- Delete the PS2.PRE file from the VENTURA 
directory. 

~ When creating PostScript files (by printing to a file) 
to be printed on another printer or typesetter, always 
include the prologue (i.e., do not delete the PS2.PRE 
file.) 
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Ruling line around images 

Because PostScript cannot print transparent over­
lapping images, a ruling box around an image will 
not print. The solution is to set the frame margins 
equal to the overall ruling box height. 

PostScript bug 
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Version 23 of PostScript implemented for the Apple 
LaserWriter below version 2 had a communications 
handling error described by Adobe Systems Incor­
porated as follows: 

"During serial input, if the input buffer becomes full 
and the Apple LaserWriter sends XOFF to stop trans­
mission from the host, it occasionally fails to send 
XON to restart transmission ... This bug occurs only 
under unusual circumstances that are difficult to 
describe ... " 

This bug does not generally manifest itself on small 
jobs consisting of several pages. However, when more 
than twenty pages are printed as a single job, the 
computer may lock up. Reason: The PC will be wait­
ing for the LaserWriter to indicate that it is ready for 
input, but the LaserWriter will believe it has already 
made that indication. 

Adobe Systems, Incorporated has released a 
downloadable patch which fixes this bug. The patch 
is provided in the file called PSt.PRE. This file is 
contained in the Utilities Disk in the POSTS CPT 
directory. To use this patch, simply copy this file from 
the Utilities Disk to the VENTURA directory. Xerox 
Ventura Publisher automatically sends this patch to 
the printer each time you print a chapter. 
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AST TurboLaser and Cordata printers 

F-24 

The AST TurboLaser and Cordata printers are con­
nected directly to the computer with their own 
cables. They print at 300 dpi for both text and 
graphics. Follow the installation instructions which 
come with each printer for important information 
about modifications to the AUTOEXEC.BAT and 
CONFIG.SYS files. 

For both the AST TurboLaser and Cordata printers, 
select serial port number 1 (or serial port 2 if the 
mouse is connected to port 1) during VPPREP. 

For the Cordata printer, you should place the follow­
ing command in the CONFIG.SYS file, using the 
ASCII text function of your wordprocessor: 

DEVICE=LLD.syS 

Also, for the Cordata printer, the RIM.EXE program 
should be run prior to running Xerox Ventura 
Publisher. 

For the AST TurboLaser, execute the following com­
mand prior to running Xerox Ventura Publisher: 

LPLOAD COMn ASTLASER.LNG 

where n is replaced with 1 or 2 depending on which 
COM port you installed during VPPREP. 

AST TurboLaser and Cordata Fonts 

The character set for the AST TurboLaser and Cor­
data printers is the same as shown in Appendix E, 
available in the following typefaces, sizes: 
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Typeface Sizes 

Swiss (san-serif) 

• 6, 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14, 18, 24 point bold 

Dutch (serif) 

• 8 point medium 
• 10,12 point medium, bold, medium italic 
• 14, 18, 24 point bold 

Symbol (greek, mathematics) 

• 10 point medium 

These fonts are loaded by Xerox Ventura Publisher 
as needed for each page. Additional type sizes and 
type faces can easily be added. See Appendix K. 

Cabling 
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The AST TurboLaser and Cordata printers are con­
nected with the special cable that comes with the 
printer. Make sure this cable is connected securely. 
No error message will print if the cable is discon­
nected.The AST TurboLaser and Cordata printers 
create each page in an uncompressed, bitmap format. 
This means that each page is represented by a one 
megabyte file which is transferred directly from the 
computer to the printer at extremely fast, video 
speeds. While this results in very fast printing, the 
fact that each page results in one megabyte makes 
storage of each page on disk impractical. Therefore, 
no Print To File option is available for either the AST 
TurboLaser or the Cordata printers. 

A maximum of four image files is allowed per page. 
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APPENDIXG 
PICTURES 

This appendix describes limitations inherent in the 
process of converting from a variety of different 
graphic formats into Xerox Ventura Publisher's in­
ternal graphic format. This chapter also includes 
other important information about pictures. 

AutoCAD pictures 

CGM 

DXF 
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Xerox Ventura Publisher converts slide files from 
AutoCAD. AutoCAD SLD files are created using the 
AutoCAD ADE-2 (Advanced Drafting Extension) 
package. The AutoCAD MSLIDE command is used. 
The use of this command is covered in the AutoCAD 
User Reference manual. Look in the AutoCAD 
Reference Manual index under Slides. Better resolu­
tion can be obtained by converting AutoCAD files to 
HPGL. 

Xerox Ventura Publisher converts CGM files. Key 
features and limitations include: 

• 128 vertices for polygons 
• All typefaces are converted to Helvetica 
• Color is converted 
• Pattern fills are converted based on the GSS 

CGI definition. 

AutoCAD and other CAD programs store files in DXF 
format (Drawing Interchange Format.) To convert 
these files to GEM format, which can be read by 
Xerox Ventura Publisher, use the DXFTOGEM 
utility. This utility is contained in the Utilities Disk 
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EPS 

G·2 

(Disk #11). To convert a file, insert the Utilities Disk 
into the A drive and type the following: 

A:DXFTOGEM filename Enter 

If the filename has no extension, the extension DXF 
is assumed. 

A file with the same name but with the extension 
GEM is created. This file can then be loaded as a line 
art GEM file using Xerox Ventura Publisher's Load 
TextlPicture option. 

The following DXF graphic attributes are not con­
verted: 

• Shape entity 
• Text mirroring 
• Tapering widths in polylines 
• Underscore and overscore in text strings 
• Text expansion factors 
• Backward text obliquing and arbitrary for­

ward obliquing 
• Symbol characters (e.g., plus/minus, circle 

dimension) in text strings 
• Curve fitting 
• 3D rendering 
• Ellipses which are not X-Y aligned 

Xerox Ventura Publisher converts EPS files. Key fea­
tures and limitations include: 

• EPS files do not display on screen. Instead a 
large X is placed in the frame. 

• EPS files can only be printed to PostScript 
printers. 

• Any single page printed to a disk by Xerox 
Ventura Publisher (using the PostScript 
driver) can be read back into a frame using the 
EPS converter. However, this file is not a true 
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EPS file and therefore cannot be read by other 
programs which read EPS files. 

o When generating print files to be read by the 
VP EPS converter, you can create smaller files 
if you temporarily rename or remove the 
PS2.PRE file contained in the \ VENTURA 
directory. Remember to put this file back 
before printing to the printer. 

Xerox Ventura Publisher converts HPGL files. Key 
features and limitations include: 

o Arcs, lines, and text are converted 
o Text size is converted 
o It is possible to have picture rotated on page, 

depending on how it's printed. If you don't 
want the picture rotated, pick a different 
orientation from the graphics program which 
generated the HPGL file. 

• Color is not converted. 
o Fonts are all converted to Helvetica. 
• Filled areas are made up of vectors, so it is 

possible that gaps will appear in the fill pat­
terns. You may also see rounded ends on lines 
if you enlarge the picture. Therefore, if at all 
possible, enlarge the picture within your exter­
nal graphics program before saving as an 
HPGL file. 

Lotus 1·2·3 pictures 
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Lotus 1-2-3 .PIC files are created using the 1-2-3 
SAVE option, which is found in the 1-2-3 Print menu. 
The keystrokes required within 1-2-3, once a graph 
has been created on the screen, are: 

/GS filename 

Filename is replaced by the name of the 1-2-3 pic­
ture file you wish to create. 
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Macintosh Paint 

Xerox Ventura Publisher converts Macintosh Paint 
files. You transfer files between the Macintosh and 
the PC using a network. Key features and limitations 
include: 

• Pictures always transfer as a full 8 x 10 page. 
Therefore, a small image on a white page must 
be enlarge considerably within the frame. 

Macintosh PICT 

Xerox Ventura Publisher converts Macintosh PICT 
files. You transfer files between the Macintosh and 
the PC using a network. Key features and limitations 
include: 

• Bit images within PICT files do not convert 
• Text fonts are usually converted into Times 

Roman. They somtimes convert into Helvetica. 

PC Paintbrush pictures 

PC Paintbrush files are created using the Save as 
option in PC Paintbrush. These files are stored with 
the extension PCX. 

• Color is not converted from PC Paintbrush or 
GEM Paint pictures. 

Video Show 

Xerox Ventura Publisher converts General 
Parametric Video Show files. Key features and 
limitations include: 

• Color is not converted. Color is instead turned 
into shades of gray. 

• Polygons with more than 128 vertices are 
truncated. 

• The 3D bar function is not implemented. 
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Text to PCX conversion 

Any text file of up to twenty-five lines or less can be 
converted to a graphic PC Paintbrush file. This file 
can then be loaded as a PC Paintbrush image file and 
placed in a frame. This utility is used to print the 
computer screen as you see it, complete with ruling 
lines and other text effects which don't normally 
print when importing text data from the screen into 
programs like Sidekick. 

To convert a text file that has been captured from the 
screen using Sidekick or some other background 
utility, and save to a file, type the following: 

TXTTOPCX filename /% Enter 

where filename is replaced with the name of the file 
to convert, and % is replaced with the type of display 
in use 

EGA with Enhanced Monitor use: C 
EGA with Monochrome Monitor use: M 
Color Card or EGA with Color Monitor use: 0 
AT&T 6300 or Xerox 6065 use: A 

A file with the same name but an extension of PCX 
is converted. 

This utility does not work with a Hercules card. 

~ Reverse video and boldface text are not converted by 
this utility. 

REFERENCE GUIDE G-5 



APPENDIX G-PICTURES 

This Page Intentionally Left Blank 

G·6 REFERENCE GUIDE 



APPENDIXH 
APPLICATION NOTES 

Publishing a database 

This application note describes how to extract, pre­
format, and ultimately publish information from a 
database program. 

Example: Phone directory 
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This example assumes some knowledge of dBase III, 
although the concepts apply to any database 
program. Suppose you want to publish a phone direc­
tory using information from a dBase III mailing list 
database. This simple directory contains last name, 
first name, and phone number. A typical structure for 
such a database is shown below. 

Example database structure 

Field Field name I¥pe Width 
1 DATE Date 08 
2 CaMP_NAME Character 31 
3 MISTER Character 04 
4 FIRST_NAME Character 12 
5 LAST_NAME Character 12 
6 TITLE Character 25 
7 ADDRESS Character 34 
8 CITY Character 20 
9 STATE Character 02 

10 ZIP Character 06 
11 PHONE Character 12 
13 CaMP_TYPE Character 15 

To publish a directory, create a style sheet with three 
tag names: Body Text, FN, and Phone. Set page 
layout to single sided. The relevant settings for 
each of these three tags is shown on the next page: 
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Body Text Font 

Alignment 
Spacing 

Break 

FNFont 

Alignment 
Spacing 

Break 

Phone Font 

Alignment 
Spacing 

Break 

10 point, bold 

Left, Hyphen off 
Inter-line and Inter­
paragraph: 1 pica 
Line Break Before 

10 point, normal 

Left, Hyphen off 
Inter-line and Inter­
paragraph: 1 pica 
In From Left: 1 inch 

No Line Break 

10 point, normal 

Right, Hyphen off 
Interline and Inter­
paragraph: 1 pica 
Line Break After 

The dBase III LABEL command can be used to ex­
tract the information from this database, insert the 
FN and PHONE tags, and save the resulting infor­
mation into an ASCII text file. 

The following assumes some familiarity with dBase 
III, and assumes that the database has already been 
created with the structure shown above. 

First, generate a dBase label file called 
PHONEGEN by typing modi label phonegen 

On the first page of the label form, enter the follow­
ingvalues: 

Width of label: 
Height of label: 

•• 80 
3 
o 
o 
o 

Left margin: ..... 
Lines between labels: 
Spaces between labels: 
Number of labels across: . 1 
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On the second page of the label form, enter the fol­
lowing values: 

1 trim(last_name)+',' 
2 '@FN = '+trim(first_name) 
3 '@PHONE = '+trim(phone) 

Save the label by pressing and holding the Ctrl key 
and then pressing W. 

Next, either index or sort the database on the field 
last_name. 

Finally, to create an ASCII text file called 
PHONEl.TXT that can be read directly by Xerox 
Ventura Publisher, type the following command: 

. label form phonegen to phonel 

Read the file PHONEl.TXT into Xerox Ventura 
Publisher as a Wordstar file. Load the style sheet 
you created earlier. The phone list will already be for­
matted and ready to print. 

Example: Product listing 

The &LSTG-P2.CHP example in Appendix L 
provides a simple example of a product listing. A por­
tion of the text contained in this chapter is 
reproduced on the next page. 

This example is similar to the previous phone listing 
example, except that line breaks (created with the 
<R> code) are used to separate fields which appear 
on different lines, but which are formatted with the 
same typeface. When publishing a database, use line 
breaks instead of paragraphs to create new lines 
whenever possible. 

I@f The general rule of thumb is that a line break should 
be used, when publishing a database, between any 
two lines which are typographically identicaL 
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@CATEGORY = Digitizers 
@COMP = Chorus Data Systems (603) 424 2900 
@MODEL = PC-Eye 

Publishing a database 

Video capture image digitizer<R>450.00<R>IBM PC 256K, long 
slot 
@COMP = Datacopy (415) 9657900 
@MODEL = Model 900 Imaging System 
35-mm digitizing camera with computer 
interface<R>11945.00<R>IBM XT/AT 

Figure H-l Text generated by database report generator. Note 
<R> used to generate line breaks. 

Digitizers 

Chorus Data Systems (603) 424 2900 

• PC-Eye 
Video capture image digitizer 
450.00 
IBM PC 256K, long slot 

Datacopy (415) 965 7900 

• Model 900 Imaging System 
35-mm digitizing camera with computer 
interface 
11945.00 
IBMXT/AT 

Figure H-2 Text from Figure H-l formatted with the style sheet 
used for this Reference Guide. 
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The reason for using line breaks is that they consume 
far less internal memory than paragraph endings. 
This lets you create larger chapters and improves for­
matting speed. 

Tabs 

Another technique for separating fields in a database 
is to use tab characters between fields. This is espe­
cially useful for inserting leaders between fields, for 
example: 

Smith, John 
Turner, Fred 

(408) 555-1234 
(408) 555-1111 

Tabs should be used sparingly, however, because they 
consume internal memory. If too many tab characters 
are used, you may encounter the following error mes­
sage: 

This frame is too complex to completely format. 
Try splitting it into two frames or reducing the 
number of columns, tabs, leaders, and lines of 
text. 
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If you cannot create the document with fewer 
leadered tabs and if you cannot increase the space be­
tween lines, then draw one or more frames on the 
page, and flow the text into the first frame and then 
into the second frame. Select each frame individual­
ly and make it a repeating frame. These frames will 
automatically repeat on each page until the entire 
text file has been placed in the document. Some text 
must still flow into the underlying page in order to 
force Xerox Ventura Publisher to automatically 
create new pages. 
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APPENDIX I 
GLOSSARY 

ASCII Text Files - American Standard Code For In­
formation Interchange. ASCII text is stored in exact­
ly the same order as you see it on a printed page, with 
no additional characters added or deleted. ASCII files 
are often called "print" files. 

Ascender - The part of a lower case character which 
rises above the height of the lower case "x." 

Assignment List - The list of files, tags, or at­
tributes that can be transferred to the selected 
frame, paragraph, or selected text. Shown in the 
Side-Bar on the left side of the screen. 

Attribute - Any style used to enhance readability of 
text. Typical attributes include boldface, underline, 
and italic. Font changes assigned to selected text are 
also considered attributes. Examples of these font at­
tributes include 14 point, blue, and kern. 

Base Line - An imaginary line on which type rests. 
Descending characters hang below the baseline. 

Binding Margin - The additional space added to the 
side of the page that will be drilled or punched prior 
to insertion into a binder. Use different margins for 
left and right pages to create binding margins. 

Body Text - The text of the main part of the docu­
ment. 

Box Text - A box created using the Graphic Drawing 
function which contains text. Box text does not flow 
around frames, and can have graphics (e.g., arrows) 
directly attached to it. Use box text for tables and cal­
louts. Use frames containing text files for 
newspaper-type make-up. 
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Break - An interruption in the flow of text from one 
paragraph to the next. Normally each paragraph con­
tinues directly below the previous paragraph or, ifno 
more room is left on this column or page, it continues 
at the top ofthe next column or page. This is called a 
line break. If a paragraph always begins at the top of 
a new column, this is called a column break. If a 
paragraph always begins at the top of a new page, 
this is called a page break. 

Chapter - A combination of text and picture files, 
formatted with a style sheet. A chapter file consists 
of pointers to each of these files, along with instruc­
tions on how to combine them together on the com­
puter screen or on the printer. 

Clipboard - A temporary, invisible holding place for 
text, pictures, and graphics. Any text block or picture 
placed on the clipboard using a cut or copy operation 
can be placed anywhere else in the chapter. The clip­
board can independently hold one text block, one pic­
ture, and one graphic. 

Crop - Eliminate unwanted portions of a picture. 
The portions not displayed in the document are still 
stored in the original picture file. 

Crop Marks - Alignment marks which delineate the 
outside edges of the printed page. Also sometimes 
called trim marks or register marks. Crop marks can 
be automatically added at print time or you can draw 
your own using the Graphic Drawing function. 

Dialog Box - The set of choices presented on the 
screen for each menu option selected. 

Discretionary Hyphen - A hyphen, placed in a 
word, which only prints if the word appears at the 
end of a line. Used to add hyphens beyond those 
produced by the hyphenation algorithm. Discretion­
ary hyphens always take precedence over any hy­
phens inserted by Xerox Ventura Publisher. 
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Em Dash - An em dash (decimal 197) is used to 
separate parenthetical statements-such as this 
one-from the surrounding text. 

Em Space - An em space equals the width ofthe let­
ter M in current point size. An em space is created by 
pressing and holding both the Ctrl and Shift keys 
and then pressing M. 

En Dash - An en dash (decimal 196) is used between 
numbers. For example: Figure 5-35. 

En Space - An en space equals one halfthe width of 
an em space. An en space is created by pressing and 
holding both the Ctrl and Shift keys and then press­
ingN. 

Extension - The part of the file name to the right of 
the period. For instance, the extension in the file 
name "DOC2.WP1" is WPI. Extensions are used by 
Xerox Ventura Publisher to differentiate between 
files of different types. 

Figure Space - A figure space equals the width of a 
number in the current point size. Use figure spaces 
between numbers in tables to keep tabular informa­
tion aligned properly. A figure space is created by 
pressing and holding both the Ctrl and Shift keys 
and then pressing F. 

File - A unit of information stored on hard disk. Dif­
ferent types of information are stored in files with dif­
ferent extensions, and are treated differently. The 
different file types recognized by Xerox Ventura 
Publisher are Style Sheet (STY), Chapter (CHP), 
Publication (PUB), Width Table (WID), Caption 
(CAP), Graphic (VGR), text, image, and line art. 

Filter - The specification on the Directory line in the 
Item Selector that determines which files are dis­
played. The character "*,, indicates that any set of 
characters can be displayed; the character "?" indi-
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cates that any single character can be displayed in 
that position. For instance, * .STY will display any 
file name with the extension STY. GRAB????.IMG 
will di~play all eight character file names starting 
with the letters GRAB having the extension IMG. 

Font - A unique combination of typeface, type size, 
type style, and type weight. For instance, Swiss 
(typeface), 12 point (type size), bold (type weight) is 
one font; Swiss, 14 point, bold is another. 

Font Metric - The width and height information for 
each character in each font. This information is 
stored in a width table. 

Footer - Text which appears at the bottom of every 
page in the document. 

Footnote - Explanatory information at the bottom of 
the page which is referenced on the same pages. 

Frame - A rectangular box used to hold text or pic- ~ 
tures. Underlying pages are special frames which 
Xerox Ventura Publisher automatically creates as 
needed to accommodate all text in a file. 

Greeking - The act of representing text by dummy 
type having no meaning, or by a series of straight 
lines. Within Xerox Ventura Publisher, greeking is 
used to increase screen drawing speed when the text 
is too small to be legible. Does not affect what gets 
printed. 

Image - A picture which is composed of individual 
dots created with a "paint" program or with a scan­
ner. See also Line Art. 

Indent - The blank space at the beginning of the first 
line of a paragraph. ~ 

Inter-line Spacing - The space between lines in a 
paragraph. See Leading. 
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Interpress - A language used to describe how to 
print a page which consists of both text and pictures. 
This description is completely independent of the 
printing device. This means that the page can be 
printed on printers which use Interpress, and the 
page will be printed at the full resolution that each 
printer or typesetter can produce. 

Justification - Text aligns evenly with both the 
right and left margins. 

Kerning - Space reduction between specific letter 
pairs. Even when proportionally spaced, certain let­
ter pairs should be placed more closely together 
eliminate excessive white space. This space is espe­
cially noticeable with larger type sizes. For instance, 
an upper case V which follows an upper case A should 
be placed closer to the A. For example: 

This is not kerned: AV. 
This is kerned: AV. 
Landscape - A page printed so that as you read it, 
the width of the page is greater than its height. 

Layout - The arrangement of text and pictures on 
any given page. 

Leaders - Characters placed in the blank space be­
tween items in a list. For example: 

Table Item 1 .... .Item 2 .... .Item 3 .... .Item 4 

Leaders ~ ____________ -L ________ ~ ________ ~ 
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Leading - The distance in points from the baseline 
of one line of type to the next. 

Line art - A picture which is produced on the com­
puter and stored as mathematically defined objects. 
Any picture not produced using a paint program or 
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scanner is probably line art. Contrast line art with 
the definition of Image. 

Line Break - The blank line which separates two 
paragraphs. If no line break is set between two 
paragraphs, the second paragraph will begin at the 
same vertical point as the first line in the first 
paragraph (Next Y Position: Normal); or at the same 
vertical point as the last line in the first paragraph 
(Next Y Position: Beside Last Line of Previous 
Paragraph.) 

Line Length - The length of a line of type. Usually 
expressed in picas and points. 

Monospaced - An equal amount of character width 
for each character. Most typewriters and printers are 
monospaced, whereas most typeset material is 
proportionally spaced. See Proportional Spacing. 

Mechanical - A finished "camera ready" piece of 
artwork, generally one or two pages. 

Orphan - One or more lines of text left at the bottom 
of a column or page. Also, see Widow. 

Outdent - Text on the first line of a paragraph which 
prints to the left of the paragraph margin. 

Paste - The act of moving text or a picture from the 
clipboard to the page. 

Paragraph - Any line or lines of text ended by press­
ing the Enter key. A single letter, word, or line is con­
sidered a paragraph if the Enter key is pressed at the 
end ofthe letter, word, or line. 

Pica - Typographic unit of measurement equal to 1/6 
inch. Twelve points equals one pica. 

Picture - Any drawing or illustration placed in a 
frame. A picture can be either image or line art. 
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Point - Typographic unit of measurement equal to 
1172 inch. 

Proportional Spacing - Different space is given to 
each character in a font. When proportionally spaced, 
the letter i gets less space than the letter w. 

Port - The connection point in the computer for 
peripherals such as a printer or mouse. 

Portrait - A page printed so that, as you read it, the 
width of the page is less than its height. 

PostScript - A language used to describe how to 
print a page which consists of both text and pictures. 
This description is completely independent of the 
printing device. This means that the page can be 
printed on any printer or typesetter that uses Post­
Script, and the page will be printed at the full resolu­
tion that each printer or typesetter can produce. 

Publication - A combination of chapter files. Each 
chapter file can have its own set of text, picture, and 
style sheet files. 

Reflect - Reflected settings place a mirror image of 
that setting on alternating pages. For example, if a 
picture is placed at the left side of a left page and then 
reflected using the For All Pages Left & Right in 
the Repeating Frame option, the picture will then be 
placed on the right side of right pages. 

Ruling Line - Any horizontal or vertical line used to 
separate text or frames from the surrounding layout. 

Run around - Text which follows the outline of a pic­
ture. 

Scale - Increasing or decreasing the size of a picture. 

Scanner - A device which converts a paper drawing 
into a computer image. 
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Select - Point to something on the screen and press 
the mouse button. 

Style Sheet - A file which is stored separately from 
text, but which controls the typographic format of 
that text. 

Tag - The format applied to a particular paragraph. 

Thin Space - A thin space is the width of a period. 

Typeface - The style of type e.g., Bookman, Palatino, 
Avant Garde, Zap! Cfiancery. 

Typeset - The act of producing a document on a 
typesetting machine. Xerox Ventura Publisher can 
produce documents on a laser printer that have near 
typeset quality. 

Underlying Page - The frame defined by the Page 
Layout option. Additional frames are placed on top of 
this page. The page counter on the screen shows the 
number of underlying pages in the document. 

Widow - One or more lines of text left at the top of a 
column or page. Note: A widow also refers to a single 
word on the last line of a paragraph. While this is 
considered poor form, Xerox Ventura Publisher does 
not attempt to prevent this kind of widow. Also, see 
Orphan. 

Width Table - A file which contains font metric in­
formation. 

WYSIWYG - What You See Is What You Get 
(printed.) Refers to the ability to display on the com­
puter screen a close representation of what is 
printed. A word processor which uses special charac­
ters to mark the beginning and end of underlined 
text, rather than showing text with an underline is 
an example of a program which does not have 
WYSIWYG. 
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Document formats 

Up to eight columns per page or frame. Multiple 
frames on same page can create more than eight 
columns. Columns can be unequal width. 

Different column widths and indents for left and 
right pages. 

Text flows automatically across page boundaries if 
placed in underlying page. 

Vertical rules between columns, plus two vertical 
rules per frame. 

Portrait or landscape format. Set globally for entire 
chapter. 

Ruling lines (up to three) of different widths can be 
placed above, below, or around each frame. 

Document content 

Multiple, non-contiguous articles per document. 

Up to 128 chapters can be chained together when 
printing, generating a table of contents or index. 
Documents up to 9,999 pages can therefore be hand­
led. 

Document views 

• Facing (Two full pages.) 
• Reduced (Full page.) 
• 100% (Normal size.) 
• 200% (Enlarged view.) 
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Style-sheet Format Control 

Style sheets control each paragraph's format through 
paragraph tags. In each chapter, a 640K system 
can handle up to 128 tags;. up to 500K bytes of text; 
and up to 8,000 paragraphs. 

Style sheets control the following on a paragraph by 
paragraph basis: 

• Typeface and font 
Fonts available depends on printer 

- Any integer size between 1 and 254 point 
available for page description languages 

• Text alignment within column 
• Hyphenation (two different languages can be 

hyphenated within the same document) 
• Justification 
• Indent/outdent for any number oflines 
• Line to line spacing (leading) 
• Paragraph spacing 

Temporary margins (using spacing in from ~ 
left, in from right) 

• Page, line, or column breaks 
• Large first letter of paragraph 
• Automatic bullets 
• Tabs 

Sixteen horizontal tabs per paragraph 
- Left, center, right, decimal point aligned 
- Leaders 

• Automatic kerning (if kerning information is 
in printer width table) 

• Automatic letterspacing (flags loose lines) 
- Normal, mInImUm and maximum 

spaceband settings 
• Letter space adjustment 
• Single/double underline, overs core , and 

strikethrough thickness and position settable 
• Horizontal ruling lines 
• Up to three ruling lines, each of different 

thickness and spacing above, below, or around 
text 
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Pre-set options: Rule length equal to text, 
margin, column or frame 
Customized options: Rule length and indent 
settable 

• Eight textures and colors available 
• Text within ruling line allowed 
• Ruling lines the width of text, margin, column, 

or custom width 
• Margins & Columns 
• Portrait, landscape, paper size 
• Widows & Orphans 
• Vertical tabs 
• Automatic section numbering 

Up to ten levels 
- Can be used for manuals, outlines, lists 

Page controls 
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Automatic headers/footers. 

• Separate headers/footers for left and right 
pages 

• Left, center, right aligned text in each header. 
Two lines each 

• Automatic page numbering and section head­
ings in header or footer 

Page numbering in choice of: 

• Arabic numbers (1,2,3) 
• Upper or lower case roman numerals 
• Upper or lower case letters (A,B,C) (A-Z only) 
• Alphabetic (One, Two, Three) 

Page counter: 1-9999. 

Automatic footnotes. 

• Footnote text appears at the bottom of the 
page 

Column balance on last page of chapter. 
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Chapter headings forced to same page as next 
paragraph. 

Editing 

Accepts text from and stores text (and formatting in­
formation) back to standard wordprocessors: 

• Displaywrite III and N (DCA) 
• Microsoft Word 
• Multimate 
• Wordperfect 
• Words tar 
• Xerox Writer 
• Xywrite 
• Any wordprocessor or other program that 

generates a standard ASCII file 

Real-time re-format during editing 

Files from different word processors can be mixed in 
same document. 

Text insert or delete at any point. 

Text blocks can be deleted, moved, or copied 

Any letter, word or group of words can be changed to: 

• Boldface 
• Italic 
• Small caps 
• Strikethrough 
• Subscript 
• Superscript 
• Underline 
• Double underline 
• Overscore 
• All lower case 
• All upper case 
• All initial caps 
• Any available font 
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Selected text can be moved: 

• Horizontally (manual kerning.) 
• Vertically (base line jump) 

Pictures 
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Accepts pictures generated by: 

• AutoCAD SLD 
• GEM Draw, GEM Graph 
• Lotus 1-2-3 
• Mentor Graphics 
• PC Paintbrush, GEM Paint 
• Any program that can save files in General 

Parametric's Video Show format (e.g., Lotus 
Freelance) 

• Any program that can save files in CGM for-
mat 

• Macintosh PICT files 
• Macintosh Paint files 
• Encapsulated PostScript files 
• HPGL 
• Images scanned from Microtek, Dest, 

Datacopy, or other scanner which saves files in 
PC Paintbrush PCX format 

• CAD pictures stored in DXF format 

Handles text around irregular pictures using text 
flow around and multiple frames. 

Any picture can be automatically repeated 
throughout the document. 

Picture scaling: Stretch to fit picture frame, maintain 
original aspect ratio, or scale by factors 

Picture cropping: Pictures larger than frame can be 
cropped as desired. 

Captions. 
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• Attached to pictures 
• Abovelbelow/leftlright of picture 
• Automatic figure or table numbering 
• Rules above, below, around each caption 

Anchored Pictures. 

Printing 

• Picture can be anchored relative to a position 
in the text 

• Picture can move to the same page as the text, 
below the text, or above the text when Re­
Anchor Frame command is given 

Single- or Double-sided formatting (start on left or 
right side.) 

Print left pages or right pages only (for manual 
duplex printing) 

Paper type: 

• 81/2X 51/2 
• 81/2 X 11 
• 81/2 X 14 
• 11X17 

- Shingle feature lets you print multiple 8 1/2 
x 11 pages to achieve one 11 x 17 page 

- Shrink feature lets you print an 11 x 17 
page on 81/2 x 11 paper (PostScript only) 

• 18 x 24 (Broadsheet) 
- Shrink 
- Strips output for typesetters 

• A4 
• B5 

Collating and printing order control. 

Multiple paper trays 

Print all, current, or selected pages. 
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Frontlback matter 

Automatic table of contents, table of figures, table of 
tables, generation by searching for paragraph tags 

Automatic index generation by searching for index 
entries. 

Printers 
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Up to five printers installed simultaneously. 

Additional printer and screen fonts can be added 
using utilities supplied 

See Appendix F for list of printers supported. 
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ADDING FONTS 

The Utilities Disk contains programs which let you 
add additional printer and screen fonts to Xerox Ven­
tura Publisher. Fonts can be purchased from many 
companies. They must be designed for your printer. 
(Exception: Fonts for the HP LaserJet Plus can be 
converted for use by the AST TurboLaser, Cordata, 
and JLaser printers.) 

What is a font? 
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Every printed character is defined by a combination 
of attributes that give that character its unique 
shape, size, and look. A combination of characters 
forms a character set. Xerox Ventura Publisher con­
tains two character sets (Appendix E): 

• An international character set 
• A symbol character set 

Other character sets, such as Dingbats, are available 
from various font vendors. 

A set of characters that are designed to look similar 
constitute a typeface. Xerox Ventura Publisher 
provides three standard typefaces for the interna­
tional character set (not all typefaces are available 
for each printer): 

• Helvetica (or equivalent) 
• Times Roman (or equivalent) 
• Courier (or equivalent) 

Xerox Ventura Publisher provides one typeface for 
the symbol character set. 
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Within a typeface, each character can be printed in 
different sizes. The size of a character is measured 
in points, where one point equals 1172 inch. 

Each character can also have a different style, where 
a style can be: 

• Normal 
• Bold 
• Normal italic 
• Bold italic 

Finally, each character can be printed in one of two 
orientations: 

• Portrait 
• Landscape. 

Each combination of typeface, size, style, and orien­
tation defines a font. Many people use the word font 
when they really mean typeface. However, through­
out this manual, font means the unique combination 
of typeface and size, style, and orientation. 

How are fonts used by the printer? 
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Within a graphic printer (such as a laser printer or 
typesetter), each character in each font is ultimately 
drawn as a series of individual dots. The printer 
creates these dot-by-dot drawings from information 
contained in font files. Font files are stored on either 
the computer's hard disk or in the printer's memory, 
depending on the type of printer you have. Xerox 
Ventura Publisher works with three different types 
of printers: 

• Type 1: Printers that manage font files within 
the printer (e.g., HP LaserJet Plus, Xerox 
4045) 
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• Type 2: Printers that let the PC manage the 
font files (e.g., AST TurboLaser, Cordata, 
JLaser) 

• Type 3: Printers that use a page description 
language to generate font sizes from font out­
lines (e.g., Apple LaserWriter, IBM 4216, other 
PostScript printers; Interpress printers.) 

If you want to print characters in fonts different from 
those supplied with Ventura Publisher, you must 
purchase fonts from a font supplier which are 
designed for your particular printer. You then store 
these fonts on your computer's hard disk or within 
the printer's memory, depending on the printer type. 
Once they are stored, you then create tables which 
provide Xerox Ventura Publisher with information 
about each individual character in the new fonts. The 
procedure for creating these tables, called Width 
Tables, is described in the following sections. In ad­
dition, width tables also contain information which 
configures Xerox Ventura Publisher's Font Dialog 
Boxes to display the font name and sizes correctly. 

How are fonts used by the computer display? 
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Because the display on your computer has a much 
lower resolution and different aspect ratio from your 
printer, the fonts you purchase for your printer can­
not be used to show new fonts on your computer dis­
play. You can, however, purchase new screen fonts 
(which are separate files from the printer fonts.) 
These screen fonts will not match the printer font 
widths and style, unless purchased with the printer 
fonts as part of a matched set. 

Since matching screen fonts are not always avail­
able, Xerox Ventura Publisher lets you add printer 
fonts while still using the screen fonts already in­
stalled. When a screen font is used which does not 
match the printer font, Xerox Ventura Publisher ad­
justs the space between words on the screen as neces-
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sary to compensate for the differences in widths be­
tween the new printer font and the generic screen 
font. This assures that each line and paragraph ends 
at the correct location. While this may make each 
word appear either too close or too far from its neigh­
bor on the computer screen, the line and paragraph 
endings will be correct, arid the page will look correct 
when it is printed. 

If you add printer fonts for characters other than 
those shown in Appendix E, Xerox Ventura Publisher 
will not display the corresponding fonts on the screen 
unless you add the appropriate screen fonts. 

Adding new screen fonts 
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Screen fonts must be provided by the font vendor in 
Xerox Ventura Publisher format, and they must 
match the resolution for your computer display. 
Screen fonts for the IBM Enhanced Graphics Display 
(91 x 72 dpi resolution) will work with all displays 
shown in the VPPREP installation menus, except the 
IBM Color Display (options A and B.) 

To add new screen fonts: 

~ Copy the fonts to the VENTURA directory 
~ Type the three letter file extension on the Screen 

Fonts line in the Set Printer Info Dialog Box if dif­
ferent from EGA. 

The new screen fonts are loaded and immediately 
displayed. 

If the fonts are a different resolution from EGA, then 
the extension must be different from EGA, and the 
new fonts must contain both Helvetica and Times 
Roman fonts. The maximum file size for anyone 
screen font is 35K bytes. You can add up to 500 screen 
fonts. 
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If you purchase PostScript screen fonts from Adobe 
Systems, these must first be converted to Xerox Ven­
tura Publisher format before loading them. These 
fonts have different resolution (75 x 75 dpi) than EGA 
fonts, so they you must include both Helvetica and 
Times Roman fonts in the following conversion. To 
convert these fonts: 

~ Copy the font files to the VENTURA directory. 
~ Rename the font files, if necessary so that they all 

have the extension ABF. 
~ Copy the ABFTOFNT converter from the 

POSTSCPT directory on the Utilities Disk (Disk 
#11) to the VENTURA directory by typing the fol­
lowing: 

COpy A: \POSTSCPT\ABF. * C: \ VENTURA 
Enter 

~ Convert the fonts by typing the following: 

ABFTOFNT *.ABF Enter 

The fonts are all converted to Xerox Ventura Pub­
lisher format, and the file extensions are all changed 
to PSF. To load these fonts, see the Set Printer Info 
secion in the Menu chapter. 

If you have several different printers installed and 
each has its own set of matching screen fonts, make 
the extension for each printer's matching screen 
fonts unique to that printer. 

Adding new printer fonts-General instructions 
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To add new printer fonts, follow these instructions. 

~ Copy all font files from floppy disk to the VEN­
TURA directory on your computer hard disk (Post­
Script fonts are copied instead to a directory which 
you create called PSFONT) 
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~ Copy the width table for these fonts to the VEN­
TURA directory. If the font vendor did not supply 
a width table for these new fonts, you must create 
one. Width Table creation is different for each 
printer and is described in the following sections. 

~ Use the AddlRemove Font option to merge the 
width table for these new fonts into the width table 
for the fonts already in use. 

Consult the appropriate section later in this chapter 
for additional information on your particular printer. 

Adding new fonts to the HP LaserJet Plus 
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I To add new fonts to the HP LaserJet Plus, follow the 
general directions for adding new printer fonts. 

Creating an HP LaserJet Plus width table 

If the font vendor did not supply a Xerox Ventura 
Publisher width table for your HP LaserJet Plus, you 
must create one. To create a width table for new fonts 
which have already been copied to your computer 
hard disk: 

~ Use the DOS RENAME command to rename all 
new portrait font files to have the extension SFP, 
and all new landscape fonts to the extension SFL. 

~ Iflandscape fonts are not supplied by the font ven­
dor, create landscape fonts from portrait fonts. 
This is done as follows: 

• Insert the UTILITIES DISK (#11) into drive A 
• Type the following command: 

A:PORTOLAN C:\VENTURA\*.8FP Enter 

~ Copy the HPLTOVFM.EXE utility from the 
UTILITIES DISK #11 to the VENTURA directory 
by typing the following command: 

COpy A:\HPLJPLUS\*.* C:\VENTURA Enter 
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~ For each portrait font file, you must create a Ven­
tura Font Metric (VFM) file. This is a readable text 
file which provides Xerox Ventura Publisher with 
important information about your new fonts. The 
VFM file is described in more detail near the end 
of this chapter. To create this file, type the follow­
ing command for each new font file: 

HPLTOVFM fontname.SFP [switches] Enter 

where [switches] is replaced with the following: 

• IF=Typeface name (15 characters maximum) 
• IN=Typeface ID (15-255; See ID table later in 

this chapter) 
• IP=Point size (always 2 characters) 
• IW=Weight (style) (1 character: N=normal; 

B=bold; I=normal italic; T=bold italic) 

You must specify all switches for each font file. The 
typeface names, typeface ID, and weight (style) com­
binations are shown later in the chapter under the 
Typefaces heading. 

Example: You purchase seven new portrait fonts: 
Century Schoolbook 8 point normal; 10 point normal; 
10 point bold; 10 point italic; 12 point normal; 12 
point bold; and 12 point italic. You copy these to your 
computer's hard disk and rename the files so they 
have the extension SFP. The file names are: 

CENT08NP.SFP 
CENTIONP.SFP 
CENTIOIP.SFP 
CENTIOBP.SFP 
CENT12NP.SFP 
CENT12IP.SFP 
CENT12BP.SFP 

To create VFM files for each ofthese fonts, type these 
commands (placing these commands in a batch file 
and then executing that file is less prone to error): 

K-7 



APPENDIX K-ADDING FONTS Adding new fonts to the HP LaserJet Plus 

K-8 

HPLTOVFM CENT08NP.SFP IF=CenturylN =20!P=081W =N Enter 

HPLTOVFM <{ENTIONP.SFP IF=CenturylN=20!P=lOIW=N Enter 

HPLTOVFM CENTlOIP.SFP IF=CenturylN=20/P=lOIW=I Enter 

HPLTOVFM CENTI OBP.SFP IF=CenturylN =20!P=1 OIW =B Enter 

HPLTOVFM CENT12NP.SFP IF=CenturylN =20!P=12IW =N Enter 

HPLTOVFM CENT12IP.SFP IF=CenturylN=20/P=121W=I Enter 

HPLTOVFM CENT12BP.SFP IF=CenturylN=20!P=121W=B Enter 

Once all the VFM files have been created, you next 
create a list of all VFM files. This list must contain 
the name of every VFM file just produced. Create the 
list with any wordprocessor, and save as an ASCII 
text file. The name of this file should be the same as 
the name of the ultimate width table file, and the ex­
tension should be LST. 

The VFM file names should be placed in the LST file 
with all fonts for a given typeface together, starting 
with the smallest point size and then going to larger 
point sizes. Within a given size, the order should be 
normal, italic, bold, and then bold italic. 

Example: The LST file for the seven fonts whose 
VFM files were created in the example above should 
look like this: 

CENT08NP.VFM 

CENTIONP.VFM 

CENTlOIP.VFM 

CENTIOBP.VFM 

CENT12NP.VFM 

CENT12IP.VFM 

CENT12BP.VFM 

As the last step in the width table generation process, 
the VFMTOWID.EXE uses the LST file to create a 
new width table. The syntax for this conversion is: 

VFMTOWID fliename.LST Enter 

where filename is replaced with the name of the list 
file you wish to convert. The VFMTOWID.EXE file 
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must be copied from the Utilities Disk to the VEN­
TURA directory by placing the Utilities Disk in the A 
drive and typing the following: 

COPY A:\ VFMTOWID.EXE C:\ VENTURA Enter 

Example: For instance, to create a width table from 
the list file created in the previous example, assum­
ing this file is saved under the name CEN­
TURY.LST, type the following: 

VFMTOWID CENTURY.LST Enter 

This will create a width table called CEN­
TURY.WID. This width table can be merged into an 
existing width table using the AddlRemove Fonts op­
tion within Xerox Ventura Publisher. 

When you are finished generating new width tables, 
you can save the VFM files onto a floppy disk and 
then erase them from your computer's hard disk. 
They are not used by Xerox Ventura Publisher except 
when generating a new width table. 

Adding new fonts for the Xerox 4045 Laser Printer 

To use new fonts with the Xerox 4045, follow the 
general directions for adding new printer fonts, ear­
lier in this chapter. 

Creating a width table for the Xerox 4045 
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If the font vendor did not supply a Xerox Ventura 
Publisher width table file for your 4045 printer, you 
must create one. This is done as follows: 

~ Copy the XRXTOVFM.EXE utility from the 
UTILITIES DISK #11 to the VENTURA directory 
by typing the following command: 
COpy A:\XRX_4045\*.* C:\ VENTURA Enter 
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~ Rename each font file according the following con­
ventions: 

The file extension must be .XFN 
The file name must be in the following format. 

X450FPPW.XFN 
where: 

o is replaced with the orientation (portrait = P; 
landscape = L) 

F is replaced by one of the following typefaces: 

A Avant~arde 

B Bookman 
C Century 
D Dingbats 
F Friz_quadrata 
G Garamond 
H Helvetica 
L Lubalin 
N Nar_helvetica 
0 Optima 
P Palatino 
S Souvenir 
M Symbol 
T Times 
Z ZapCchancery 

PP is replaced with the type size (e.g., 08 for 8 point, 
10 for 10 point etc.) 

W is replaced with one of the following type weights 
(styles): 

B 
I 
N 
T 

Bold 
Italic 
Normal 
Bold Italic 
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Example: The file name for 14 point, italic, 
Lubalin, portrait, should be X45PL14I.XFN. 

>- Convert each font to a Xerox Ventura Publisher 
VFM file using the XRXTOVFM.EXE converter. 
The resulting VFM file is an ASCII text file that 
can be edited. (See end of this chapter.) Each file 
must be converted individually. 

Example: To convert the font file in the previous 
example, type the following: 

XRXTOVFM X45PL14I.XFN Enter 

>- Create a list of all VFM files that should be in­
cluded in a new width table. This list should con­
tain all typefaces and sizes that you want to ap­
pear in the Font Settings dialog boxes, and must 
contain at least one system font. Create this list 
with any wordprocessor, and save as an ASCII tex:t 
file. The name of this file should be the same as the 
name of the ultimate width table file, and the ex­
tension should be LST. The VFM file names should 
be placed in the LST file with all fonts for a given 
typeface together, starting with the smallest size 
and then going to larger sizes. Within a given size, 
the order should be normal, italic, bold, and then 
bold italic. 

Example: The 4045 LST file which created the 
fonts provided with Xerox Ventura Publisher is: 

X45PH06N.VFM 
X45PH08N.VFM 
X45PHI0N.VFM 
X45PHI0LVFM 
X45PHI0B.VFM 
X45PH12N.VFM 
X45PH12LVFM 
X45PH12B.VFM 
X45PH14B.VFM 
X45PH18B.VFM 
X45PH24B.VFM 
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X45PT08N.VFM 
X45PTION.VFM 
X45PTIOI.VFM 
X45PTIOB.VFM 
X45PT12N.VFM 
X45PT12I.VFM 
X45PT12B.VFM 
X45PT14B.VFM 
X45PT18B.VFM 
X45PT24B.VFM 
X45PC12N.VFM 
X45PMION.VFM 

~ Finally, convert the LST file to a width table using 
the VFMTOWID.EXE program as follows: 

VFMTOWID filename.LST Enter 

where filename is replaced with the name of the 
list file you wish to convert. 

This width table can be merged into an existing I 

width table using the AddlRemove Fonts option 
within Xerox Ventura Publisher. 

When you are finished generating new width tables, 
you can save the VFM files onto a floppy disk and 
then erase them from your computer's hard disk. 
They are not used by Xerox Ventura Publisher except 
when generating a new width table. 

Adding fonts to: AST Turbo Laser; Cordata; JLaser 
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Some font vendors supply printer fonts in Xerox Ven­
tura Publisher format. These fonts are intended for 
use with AST TurboLaser, Cordata, and JLaser 
printers. Follow the general directions for adding 
printer fonts given earlier in this chapter. The exten­
sion for these fonts should be renamed to B30 for 
JLaser and Cordata printers and to W30 for the AST 
TurboLaser printer. 

REFERENCE GUIDE 



Adding fonts to: AST Turbo Laser; Cordata; JLaser APPENDIX K-ADDING FONTS 

REFERENCE GUIDE 

Downloadable fonts (fonts on disk) for the HP Laser 
Jet Plus can be converted for use with the AST Turbo 
Laser, Cordata Laser Printer, and JLaser board. To 
do this, follow the procedure described in the Adding 
new fonts for the HP LaserJet Plus section, with 
the following changes: 

• Only portrait fonts are required. 
• During the VFMTOWID operation, specify the 

printer name as follows: 

VFMTOWID CENTURY.LST IN=printer Enter 

where printer is replaced with the name of the 
printer exactly as it appears in the Set Printer Info 
Dialog Box. 

After the width table has been generated, convert the 
fonts themselves from HP format to Xerox Ventura 
Publisher's format by using the HPLTOFNT.EXE 
utility contained on the UTILITIES DISK #11. To 
convert the fonts: 

~ Copy the HPLTOFNT.EXE utility from the 
UTILITIES DISK #11 to the VENTURA directory 
by typing the following command: 

COPY A: \ HPLTOFNT.EXE C:\VENTURA Enter 

~ For each portrait font file type the following com­
mand: 

HPLTOFNT fontname.SFP [switches] Enter 

where [switches] is replaced with the following: 

IF=Typeface name (15 characters maximum) 
IN=Typeface ID (15-255; See ID table later in 
this chapter) 
IP=Point size (always 2 characters) 
IW=Weight (style) (1 character: N=normal; 
B=bold; I=normal italic; T=bold italic) 
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For instance, to convert a 10 point, Century School­
book, normal, portrait font from HP LaserJet Plus to 
Xerox Ventura Publisher format, type the following: 

HPLTOFNT CENTIONP.SFPIF=CenturyIN=201P=lOIW=N 
Enter 

The extension for the resulting fonts should then be 
renamed to B30 for JLaser and Cordata printers and 
to W30 for the AST TurboLaser printer. 

Adding new PostScript fonts 

To add new fonts for PostScript printers, copy the 
font files to the PSFONT directory on your computer 
hard disk. (Create this directory, if necessary.) Re­
name the font file name, so that it matches exactly 
one of those shown in the Typeface subsection which 
follows, and with the extension FIB (or FlA if your 
fonts files are ASCII). 

If you wish to save fonts in a different directory, use 
the ASCII text editing function of your wordproces­
sor to edit the POSTSCPT.CNF file located in the 
VENTURA directory. For instance, if all fonts are 
saved in a directory called NEWFONTS, change the 
line in the POSTSCPT.CNF file which reads: 

psfonts(C: \PSFONT\) 

to: 

psfonts(C: \NEWFONTS\) 

Then, for each font added, use the AddlRename 
Font option to change the state of each new font. 
They should each be set for Download. 

~ Remember to change the download/resident 
switch for each Face, Size, and Style combination. 
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The PostScript width table which is installed with 
Xerox Ventura Publisher includes the most common 
PostScript typefaces. Therefore, you don't need to 
copy or merge width tables. However, the file name 
for each typeface added must match those shown in 
the Typefaces section (later in this chapter) exactly, 
and the download/resident switch must be set as 
described on the previous page. 

The following is a list of the standard typefaces and 
their associated ID's and weights (styles.) If the type­
face you are adding is not on this list, assign the 
largest number available for the class of typeface you 
are adding. For example, if you have already added 
two new serifed typefaces, neither of which is on this 
list, you would have already assigned typeface ID 
number 49 and 48. The next typeface, if it is not on 
the list, should then be assigned number 47. 

The PostScript file name is shown for reference. For 
file names which contain the underline character you 
must type enough underline characters to make the 
file name exactly eight characters long. 

System Faces (International Character Set) 

PostScript Weight 
Typeface FileName FaceId (Stl:':le) 
Courier-Bold COURIB 1 1 
Courier-Bold Oblique COURIBO 1 5 
Courier COURI 1 0 
Helvetica-Oblique BELVEO 2 4 
Helvetica-Bold HELVEB 2 1 
Helvetica HELVE 2 0 
Helvetica-Bold Oblique HELVEBO 2 5 
Times-Bold Italic TIMESBI 14 5 
Times-Italic TIMESI 14 4 
Times-Bold TIMESB 14 1 
Times-Roman TIMESR 14 0 
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Serifed Faces (International Character Set) 

PostScript Weight 
Typeface FileName Face Id (St;rle) 
New Century Schlbk-Italic NCI 20 4 
New Century Schlbk-Roman NCR 20 0 
New Century Schlbk-Bold Italic NCBI 20 5 
New Century Schlbk-Bold NCB 20 1 
Palatino-Italic POI 21 4 
Palatino-Bold Italic POBI 21 5 
Palatino-Bold POB 21 1 
Palatino-Roman POR 21 0 
Garamond-Bold GAB 22 1 
Garamond-Bold Italic GABI 22 5 
Garamond-Light GAL 22 0 
Garamond-Light Italic GALl 22 4 
Bookman-Demi BKD 23 1 
Bookman-Light Italic BKLI 23 4 
Bookman-Demi Italic BKDI 23 5 
Bookman-Light BKL 23 0 
Lubalin Graph-Demi Oblique LUDO 24 5 
Lubalin Graph-Book LUW 24 0 
Lubalin Graph-Book Oblique LUWO 24 4 
Lubalin Graph-Demi LUD 24 1 
Souvenir-Light SUL 25 0 
Souvenir-Light Italic SULI 25 4 
Souvenir-Demi SUD 25 1 
Souvenir-Demi Italic SUDI 25 5 
Benguiat-Book BGW 26 0 
Benguiat-Bold BGB 26 1 
Glypha-Bold GYB 27 1 
Glypha GYR 27 0 
Glypha-Oblique GYO 27 4 
Glypha-Bold Oblique GYBO 27 5 
Friz Quadrata FQR6 28 0 
Friz Quadrata-Bold FQB 28 1 
ZapfChancery-Medium Italic ZCMI 29 4 
Trump Mediaeval-Italic TMI 30 4 
Trump Mediaeval-Bold Italic TMBI 30 5 
Trump Mediaeval-Roman TMR 30 0 
Trump Mediaeval-Bold TMB 30 1 
Melior-Bold Italic MEBI 31 5 
Melior-Bold MEB 31 1 
Melior-Italic MEl 31 4 
Melior MER 31 0 
Galliard-Bold Italic GLBI 32 5 
Galliard-Bold GLB 32 1 
Galliard-Italic GLI 32 4 
Galliard-Roman GLR 32 0 
New Baskerville-Bold Italic NBBI 33 5 
New Baskerville-Bold NBB 33 1 
New Baskerville-Italic NBI 33 4 
New Baskerville-Roman NBR 33 0 
Goudy-Bold Italic GOBI 34 5 
Goudy-Bold GOB 34 1 
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Goudy-Italic GOI 34 4 
Goudy GOR 34 0 
Park Avenue PAM 35 0 
Bodoni-Bold Italic BDBI 36 5 
Bodoni-Bold BDB 36 1 
Bodoni -Italic BDI 36 4 
Bodoni BDR 36 0 
Bodoni-Poster BDPS 37 0 
Century Old Style-Bold COB 38 1 
Century Old Style-Italic COl 38 4 
Century Old Style-Regular CORG 38 0 
Cheltenham-Bold Italic CHBI 39 5 
Cheltenham-Bold CHB 39 1 
Cheltenham-Book Italic CHWI 39 4 
Cheltenham-Book CHW 39 0 

Sans Serifed Faces (International Character Set) 

PostScript Weight 
Typeface FileName Face Id (St;yle) 
Helvetica-Narrow-Bold HELVENB 50 1a 
Helvetica-Narrow-Bold Oblique HELVENBO 50 5 
Helvetica -Narrow-Oblique HELVENO 50 4 
Helvetica-Narrow HELVEN 50 0 
Avant Garde-Book AGW 51 0 
Avant Garde-Demi Oblique AGDO 51 5 
Avant Garde-Demi AGD 51 1 
Avant Garde-Book Oblique AGWO 51 4 
Optima-Bold Oblique OPBO 52 5 
Optima-Bold OPB 52 1 
Optima-Oblique OPO 52 4 
Optima OPR 52 0 
Korinna-Kursiv Bold KRKB 53 5 
Korinna -Bold KRB 53 1 
Korinna-Kursiv Regular KRKX 53 4 
Korinna -Regular KRRG 53 0 
Helvetica-Light HVL 54 0 
Helvetica-Light Oblique HVLO 54 4 
Helvetica-Black HVBL 55 0 
Helvetica-Black Oblique HVBLO 55 4 
Franklin Gothic-Demi FRD 56 1 
Franklin Gothic-Book FRW 56 0 
Franklin Gothic-Demi Oblique FRDO 56 5 
Franklin Gothic-Book Oblique FRWO 56 4 
Franklin Gothic-Heavy FRH 57 0 
Franklin Gothic-Heavy Oblique FRHO 57 4 
Helvetica-Condensed-Light Oblique HVCLO 58 4 
Helvetica-Condensed-Light HVCL 58 0 
Helvetica-Condensed-Bold Oblique HVCBO 59 5 
Helvetica-Condensed-Oblique HVCDO 59 4 
Helvetica -Condensed HVC 59 0 
Helvetica -Condensed-Bold HVCB 59 1 
Helvetica-Condensed-Black Oblique HVCO 60 4 
Helvetica -Condensed-Black HVCBL 60 0 
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Typewriter (mono-spaced) faces (International Character Set) 

PostScript Weight 
Typeface FileName Face Id (St,r:le) 
American Typewriter-Bold ATB 100 1 
American Typewriter-Medium ATM 100 0 
Machine MAM 101 0 
Courier-Oblique COURIO 102 4 
Prestige Elite PERG 103 0 
Prestige Elite-Bold PEB 103 1 
Prestige Elite-Bold Slanted PEBSL 103 5 
Prestige Elite-Slanted PESL 103 4 
Orator-Slanted ORSL 104 4 

~-

Orator ORRG 104 0 
Letter Gothic-Bold LGB 105 1 
Letter Gothic-Slanted LGSL 105 4 
Letter Gothic LGR6 105 0 
Letter Gothic-Bold Slanted LGBSL 105 5 

PI Fonts (Different Character Sets) 

Typeface 
Symbol 
ZapfDingbats 
Sonata 

PostScript 
File Name Face Id 
SYMBOL 128 
ZDM 129 
MUSO 130 

Weight 
(St,r:le) 

o 
o 
o 

VFM file format 
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The VFM file created during the width table genera­
tion process describes the font characteristics for 
each font file. It has the same format, regardless of 
what font file type (e.g., HP LaserJet Plus, Post­
Script) was used as the source. While most readers of 
this note will not need to edit the VFM file, the fol­
lowing information is provided for those who have 
the need to make changes to the font information. 
Remember, after you edit any VFM files, you must 
then generate a new width table using the 
VFMTOWID utility, and then merge this new width 
table using the AddJRemove Fonts option in the Op­
tions menu. Otherwise, changes made to the VFM 
table will not affect Xerox Ventura Publisher's out­
put. 
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A sample VFM file is shown below for reference. 

In this file, each field has the following function: 

DEVICE This specifies the printer or typesetter on 
which this font will be printed. The name is deter­
mined by the VFM converter you use. For example, 
if you use the HPLTOVFM converter, the DEVICE 
name will be automatically set to HP LJ+. This 
string is used to determine whether Xerox Ventura 
Publisher is currently set for draft or ultimate 
printing (as shown in the Set Printer Info Dialog 
Box.) Key Note: Draft printing is done on a different 
printer than the one for which you added fonts. Only 
the system fonts will be used when draft printing, 
and space between words will be adjusted as neces­
sary in order to make lines and paragraphs end at the 
correct place. 

TYPEFACE This specifies the typeface name. The 
name is set by the IF option during VFM generation. 
It can be a maximum of 15 characters, and must be 
unique for each type family. 

FACEID This number is the typeface ID. This num­
ber is set by the IN option during VFM generation. It 
must also be unique for each typeface. The valid 
range is 15-255 decimal. Serifed fonts are 20-49. 
Sans serifed fonts are 50-99. Mono-spaced fonts are 
100-127. PI fonts (i.e., character sets other than the 
international character set shown in figures E-1 and 
E-2) are 128 and above. 

SIZES This is the point size. It can range from 1-255 
points. This number is set by the IP option during 
VFM operation. The number 255 is used to set con­
tinuous font scaling (this enables the Custom font 
setting in the font Dialog Boxes.) 

ATTRTYPE This number specifies the weight ofthe 
font, where 1=medium; 2=bold; 5=medium italic; 
6=bold italic. This field along with sizes and face ID 
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are used by Xerox Ventura Publisher to uniquely 
identify a font. 

UFACEID This number is always the same as 
FACEID.1t is an abbreviation of ultimate face ID.1t 
is used to select the typeface on the printer when it 
is the ultimate device. 

USTYLE This number is used to select the weight 
of the font on the ultimate device. The numbering 
convention is different than ATTRTYPE: O=medium, 
l=bold, 4=medium italic; 5=bold italic. 

SFACEID This is no longer used in this version. 

SSTYLE This is no longer used in this version. 

TOP This defines the distance from the baseline to 
the top of the cell of the font, using a normalized 
measurement system. To convert this number into 
inches, use the following formula: (yDIVNMPY) * 
TOPI1200 

BOT This defines the distance from the baseline to 
the bottom of the cell of the font, using a normalized 
measurement system. To convert this number into 
inches, use the following formula: (YDIVNMPY) * 
BOT/1200 

XMPY,XDIV Xerox Ventura Publisher's coordinate 
system is based upon a 111200 inch grid. The ratio of 
these two numbers provides the conversion between 
the normalized internal measurement system, and 
inches. 

YMPY,YDIV Xerox Ventura Publisher's coordinate 
system is based upon a 111200 inch grid. The ratio of 
these two numbers provides the conversion between 
the normalized internal measurement system, and 
inches. 
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DEVICE HP LJ+ 
TYPEFACE Swiss 
FACEID2 
SIZES 18 
ATTRTYPE2 
UFACEID 2 
USTYLE 1 
SFACEID2 
SSTYLE 1 
TOP 72 
BOT 17 
YMPY4 
YDN18 
XMPY4 
XDN18 
DEVSPEC NONE 
WIDTHS 192 

Character widths, 
starting with the space 

/ character (decimal 32) 

21 252558426453192828377521 2521 24 
42 42 42 42 42 4242 42 42 42 23 23 75 75 7542 
75 51 53 56 54 49 45 58 56 23 41 53 44 66 56 59 
50595450455349704847452938297537 
19424641464324464520204220664546 
46 46 29 41 244540 5740 40 38 37 37 37 75 1 
56 45 43 42 42 42 42 41 43 43 43 20 20 20 51 51 
49667546464645454059534242454542 
42204645455629324233331818253434 
42 46 59 46 71 85 51 51 59 37 37 37 37 62 62 65 
33 75967537752551 51 49494923232323 
59 59 59 50 41 53 53 53 47 45 0 0 0 0 0 0 
KERN 2 
6599 -5 
65101 -5 ............... Kerning pairs. First 

pair is Ac. Second 
pair is Ae. 

Figure K-l Typical VFM file. 
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DEVSPEC This string is used to pass information 
to the output device at print time, and is associated 
with a particular face, size and weight. The format of 
the string must be: 

JUNKIpfilename/lfilename 

Ip must be placed in front of the portrait font's name, 
and II in front of the landscape font's name. 

WIDTHS This specifies the number of characters in 
the width table. 

The width shown in the VFM file is converted from 
points as follows: 

(1200172) * (XMPYIXDIV) * width 

Example: 

If XMPY=4 and XDIV=18, the width measurement 
for 18 points is: 

(1200172) * (4/18) * 18 = 67 

Modifying kerning pairs 
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This subsection describes how to add kerning infor­
mation, even for fonts that don't normally include 
kerning. 

To add kerning information, modify each font's VFM 
file prior to generating a width table. Kerning infor­
mation is appended to the end of the VFM file. For 
each pair of characters to be kerned, add a one line 
entry of the following form: 

Chari! Char#2 Kerning 

where Chari! is replaced with the· decimal 
equivalent for the first character, Char#2 is replaced 
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with the decimal equivalent for the second character, 
and Kerning is replaced with the amount of kerning 
desired. The units of measurement for kerning are 
the same as described above for VFM widths. 

Example: 

To provide 1.5 point kerning for a capital A (decimal 
65) followed by a capital V (decimal 86), where 
XMPY=4 and XDIV=14, add the following line to the 
end of the VFM file: 

65 86 ·7 

Add the word KERN followed by the number ofkem­
ing pairs before the first kerning pari. (See Figure K-
1.) 
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APPENDIXL 
STYLE SHEETS 

Xerox Ventura Publisher comes with 20 different style sheets. Each 
style sheet is named according to the following formula: 

&-identifies an original style sheet supplied with the software 
P or L-identifies the printing orientation as portrait (vertical) or 
landscape (horizontal) 
Digit-number of columns in the style sheet 
STY-file extension for a style sheet 

Thus, a book style which is printed portrait mode in two columns is 
&BOOK-P2.STY. 

Below is a complete list of style sheet titles with a brief description: 
&BOOK-P1.STY Book, I column 
&BOOK-P2.STY Book, 2 column 
&BRO-L2.STY Brochure, landscape, 2 column 
&BRO-P3.STY Brochure, portrait, 3 column 
&INV-PI.STY Invoice form with line items 
&LSTG-P2.STY Product listing 
&LTRI-P1.STY Letter 
&MAG-P3.STY Magazine 
&NEWS-P2.STY Newsletter,2 column 
&NEWS-P3.STY Newsletter, 3 column 
&PHON-P2.STY Phone listing 
&PREL-P1.STY Press Release 
&PRPT-P1.STY Proposal/report, I column 
&PRPT-P2.STY Proposal/report, 2 column 
&TBL-PI.STY Tabular financial table 
&TBL2-LI.STY Columnar table 
&TCHD-PI.STY Technical manual 
&TDOC-P1.STY Technical manual 
&VWGF-L1.STY Viewgraph, landscape 
&VWGF-P1.STY Viewgraph, portrait 

The style sheets provided with Xerox Ventura Publisher and 
described in the appendix represent common publishing applications. 
Any style sheet can be modified to fit your exact needs. Just remem­
ber to make a copy of the style sheet before editing so the original 
remains intact. Any changes made to a style sheet affect all chapters 
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which use it, To make a copy ofastyle sheet, use Save As New 
Style in the File menu. 

Xerox Ventura Publisher also provides a chapter file (on the Ex­
amples Disk) for each of the style sheets. The chapter file provides a 
text and frame Template for the style sheet to format. 

To look at an example of each style sheet: 

~ Select the Open Chapter option in the File menu. 

~ Select the chapter name which corresponds to the style sheet 
you want to see (i.e., &BOOK-Pl.CHP uses &BOOK-Pl.STY.) 

~ Specific information about typeface or point size is not given. 
This information varies according to the printer you have in­
stalled. 

Xerox Ventura Publisher also contains several other style sheets: 

CAPABILLSTY 

SAMPLEl.STY 
CHARSET.STY 

SCOOP. STY 

Used by the CAP ABILI chapter to visually 
show you the limitations of your printer. Open 
this chapter and then print it to see whether 
your printer can print white text on a black 
background or transparent graphics. This 
also shows you what font sizes your printer 
can print, and how much space it leaves 
around the edge of the page. The CAP ABILI 
chapter is shown on the next page. 
D sed for training exercises 
Used by the CHARSET chapter to display 
and print the Xerox Ventura Publisher 
character set. Printing this chapter will show 

you what characters your printer can print. 
Used by the SCOOP chapter to display an 
example of a typographically sophisticated 
page. You should open this chapter, then 
select individual frames to see how to create a 
complex document. 

To see an example of each style sheet:, open the chapter which has 
the same name as the style sheet. For example, to see an example of 
a phone list formatted with the &PHON-P2 style sheet, open the 
chapter &PHON-P2.CHP. 
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PRINTER CAPABILITY PAGE 

(Print This File On Your Printer To See What You Get) 
This page will help you understand the capabilities of your particular printer. It illustrates the use 

of white text on black background and other features which not all printers have. 

Reverse Text 
The box to the left should be black with the words "Reverse Text" primed in 
whiteon top of it. Ifyourprinlcrcannot print white texloo a black background, 
you will see only a black box. 

The word "Under" from the phrase "Text Under Graphics" should be com­
pletely obscured by the opaque circle on top of it. 

The word "Under" from the phrase "Text Under Graphics" should be partial~ 
ly obscured by the transparenlcirc\con lOp of it. On PostScript and some other 
printers which cannol handle transparent graphics, this picture will look iden­
tical to the one directly above. 

,,',9,1Il,12,14.18243648,72 

The numbers to the left represcnt a 
range of point sizes between 6 and 
72 point Timcs(or Dutch). If the size 
is not available in your printer, the 
number will print in the nearest 
available size. 
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The box outline to the left is drawn 
with 3 black ruling lines and its 
lower right hand comer is complete­
ly obscured by an opaque circle (i.e., 
graphics). 

CAPABILI.CHP 

This ruling line around the page 
goes right to edge of the physical 
page. When printed, the white space 
outside the ruling line represents the 
"dead" space to which your printer 
can't print. 
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STYLE SHEET: &BOOK-Pl.STY 

Description: Single column book layout 

Comment: For any document with multiple chapters or sections. 

Special Characteristic: Menu: Option 

One 36-pica column Frame Margins & Columns 

Column-wide rules above Paragraph Ruling Line Above 
and below Chapter # Ruling Line Below 

Chapter #, Chapter Title Paragraph Alignment 
centered on page 

Big first character Paragraph Special Effects 
in Firstpar 

Body Text indented 1.5 Paragraph Spacing 
inches in from left margin 

Bullet indented 10 picas Paragraph Spacing 
from left margin and begin Special Effects 
with • 

Ruling line separating Page Footnote Setting 
footnotes from text 

Page Break has page break Paragraph Breaks 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph Ruling Box Around 
a custom ruling box around 
where the width ofthe rule 
and the height of the rule are 
the same. 

Tags and Function Keys 
F1 Firstpar F2 Major Heading 
F3 Minor Heading F4 Bullet 
F5 Chapter Head F6 Chapter # 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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STYLE SHEET: &BOOK-P2.STY 

Description: Two column book layout 

Comment: For any document with multiple chapters or sections. 
Note how frame-wide Chapter headings keep text from flowing to top 
of second column on page one. 

Special Characteristic: Menu: Option: 

Rule around entire frame Frame Ruling Box Around 

Two 17-pica columns Frame Margins & Columns 
with a 2-pica gutter 

Chapter #, Chapter Title Paragraph Alignment 
flush left on page, extends 
across columns 

Big first character Paragraph Special Effects 
in Firstpar 

Major Heading flush left Paragraph Alignment 
in column 

Ruling line below Paragraph Ruling Line Below 
major Heading 

Bullet indented 10 picas Paragraph Spacing 
from left margin and begin Special Effects 
with • 

Page Break has page break Paragraph Breaks 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph Ruling Box Around 
a custom ruling box around 
where the width of the rule 
and the height of the rule are 
the same. 

Tags and Function Keys 
F1 Firstpar F2 Major Heading 
F3 Minor Heading F4 Bullet 
F5 Chapter Title F6 Chapter # 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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STYLE SHEET: &BRO-L2.STY 

Description: Two-column landscape brochure 

Comment: Use to describe meeting agenda 

Special Characteristic: Menu: Option: 

Two 26.5 pica columns Frame Margins & Columns 
with a 6-pica gutter 

Title, Subtitle and Setting Paragraph 
centered on page 

Alignment (frame-wide) 

Ruling line below Setting Paragraph 
(To use Setting tag 
without ruling line, press 
Ctrl + Enter after text to 
create a line break. July 
23, 1987 and Mariott 
Hotel are examples.) 

No line break after Time Paragraph 
(Line Break=Before. This 
means another tag, i.e., 
Event, can be on the 
same line, since it is in-
dented from left margin) 

Event and Position Paragraph 
are indented 1.5 inches in 
from left margin 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Ruling Line Below 

Breaks 

Spacing 

Breaks 

Tags and Function Keys 
F1 Title 
F3 Setting 
F5 Event 
F7 Time 
F9 Position 

REFERENCE GUIDE 

F2 Subtitle 
F4 
F6 
F8 Page Break 

F10 Body Text 
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ACME PUBLISHER 
Professional Publishing For Your Desktop 

ill can take text from 
;ur favorite word proces­

sor, and graphics from 
popular graphics programs 
or scanners, and create 
professionat, typeset quality 
documents. Without being a 
professional layout artist, 
typesetter or graphic desig­
ner. You don't even have to 
think 6ke one. 

You can compose any dow­
ment that you desire in a 
fraction of the time if would 
take to sel1d it to a typeset­
ter, proof 11:, and print it. 

Se!cifications 

Feature Muff. Mod, Rel.1 

Text Ves Ves Ve, 

Picture Yes No Ve, 

Ve, Ves 

With the Acme Pub6sher™, 
an you need to know is how 
to paint. The mouse driven 
software contaros dozens of 
professionally designed­
style-sheets-i'or news Ie!· 
tars, flyers, technicar docu­
ments, catalogs, proposals, 
and magazines. Pfus, you 

can design your own, or 
modify ours. 

-!f choose your design by 
selecting a style~sheet 
Click. Load text from your 
word processor. Clicle And 
watch ftffow, instantly, into 
your format. 

You want three corumns, not 
two? Click. Done. The whore 
chapter, up to 100 pages, is 
now three cofumn format 
with proportional spacIng, 
justifIcation. hyphenatioll, 
multiple type styles and 
sizes. Just like you get from 
the typesetter. 

Headline 

Deckhead 

Table Item 

Z_CAPTION 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &BRO·P3.STY 

Description: Three-column portrait brochure 

Comment: Use for sales brochures. 

Special Characteristic: 

Three 13-pica columns 
with a 1.5-pica gutter 

Headline automatically 
kerned and tracked 

Headline, Deck Head 
centered on page 

Major Head flush left 
over column 

Table Header centered 
over column 

Custom 1 point underline 
used on first line of Table 
Item 

Ruling line below 
Table Header 

Table Item tab settings: 
tab1=left (4 picas) 
tab2=right (10 picas) 
tab 3=right (13 picas) 

Menu: 

Frame 

Paragraph 

Paragraph 

Paragraph 

Paragraph 

Paragraph 

Paragraph 

Paragraph 

Body Text flush left Paragraph 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Option: 

Margins & Columns 

Typographic controls 

Alignment (frame 
wide) 

Alignment (column 
wide) 

Alignment 

Typographic controls 

Ruling Line Below 

Tab Setting 

Alignment 

Breaks 

Tags and Function Keys 
F1 
F3 
F5 
F7 
F9 

Headline 
Major Head 
Table Header 
Address 
List Item 

REFERENCE GUIDE 

F2 Deckhead 
F4 
F6 
F8 

FlO 

Table Item 
Page Break 
Body Text 
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Logo 

Address 

Date 

Customer 

Invoice 

Column heads 

Total 

m,croPublishing Report 
Small Computer Solutions for Publications Professionals 

2004 Cunis Ave. #A 

March 1, 1986 

Quantity Description 
Subscription 
Seminar fee including 
late charges 

Redondo Beach, CA 90278 

INVOICE 

Price 
$175.00 
$57500 

(213) 376-5724 

Subtotal 
$175.00 

$2,875.00 

-Total now due: ....................................................................................... $3,050.00 

Line item 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &INV-Pl.STY 

Description: Single column invoice 

Comment: Mixed type sizes in Logo. (Set tag attributes, then go to 
Text mode. Select the word to be in a different font and use Set Font 
to change it. Note: Paragraph Tag does not override Set Font at­
tributes) 

Special Characteristic: Menu: 

One 42-pica column Frame 

Address tab settings: Paragraph 
tab l=center (21 picas) 
tab 2=right (42 picas) 

Invoice in shaded box Paragraph 
(use an 18-pt. rule with 
pattern 1. Select a nega-
tive value (-) for Space 
Below Rule 3. This has 
the effect of moving the 
line below 18 points 
higher and creates dark 
words on a shaded band.) 

Column Head tab settings: Paragraph 
tab l=left (6 picas) 
tab 2=left (20 picas) 
tab 3=right (42 picas) 

Line Item tab settings: Paragraph 
tab l=left (6 picas) 
tab 2=left (20 picas) 
tab 3=decimal (40 picas) 

Ruling line above Paragraph 
Total 

Total tab settings: Paragraph 
tab 1 =decimal (40 picas) 

Option: 

Margins & Columns 

Tab Setting 

Ruling Line Above 

Tab Setting 

Tab Setting (leaders 
turned on for tab 3) 

Ruling Line Above 

Tab Setting 

Tags and Function Keys 
F1 
F3 
F5 
F7 
F9 

Headline 
Major Head 
Table Header 
Address 
List Item 

REFERENCE GUIDE 

F2 Deckhead 
F4 
F6 
F8 

FlO 

Table Item 
Page Break 
Body Text 
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Z_HEADER 

Category 

Comp 
Model 

Body Text 

Digitizers 

Digitizers OeclslonWare, Inc. . • (555) 383 6059 
RlghtWriter 
Document and style proofreader for IBM PC 
75.00 

Chorus Data Systems .......... (555) 424 2900 IBM PC 96K, DOS 2.0 
• PC·Eye 

.~ Video capture image digitizer 
450.00 

Emerging Technology. . .... (555) 447 9495 

IBM PC 256K, long slot 

Datacopy . . ... (555) 965 7900 
Model 900 Imaging System 

Professional Writers Package 
Word processing and document development 
software 
490,00 
192K 

35·mm digitizing camera with computer interlace 
11945.00 living Vldoetext, Inc .. 

Thinktank 
" . (555) 964 6300 

16M XT/AT, 
Hercules card Outlining software 

195.00 
Koala Technologies, Inc. . ... (555) 676 5655 IBM PC or Macintosh 
MacVisfon 
Image digitizer for MaCintosh computer RefetenceSoftware , . , , (555) 626 2222 
349.95 Reference Set 
Macintosh On-line thesaurus 

89.00 
Microvislon Co. . .. (555) 438 5520 IBM PC 
MacVIZ 
Image digitizer for Macintosh 
299.00 

ScenlcSoft Inc, 
ScenicWriter 

(555) 742 6677 

Macintosh Text editing, correcting, and composition software 
for IBM 

Quadram Corp. • ......... (555) 923 6666 PC 
Palette Capture 995.00 
Video input digitizer MS DOS 
795.00 
IBM PC 360K, DOS 2.1 TCI Software Research. , .... (555) 522 4600 

T3 

Editorial Software 

Arrlx Logic Systems Inc, ... (555) 292 6425 
APSlmicroDCF 
lBM·based lext processing system 

Scientific word processing system 
595.00 
IBM PC, S12K. graphics 

Writing Consultants. . . , .. (555) 377 0130 
Word Fmder 
On-line thesaurus 
124.95 
IBM PC 

pagel 4 Z_FOOTER 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &LSTG·P2.STY 

Description: Two column product listing 

Comment: Line breaks are used to separate different entries in 
Body Text. In long directory listing, this dramatically increases the 
size of the chapter that can be created compared to using paragraphs 
between each line. 

Special Characteristic: Menu: 

Two 19-pica columns Frame 
with a I-pica gutter 

"Live" headers automatically Page 
place, in the header, the first 
occurrence of text which is 
tagged as Category. This is 
stored in chapter, not style 
sheet. 

Text attributes in the footer Page 
(the word page is subscripted) 

Option: 

Margins & Columns 

Headers & Footers 

Headers & Footers 

Comp uses one tab, with 
with dot leaders to create 
the phone number. 

Paragraph Tab Settings 

tab:::right 19 picas 

Fl Category 
F3 Model 
F5 
F7 
F9 

REFERENCE GUIDE 

Tags and Function Keys 
F2 Comp 2 
F4 
F6 
F8 

FI0 Body Text 

L-15 
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Name - Ajax Corp. 

Address 
Leaders in Indus/ria/lnnovmion 

[ 
123 Sapporro RO:ld 

-+-----------I.~ palo~)~~;(i:i~~3~027~4 ...... I_----------_+-
..... 

Mr. 1. Smith 
I ~ 123 Main SI To ~ Detroit, MI 98989 November 15, 1987 ......... -1-

Body Text --r. D,," M,sm;th 

Body Text 

It has been called to our altemion that you have been having i\ difficult time with our new 

~ widget. Upon reviewing your case, we h;l'ie found that you have fuiled to plug your widget UllO 

an electrical outlet. As may know, OUf widget doe~ require power to operate properly 

Thank yOll for buying our widgets, and we look forw:lrd to your continued b\l~ines~ 

To~ 1 
S;"",dy. 

John L. Smith 

Cusromer Service MJnager 

Motto 

Phone 

Date 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &LTR·Pl.STY 

Description: One column standard business letter 

Comment: 

Special Characteristic: Menu: 

Company Name centered Paragraph 
with rule below it 

Body Text double spaced Paragraph 
(use Inter-line spacing option; 
Spacing Above is one-half 
the amount entered for 
Inter-line) 
Change inter-line spacing 
to 13.98 points for single 
line spacing. 

Date has line break after Paragraph 
with Beside Last Line of 
Previous Paragraph 
This, combined with 
right alignment places the 
date on the same line as 
the last line of the previous 
paragraph 

Page Break has page break Paragraph 
after set so that following 
paragraph starts new page. 

Change Bar is created with Paragraph 
a custom ruling box around 
where the width of the rule 
and the height of the rule are 
the same. 

Option: 

Alignment 
Ruling Line Below 

Spacing 

Break 

Alignment 

Breaks 

Ruling Box Around 

Tags and Function Keys 
F1 
F3 
F5 
F7 
F9 

Name 
Address 
Recipient 

Change Bar 

REFERENCE GUIDE 

F2 Motto 
F4 Date 
F6 
F8 Page Break 

FlO Body Text 
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Deckhead 

Byline 

Creditline 

Z_LABEL FIG 
Z_CAPTION 

First par 

Body Text 

Z_FOOTER ~NM'mb"I51988 

Laser Printers Arrive 
fwm 

Bullet 

+ • Laser printers wilh write-whLIe 
engines and copicr optIons, u~iTlg 
dry powder tuner 

Laser prnlt-crs still have a few arcus 
lhal_could be improved, according 10 
George Jones, a key indusuy analyst 
He noted that there are no standards in 

Figurc-I1-
Thc:Author 

This is a liflout. It 
highlights a keJ quole or -'N&lurI9sStSlcbfiLtrUCUttS 

Headline 

Subhead 

Bullet 

Lift 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &MAG·P3.STY 

Description: Three column magazine 

Comments: Note automatic figure numbering in frame captions. 
This is saved. in the chapter. Also, note that text in the Liftout box is 
from a different text file. 

Special Characteristic: 

Three l3-pica columns 
with a l.5-pica gutter 

Body Text first line indent 
of6 points 

Letterspacing on for Body 
Text 

Vertical rules between 
columns 
(Inter-column=on) 

Headline centered 
across page, frame-wide 

Firstpar not indented 
(Relative indent=O) 
Big first character in 
Firstpar 

Bullet has l.l-pica 
fixed indent 
each Bullet item begins 
with • 

Larger type size 
for text in liftout box 

Ruling lines above and 
below Liftout 

Menu: Option: 

Frame Margins & Columns 

Paragraph Alignment 

Paragraph Typographic Controls 

Frame Vertical Rules 

Paragraph Alignment 

Paragraph Alignment 

Paragraph Special Effects 

Paragraph Alignment 

Paragraph Special Effects 

Paragraph Font 

Paragraph Ruling Line Above 
Ruling Line Below 

Tags and Function Keys 
Fl Headline 
F3 Firstpar 
F5 Creditline 
F7 Byline 
F9 

REFERENCE GUIDE 

F2 Subhead 
F4 Deckhead 
F6 
F8 Bullet 

FlO Body Text 

L-19 
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Widget World News 
Views and News of Widget Manufacturing in the 80s ---

Headline +Software Salaries: How do you stack up? 

Byline +bYJOCSm'tl' I 
HowmuchyolJrsofLwareprof~ssionalsarepajdisafunc- CD·ROM Breaks New 

~o;o~~ ~r~n:ni;J~~I.CS. and a subject of consIderable ,nterest G ro u n d -
Subhead ~softWareSalarypaYS~aleS 

Because of the dynamiC growth of the software industry 
over Lhe la.>t decade, the demand for experienced, qualified 
programmers has greatly increaser;!, thus leading 10 3 spiraling 
ofsaJancs 

Body Text 

TOC Title 

Bul what causes managers to pay one programmer more 
lhan anOlhcr'! Docs the lype of organization, its size, or loca­
tion make a dJffcrcnce? Whm career path or programming 

~.PCCia!lY1Cadstolhcmostrcmllncration? 

To answer these questions. Acme Magazine recently COIl­
ducted il~ third annual compensation survey for software pro· 
fessionals_ This newslellcr article presents the results of this 
study and explores whalthe findings may mean to you 

Acme Magazine asked Joe Smith, a compensation consult­
ing specialist [or the software industry. LO design and eonduet 
the survey. T wcmy·four positions, representing four program­
mer job families plus management, were included. 

Data was collccted for base pay, bonl.lS and incentive pay­
ments, and whether nor not lncumbents received stock options 
orotherformsofequity. 

Questionnaires were sent to the data processing heads of 
2,400 organizntions throughout the United States 

-+--+-........ Table of Contents 

Sp 

... _3 TOC Entry -+-- •...... ",..5 Next comes /he fourth 

A Long artie/e breaks to the nexlline without 

running into the page number_ .. .. _ ...•. _ ... ",,_.6 

Note that this TOC could have been generated 
from the newsletter CHP file . .. _ ... 9 

Compact Disk Read Only 
MemorY (CD-ROM) IS a rap­
idly emerging new technol· 
ogy for the retrieval of vast 
amounts of information from 
an optical disk, This new 
peripheral device allows a to­
tally new level of func­
tionality in the use of 

Theory of Operation 
Information stored on a 

CD·ROM can be loaded into 
memory (RAM), displayed 
and printed, as with other 
media. While that data in 
RAM may be altered and 
storcd 10 a conventional mag­
netic di;k. the original infor­
mJtion o~ the CD-ROM is 

unalterable, always ensuring 
the original copy is intact, 
making archiving easy 

The storage capacity, low 
cost., and read only feature of 
CD-ROM bring an enormous 
new capability \0 microcom­
puter users - that is, infor­
matiorlretrievalofverylarge 
reference publications. How 
pcoplereceive and useinfor­
matiorlin the immediatcand 
longlerm fUlurewillbcdl""d­
matically changed by CD­
ROM, 

In addition to lhe huge ca­
pacity of raw information 
storage, spccializedsoftware 
forthesearchofthalinforma-

Caption ...... _-------+--
/lfanh,1Y87 --

Masthead 
Credo 

Headline 

Z_LABEL CAP 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &NEWS-P2.STY 

Description: Two column newsletter 

Comment: Frames placed on top of underlying page frame allow 
multiple text files to be placed in document. Each frame can have its 
own set of columns. Text flows from frame to frame. The order of flow­
ing is determined by what order the frames were created. 

Special Characteristic: Menu: Option: 

Two 20.5-pica columns Frame Margins & Columns 
with a I-pica gutter 

First line of Body Text Paragraph Alignment 
indent of 1 pica 

Table of Contents frame has Frame 
ruling box around and shaded 
background 

Ruling Box Around 
Frame Background 

Table of Contents entries Paragraph Spacing 
indented 1 pica from left 
and right frame margin 

TOC tab settings: 
Tab l=right (19 picas) 
leader=periods 

Successive hyphens 
in Body Text restricted to 
2 in a row 

Paragraph Alignment 

Tags and Function Keys 
Fl Deckhead 
F3 Bullet 
F5 TOC Entry 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 Credo 
F6 
F8 Subhead 

FI0 Body Text 
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Software Salaries: How 
do you stack up? 

hyJIlcSmith 

How mu~b your software profcs­
slonal~ arc JI'lid ~~ a funcuon or many 
variahle's, and a ~ubjCl1 of mn~idcr.lble 
zntcfl:stloyuurorganlf.:tuon. 

Software salarv pay scales 
Bccausc ofLhc dynamic grnwlh or 

tile sortware mdUSIT)' over the last 
decade, Ihe demand forc"pcricnccd, 
qualificd programmersltasgrcatly in­
creased,lhuskooingloaspiralingof 
salanes. 

Bu[v..t>a! causcsmanagcrlI 10 pay 
one programmer more than another? 

Z_CAPTION 

+ FlgullIl C.pL,,>nlnfonnau<lII 

Does the type of orgamzation,lts size, 
or location mak.e a differcnce? What 
earocrpaLhorprogrammLRgspccialty 
lcadsto thc most remuneration? 

To answcrlhcsc questions, Acme 
MagazlRcreecntlyeonductcditstbird 
annual compensation survey for 
software professionals. This ncwslet· 
tcrarucleprcscnts thc rcsults of this 
study andexplorcs what the findings 
muy mcan to you. 

Acme Magazincask.edJoeSmith,a 
compcnsalionconsultingspccialistfor 
the software ioduslf)', to design and 
conductthcsUTVeY. Twenty-fourposi­
lions, representing four programmer 
job families plus management, were 
inducted. 

November. 1987 

Detroit, MI9B987 

Data was collected for base pay. 
bonus and incenuve payments. and 
whclhcrnornotincumbentsrccelved 
SlOCkoptionsorOlhcrfonnsofcquily. 

Qucstionnaircswcrcscntlothedata 
processing heads of 2.400 organi7..a­
(ionslllmllgllouttbeUnitedStatc.~. 

CD-ROM BreaKS NeW 
Ground 

Compact DISk Read Only Memory 
(C[)"ROM) is a rapidly enlCfging new 
technology for the retrieval of vast 
amounts of lRformallon from an opU· 
cal disk. ThIS new penpberal deVIce 
allows a totally uew level of fune· 
1I0nahtYlnthcuscofmicrocomputcrs. 

Pbysically, the CD.ROM device 
bas a lascrdlSk. drive (OI "playcrj tbc 

same size as a traditional 51/4·' drive. 
Theremovablediskis43/4",andhas 
a capacity of 55 OM bytcs (equivalent 
to 1500 360K floppy dISks). 

Theory Of Operation 
Information stored on a CD·ROM 

can be loaded 1010 memory (RAM), 
displayed and prinled, as with other 
media. While that data in RAM may 
be altered and stored to a conventional 
magneticdisk,tbeoriginalinformation 
on !be CD-ROM isunalterabJe,always 
ensuring the origmai copy IS lUlaCt. 
making archiving easy. 

"The storage capacity, low cost, and 
read only featllfeofC[)..ROM bringan 
enormous new capability 10 

(413) 567-9888 

microcompU1C(users-~tbatis,infor­

mationn:u:-icwlofvcrylargercferencc 
pubhcauons. Howpcoplereceiveand 
use. informallon in tbe immediate and 
1000gtcnn fUlure will be drnmatically 
changed by CD-ROM. 

In addition to the bugecapacilyof 
raw information storage. ipOCialil.ed 
sofLware forthescarcbofthalinforma· 
tion is currently being intnxruced. 
This software allows scan:bing Ihc in­
formation in areas, metbods and 
speedsootpreviouslyfeasitlle. 

It now becomes possible to 
electronically publish reference 
material more economically than to 
print tIie same material in book form. 
Thatcost benefit, coupled. with search 
and retrieval software. make an 
astouisbing price/pwfonnance ratio. 

TabJe of Contents 
Firststory .•.•.... ,d •••••• _ •••••••• l 
Second sto(y, .• ,_ ...... ~ .•..•... 2 
Thf/lhltdartic/e ............... 3 
Next comes the fourth ....... 5 
A Lang article breaks to !he 
._J{ne without running into 

s,:1JieiatJepumbllr . __ ....... : .. 6 
.' Ntit¢thaithfs TOOcoutct 

Masthead 
Credo 
Address 

Body Text 

TOC Title 

TOC Entry 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &NEWS-P3.STY 

Description: Three column newsletter 

Comments: Unlike text in &NEWS-P2.CHP, the text in this 
chapter flows directly into the underling page. The table of contents 
frame has a ruling box around and a shaded background. These ef­
fects are part of the chapter, not the style sheet 

Special Characteristic: Menu: Option: 

Three 12.5-pica columns 
with a 2-pica gutter 

Page Margins & Columns 

Inter-column vertical rules 
between columns 

Headline has ruling line 
above 

Firstpar has no indent 
(Fixed indent=O) 

Body Text has I-pica 
fixed indent 

Table of Contents entries 
indented 1 pica from left 
frame margin 

TOC tab settings: 
Tab 1 = right (19 picas) 
leader=periods 

Frame Vertical Rules 

Paragraph Ruling Line Above 

Paragraph Alignment 

Paragraph Alignment 

Paragraph Spacing 

Generated caption line Paragraph Breaks 
break before. Free-form 
caption line break after and 
indent relative to length of Aligrment 
previous line plus 12 points 

Tags and Function Keys 
Fl Deckhead 
F3 Bullet 
F5 TOC Entry 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 Credo 
F6 
F8 Subhead 

FI0 Body Text 
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APPENDIX L-STYLE SHEETS 

CHAPTER: &PHON-P2.CHP 

Text file: PHONE.TXT 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PHON-P2.STY 

Description: Two column portrait style for phone books or other 
directories 

Comment: The break and alignment settings in the Body Text and 
Phone tags allow a directory to be created without tab settings. 
However, dot leaders cannot be used. Text was automatically tagged 
by database report generator. By making the company name a 
separate tag from the phone number, the company name can 
automatically be placed into the header. 

Special Characteristic: Menu: Option: 

Two 20.5 pica columns Frame Margins & Columns 
with a l-pica gutter 

"Live" header on odd and Page 
even pages. First and last 
occurrence of text tagged 
with Body Text are placed 
in the header. 

Ruling line below Header Paragraph 

Body Text has line Paragraph 
break before, but not after 

Phone has line break after Paragraph 
and right alignment. This 
makes the phone numbers 
appear on the same line with 
the company names. 

Phone flush right Paragraph 
in column 

Headers & Footers 

Ruling Line Below 

Breaks 

Breaks 
Alignment 

Alignment 

Tags and Function Keys 
Fl Phone 
F3 
F5 
F7 
F9 

REFERENCE GUIDE 

F2 
F4 
F6 
F8 

FlO Body Text 
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Name .. Ajax Corp. 
Leaders in Industrial f nnovation ..... 

[ 
123 Sapporro Road 

Address .. P'I"V''''~.CA9027_4 ... ~ __________ +-
(555)541-1234 .... 4 

For Release ~ FOR IMMEDIATE RELEASE 

XYZ COrp. Ships 1000th Product 

Formoreinfi,ormation: ~...- I _ 
Mr Joe Flack ............-r­

(212)555-12]2 

-
Datel ine ~I ws ANGELES, CA, July 17~XYZCorp .• thel~ading.manufacturerofwidgetsforthe aut~ated 

waget supply mdustry, announced that it has shipped Its IOOOth Model 123-X enhanced Widget. ~ ...... -+­
The customer is ABC Inc. of Livonia Hills, ML 

Body Text 
"This is an imponant step for XYZ Corp., and the emerging widget industry," said Fred Smith, 

~ president of XYZ Corp. "We have now shipped more widgets than the other ten companies com­
bined. We believe our technology is second to none." 

Marketing plans, availability, and pricing for Ihe new widget line will be announced later this fall. 

XYZ Corp., Inc. was fanned in 1975. Headquaners are in Los Angeles California. 

Motto 

Phone 

Contact 

Headline 

Firstpar 

UJ 
Cl 
5 
(9 

UJ 
() 
Z 
UJ 
a: 
UJ 
LL 
UJ 
a: 

<0 
C\J 
...j 



APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PREL·Pl.STY 

Description: One column press release 

Comment: The letterhead is placed in a separate frame. 

Special Characteristic: Menu: Option: 

One 39-pica column 

Contact is flush right 

Frame 

Paragraph 

Margins & Columns 

Alignment 

Dateline has line break Paragraph Breaks 
before, but not after 
(another tag can be placed on the same line) 

Firstpar has line break 
after 

Firstpar is indented 
relative to previous line 

Paragraph 

Paragraph 

Breaks 

Alignment 

The combination of Dateline and Firstpar attributes create an 
automatic lead-in. The first paragraph is always placed exactly after 
the Dateline, regardless ofthe Dateline length. Also, the Dateline is a 
different font from Firstpar. 

Tags and Function Keys 
Fl Headline F2 Dateline 
F3 For Release F4 Contact 
F5 F6 
F7 F8 Page Break 
F9 Firstpar FlO Body Text 
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Title of Report 

PROPOSAL TO ACME INSURANCE CORPORATION ....... --1-

Z_HEADER 

Title 
Head level 1 • Corporate Training 

T~h~'~Co~;~po~m~"~T~m~i"~i"~gd~'-PO-n-me~"~'h-",-'d~e~m~ifi-ed~'~"~Ob~je~CI~i'~eI-o-"d7e~si~g"~'~"d~re~w~~-'~o-o,-" 
900() pages of textual and ,graphic information which constitutes the company's training 
documentation elements. In addition to redesigning this substantial amount of inform all on, 
the department will also add new sections to the current tmining curriculum. The training 
documentation is currently available in a variety of media, mostly on much copied papers. 
Thedocumentation is ~omewhal outof date ,.., -------------, 
since the collection of materials dates back 

Body Text I .~ 

Bullet 

Head level 2 

Z_LABEL FIG 

Acme Insurance staff to coordinate the 

processes of rewriting the documentationr· 7Fi;gc;;:":i,"i.,Ti'The",7,,;Pp;:;,,,:;:'" i::'loc;'ii,h;:;,,;'jj,,:;:gc:::"-";;iiiliI.---.l-- Z _ C A PTI 0 N 
Currently, there is an in-house printing and 
type-setting shop. Because of delays and priorities, the training department does not have 
ready access to this facility. Due to the size and nature oflhis project, a decision has been 
made to evaluate departmental or work-group desk-top publishing solUlions specifically for 
the training facility. Having an depanmenlaI facility for documentation will give the train­
ing operation the following benefits: 

• FasllUm·around time without having to depend on another corporate department 
to print documentation. 

• Ability to make immediate changes and update training modules. 

• Ability to use already installed Personal CompUlers and Word Processing equip­
ment in association with the new publishing equipment 

• Ability to incorporate the new machinery directly into the day-to-day operations 
of the department. 

The TXN Solution 
It is the recommendation of TXN Corporation that Acme Insurance consider the 3544 
graphic workstation as the input terminal for the redesign/reformat processes in the training 
facility. TXN was the first company to offer this unique type of workstation. In 1976, we 
introduced the 9967 professional computer which had the power of combining textual and 
graphic elements on the same screen. Now, ten years later, after many modifications and 
refinements of our original technology, we are proud to introduce the 3544 Professional 
Workstation for publishing applications . 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PRPT·Pl.STY 

Description: One column proposal/report. 

Comment: Header and Footers are contained in chapter. Chapter 
has different headers on left and right pages. 

Special Characteristic: Menu: Option: 

One 36-pica column Frame 

Horizontal padding of Frame 

Margins & Columns 

Sizing & Scaling 
3 points for caption 
frame. This keeps the text 
on the left ofthe frame from 
touching the frame, yet the 
right side of the frame snaps 
to the right column guide. 

Ruling line below Head Paragraph 
Levell 

Bullet items indented 3 picas Paragraph 
in from left margin 

Extra space above and below Paragraph 
Bullet items (gives the effect 
of double spacing) 

Space between Body Text Paragraph 
paragraphs set with inter-
paragraph space This lets 
Head Levell be closer to 
Body Text than Body Text 
paragraphs are to each other. 

Ruling Line Below 

Spacing 

Spacing 

Spacing 

Tags and Function Keys 
FI Title F2 Head Levell 
F3 Head Level 2 F4 Bullet 
F5 F6 
F7 F8 Page Break 
F9 Change Bar FlO Body Text 
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Title 

Head level 1 

Body Text 

Bullet 

Z_FOOTER 

-
PROPOSAL TO ACME INSURANCE 

CORPORATION 

and pr,}(:,-'~S for the training dOCUlnenl:nion 
:-ls_ Brlden will bec-omc a Illember of the 
A'-'Ill': Insurance sl;lff !O coordinate the 
pro(C\SCS ofrewrillllg the documentalion. 

• Fast turn-around time without 
having to depend on another cor­
porate department to pTlnt 
documentation. 

equipment 

the new 
into the da\'­

lo-d;IY operations of the depan-

The TXN Solution ........ -------t-­
It is the recommendation ofTX:-J Corpora-
tion thaI Acme Insurance considerlhe 3544 

on the same screen. Now, ten years later, 
afler many modifications and 

-+-...... ~TitleofReport 1-1 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &PRPT-P2.STY 

Description: Two column proposal/report. 

Comment: Header and footers are in chapter, not style sheet. 
Ruling line around caption (store in chapter) has 3 points space above 
the rule. 

Special Characteristic: Menu: Option: 

One IS-pica column, one Frame Margins & Columns 
17 -pica column with a 
2-pica gutter 

Ruling lines above and below Paragraph Ruling Line Above 
Title Ruling Line Below 

Head Levell centered Paragraph Alignment (column 
in column wide) 

Bullet items indented 3 picas Paragraph Spacing 
in from left margin 

Extra space above and below Paragraph Spacing 
Bullet items (gives the 
effect of double spacing) 

Ruling line below footer Paragraph Ruling Line Below 

Different font for generated Paragraph Font 
caption than for free-form 
caption 

Tags and Function Keys 
Fl Title F2 Head Levell 
F3 Head Level 2 F4 Bullet 
F5 F6 
F7 FS Page Break 
F9 Change Bar FlO Body Text 
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APPENDIX L-STYLE SHEETS 

CHAPTER: &TBL-PI.CHP 

Text file: TABLE.TXT 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TBL-Pl.STY 

Description: One column table. 

Comment: Use for financial statements. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Column Heads tabs: 
Tab l=center (14 picas) 
Tab 2=center (30 picas) 

Ruling line below Column Paragraph Ruling Line Below 
Heads 

Body Text has fixed indent Paragraph Alignment 
of 3 picas from left margin 

Body Text and Total tabs: Paragraph Tab Setting 
Tab l=decimal (18 picas) 
(has dot leader) 
Tab 2 =decimal (35 picas) 

Ruling lines above and below Paragraph Ruling Line Above 
Total Ruling Line Below 

Tags and Function Keys 
Fl Column Heads F2 
F3 Category F4 
F5 Total F6 
F7 F8 
F9 FI0 Body Text 
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Title 
I • Title of this table 

Table header ~ HeaderlorTable NexlColumn Th;rdCol. Pr;ce 

Rule 

First Entry The second column describes some 
featu res 01 the item called out In the Ii rsl 
column. Notice thai the text for the 
column is too wide to lit on one line 
This type of style might be useful In a 
comparison chart where flowing texl is 

The third column might 
on Ihe second column 
column just holds a number, such as 
pnce 

$456 

~ used 

Second model. The next column The second model compareS qUite $654 
favorably to the firs! model descnbed .. 

Entry #3 More descriptive text about entry num­
ber three. Irs called WYSIWYG. It 
means that as you edit and modify, 
your screen shows you exaclly what 
you're going to get when you print it out. 
No surprises. It's all Ihere in front of 

~ your eyes. 

• 

Col 1 Col 2 

above. There's not as mUCh text here 
though. 

Another column of text $66 

~ j 

Col 3 Col 4 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TBL2-LI.STY 

Description: One column table in landscape mode 

Comment: This table style sheet uses tags to create vertical tabs. 
The ruling lines below Table Header is part of its tag. The other 
ruling lines are a separate tag attached to a paragraph with no text 
in it. 
Note: When adding text to vertical tab, you may have to push the 
ESC key to get the page to reformat. 

Special Characteristic: Menu: Option: 

One 54-pica column Frame Margins & Columns 

Title centered on page Paragraph Alignment 

CoIl has line break before, Paragraph Breaks 
no line break after 

Col 2 has no line breaks Paragraph Breaks 

Col 2 justified Paragraph Alignment 

Col 2 indented 12 picas in Paragraph Spacing 
from left margin; 28picas 
from right 

Col 3 has no line breaks Paragraph Breaks 

Col 3 indented 30 picas in 
from left margin; 10 picas 

Paragraph Spacing 

from right 

Col 4 has line break after 
no line break before 

Paragraph Breaks 

Col 4 flush right Paragraph Alignment 

Col 4 indented 36 picas in Paragraph Spacing 
from left 

Tags and Function Keys 
F1 Title 
F3 CoIl 
F5 Col3 
F7 Rule 
F9 

REFERENCE GUIDE 

F2 Table Header 
F4 Col2 
F6 Col4 
F8 

FlO Body Text 
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r;~~~~~.--- PUBLI$HINGCHAPTER I 
PUBLISHING CHAPTER 

.. MENU COMMANDS 

I 
Most of Ventura Publisher's functions are controlled 
through the menus at the top of the screen. This section 

-+---------I.~ ~~~~~~~i;~i~ ~~:~.t~;e~fee:~:~~~:~ep~~~ea~~~hi~ 
the order in which they appear on the screen. Use the 
index for an alphabetical reference to these commands. 

-+--------•• ~ Menu Conventions 

--.. DESK 

Often, a menu option will be shown in gray and cannol 
be highlighted. This usually indicates that the proper 
function has not been selected. The table below indi­
cates these dependencies 

I Publisher Info Always available .... 4.----i--
FILE 

N,. 
Open. 
Save 
Save As 

FILE MENU 

Must first Open chapter or load file 
Always available 
File name must be in title bar 
Always available 

Description/Application 

The File Menu controls information flow into and out of 
Ventura Publisher. 

Z_HEADER 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TCHD-Pl.STY 

Description: One column in portrait mode 

Comments: Use for technical documentation. This style sheet was 
derived from the one used to format this reference guide. The equa­
tion on page 2 illustrates the use of centered tabs to create equations. 
The text TECHDOC.TXT contains index references. Also, this style 
sheet contains both index and table of contents tags. Therefore if you 
generate either a table of contents or index, this style sheet will for­
mat them automatically. This is the most sophisticated style sheet in 
the TYPESET directory. 

Special Characteristic: Menu: Option: 

One 27-pica column Frame Margins & Columns 

Ruling line below header Paragraph Ruling Line Below 

Ruling line above footer Paragraph Ruling Line Above 

Chapter Head flush right Paragraph Alignment 
with ruling line below Ruling Line Below 

18 points of space below Paragraph Spacing 
Chapter Head 

Heading 1 flush left with Paragraph Alignment 
ruling lines above and below Ruling Lines Above 

Ruling Lines Below 
2 picas above and below 
Heading 1 

Paragraph Spacing 

Body Text indented 7 picas Paragraph Spacing 
in from left margin 

Ruling line below Heading 2 Paragraph Ruling Line Below 

Ruling line above Table 
Head 1 

Paragraph Ruling Line Above 

List 1 indented 8 picas Paragraph Spacing 
in from left margin 

Tags and Function Keys 
F1 Chapter Head F2 Heading 1 
F3 Heading 2 F4 Computer Text 
F5 Key Note Text F6 List 1 
F7 List 2 F8 Page Break 
F9 Table 1 F10 Body Text 

REFERENCE GUIDE L-37 



~ 

= 0 
~ 
~ 

I 

0 
0 
~ 

~I 
~ 
~ 

W 
I m 
W 
.-J 
>-

~ I-m 
J r.l 
x ~ 
0 

~ z 
w 
c... 
c... 0 « 

~ 

~ 
as -a= .... 
~ 
~ 
~ 

Z_SEC 1 

Z_SEC 2 
Z_LABEL FIG 

Z_CAPTION 

Z_SEC 3 

Z_FOOTER 

1.1 USER INTERFACE ......... ------_t_ 

VcnlUrn Publisher is designed to provide What You See (on the screen) Is What You Get 
printed (WYSIWYG). This means that the computer display should match as closely as 

~~~~~'l~~ aJ~~~~~~~:r~~;~ ~:~[p: ~np~gee~:~ ~~n;!:::a~! :U:b~:l~~::r:: ........ -+--
\0 prim a page on a laser printer or typesetter, do create some unavoidable differences. In 
particular. because the computerCRT screen cannot prodoce anywhere near the same resolu" 
lion of a prinu:r or typesetter, and because what IS displayed is shown in a diffcrcm aspect 
ralio (height 10 width ratio), the space between words and between lines may appear 10 be 
bigger or smaller than the printed page under certain cm:umstances. Several thin ruling 
lines, with lit~e space between, may show on the screen as one thiCK line 

""~------I.~B Keyboard Keys ........ --------------+--
Various keys on the keyboard perfonn special functions 

• The keyboard Cursor keys conuol the Text Cursor (The text cursor is displayed 
as a thin venical line.) 

• The Home key goes to the first page of the document 

• The End key goes to the last page of the document "4"~------+-
• The Pg Up key goes to the previous page. 

• The Pg Dn key goes to the next page. 

1.2. ITEM SELECTOR 

'-A 

1.2.1 Description 

The display shown in Figure 10-2 is called an Item Selector. The lrem Selector is used for 
savmg and retrieving files 

WYSIWYG 

Chapter Head 

Major Heading 

Body Text 

Minor Heading 

Bullet 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &TDOC·Pl.STY 

Description: One column in portrait mode. 

Comment: Use for technical documentation. Note: the frame is 
anchored below the first Major Heading. Also note, the text con­
tains many index points. Show Tabs & Returns to see where they are. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Auto-numbering used for Page Auto-Numbering 
Chapter Head, Major 
Heading, Minor Heading 

Generated tags for auto- Paragraph Breaks 
numbers have line break 
before, and not after 
(permits other tags 
on same line) 

Chapter Head, Major 
Heading, and Minor 

Paragraph Alignment 

Heading are indented 
relative to previous line 
plus 12 points 

Chapter Head, Major Paragraph Breaks 
Heading, and Minor 
Heading have line break 
after and not before 

Body Text, Table Head, Paragraph Spacing 
Table Item indented 9 picas 

Bullet, System Prompt Paragraph Spacing 
indented 11 picas in from left 
margin. Each Bullet item 
begins with • 

Paragraph Special Effects 

Ruling box around Warning Paragraph Ruling Box Around 

Tags and Function Keys 
F1 Chapter Head F2 Major Heading 
F3 MinorHeading F4 Warning 
F5 Table Head F6 Table Item 
F7 System Prompt F8 Page Break 
F9 Bullet FlO Body Text 
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Presenter's Organization 
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Use line breaks to add space vertically 
a - Use the special function keys as you type to tag the 

paragraphs you are typing 

- For instance, this paragraph was tagged by pressing 
function key F5 

Another subtopic 
Still another subtopic 

Another Main To~ic 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &VWGF-LI.STY 

Description: One column in landscape modeo 

Comment: Use for horizontal viewgraphs 

Special Characteristic: Menu: Option: 

One 54-pica column Frame Margins & Columns 

Title, Presenter centered Paragraph Alignment 

Ruling line below Paragraph Ruling Line Below 
Topic Levell 

Topic Level 2 indented Paragraph Spacing 
6 picas in from left margin 

T01ic Level 2 begins Paragraph Special Effects 
wit bullet (.), followed by 
Oo5-inch indent 

Topic Level 3 indented Paragraph Spacing 
12 picas in from left margin 

Topic Level 3 begins Paragraph Special Effects 
with and en dash (-) 
followed by Oo5-inch indent 

Tags and Function Keys 
Fl Topic Levell F2 
F3 Topic Level 3 F4 Table Item 
F5 Presenter F6 Title 
F7 F8 
F9 FlO Body Text 
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Presentation Title .. 
Presenter's Name 

Presenter's Organization .. 
..... Main To~ic is the Most Im~ortant 

.. Use line breaks to add space vertically 
Use the special function keys as you type 
to tag the paragraphs you are typing 

For instance, this paragraph was 
tagged by pressing function key 
F5 

Another subtopic 

This is a Diagram 

Still another subtopic 

Another Main To~ic 

Subtopic 
Subsubtopic 

Title 

Presenter 
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APPENDIX L-STYLE SHEETS 

STYLE SHEET: &VWGF·Pl.STY 

Description: One column in portrait mode. 

Comment: Use for vertical viewgraphs. 

Special Characteristic: Menu: Option: 

One 39-pica column Frame Margins & Columns 

Title, Presenter centered Paragraph Alignment 

Ruling lines above and Paragraph Ruling Line Above 
below Topic Levell Ruling Line Below 

Topic Level 2 indented Paragraph Spacing 
6 picas in from left margin 

T01.ic Level 2 befons 
wit bullet (. ), fol owed by 

Paragraph Special Effects 

O.5-inch indent 

Topic Level 3 indented 
12 picas in from left margin 

Paragraph Spacing 

Topic Level 3 begins Paragraph Special Effects 
with en dash (-) followed 
by O.5-inch indent 

Tags and Function Keys 
Fl Topic Levell F2 
F3 Topic Level 3 F4 Table Item 
F5 Presenter F6 Title 
F7 F8 
F9 FlO Body Text 
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REFERENCE GUIDE 

APPENDIXM 
APPLICATIONS 

This appendix gives step-by-step instructions for 
using Xerox Ventura Publisher for the following ap­
plications: 

Big First Character 
Bullets 
Columns 
Coupons 
Footnotes 
Headers and Footers 
Indents/Outdents 
Leaders 
Mixing Type Styles 
Reverse Type/Shaded Type 
Ruling Lines 
Tables 
Tabs 

Before you use this section, you should complete the 
exercises in the Training Guide so that you are 
familiar with the basic concepts and usage of the 
software. 

M-1 



APPENDIX M-APPLICATIONS Big First Character 

Big First Character 

The text in the example box below explains big first characters. 

B ig first characters (also called dropped caps) are frequently 
used to start the first word in a paragraph of a chapter, section 

or article. With Xerox Ventura Publisher you can control the num­
ber oflines indented to allow for the large letter. You can also shift 
the character up or down in the defined space. Directions for using 
this feature are in the "Menu Commands" section of this manual. t " ou can create a reverse box for your Big First Character by 

using a special combination of text-wide ruling lines and 
reaks. Instructions are given below. Make sure your printer sup­

ports reverse type before trying this feature. 

M-2 

Creating a reversed big first character 

~ Type the large letter and the text that will fol­
low it. Make the large letter a separate 
paragraph (i.e., the paragraph consists of just 
one letter). 

~ Create two new tags. Both should have the 
same attributes initially. The Spacing for both 
tags must remain identical even after you make 
the following modifications .. 

~ Select the Paragraph Tagging function and 
select the paragraph for the big first character. 

~ Select the Ruling Line Above option in the 
Paragraph menu. 

~ Select Text for the Width option. 

~ Enter 2 fractional points for the Space Above 
Rule 1. This controls the distance the black box 
extends above the first line of text. You can ad­
just this after you're finished. 

~ Enter a Height for Rule 1 that is about four 
points smaller than the tag's point size. For ex­
ample, create a 20 point rule for 24 point type. 
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~ Enter a Space Below Rule 3 that is the sum of 
the Space Above Rule 1 and the Height of Rule 
1. For example, for the values given in the pre­
vious two steps, enter 22. 

~ Select the - (minus sign) for the Space Below 
Rule 3. 

~ SelectOK 

~ With the letter still selected, select the Special 
Effects option in the Paragraph menu. 

~ Select Custom and then select the Space For 
Big First Character to the desired number of 
lines. 

~ Select the appropriate size and typeface and 
then select White for color. 

~ Select OK and then select OK again. 

~ Select the tag for the text that will follow the 
reversed letter. 

~ Select the Alignment option in the Paragraph 
menu. 

~ Select Relative Indent Length of Previous Line. 
Then enter an indent value of 2 to 3 fractional 
points. 

~ Enter a number to indicate how many lines 
should be indented to allow for the reversed 
box. 

~ Select OK 

~ With the paragraph text still highlighted, select 
the Breaks option in the Paragraph menu. 

~ Select After for the Line Break option. 

~ SelectOK 

~ Select the big first character and, if necessary, 
set the break option to Line Break Before. 
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Bullets 

The text in the example box below explains bullets. 

• The small black circle before this paragraph is traditionally 
called a bullet. Bullets are used to draw attention to blocks of 
text, for example, lists. 

• A bullet may be any character you wish. Some characters often 
used for bullets include: 

a hyphen 

* an asterisk or 
> a caret, or other special symbol 

• You can easily set the indent spacing after the bullet at the 
same time you define the bullet character. The indent space 
must be defined to prevent the bullet and text from overlap­
ping. 

• If you have a Postscript printer, you can define a square bullet 
by using ASCII value 110 and a Dingbat font. However, if you 
do not have a Postscript printer, you can create a square bullet 
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by using the custom rule above in the tag's paragraph settings. ,4 
The procedure for doing this is provided on the next page. ~ 

> Select the Paragraph Tagging function and 
highlight the paragraph which will begin with a 
bullet. 

> Select Special Effects in the Paragraph menu. 

> Choose Bullet 

> Optional: Select Set Font Properties if the bul­
let will have a different type face, size, or style 
than the rest of the paragraph. (All of the bul­
lets in the example box are 14 point; the text is 
10 point.) 

Select the appropriate options. 
Select OK 
The Special Effects dialog box displays 
again. 
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• Select one of the 13 characters for the Show 
Bullet As option. 

OR 

Select Other, if you want to define a special 
character which is not listed. 

• Enter the ASCII value for the bullet charac­
ter. See Appendix E for a complete listing of 
ASCII characters. 

>- Enter a value for the Indent After Bullet option 
that defines the space between the bullet and 
the text. A suggested value for the indent is an 
em. This will be the same number as the point 
size. For example, if the bullet is 12 point type, 
enter 12 fractional points for the indent. If you 
do not make an entry in this field, the text will 
print on top ofthe bullet. 

>- Select OK 

Note: If you want the bullet indented from the left 
margin, use the In From Left setting in the Spacing 
option from the Paragraph menu. 

Defining a square bullet 
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If you have a Postscript printer, you can use the 
steps above to define a bullet as ASCII character 
110. Select a Dingbat font for the character. 

If you do not have a Postscript printer, use the 
steps below for a square bullet. (You may have to 
experiment with the values given and make adjust­
ments for your printer.) 

>- Select the Paragraph for the bullet. 

>- Select the Ruling Line Above option In the 
Paragraph menu. 

>- Select Custom for Width. 

>- Enter a value for the Space Above Rule 1 that 
equals half of the size of the font used for the 
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tag. For example, enter 5 fractional points if the 
text for the tag is 10 point type. 

~ Enter the same number from the previous step 
for the Height for Rule 1 option. 

~ Enter a number that is the total of the numbers 
entered in the previous two steps for the Space 
Below Rule 3 option. For example, if you enter 5 
for both the Space Above Rule 1 and the Height 
of Rule 1, enter 10. 

~ Select the - (minus sign) for the Space Below 
Rule 3. 

~ Enter a value for the Custom Width that equals 
half of the size of the font used for the tag. For 
example, enter 5 fractional points if the text for 
the tag is 10 point type. 

~ SelectOK 

~ With the tag still selected, select the Alignment 
option in the Paragraph menu. 

~ Enter a value for the In/Outdent Width that 
identifies how much space should be placed be­
tween the square bullet and the text. 

~ Enter a very large value (for example, 100) for 
the In/Outdent Height. 

~ Select OK 
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Coupons 

Coupons (or other special forms) can be created easily using the Box 
Text feature in the Graphic Drawing function. Because the Box Text 
frame can have a shaded background, it's easy to create special ef­
fects, as shown in the illustration below. 

Use the other Graphic Drawing tools to add ruling lines, solid boxes or 
additional finishing touches to your form . 
...................................................... ..•..•....•••...... ~ 

Don't delay. Return this coupon today! 
Check the option you prefer: 

Name 
~~-------------------------------------------

Company ~ __________ ~ ____________________________ __ 

Address ___ ~~ __ ~ __ ~ ____ ~ __ ~ __ -'---~ __ ~ ____ ~ __ _ 

City _~ ____ ~ _____________ State ______ Zip ___ ~ __ _ 

...................................................... ......•............ ~ 

REFERENCE GUIDE 

~ Draw a brief sketch of the coupon or form you 
want to create. Try to estimate the amount of 
text that will be in each area. 

~ Select the frame that will hold the coupon. This 
can be a frame you have drawn especially for it 
or the underlying page frame. If you draw the 
coupon directly on the underlying page frame, it 
will repeat on every page in the chapter. 

~ Optional: If you want a broken line around the 
entire coupon, select Ruling Box Around in the 
Frame menu. 
• Select Frame for Width. 
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• 
• 
• 

• 

Select Solid for Pattern. 
Select Dashes Off (to turn Dashes On). 
Enter a value for the Height of Rule 1. 
A dashed line is shown in the Dialog Box. 
Select OK 

~ Optional: You may find it easier to work with 
rulers on. 
• Use Set Ruler in the Options menu to define 

the horizontal and vertical ruler measure­
mentunits. 

• Select OK 
• Select Show Rulers in the Options menu. 

~ Select the Graphic Drawing function. 

~ Select the Grid Setting option in the Graphic 
menu. 
• Select On for Grid Snap. 
• Enter values for the horizontal and vertical 

spacing. (If will draw a ruling line in a Box 
Text frame, set the grid to correspond to the 
point size of the type. For example, 12 frac­
tional points for 12 point type.) 

• Select OK 

~ Select Box Text and begin drawing boxes at 
each text location. Hold down the Shift key as 
you draw to keep the function selected. (You can 
also copy Box Text frames if you need multiple 
frames of the same size.) If you were creating a 
coupon similar to the one on the previous page, 
your final form would look similar to the one 
below. 

I 
Box Text 

I 

I Box Text I I Box Text I I Box Text I 

I 

Box Text 

I 
Box Text 

I 

Box Text 
I 

Box Text 
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~ When you have all of the Box Text frames 
drawn, select the Text Editing function. 

~ Delete the words BOX TEXT and enter the text 
for the coupon. 

~ Create new tags and change attributes as 
needed. 

~ Optional: If you need to add lines, use the Line 
Drawing tool in the Graphic Drawing function. 

~ Optional: If you want to add shading to any Box 
Text frame, use the Fill Attributes option in the 
Graphic menu. (You can also display this menu 
by pressing Ctrl + F.) 

~ Optional: Delete ruling lines around the Box 
Text frames by using the Line Attributes option 
in the Graphic menu. (Or, type Ctrl + L to dis­
play the menu.) 

Saving and loading line and fill attributes 
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You can define default values for line and fill at­
tributes. Once you define attributes for any of the 
Graphic Drawing tools, an object created with that 
tool has the assigned attributes. For example, if you 
draw a line and select rounded ends in the Line At­
tributes menu, the next line you draw will also have 
rounded ends. 

~ Select a line or a graphic (including Box Text 
frames) that will have the default values. 

~ Display either the Fill Attributes or Line At­
tributes options from the Graphic menu. 

~ Set the values you want. 

~ Select Save To ... 

~ SelectOK 
All graphics of the same type you now create will 
have the default attributes. 
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You can also apply stored default values to any 
graphic which has already been created. 

» Select the graphic which will also have the 
default values. 

» Select the Line Attributes or Fill Attributes op­
tion in the Graphic menu. 

» Select the Load From ... option. 

» Select OK 

Hints for graphics 

• 

• 

• 

If you have problems selecting an object created 
with the Graphic Drawing tools, change to the 
Frame Setting function and select the frame 
that the graphics are tied to. Then, select the 
Graphic Drawing function and select the object. 

Sometimes it is easier to draw long ruling lines 
with the line drawing tool using reduced view. 

If you want to block text or background shading 
from any area, draw a rectangle and choose 
White for Background and Opaque for Result in 
the Fill Attributes. The white boxes on top of 
the shaded area in the example for this section 
were created this way. This only works with 
some printers. It does not, for instance, work 
with any of the HP LaserJet printers. 
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Footnotes 

Footnotes are used in an article, paper or book to provide references to 
other information. They are placed at the bottom of a specific page to 
correspond to a reference number in the text. Footnotes can only be 
added to text on the underlying page frame. They cannot be added to 
text files in another frame or to box text. 

You control whether the footnotes are numbered from the beginning 
of a page or a chapter. The footnote number is automatically assigned 
a Z_FNOT # tag and the reference is assigned a Z_FNOT ENTRY tag. 
The attributes of these tags can be changed for different formatting ef­
fects. 

An example offootnote usage is in the illustration box below. 

Selected Data and Ratios 

Average Common Shares Outstanding (in thousands) 
Common Shareholders ~f Record at year-end 
Employees at Year-End 
Book Value per C2>mmon Share 
Return on Assets 3 
Return on ~quity 
Total Debt to Total Capitalization5 

96,159 
92,179 

110,936 
$45.54 

10.6% 
7.8% 

33.2% 

1 Excludes employees of discontinued operations and 
unconsolidated subsidiaries. 

2 Calculated by dividing profits before federal and foreign 
income taxes and outside shareholders' interests, from 
continuing operations by average assets of continuing 
operations. 

3 Calculated by dividing income from continuing operations less 
preferred stock dividends by average common and Class B 
shareholders' equity. 

4 Defined as the sum of notes payable, current portion of 
long-term debt and long-term debt. 

5 Defined as the sum of total debt, outside shareholder's 
interests in equity of subsidiaries, and common and Class B 
shareholders' equity. 
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Adding footnotes to a chapter 

You can insert footnotes into text that has already 
been typed and tagged or you can define the foot-
note settings and then create the text. ~ 
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> Select the Footnote Settings option in the Page 
menu. 

> Select one of the options for Usage and Format 
to indicate where the footnote numbering 
should begin (on the page or from the beginning 
of the chapter). 

> Optional: If you want the footnote number 
shifted up from the text baseline, select Super­
script for the Position of Number option. 

OR 

If you want the footnote number shifted down 
from the text baseline, select Subscript for the 
Position of Number option. 

> Optional: Enter a length for the line between 
the footnotes and the document in the 
Separator Line Width option. The length of the 
line is measured from the left margin of the 
page, although the line will not print in the 
margin. 
• Optional: Enter a value for the space above 

the separator line (and below the text). 
Enter a value for the width of the line in the 
Height of Line option. 
Select OK 

> Select the Text Editing mode and place the cur­
sor at the position in the text where the footnote 
number is to be inserted. 

> Select the Insert Footnote option in the Edit 
menu. 
A reference number appears to the left of the cur­
sor. At the bottom of the page, the same reference 
number appears followed by: TEXT OF FOOT­
NOTE. 
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Note: If you have selected Show Tabs & Returns 
in the Options menu, the footnote location will 
also be marked in the text by a 0 symbol to left of 
the footnote number. This symbol remains with 
the text if you ever turn footnotes off. 

» Move the text cursor to the footnote frame and 
delete TEXT OF FOOTNOTE. 

» Type the text for the footnote. The only limit on 
footnote size is that the combined length of all 
footnotes should not exceed one-half page. 

Formatting footnotes 
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When you insert footnotes in a chapter, two tags, 
Z_FNOT # and Z_FNOT Entry, are automatically 
generated. These tags have Body Text attributes. 

These tags can be changed just like any other tag 
by using the Paragraph menu. 
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Indents/Outdents 

The text in the example box below explains the different methods of 
indenting text. 

Indenting the first line of a paragraph is the most common 
use of an indent. Paragraphs are not indented by using the 
Tab key. Instead, you set the amount of the indent in the 
Alignment option in the Paragraph menu. This paragraph has 
a First Line Indent of 0.25 inches. 

IY ou can also set an outdent with the Alignment option. An out­
~ent simply means that the beginning line or lines of a paragraph 

are moved to the left of the margin of the frame or page. You 
can define the number oflines a paragraph should be indented 
or outdented. This paragraph has a First Line Outdent of 0.25 
inches and an In/Out Height oftwo lines. 

Indent 
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Sometimes you may want to create a 
special effect by indenting text from 
both margins. This is frequently used 
in legal documents or for indicating a 
long quote. These temporary margins 
are set in the Spacing option in the 
Paragraph Menu. This paragraph has 
In From Left and In From Right both 
set to 0.75 inches. 

This paragraph has temporary 
margins set in the Spacing option. It 
also has a paragraph indent set in the 
Alignment option. 

Hanging indents are created as two separate 
paragraphs. The technique is described on the 
next page. In this example, the boldfaced word In­
dent at the beginning of the paragraph is actually 
a separate paragraph. 
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Hanging indents 
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To create a hanging indent, follow these steps: 

~ While in the Text Editing function, type the 
part of the paragraph that is to be hanging in 
the margin and press the Enter key. Then type 
the rest of the paragraph. 

~ Select the Paragraph Tagging function. 

~ Select the first paragraph. 

~ Select the Breaks option in the Paragraph 
menu. 

Select Before for the Line Break option. 
• Select OK 

~ Select the second paragraph. 

~ Select the Spacing option in the Paragraph 
menu. 
• Enter a value for In From Left to separate 

the second paragraph from the first. For ex­
ample, 1.00 inches. 
Select OK 

~ Select the Breaks option in the Paragraph 
menu. 
• Select After for Line Break. 
• Select OK 

For information on how to create more complex 
hanging indents, consult the Tables heading later 
in this appendix. The vertical tabs described there 
are really just another form of hanging indent. 
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Leaders 

Leaders are commonly used in tables of contents and in programs. 
Generally, the period is used for leaders; however, hyphens, under- I 

lines or other special characters may be selected. Leaders are defined 
in the Tab Setting option in the Paragraph menu. You can define 
leaders for any or all of the tag's tabs. 

The example in the box below shows leaders used in a table of con­
tents. (See Exercise 7 in the Training Guide for information on creat­
ing a table of contents.) 

TABLE OF CONTENTS 

Introduction ...................................................................................... .1 

Setup and Installation ...................................................................... 7 

User Interface .................................................................................. 1 7 

> Select the Paragraph Tagging function. 

> Select the paragraph which will have the tabs 
with leaders. 

> Select the Tab Settings option in Paragraph 
menu. 

> Select 1 for Tab Number. 

> Select one of the alignment positions for Tab 
Type. 

> Select Shown as Leader Char for Tab Display 
option. 

> Enter the Tab Location as measured from the 
left margin of the frame or column. 

> Select periods for the Leader Character. 
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• Optional: Select Leader Spacing (1,2, etc.) to in­
crease the space between leaders. (No space 
was added to the example in the box.) 

~ SelectOK 
Leaders are active for each tab in the tag 

Deleting leaders from tabs 
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Sometimes you may have multiple tabs set for a tag 
and just need leaders in one of them. When this 
happens, 

~ Select the tab in the tag which should not have 
leaders. 

~ Select Shown As Open Space for the Tab Dis­
play option. 

~ Repeat for each tab which should not have 
leaders. 

~ SelectOK 

Note: There is more information on leaders in the 
"Tabs" section of this Appendix. 
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Mixing Type Styles 

There are several methods for mixing type styles and sizes on a page. 
For example, if you want your paragraph lead-in (first sentence) to be 
in larger type, as shown in the example box below, you would create a 
different tag for it. This tag would have a Break Before. The tag for 
the remainder of the paragraph would have a Break After and would 
be indented relative to the previous line. 

Normally you set font type for an entire tag. However, to add special 
emphasis you may want to have individual words in a different font. 
You can use the Set Font button to change text attributes while in 
Text Editing mode. The word "INTERNATIONAL" in the company 
name in the example below was done this way. 

You can also use the list of text attributes in the Assignment List to 
change the appearance of a specified word(s) by bolding, underlining 
or using another text attribute. (If you want to add the codes for these 
attributes while creating the document in your wordprocessor, see Ap­
pendixD.) 

the INTERNATIONAL company 

123 Main Street Dallas, Texas 75201 214/555-9080 

Dear Ms. Jones: 

You may already be a winner! That's right. We've al­
ready selected prize winners living in your zip code and you could 
be among them. This year we will award our largest sweepstakes 
prize ever. 

The grand prize is $500,000 a year for the rest of your life! Just 
think what that means. No money worries ever again. 

To find out if you're a winner, just return the card in the envelope 
provided. We'll announce the prize winners soon. 

Don't delay. Reply today. 

Sincerely, 

J. Ross, President 
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Creating a lead-in 

~ Select the Paragraph Tagging function. 

~ Select the text for the lead-in. 

~ Select the Paragraph menu. 

~ Change the lead-in attributes to: 
Font As desired 
Line Break Before 

~ Now select the paragraph which follows the 
lead-in and change its attributes to: 
Font As desired 
Alignment First Line Indent 

Indent width=em 
Relative Indent=Length 
of Previous Line 

Line Break After 

~ Optional: If the lead-in will be more than one 
line in length, make the following change to the 
paragraph following it: 
Breaks Next Y Position= 

Beside Last Line ofPrev. 
Para 

Using Set Font to change text 
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~ Select the Text Editing mode. 

~ Select the text to be changed. 

~ Select the Set Font button. 
The Font Setting dialog box displays. 

~ Select the appropriate options. 

~ SelectOK 
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Using the Assignment List to change text 

~ Select the Text Editing mode. 
The Assignment List shows the following at­
tributes: 

Normal (cancels any changes made by select­
ing one of the other options, except case con­
versions, and returns text to whatever at­
tributes are specified in the paragraph tag) 
Bold . 
Italic 
Small (reduces the type size in proportion to 
its original size) 
Superscript 
Subscript 
Underline 
Double Underline (UndrLn) 
Strike-thru 
Overscore 
Upper Case (changes all letters to capitals) 
Capitalize (starts each word with a capital) 
LowerCase 

~ Select the text you want to change. 

~ Select one of the options. 
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Reverse Type/Shaded Type 

Reverse type is white letters printed on a black background. Check 
Appendix F to see if your printer supports this style of printing. The 
example below shows reverse type. 

REVERSE TYPE 
Shaded, or screened, type is black letters printed on a gray back­
ground. The example below shows shaded type. 
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~ Select the Paragraph Tagging function. 

~ Select the paragraph that will print in reverse 
or shaded type. 

~ Select the Font option in the Paragraph menu. 

~ Select the correct point size. 

~ Select White for Color for reverse type. 

OR 

Make sure Black is selected for Color for shaded 
type. 

If you selected White for reverse type, a black bar 
indicates the position of the paragraph. The text 
cannot be read since the letters and background 
are both white. 

~ SelectOK 

~ With the paragraph still selected, choose Ruling 
Line Above option in the Paragraph menu. 

~ Select one of the Width options. 
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> Select Solid for Pattern for reverse type. 

OR 

Select one of the numbered Pattern options for 
shaded type. 

The Pattern selected displays in the dialog box. 

> Enter a Height for Rule 1 that is larger than 
the tag's point size. For example, create a 36 
point rule for 24 point type (shown in the 
reverse type example) or a 24 point rule for 18 
point type (shown in the shaded type example). 
This will result in the thick, black rule being 
placed above the text. 

> Select the - (minus sign) for Space Below Rule 3 
option. (Remember that this measurement rep­
resents the space below the last ruling line, not 
just the third line.) Choosing this option will 
subtract space, so that the ruling line is moved 
down, on top ofthe text. 

> Calculate the distance the ruling line should be 
shifted in order to center the text within the ( 
ruling line. 

Add the ruling line height and the type 
point size. 

• Divide the total by 2. 

Example: 
36 = points in ruling line height 

+ 24 = type pOint size 
= 60 
+ ~ 

30 

OR 

24 = points in ruling line height 
+ 18 = type point size 

42 
-'- ~ 
= 21 

> Enter the distance calculated in the step above 
(e.g., 30 or 21) for the value in the Space Below 
Rule 3 option. Select OK 
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Tables 

Tabs can be used to place single lines of text in a table. However, often 
text must flow freely within a column, as shown in the example box 
below. This kind offormat requires a vertical tab. 

A vertical tab is not a column, but an effect created with tags. The 
columnar effect is created by using In From Left and In From Right 
margins and (line) Breaks. To add additional space between blocks of 
text in one column, use a line break (Ctrl + Enter) rather than a 
return. 

For information on setting statistical tabs, see the section on "Tabs" in 
this Appendix. 

Position 

Technical 
Writer 

Secretary 

Depart. 

DoclEd 

Accounting 

Duties 

Prepares instructional 
material for customer 
use; edits technical 
material for in-house 
training courses. 

Prepares correspon­
dence for department 
manager and staff; re­
searches and completes 
monthly activity report 
for on-going projects. 

Grade 

10 

5 

Sometimes you may want to create a table consisting of single lines 
which should be boxed. This effect also created using vertical tabs 
that have a ruling box around. 

Position Department Reports To Grade 
Writer DoclEd Jane Jones 10 
Grade level 1 
Secretary Accounting Bob King 5 
Clerk II Personnel David Smith 3 
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Typing text for vertical tabs 

> Type all the text for the table using your word 
processor or the Text Editing function. Type 
each block of text as a separate paragraph. 
Type the paragraphs in the order they will ap­
pear, reading across. For examfle, for the il­
lustration above, type "Technic a Writer", then 
type "Doc/Ed". 

> Use a line break (Ctrl + Enter) to add space be­
tween lines. Do not use the Return key. 

Creating tags for vertical tabs 

Each column is tagged with its own separate tag. In 
the example on the previous page, you sill need four 
tags. 

You use a special combination of In from Left and 
In from Right settings (Spacing option) and Breaks 
to define vertical tabs. The settings (in inches) for 
the multi-line table in the example box on the pre­
vious page are: 

Column 1 
(Position) 

Column 2 
(Depart.) 

Column 3 
(Duties) 

Column 4 
(Grade) 

In from Left -
In from Right -
Line Break-
In from Left -
In from Right -
Line Break-
In from Left -
In from Right -
Line Break-
In from Left -
In from Right­
Line Break-

o 
3.50 
Before 
1.00 
2.50 
No 
2.00 
0.75 
No 
3.75 
o 
Mter 

The settings for the single line table in the example 
are: 
Column 1 
(Position) 

In from Left -
In from Right -
Line Break-

o 
3.40 
Before 
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Column 2 
(Depart.) 

Column 3 
(Reports To) 

Column 4 
(Grade) 

In from Left -
In from Right­
Line Break-
In from Left -
In from Right­
Line Break-
In from Left -
In from Right -
Line Break-

The first column 

1.25 
2.15 
No 
2.50 
0.75 
No 
3.90 
o 
After 

>- Select the Paragraph Tagging function. 

>- Select the text for the first vertical tab. 

>- Select the Spacing option in the Paragraph 
menu. 
• Define In from Left as 0 (unless it should 

align with other text that is indented. Then, 
use the same measurement for the indent). 

• Enter a value for In from Right that sets 
the right-hand margin of the first column. 

• Select OK 

>- Select the Breaks option in the Paragraph 
menu. 

Select Before for Line Break. 
• Select No for Allow Within 

Select Yes for Keep With Next 
Select OK 

The middle columns 

>- Select the text for the second vertical tab. 

>- Select the Spacing option in the Paragraph 
menu. 
• Enter a value for In from Left that iden­

tifies the left-hand margin of the column. 
Make sure that this value allows for the 
second column to begin past the point where 
the first column ends. 

• Enter a value for In from Right that iden­
tifies the right-hand margin of the column. 

• Select No for Allow Within 
Select Yes for Keep With Next 

• Select OK 
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> Select the Breaks option in the Paragraph 
menu. 

Select No for Line Break. 
• Select No for Allow Within 
• Select Yes for Keep With Next 
• Select OK 

> Repeat these steps for any columns located be­
tween the first and last columns. 

The last column 

> Select the text for the last column. 

> Select the Spacing option in the Paragraph 
menu. 

Enter a value for In from Left that iden­
tifies the left-hand margin of the column. 

• Define In from Right as o. 
• Select OK 

> Select the Breaks option in the Paragraph 
menu. 
• Select Mter for Line Break. 
• Select No for Allow Within 
• Select Yes for Keep With Next 
• Select OK 

Placing boxes around vertical tabs 

> Select the Paragraph Tagging function. 

> Select the first vertical tab which you defined 
according to the steps listed above. 

> Select the Ruling Box Around option in the 
Paragraph menu. 

> Select Margin for Width. 

> Enter a value for the Height of Rule 1. This 
should be narrow since it will overlap lines from 
other tabs. For example, enter .002 inches. 

> Select OK 
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~ Repeat defining a ruling box around for each 
vertical tab in the table. 

~ Optional: Select the Spacing option in the 
Paragraph menu for each vertical tab and 
delete any extra space being added above or 
below the tag. 

Using Box Text for tables 

REFERENCE GUIDE 

You can also use Box Text to create multi-line 
columnar formats. Simply draw Box Text frames at 
each location where text will be placed. See the sec­
tion on "Coupons" in this appendix for information 
on how to use this feature. 
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Tabs 

Tabs can be used for simple tables in which the entries do not exceed 
one line in each column. For multiple line columns, see the section on I 

"Tables" in this Appendix. The text in the example box shows simple 
columns set using tabs. 

METROPOLITAN HOME PRICES 

Metro Area 1986 

Boston ........................ $156,200 
Chicago ........................... 84,700 
Dallas ............................. 93,600 
Denver ............................ 86,200 
Houston .......................... 72,000 
Los Angeles .................. 128,700 
Memphis ........................ 71 ,300 
Metro NYC ................... 160,000 
Phoenix .......................... 78,800 
Portland ......................... 63,400 

Setting tabs 

1985 

$131,000 
81,800 
87,100 
83,700 
76,200 

116,900 
63,800 

130,400 
73,900 
60,600 

% Change 

19.2% 
3.5 
7.5 
3.0 

-5.5 
10.1 
11.8 
22.7 

6.6 
4.6 

You may need to define different tab settings for the 
heading line. For example in the illustration above, 
the tabs (in inches) for the heading line are: 

M-28 

Tab 1 = 1.75 (centered) 
Tab 2 = 3.00 (centered) 
Tab 3 = 4.00 (centered) 

The tabs for the listing itself are: 

Tab 1 = 2.00 (right) 
Tab 2 = 3.25 (right) 
Tab 3 = 4.00 (decimal) 

> Select the Paragraph Tagging function. 

> Select the Paragraph which will contain tabs. 
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~ Select the Spacing option in the Paragraph 
menu and make sure that Alignment is not set 
for Justified. 

~ Select Show Rulers in the Options menu. 

~ Select the Tab Settings option in the Paragraph 
menu. 

~ With Tab 1 selected for Tab Number, select Tab 
Type. 

Left tabs start at the Tab Location 
Center tabs are centered around the Tab 
Location. 
Right tabs end at the Tab Location. 
Decimal tabs place the decimal at the Tab 
Location. 

~ Enter a value for the tab location measured 
from the left margin of the current column. 

~ Continue selecting Tab Numbers and defining 
locations until all tabs are defined. 

~ Select OK. 

Adding leaders to all tabs 

Frequently you can make tabbed material easier to 
read by using leaders. Leaders are usually a line of 
periods which connect columns of text. (Refer to the 
"Leaders" section in this Appendix for more infor­
mation.) 

~ Define each tab location using the steps in "Set­
tingtabs". 

~ Select Shown As Leader for Tab Display option 
for any tab which has been defined. 

~ Select the periods as the Leader Character. 
Leaders are active all of the defined tabs in the 
paragraph. 

~ SelectOK 
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Turning off leaders in specific tabs 

The example in the illustration box has leaders in 
the first tab only. 

~ Define each tab location using the steps on the 
previous page. 

~ Select the Tab which will have leaders. 

~ Select Shown As Leader Char for the Tab Dis­
play option. 

~ Select the periods as the Leader Character. 

~ Select Shown As Open Space for the Tab Dis­
play option for other tabs in the tag. These tabs 
will not have leaders. 

Setting tabs for mixed units 

Sometimes you may have different units appearing 
in tabbed material. For example, you may want to 
have a special symbol following a tab, as shown in 
the example below: 

Common share market value 

Return on Assets 

~ Set a right tab for the number. 

$59.75 

10.6% 

~ Set a left tab at the same location. In the ex­
ample above this tab would be used for the per­
cent sign. 

Comments 

When you are entering text with your word proces­
sor that will be formatted into tabs in Xerox Ven­
tura Publisher, insert only one tab character be-
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tween columns. Do not try to align the tabs in the 
word processor; align the tabs in Xerox Ventura 
Publisher. 

Also, many word processors insert spaces instead of 
a true tab code. Refer to Appendix D for more infor­
mation. 
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A 

Abandon, 5-12 
Abort 

Go to page, 3-3, 5-76 
Installation, A-4 
Print, 3-3 

Add new frame, 4-3 
Keep enabled, 3-3 

Add new tag, 4-14 
Adding non-keyboard characters, 4-25 
Alignment, 5-108 - 5-11 0 

Example, frame wide, L-7, L-19 
See also Set rulers 

Alt key, 3-3 
Anchors & captions, 5-92 - 5-95 
Apple LaserWriter 

See LaserWriter 
Arabic numbering 

Defined, 5-50 
Arrow keys 

See Cursor keys, 3-3 
Art 

See Pictures 
Ascender, 1-1 
ASCII text, D-11 

Characters not used, D-12 
Defined,I-1 
From mainframes, D-12 

Aspect ratio, 3-19 
Assign function keys, 4-22, 

5-136 - 5-137 
Assignment list, 3-17 

Defined, 3-17, 1-1 
Tag names in capitals, 6-16 
Using to change text 
attributes, M-20 

AST ThrboLaser, F -24 - F -26 
Fonts, F-24 
Images, number/page, F-25 
New fonts for, K-12 - K-13 
Print to fIle, F-25 
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INDEX 

Attribute 
Defined,I-1 
See also Text attributes 

Auto adjust styles, 5-107, 5-151 
Auto-numbering, 5-54 - 5-60 

Example, L-39 
See also Section numbering 

AutoCAD, G-1 

B 

Creating slide files, G-1 
DXF files, G-1 
Slide files, G-1 

Backspace key, 3-3, 4-20 
Backup fIles, 5-10 
Bad break 

See Widow 
Baseline, 1-1 
Baud rate on PostScript printer, F-19 
Beep 

What it means, 3-6, 3-12 
Beginning the program, 2-7 
Big first character, 5-123 - 5-124, 

M-2 - M-3 
Example, L-7 
Reversed, M-2 

Binding margins, 5-80 
Defined,I-1 

Blowup 
See Sizing & scaling 

Body text, 5-104 
Cannot remove, 6-16 
Defined,I-1 

Body type 
See Body text 

Bold 
See Text attributes 

Borders 
See Ruling box around 
See Ruling line abovelbelow 
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Box 
See Ruling box around 
See Ruling line abovelbelow 

Box text, 4-32, M-27 
Compared to frames, C-4 
Using for coupons, M-7 

Breaks, 5-117 - 5-119 
Defined,1-2 
Example, L-9, L-15, L-17, 
L-25, L-27, L-35 

Vertical tabs, 6-18 
Bring to front, 5-140 
Broadsheet, 5-21 
Bullet, 5-123 - 5-124, M-4 - M-6 

Example, L-5, L-7, L-29, 
L-31, L-39 
See also Special effects 
Square, M-5 

Button on mouse 
See Mouse 

c 
Cabling 

Printer, F-19 
CAD conversion, G-1 
Callouts, 4-32 - 4-33 
Camera guides, 5-21 
Cancel a menu, 3-8 
CAP files, 5-10 - 5-11 
Capitalize, 4-17 

Change capitals to lower 
case letters, M-20 
First letter of each word, M-20 
Make all letters in a 
word capitals, M-20 

Caps Lock, 4-20 
Caption files, 4-19, 5-94 
Captions 

Adding to pictures, 5-92 - 5-95 
Auto-numbering for, 5-93, 
5-96 - 5-97 
Caption margins, 5-80 
Converting to text file, 5-41 
Example, L-23 
Figure counter, 5-96 - 5-97 

Index-2 

Placing both on same line, 5-94 
Table counter, 5-96 - 5-97 
Tags, 5-94, 6-16 

Carriage return 
See Enter 

Center 
See Alignment 

Center text 
See Alignment, 5-108 

Centimeter, 3-9 
CGM, 5-16, G-1 
Change bar 

Example, L-5, L-7 
Change bars, 5-132 
Chapter 

Continue page numbers across 
multiple, 5-52 
Defined,1-2 

Chapter counter, 5-50 - 5-51 
Chapter files 

C 

Combining into publications, 5-172 
Difference from text file, 4-22 
Printing, 5-19 - 5-21, 5-174 
See files associated with, 5-173 

Character formatting 
See Style sheet 

Character set, E-1 
Character space 

Changing, 4-19 
Characters 

See Alt key 
See Fonts 
See Foreign character 
Hidden, 5-167 

CHP extension, 5-8 
CIF files, 5-10 - 5-11 
Clear menu, 3-14 
Clipboard 

Defined,I-2 
Frame, 5-29 
Graphic, 5-30 
Text, 5-28 

Close chapter 
See Quit, 5-24 

Color, 3-19, D-6 
Color separations, 6-18 
Column balance, 5-84 

Columns don't balance exactly, 5-84 
Column break, 5-117 - 5-119 
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Colwnn guides, 5-165 
Underlying page used as grid, 6-2 

Colwnn snap, 5-168 
Colwnns 

Aligning text within, 5-168 
Changing to equal width, 5-79 
Changing to unequal 
column width, 5-79 
Different left/right page, 5-80 
Example, unequal, L-31 
Margin & column 
option, 5-78 - 5-81 
See also Margins & Columns 
More than eight, 5-91 
Rules, 5-98 
Vertical tabs, 6-17 

CONFIG.SYS, 2-6 
Contents of Ventura Publisher, 1-2 
Conversion 

DXF to GEM, G-l 
Text to PCX, G-5 

Copy, 5-26 - 5-30 
Chapter, C-l, 5-179 
Frame, 5-29 
Graphic, 5-30 
Publication, 5-179 
Text, 5-27 
Text attributes, 5-28 

Copy-fitting, 6-8 
Copyright symbol, 4-25 

See Keyboard keys 
Cordata printer, F -24 - F -26 

Fonts, F-24 
Images, nwnber/page, F-25 
New fonts for, K-12 - K-13 
Print to file, F -25 

Coupons, M-7 - M-I0 
Creating new tags, 4-14 
Crop, 5-85 

Defined,I-2 
See Sizing & scaling 

Crop marks, 5-21, 1-2 
Crosshairs, 5-153 
Ctrl key, 3-4 
Current Selection Indicator, 4-6, 4-20 
Cursor 

Mouse, 1-5,3-1 
Text, 1-5 

Cursor keys, 3-3 
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Cut, 5-26 - 5-30 
Text attributes, 5-28 

Cut/copy/paste, 5-26 - 5-30 
Cutlines 

See Callouts, 4-32 

D 

Database publishing, H-l 
Example, L-25 

Dataproducts 
LZR 2660, F-18 - F-23 
LZR 2665, F-18 - F-23 

Dbase III, D-l, D-13, H-l 
DCA, D-14 
DEC Print Server 40, F-18 - F-23 
Default settings, 5-24 
Definition, I-I 

Arabic numbering, 5-50 
Assignment list, 3-17 
Images, 1-5, 4-5 
Line art, 1-4, 4-5 
Line break, 4-23 
Mouse cursor, 1-5 
Orphan, 5-48 
Pictures, 4-5 
Tag, 5-104 
Text, 1-4 
Text cursor, 1-5 

INDEX 

Typographic conventions, 1-4 -1-6 
Widow, 5-48 

Delete 
Character, 4-19 
Directory, 5-22 - 5-23 
Extra carriage returns, D-ll 
Files, 5-22 
Frame, 5-28 
Graphic, 5-29 
Page, 5-73 - 5-74 
Repeating frame, 5-90 
Text, 4-20, 5-27 

Delete key, 3-3 
Desk menu, 5-5 
Dialog box 

Defined,I-2 
Erase line oftext, 3-8 
Use of, 3-7 - 3-9 
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Dictionary 
See Hyphenation dictionary 

Direction keys 
See Keyboard keys 

Directory 
Changing, 3-12 

. Creating new, 5-23 
Delete, 5-22 - 5-23 
Make new, 5-22 
See also Subdirectory 

Discretionary hyphen, 3-6, D-9 
Defined,I-2 

Disk drives 
Changing, 3-12 

Disk full, 5-22 
Displaywrite, D-14 
Document 

See Chapter 
Documentation 

How to use, 1-1 
DOS COPY command, C-l 
DOS file operations, 5-22 - 5-23 
DOS version, 2-4 
Dot leader 

See Tabs 
Dot leaders 

See Leaders 
Dot matrix printers, F-17 

Fonts, F-18 
Paper size, F -17 
Resolution, F-17 

Double spaces 
Eliminating, 5-15 

Double underline, 4-17 
Change defaults, 5-125 

Drawing 
See Graphic drawing function 
See Graphics 

Drives 
Changing the active, 3-12 

Dropped capital, 5-123 - 5-124 
M-2 -M-3 ' 

Duplex printing, 5-20 
DXF file, G-l 
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E 
Edit menu, 5-25 - 5-41 
Editing 

See Graphic drawing function 
See Text editing 

Editing text to fit 
See Copy-fitting, 6-8 

Em dash, 3-6, 4-25, 6-11, 1-3 
Em space, 3-6, D-I0, 1-3 
EN dash, 3-6, 1-3 
En space, 3-6, D-I0, 1-3 
End key, 3-3 
End of file symbol, 5-167 
End session 

See Quit, 5-24 
Enlarging a picture 

See Sizing & scaling 
Enter key, 1-4, 3-8, 4-22 
Epson LQ 1500, F-17 
Epson MXIFXIRX-880, F-17 
Equations, 5-122 
Erase 

See Backspace key 
See Delete 

Error messages, C-6 
Escape (ESC) key, 3-3, 3-8 
Exit 

See Quit, 5-24 
Expanding font files, A-12 
Extension 

F 

Default names, 3-12 
Defined,I-3 

Features 
List, 1-3 

Figure counter, 5-29 
Example, L-19 

Figure space, 3-6, D-I0 1-3 
File ' 

Creating new text, 4-21 
Defined,I-3 
Delete, 5-22 
Filters, changing, 3-11 

E 
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Graphics files created, 5-15 
Name conventions, 3-12 
Print to file, C-1, 5-155 
Removing, 4-7, 5-38 - 5-39 
Removing excess, 5-39 
Renaming, 5-40 - 5-41 
Within chapter, 5-173 
Write protected, 5-23 

File menu, 5-6 - 5-24 
File type/rename, 5-40 - 5-41 
Files 

Backup, 5-10 
CAP, 5-10 - 5-11 
CIF, 5-10 - 5-11 
VGR, 5-10 - 5-11 

Fill attributes, 4-30, 5-143 - 5-144 
Filter 

Defined, 1-3 
First line indent, 5-109 
Floppy disks 

Don't read directly, 3-12 
Font Metric 

Defined, 1-4 
Fonts, 5-106 - 5-107 

Adding new, C-1, 5-160 - 5-162, K-1 
AST 'furboLaser, F-24, K-12 - K-13 
Changing, D-6, 4-18 
Character set, E-1 
Cordata, F-24, K-12 - K-13 
Defined,I-4 
Definition, K-1 
Disable downloading, 5-162 
Dot matrix printer, F-18 
HP LaserJet, F-12, K-6 - K-8 
Installing new, 5-159 
Interpress, F-18 
JLaser, F-16, K-12 - K-13 
Modifying automatic kerning, K-22 
Paragraph tag 
doesn't change, 5-107 
PostScript, F-18, K-14 
Printing, won't print font, 5-107 
Screen fonts, K-3 - K-4 
Selected text, 4-17 
Size limitations, 5-107 
VFM file format, K-18 - K-21 
Width tables, 5-157 
Wrong size in line art, F-1 
Xerox 4020, F-9 
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Xerox 4045, F-6, K-9 - K-ll 
Footer 

Defined, 1-4 
See also Headers & Footers 

INDEX 

Footnotes, 5-70 - 5-72, M-11 - M-13 
Adding to a chapter, M-12 
Changing placement, 5-72 
Copying/moving, 5-28 
Defined, 1-4 
Deleting, 5-31 
Editing, 5-31 
Example, L-5 
Formatting, M-13 
Inserting, D-10, 5-31 
Length limitation, 5-31 
Margins & Columns, 5-81 
'fum on/off, 5-31 

Foreign characters, D-3, 4-25 
Foreign language 

Hyphenation, B-2 
Format 

See Style sheet 
See Tag 

Forms, 4-33 
See Coupons 

Formulas, 5-122 
Mathematical, 4-26 

Frame setting 
function, 3-17, 4-2 - 4-11 

Frames 
Adding, 4-3 
Anchoring, D-10, 5-36 - 5-37 
Background, 5-102 - 5-103, L-21 
Captions, 5-94 
Changing size, 4-7 
Column snap, 5-168 
Creating multiple, 4-4, 5-38, 6-6 
Cut, copy, paste, 5-28 
Defined, 4-2 - 4-11, 1-4 
Delete, 5-28 
Example, anchored, L-39 
Example, padding, L-29 
Gray selection lines, 5-89 
Line snap, 5-169 
Margins, 5-166 
Menu, 5-77 - 5-103 
Moving, 4-7 
Placement, 5-83, 6-7 
Placing files in, 4-5 
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Re-anchor, 5-62 - 5-63 
Removing file from, 4-7, 5-38 
Repeating, 5-88 - 5-91 
Ruling lines around, 5-100 - 5-101 
Selecting multiple, 4-9, 6-7 
Selecting underneath, 6-6 
Selection borders, 6-7 
Sizing & Scaling, 5-82 - 5-87 
Text fit, 6-8 
Text flow around, 5-82 
Text in, 6-1 - 6-2 
Too complex to format, 5-91, H-5 
Underlying page, 5-77 
Word wrap around, D-5 

Full box, 3-15 
Function keys 

Assigning, 5-136 - 5-137 
See also Assign function keys, 4-22, 
5-136 - 5-137 

Function Selector, 4-1 - 4-36 

G 

Gl characters 
See Foreign characters 

GEMPRINT.SYS, F-2 
Generated numbers 

See Auto-numbering 
See Section numbering 

Generated tags, 5-148, 6-16 
Z]NOT # and Z_FNOT ENTRY, 

M-ll 
Glossary, 1-1 
Go to page, 5-75 - 5-76 

Keyboard shortcuts, 5-76 
Relative to file, 5-76 

Graphic drawing function, 3-17, 
4-27 - 4-36 

Graphic menu, 5-138 - 5-146 
Graphics 

Blocking text or shading, M -10 
Cut, copy, paste, 5-29 
De-selecting, 5-145 
Drawing multiple, 4-32 
Fill attributes, 4-30 
How to use, 4-28 
Keep tool enabled, 3-3 
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Line attributes, 4-30 
Load from, 5-142 
Overview, 4-28 
PostScript, 5-16 
Repeating, 4-28 
Save attributes, 5-142 - 5-143 
Saving/loading line and fill 
attributes, M-9 
Select all, 5-145 
Selecting graphic on bottom, 4-32 

Graphs 
See Graphics 
See Pictures 

Greeking, 5-42, 5-149 
Defined,I-4 

Grid settings, 4-29, 5-146 
Gutter 

See Columns 
Gutter rule 

See Vertical rules 

H 

Hanging indent, 1-6, M-14 
See also Outdent 

Hard disk 
Space requirement, 2-3 
Space taken on, A-2 

Head margin 
See Spacing 

Headers & Footers, 5-64 - 5-68 
Example, generated, L-25 
Example, generated phone 
list, L-15 
Generated, 5-66 
Large, 5-91 
Margins & Columns, 5-80 
Multi-column, 5-91 
Tags, 6-16 
Turn on/off, 5-69 

Help 
See Appendix C 
See relevant topic in index 

Hidden text, D-I0 
Hide column guides, 5-165 
Hide pictures, 5-166 
Hide rulers, 5-164 

G 
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Hide side-bar, 5-163 
Highlight text, 4-15 
Highlighting 

See Text attributes 
Home key, 3-3 
Horizontal scroll bar, 3-16 
Horizontal tabs, 5-120 - 5-122 
HP LaserJet, A-9, F-9 - F-14 

Cabling, F-9 
Configuration switches, F-11 
Courier font; can't 
print landscape, F-15 
Disable font downloading, 5-162 
Error 20, F-13 
Font cartridge, A-9, F-11 
Fonts, F-12 
Images, number/page, F-15 
New fonts for, K-6 - K-8 
Out of memory, F-13 
Paper size, F-11 
Resolution, F-11 
White text, F-15 

HP LaserJet II, A-9 
HP Thinkjet, F -17 
HPGL, 5-16, G-3 
Hyphenation 

Dictionary, B-1 
Example, successive control, L-21 
Foreign languages, B-2 
Overriding for specific words, 4-24 
Turning on/off, 5-109 

Hyphens 

I 

Discretionary, D-9, 4-24 
Removing, D-9, 4-24 

IBM 4216 laser printer, F-18 - F-23 
IBM Proprinter, A-8 
Images 

Cropping, 3-3, 5-85 
Defined, 1-5, 4-5, 1-4 
Scaling, 5-85 

Inch,3-9 
Indent, 5-109 

Defined,I-4 
First line, 5-109 
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From both margins, 5-116 
Hanging, M-14 

Indents/Outdents, M-14 - M-15 
Index 

Copying/moving, 5-28 
Creating, 5-32 - 5-35 
Creating within 
wordprocessor, D-10 
Deleting, 5-34 
Example, text contains 
indices, L-39 
Generating, 5-176 

INDEX 

Repeat automatically throughout 
section, 5-66 
Tags, 6-16 

Insert 
See Text editing 

Insert footnote, 5-31 
Insert key, 3-3 
Insert/edit anchor, 5-36 - 5-37 
Insert/edit index, 5-32 - 5-35 
Insert/remove page, 5-73 - 5-74 
Installation, 2-1 - 2-8 

Begin, 2-4 
Hard disk space required, 2-3 
Software, 2-2 - 2-6 
Updating from version 1.0, A-2 

Inter-line spacing 
Defined, 1-4 
Setting, 5-112 

Inter-paragraph spacing, 5-113 
Example, L-29 

Interpress, F-18 - F-23 
Defined,I-5 
Fonts, F-18 
Print files, 5-156 

Italics 
See Text attributes 

Item selector 
Beep, 3-12 
Filter, 1-3 
Operation, 3-10 -3-13 
Too many files, 3-12 
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J 

JLaser, F-15 - F-16 
Fonts, F-16 
New fonts for, K-12 - K-13 
Paper size, F-15 
Print to file, F-16 
Printing problems, F-17 
Resolution, F-16 

Justification 
Defined,I-5 

Justify 
See Alignment 

K 

Kerning, 4-19 
Automatic, 5-125 
Defined, 1-5 
Example, L-11 
Manual, D-8 
Modifying automatic, K-22 
On-screen, 5-150 

Keyboard 

L 

Characters not on, D-3, 4-25 
Keys, 3-1 - 3-6 
Shortcuts, 3-4 

Labels 
See Callouts, 4-32 

Landscape, 5-46 
Defined, 1-5 

Large documents 
Creating, 5-172 

Laser printer 
See name of printer 

LaserJet 
See HP LaserJ et 

LaserWriter, A-9, F-18 - F-23 
Baud rate, F-19 
Cabling, F-19 
Connection to PC, F-19 
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Error message, F-19 
New fonts for, K-15 

Layout 
Defined,I-5 

Lead-ins, 5-118, M-18 
Creating, M-19 
Example, L-27 

Leaders, M-29 
Defined,I-5 
Deleting, M -17 
See also Tabs 
Turning off in specific tabs, M-30 

Leading 
Defined,I-5 
See also Inter-line spacing 
See also Spacing 

Left justify text 
See Alignment, 5-108 

Letterspacing, 5-125, 5-170 
Example, L-19 

Line art 
Cropping, 5-85 
Defined, 1-4,4-5,1-5 
Scaling, 5-85 

Line attributes, 4-30, 5-141 - 5-142 
Line break, 3-4, D-9, 5-117 - 5-119 

Defined, 4-23, 1-6 
Example, L-9 
Use in a database, H-3 

Line length, 1-6 
Line snap, 5-169 
Linotronic 

100,300, F-18 - F-23 
Cabling, F-19 

Lists 
See Section numbering, 

Auto-numbering 
Load different style, 5-17 
Load from, 5-144 
Load text/picture, 3-10, 5-13 - 5-16 

Changes to text, 5-14 
Several files, 5-14 

Loading a style sheet, 6-12 
Logoff 

See Quit, 5-24 
Loose lines, 5-170 
Lotus 1-2-3, D-1 

Creating pictures, G-3 
Printing spreadsheet text, D-12 

J 
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M 

Macintosh 
Paint, G-4 
PICT, G-4 

Mainframe 
Text files from, D-12 

Maintain aspect ratio, 5-85 
Make directory, 5-22 - 5-23 
Margins 

Binding, 5-80 
Left/right page, 5-80 
Temporary text margins, 5-116 

Margins & Columns, 5-78 - 5-81 
Measurement units 

Changing, 3-9 
Rulers, 5-152 

Mechanical,I-6 
Memory 

Out of memory, C-9, C-13, 
C-21, C-26, H-3, H-5 
Printer out of memory, A-9, 5-162, 
F-7, F-13 

Menu 
Can't select, 5-1 
Clear, 3-14 
Gray text, 5-1 
Pulling down, 3-14 

Menu commands, 5-1 - 5-43 
Microsoft Word, D-14 

Style Sheets, D-14 
Minimum space width, 5-126 
Mixing type styles, M-18 - M-20 
Monospaced,I-6 
Mouse,A-7 

Cursor, 1-5, 3-1 
Double click, 3-11, 5-150 
Installation, A-7 
Middle and right buttons, 3-1 
Operation, 3-1 
Problems with, A-7 

MOUSE.COM, A-7, A-13, 2-6 
Move, 5-26 - 5-30 

Frame, 5-29 
Graphic, 5-30 
Text, 5-27 

Multi-chapter, 5-171 - 5-182 
Multimate, D-15 
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Multiple article chapters, 6-1 
Multiple copy printing, 5-19 
Multiple file loading, 5-14 
Multiple frames, 4-4, 4-9, 6-7 
Multiple graphics, 4-32 

INDEX 

Multiple paragraph tagging, 4-12, 
4-22 

N 

Network operation, C-2 
New, 5-7 
New page, 6-4 
Newspaper layout, 6-1 - 6-2 

Example, L-21 
Re-using, 6-5 

Non-breaking space, 3-6, D-9, 4-23 
Normal space width, 5-127 
Numbering 

o 

Automatic section 
numbering, 5-54 - 5-60 
Chapter, 5-50 - 5-51 
Lists, 5-59 
Page, 5-52 - 5-53 

Opaque, 5-144 
Open chapter, 5-8 - 5-9 
Options menu, 5-147 - 5-170 
Orphan 

Defined, 5-48, 1-6 
Outdent, 5-109 

Defined,I-6 
Outdents 

See also Indents/Outdents 
Outlines, 5-54 - 5-60 
Output 

See Printing 
OUTPUT.wID, 5-158 
Overscore 

Change defaults, 5-125 

Index-9 



INDEX 

p 

Packing list, 1-2 
Padding, 5-87 

Example, L-29 
Page 

Create new, 6-4 
Creating new automatically, 6-4 
Go to, 5-75 - 5-76 
InsertlRemove, 5-73 - 5-74 

Page break, 5-117 - 5-119,6-11 
Example, L-5,L-7, L-9, L-11 

Page counter, 5-52 - 5-53 
Page down, 3-3 
Page layout, 5-45 - 5-47 
Page menu, 5-44 - 5-76 
Page number indicator, 3-17, 5-53 
Page numbers 

See Headers & Footers 
See Numbering 
See Page counter 

Page up, 3-3 
Paper size, 5-46 
Paragraph 

Adding and deleting, 4-22 
Defined,I-6 
Line break, 4-23 
Numbering automatically 
5-54 - 5-60 
Spacing, 5-113 

Paragraph menu, 5-104 - 5-137 
Paragraph tagging, 3-17, 4-12 - 4-14 
Paste, 5-26 - 5-30 

Defined,I-6 
PC Paint 

Can't load files, C-5 
PC Paintbrush 

Color, G-4 
Creating, G-4 
No color, C-4, G-4 
Text to PCX conversion, G-5 

Phone directory, H-1 
Picas, 3-9 

Defined, 3-9, 1-6 
Setting measurement in 3-9 

Picture anchor, D-10 ' 
Pictures, 4-7, 5-13 - 5-16 

Defined, 4-5, 1-6 

Index-10 

Exceed frame boundaries, 5-16 
Obscurestext, F-23 
Text wrong size, C-3 
Too big for frame C-3 

Points, 3-9 ' 
Defined, 3-9, 1-7 

Port 
Defined,I-7 

Portrait, 5-46 
Defined,I-7 

PostScript, F-18 - F-23 
Bug, F-23 
Defined,I-7 
Encapsulated, G-2 
Files, 5-16 
Files don't display, 5-16 
Fonts, F-18 - F-19 
LaserWriter, B-3 
Prologue, F-22 
Resolution, F-18 

Print file 
AST TurboLaser, F-25 
Cordata printer, F -25 
JLaser, F-16 
LaserWriter, F-19 

Printer 
Capabilities, 5-144 
Determining limitations of F-1 
Installing multiple, A-10 ' 

Printer info, 5-154 - 5-159 
Printer troubleshooting, C-5 F-1 
F-17, F-25 ' , 
Printing 

Blank near edge of page, F-3 
Changing ports, 5-155 
Changing printers, 5-155 
Chapter, 5-19 - 5-21 
Disable font downloading 5-162 
Disk files, 5-156 ' 
Double sided, 5-46 
Duplex, 5-20 
Fonts won't print, 5-107 
Large format, 5-21 
Matching width tables 5-157 
Multi-Chapter, 5-174 ' 
Multiple copies, 5-19 
Options, 5-154 - 5-159 
Portrait or landscape, 5-46 
Printer won't print, C-1 

p 
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Publication, 5-174 
Selected pages, 5-20 
Space between word 
incorrect, 5-158 
Stopping, 5-21 
To a file, C-1, 5-20, 5-155, 
F-16, F-25 
To file, multi-chapter, 5-174 

Problem 
- character in dialog box, 3-9 
Assignment list, can't select, 3-18 
Assignment list, unwanted tag 
names, 6-16 
Beep, 3-6 
Blank columns, 5-109 
Blank near edge of page, F-3, F-ll 
Box text blank, 4-33 
Bullet overlaps text, 5-124 
Caption doesn't appear, 5-94 
Chapter different than saved, 5-18, 
5-134 - 5-135, 6-13 
Chapter, can't find, C-3 
Character doesn't print, 4-25 
Columns don't balance, 5-84 
Cursor keys, 3-7 
Dialog box disappears, 3-8 
Dialog box numbers change, 3-9 
Disk drive change wrecks display, 
3-12 
Disk drives, changing, 3-12 
Disks not used during installation, 
2-5 
Enter doesn't end dialog, 5-180 
Facing page format 
inoperative, 5-47 
Facing pages view 
not available, C-3 
File, can't find, 3-13 
Font selection gray, 5-107 
Font, won't change, 5-107 
Fonts (screen & printer) 
don't match, 5-159 
Fonts won't print, 5-107 
Footer spacing too large, 5-68 
Footnote space above, 5-72 
Footnotes don't appear, 5-31, 5-71 
Frame moves instead of 
changing size, 4-8 
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Frame rules overlap 
picture or text, 5-101 
Frame wide text, 5-85 
Frame, can't select, 4-29 

INDEX 

Graphic repeats on every page, 4-28 
Graphic, can't, M-10 
Graphic, can't select, 4-29 
Header not displayed, 5-69 
Header spacing too large, 5-68 
Header/footer doesn't display, 5-65 
Menu option gray, 5-1 
Menu options gray, 5-104 
Multiple paragraph 
selection lost, 4-13 
Numbers in dialog box 
change, 5-131 
Open chapter is slow, 5-8 
Page doesn't print 
completely, F-7, F-13 
Paragraph overwrites 
other text, 5-109 
Paragraph selection lost, 4-13 
Picture not in frame, C-3 
Picture obscures text, F -23 
PostScript bug, F-23 
Print doesn't match screen, 3-18 
Print, page edges blank, 3-19 
Print, page numbers wrong, 5-20 
Print, some characters 
don't print, 3-19 
Print, wrong page numbers, 5-53 
Printer won't print, C-5 
Printing, wrong space between 
words, 5-158 
Ruling box doesn't print, 6-7, F-23 
Ruling box stops at column/page, 
5-130 
Ruling line dashes don't 
print, 5-101, 5-130 
Spacing changed, 5-107 
Spreadsheet columns don't align, 
D-13 
Style sheet changed, 5-18 
System stops while loading 
text, 3-14 
Tab doesn't take effect, 5-121 
Tab, first line indent, 5-122 
Tabbed text beyond margin, 5-122 
Tabs don't work, 5-122 
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Text attributes change, 4-21 
Text beyond right margin, 6-17 
Text disappears, 4-20 
Text doesn't appear in frame, C-2 
Text doesn't match 
Appendix L styles, 6-14 
Text flow around 
irregular shape, C-5 
Text format changed in 
wordprocessor, D-2 
Text formatting speed, 5-84 
Text from later to earlier page, 6-5 
Text in first column only, 5-85 
Text in wrong'frame, 6-4 
Text into right margin, 5-110 
Text moves to next 
column/page, 6-8 
Text on top oftext, 5-59 
Text, can't place where 1 want, C-4 
Text, can't read, 5-149 
Vertical rule doesn't show, 5-99 

Problems 
Error messages, C-6 

Prologue 
PostScript, F-22 

Publication 

Q 

Creating, 5-172 
Defined,I-7 

QMS 
PS 800, 1200, 2400, F-18 - F-23 

Quit, 5-24 
Quotes 

True typographic, 3-6, 4-25, 6-11 

R 

Re-anchor frames, 5-62 - 5-63 
Rearrange 

Chapters within publication, 5-173 
Redraw screen, 4-20 
Reducing a picture 

See Sizing & scaling 
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Reformat page, 3-3 
Register marks, 5-21,1-2 
Remove 

Directory, 5-23 
File, 5-38 - 5-39 
Page, 5-73 - 5-74 
Tag, 5-133 - 5-134 

Rename tag, 5-135 
Renumber chapter, 5-61 
Repeating frames, 5-88 - 5-91 

Text in, 4-6 
Requirements 

System, 2-1 
Reset section number, 5-59 
Return 

See Enter 
Reverse type, 5-131, M-21 - M-22 
Right justifY text 

See Alignment, 5-108 
Roundoff error, 3-9 
Rulers 

Measurement units, 5-152 
Show/hide, 5-164 

Ruling box around 
Example, L-7, L-31, L-39 

Ruling lines 
Custom width, 5-130 
Dashes, 5-101, 5-130 
Defined,I-7 
Example, ruling line 
over text, L-13 
Frames, 5-100 - 5-101 
Paragraph, 5-129 - 5-132 
Vertical, 5-98 - 5-99 

Run arounds, C-5, 4-9, 5-87 
Defined,I-7 

Running head 
See Headers & Footers 

Running the program, 2-7 

s 
Save, 5-10 

Files, 3-10 - 3-13 
Publication, 5-173 

Save as, 5-11 
Save as new style, 5-18 

Q 
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Scale 
Defined, 1-7 

Scaling, 5-85 
Scanner, 5-16 

Compatibility, C-4 
Defined, 1-7 
Printing images from, 5-86 

Screen controls, 3-14 - 3-16 
Screen fonts, K-4 

PostScript, K-5 
Screen snapshot, G-5 
Screened type 

See also Shaded type 
Scroll down one line, 3-16 
Scroll left one character, 3-16 
Scroll right one character, 3-16 
Scroll up one line, 3-15 
Scrolling 

Difference from go to page, 5-76 
Search and replace, D-l 
Secondary leading 

See Inter-paragraph 
spacing, 5-113 
Section numbering, 5-54 - 5-60 

See also Auto-numbering 
Example, L-39 
In frames, 5-57 
Tags, 5-57 

Select 
Defined, 1-5, 1-8 
Menu option, 3-15 
Text, 4-15 

Select all, 4-29, 5-145 
Send to back, 5-139 
Set font 

U sing to change text 
attributes, M-19 

Set preferences, 5-148 - 5-151 
Set rulers, 5-152 - 5-153 
Shaded type, M-21 - M-22 
Shading 

See Frames, background, 5-102 
Shift 

Font, D-7 
Shift keys, 3-3 
Shortcut, 3-4 

Mouse, 3-11 
ShowlHide column guides, 5-165 
Showlhide loose lines, 5-170 
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ShowlHide pictures, 5-166 
ShowlHide rulers, 5-164 
ShowlHide side-bar, 5-163 
ShowlHide tabs & returns, 5-167 
Side-Bar, 3-17, 5-163 
Sidekick, A-I, G-5 

Note files, D-13 
Size box, 3-16 
Sizing & scaling, 4-7, 5-82 - 5-87, 6-7 
Small case, 4-17 
Soft hyphen 

See Discretionary hyphen 
See Hyphenation 

Space, 4-23 
Em, 3-6, D-I0, 1-3 
En, 3-6, D-I0, 1-3 
Figure, 3-6, D-I0, 1-3 
Non-breaking, 3-6, D-9, 4-23 
Thin, 3-6, D-I0, 1-8 

Space character 
See Character space 

Spaceband,5-126 
Spacing, 5-111 - 5-116 

Adding additional between 
paragraphs, 4-11 
After period, colon, 5-15 
Between lines, 5-112 
Between paragraphs, 5-15, 5-113 
Between words, 5-126 
Inter-paragraph,5-113 
Total paragraph space, 5-115 
Vertical,5-111 

Special characters 
See Altkey 
See Fonts 
See Foreign characters 

Special effects, 5-123 - 5-124 
Special function keys, 3-4 
Speed 

Improving screen drawing speed, 
5-166 
Printing, 5-20 
Slow loading due to 
excess files, 5-39 

Spelling check, D-l 
Spreadsheets 

Publishing, D-12 
Square Bullet, M-5 
Starting the program, 2-7 
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Store 
See Save 

Stretch to fit, 5-85 
Strikethrough 

Change defaults, 5-125 
Style sheet 

Attributes stored in, 5-44 
Changed unexpectedly, 5-18 
Creating, 6-12 - 6-13 
Defined, 6-12, 1-8 
Designing, 6-13 
Examples, Appendix L, L-1 
Loading, 5-17, 6-12 
Margins & Columns 
stored in, 5-77 
Menu options affecting, 6-15 
Modifying, 4-14, 6-12 
Saving, 5-18, 6-13 
Unwanted changes in, 5-10 
Width table stored with, 5-158 

Subdirectory 
Selection, 3-12 

Suppress previous level, 5-56 
Symbols, 4-25, E-1 
System requirements, 2-1 

T 

T-Square, 5-153 
Tab in 

See Indent 
Tab key, 3-4 
Tabbed out 

See Outdent 
See Outdent, 5-109 

Table counter, 5-29 
Table counter/figure, 5-96 - 5-97 
Table of contents 

Example, tags for, L-37 
Generating, 5-174 
Tags, 6-16 

Tables, M-23 - M-27 
Aligning numbers 
(figure space), 1-3 
Creating, 4-33,6-10 
Example, L-33, L-35 

Index-14 

Using box text to create 
tables, M-27 
Using tabs for 
simple tables, M-28 - M-32 

Tabs, 5-120 - 5-122 
Adding leaders to tabs, M-29 
Changing decimal, 5-149 - 5-150 
Example, L-11, L-13, 
L-15, L-21, L-23, L-33 
Example, vertical, L-35 
From wordprocessor, D-4 
Setting, M-28, M-30 
Showlhide, 5-167 
Text right margin, 5-122 
Used to create tables, 6-10 
Versus spaces, D-5 
Vertical, 6-17 
Wordstar, D-16 

Tag multiple paragraphs, 4-12, 4-22 
Tags 

Adding new, 4-14 
Assigning to text, 4-12 - 4-14 
Auto-numbering, 5-57 
Captions, 5-94 
Choosing names, 6-15 
Defined, 5-104, 1-8 
Extracting tagged text, 5-66 
Font, 5-106 
Frame-wide, 5-109 
Function keys, 3-4 
Generated, 4-13, 6-16 
Headers & Footers, 5-68 
Hidden, 5-148 
In a wordprocessor, D-2 
Modifying, 4-14 
Removing, 5-133 - 5-134 
Renaming, 5-135 
Showlhide generated, 5-149 
Spacing automatically 
changed, 5-107 
Unexpected new names, 6-16 
Z-tags, 6-16 

Tall orientation 
See Portrait 

Text 
Adding and deleting, 4-19 
Alignment, 5-108 - 5-11 0 
Automatic text insertion, 5-60 
Beyond right margin, 5-122 

T 
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Changes during loading, 5-14 
Defined, 1-4 
Hidden, D-I0 
Keep away from frames, 5-87 
Reverse, 5-131 
See also ASCII text, D-12 
White on black, 5-102, 5-131 

Text attributes 
Canceling, D-8 
Changing, 4-15 
Cut/copy, 5-28 
Deleting, 4-20 
End of paragraph, D-8 
Example, L-13 
Example, in footer, L-15 
Precedence over tags, 4-17 
Using Set Font to change, M-19 
U sing the Assignment List 
to change, M-20 
Wordprocessor, D-5 

Text cursor 
Defined, 1-5 

Text editing, 4-20 
Across page boundaries, 5-76 
Adding non-keyboard 
characters, 3-3 
Adding/deleting text, 4-19 
Alt key, 3-3 
Backspace key, 3-3 
Blank frame/page, 4-21 
Changing typeface, 4-18 
Copy text between chapters, 5-28 
Ctrl key, 3-4 
Cursor keys, 3-3 
Cut, copy, paste, 5-27 
Delete key, 3-3 
End key, 3-3 
Enter key, 1-4 
Escape (ESC) key, 3-3 
Hidden characters, 5-167 
Home key, 3-3 
Insert key, 3-3 
Kerning, 4-19 
Line break, 3-4, 4-23 
Move, 5-27 
Non-breaking space, 4-23 
Non-keyboard symbols, 4-25 
Page down key, 3-3 
Page up key, 3-3 
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Paragraphs, adding/deleting, 4-22 
Section numbers, 5-56 
Select text, 4-15 
Set Font, 4-17 
Shift keys, 3-3 
ShowlHide tabs & returns, 5-167 
Special function keys, 3-4 
Tab key, 3-4 

Text editing function, 3-17, 4-15 - 4-26 
Text flow around, 5-82 
Thin space, 3-6, D-I0, 1-8 
Tilde character (-), 3-9 
Title bar, 3-15, 5-10 
To print, 5-19 - 5-21 
Tracking 

Example, L-11 
Trademark symbols, 4-25 
Trailer 

See Headers & footers 
Transparent, 5-144 
Trim marks 

See Register marks 
Trim pictures 

See Scaling, 5-85 
Turn column snap on/off, 5-168 
Turn footers off/on, 5-69 
Tum headers off/on, 5-69 
Tum line snap on/off, 5-169 
Typeface 

Changing, 5-159 
Creating new, 5-159 
Defined,I-8 
See Fonts 

Typeset 
Defined,I-8 

Typographic controls, 5-125 - 5-128 
Automatic, 6-11 

Typographic conventions, 1-4 -1-6 

u 
Underline 

Change defaults, 5-125 
Example, customized, L-11 

Underlying Page 
Defined, 1-8 
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Undo 
See Abandon, 5-12 

UNTITLED.CHP, 5-10 
Update from version 1.0, A-2 
User interface, 3-1 - 3-20 

v 
Version information, 5-5 
Vertical justification, 5-84 
Vertical rules, 5-98 - 5-99 

Example, L-19, L-23 
Vertical scroll bar, 3-16 
Vertical tabs, 6-17, M-23 - M-27 

Creating tags for, M-24 
Example, L-35 
Typing text for, M-24 

VFM file, K-18 - K-21 
VGR files, 5-10 - 5-11 
Video Show, 5-16, G-4 
View menu, 5-42 - 5-43 
VP.INF file, 5-24 

w 
White letters on a black background 

See Reverse type 
Wide orientation 

See Landscape 
Widow 

Defined, 5-48, 1-8 
Widows & Orphans, 5-48 - 5-49 
Width table 

Not in standard format, C-17 
Won't load, C-18 

Width tables, A-10, 3-13 
Adding kerning to, 5-126 
Changing, 5-157 
Creating new, 5-161, K-5 
Defined,I-8 
Load new width table, 5-161 
OUTPUT.WID, 5-158 
Stored with style sheet, 5-18 
Use, 5-17, 5-154 
Used to add fonts, 5-159 
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Wildcard,I-3 
Windows Write, D-14 
Wordprocessor, D-1, 4-19 

Attributes, E-1 

v 

Converting between different, 5-40 
Developing index in, D-ll 
Information deleted, D-1 
Text attributes, D-5 
Writing custom converter, D-1 

Wordstar, D-16 
Tabs, D-5, D-16 

Wrapping text around picture 
See Run arounds 

WYSIWYG 
Defined, 3-18 - 3-20, 1-8 

x 
Xerox 4020, F-8 

Fonts, F-9 
Resolution, F-8 
Switch settings, F-8 

Xerox 4045, F-3 - F-7 
Configuration switches, F-3 
DRAM option, F-3 
Fonts, F-6 
New fonts for, K-9 - K-ll 
Out of memory, F-7 
Paper size, F-3 
Resolution, F-6 
300 DPI driver, A-8, F-4 - F-6 

Xerox writer, D-17 
Xywrite, D-17 

z 
Z-tags, 6-16 

See also Tags,generated 
Zoom in, 5-43 
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